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Introduction

The Torrent Suite™ Software is organized according to the three main phases of the

sequencing lifecycle:

* Plan — The Plan tab contains both templates (reusable experiment designs) and
planned runs (executable instructions for individual sequencing runs). Select the
experimental design for a template that can be reused many times for sequencing
runs. Template details include application, reference, BED files, project, plugins,
and the export destinations for results files.

* Monitor — View the status of your system and running jobs, including
thumbnail quality graphs for current runs. The quality graphs provide near real-
time information on your runs, so that you know early on about any instrument

problems.

¢ Data — View summaries of completed runs, detailed run reports, and plugin
results. Also download output files, download the run report, review the planned
run settings, and group result sets into projects for data management such as

archiving or pruning of result files.

Templates are organized by research application (and by product for some

applications):

Research application Description
All
AmpliSeqDNA For lon AmpliSeq"™ research applications
(DNA and exome), including the lon
AmpliSeq™ Any Genome, and Custom lon
AmpliSeq™ panels.
AmpliSeqRNA For lon AmpliSeq" research applications

(RNA), including Oncomine Immune
Response Research Assay.

DNA and Fusions

For lon AmpliSeq"™ research applications
such as Oncomine Focus Fusions,
Oncomine Focus DNA & Fusions, Colon and
Lung Research Panel v2.

Generic Sequencing

For your own applications that do not fit in
the other categories. Use this research
application to provide all the choices for the
experiment. Your choices are not restricted
based on a common application workflow.

Human Identification

For templates to run Applied Biosystems™
Precision ID set of panels.

Torrent Suite™ Software 5.6 Help
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User versus Administrator roles

Research application

Description

Immunology

For all Immunology research applications.
For example, lon AmpliSeq" Immune
Repertoire Assay.

Immune Repertoire

For the lon AmpliSeq™ Immune Repertoire
research application.

Inherited Disease

For lon AmpliSeq™ Inherited Disease Panel
and Oncomine BRCA Research Panels.

Oncology - ImmunoOncology

For all ImmunoOncology research
applications. For example, Oncomine™
Immune Response Research Assay.

Oncology - Liquid Biopsy

For your liquid biopsy oncology research
panels.

Oncology - Solid Tumor

For your solid tumor oncology research
panels.

Pharmacogenomics

For lon AmpliSeq" Pharmacogenomics
Research Panels imported from
Ampliseq.com.

Reproductive

lon Reproseq Aneuploidy research
applications.

RNA Seq

For RNA sequencing research applications.

TargetSeq

For TargetSeq™ research applications, with
parameters optimized for hybridization-
based target enrichment.

Whole-Genome

For whole genome sequencing research
applications, such as lon ReproSeq"
Aneuploidy, which do not assume
enrichment and do not require a target
regions file.

16S rRNA Sequencing

For the lon 165" Metagenomics kit.

16S Target Sequencing

For the lon 165™ Metagenomics kit.

User versus Administrator roles

14

In Torrent Suite™ Software, the User role allows the creation and execution of planned
runs on a sequencing instrument. The Administrator role also allows the creation and
execution of planned runs, but also allows server configuration, user configuration,
base caller configuration, reference management, and data management. For more
information on Administrator functions, see “Software administration” on page 300.
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Introduction
Plan a run
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Plan arun

The following steps describe how to plan templates and planned runs that fit into
yourIon S5, Ton S5 XL, Ton PGM ", or Ion Proton” sequencing workflow.

1. Decide on your sequencing application and sequencing product (such as an Ion
AmpliSeq™ panel).

2. Select a pre-installed template with defaults for your application and sequencing
product, or create your own template from scratch to customize your template.

3. Create new planned runs from your templates, adding the names of the samples
to be sequenced. The Torrent Suite™ Software assigns your new plan a run code.

4. Enter the run code directly on the Ion sequencing instrument to start the
sequencing. The planned run automates the process from sequencing through
data analysis and data handling.

Plan templates and planned runs allow you to enter run information via the
Torrent Suite™ Software instead of directly on the Ion sequencer. The use of
templates and planned runs reduces the chance of error and wasted runs,
reduces setup time on the sequencing instrument, and increases instrument
throughput.

On the sequencer, information for a planned run is applied to the current Run
Info screen by entering the short code of the planned run, or by selecting the
planned run from a menu list of planned runs. You can also overwrite (change)
planned run information directly on the sequencer.

Register for a new account

Each new account requires administrator approval. It is not active until approval is
granted.

Follow these steps to register for a new user account:

1. On the sign in page for Torrent Suite™ Software, click Register.

2. Enter the new user information, then click Submit.
Upon the approval of an administrator, the new account is created.

Torrent Suite™ Software 5.6 Help 15
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Samples and Sample Sets

You can set up Samples and Sample Sets when you create Planned Runs, or before
you begin.

1.

2.

Enter new sample

1.

2.

5.

In the Plan tab, click Samples, then click Enter Samples Manually.

Do one of the following:

* Create sample sets manually.
¢ Import samples and sample sets.

* Manage sample attributes.

In the Plan tab, click Samples, then click Enter Samples Manually.
Click Enter New Sample.
In the Add Sample window, complete the fields as described in “Sample

information” on page 20.

Note: The Sample Name field is required. If you do not name the sample, you
will get an error.

Click Done in the Add Sample window.

The sample is not saved until you click Save Sample Set and select a sample set.
If you log out of Torrent Suite™ Software and do not save it to a set, the sample is
not saved.

Click Save Sample Set in the Enter Samples list.

Your new sample is now available in the Enter Samples list.

16
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Samples and Sample Sets
Create sample sets manually

Create sample sets manually
1. In the Plan tab, click Samples, then click Enter Samples Manually.

2. Click Enter New Sample. The following window appears:

Add Sample

sample Name Basic Annotations  Extra Annotations  User-defined Attributes
(required)

sample Extemnal
D

PCR Plate
Position

uuuuuu

Barcode Kit

(Optional) If you have sample pairs, set Relationship Group numbers to reflect
pairs. For example, DNA and RNA samples from the same sample would have
the same Relationship Group number.

a. Fill in the information as required.

b. Click Done. The attributes appear on the Enter Samples list.
c. Enter additional samples.

d. Name Sample Set or add samples to an existing sample set.

3. Click Save Sample Set.

Import samples to create a sample set

If you have multiple samples, you can import the samples with a comma separated
values (CSV) file.

Note: The latest Sample File Format CSV template has a top row that indicates the
version of the template. If you are using sample CSV files that you created with
versions prior to Torrent Suite Software 5.2, you must create a new CSV file with a
new template that is downloaded in version 5.2 or later. To create a new CSV file,
copy and paste the contents of your existing sample CSV file into the new template
under the version row.

A B C D E F G H J K L M N o}
[1 sV Version (required) | 1]
2 |Sample Name (required] Sample 1D PCR Plate | BarcodekitBarcode Gender  Type Group  Descriptio DNA/RNA Cancer Ty Cellularity Biopsy Day Couple ID Embryo 1D
3

1. In the Plan tab, click Samples, then click Import Samples from File.

2. Click Sample File Format to download a CSV template.
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3. Open the CSV template, then enter sample information into the cells, then save it
to your computer.

See “Sample information” on page 20 for more details about fields that are used
in the sample import file.

4. Click Select File, then browse to and upload the sample import file.

5. Click Add Sample Set, then enter a Sample Set Name, Group Type, and
(optional) Description.

The software automatically imports the samples into the Sample Sets list.

6. Click Save & Finish.

Example use of a This example shows a trio sample set and how the run plan reads the sample set
sample set information for Ion Reporter™ Software users.

In the sample set

A trio sample set, named Example Sample Set, is shown in the main Sample Sets
listing:

Samples ]

Sample Sets

Set Name Date # Samples Description Grouping Status
iy
¢ Example sample 201310/03 3 Example Trio planned g
Gat
¢ 09232013 Run 2013026 7 Self created o-
¥ 09242013 Run 2013026 6 Self created o

Expand Example Sample Set entry to open the details for the sample set:

Sample Hame] Sample ID | Gender| Description  [Type| Group
Sampledq Female Example sample |Mother B
SampledZz Male Example sample |Father <
SampledZ Male Example sample |Self B

18 Torrent Suite™ Software 5.6 Help
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The sample set contains three samples that are related and eventually analyzed as

related samples in one Ion Reporter™ Software analysis.
* Type is the Ion Reporter™ Software relationship type information.

* The Group number is the sample set mechanism to mark the samples as related.
(Related means that in the eventual Ion Reporter™ Software analysis, these
samples are analyzed in one analysis with a defined relationship between the
samples, such as Tumor and Normal.)

Sample attributes

You can add fields to samples for sample management. Attributes that you create
appear in the sample listing, in the Add Sample dialog, and in the CSV file that is
used to import sample information.

You can add to the sample attributes that are available when you enter sample
information. Each attribute that you add is available in:

¢ Lists of samples and sample sets in the Torrent Browser
¢ The Add Sample window in the software

¢ The CSV file that is used to import sample information.

An attribute can be made mandatory, in which case it must be entered with every
sample.

Note: Although you create an attribute in the Sample Sets window, the attribute is
applied to individual samples, not to the sample set itself.

Add a sample 1. To create a new sample attribute, in the Plan tab, click Samples, then click

attribute Sample Attributes » Add.
- T oK

Samples

Sample Sets

IManage

Q- Go Clear

2. Inthe Add Attribute window, enter the following:
¢ Attribute Name
e Attribute type
* Description
Note: If you want the attribute to be required with every sample, select the Is

Mandatory checkbox. If the Attribute Type is set to Integer, you can only enter
numeric characters (whole numbers) for this attribute.

Torrent Suite™ Software 5.6 Help 19



)
‘|
|

Rk Samples apd Sample Sets
L Sample attributes

Hide a sample If you hide an attribute, that attribute no longer appears in sample listings or in the

attribute Add Sample dialog. If you hide a mandatory attribute, that attribute is no longer
mandatory.

You can hide a sample attribute in the attribute manage screen.

1. Inthe Plan tab, click Samples, then click Sample Attributes » Manage.

Import Samples from File Enter Samples Manually Sample Attributes

Add

2. In the Sample Attributes list, click Settings (%) » Show/Hide next to the

attribute:
# -
Edit
Delete
Sample This table describes the fields in the Add Sample dialog. The same fields are used in a
information CSV file that is used to import samples.
Field Description
Sample Name Must follow lon Reporter™ Software sample name limits. If the
. actual sample name already exists in lon Re orter” Software, a
(Required) P p

string such as _v1 or _v2, etc., is added to the sample name.

Sample External ID | A field for your own use.

PCR Plate Position | The well number of the sample in the PCR plate.

Barcode Kit The name and/or catalog number of the barcode kit used to make a
library from the sample.

Barcode The name of the specific barcode used to generate a library from
the sample.

Control Type The name of the control used when preparing and sequencing the
sample.

Basic Annotations

Description An open text entry field.
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Field

Description

DNA/RNA/Fusions

The type of library created from the sample.

Gender

The gender of the sample.

IMPORTANT! Do not leave this field empty. Select Unknown if the
gender is not known. Several workflows in lon Reporter™
Software, especially copy number variation detection and genetic
disease screening, are limited when the gender is not known, and
they return unexpected results when the gender is incorrectly
specified for a sample.

Type

The relationship type for this sample, used by lon Reporter”
Software.

Relationship Group

The group number of the sample set of which the sample is a
member. This is identical to the Set ID in the lonReporterUploader
plugin, and is used to identify related samples.

User-defined Attributes

<user defined>

If you create additional sample attributes, each attribute will be
listed here and in the CSV file. Attributes that are marked as
mandatory must be entered for each sample. If you create an
attribute of typelnteger, only numeric characters (whole numbers)
can be entered into the field for that attribute.

Vocabulary and field restrictions

When sample sets are used to automate integration with Ion Reporter™ Software, the
sample information must follow the rules for Ion Reporter™ Software samples.

The following sample relationships are supported:

e Self

e Tumor, Normal

¢ Control, Sample

e Father, Mother, Self

Note: Self is used both for a single sample and for the proband sample in a trio. A
single sample is not related to other samples and is analyzed by itself. Always supply
a value for gender. If gender is not known, select unknown.

Search samples

To search samples, use the steps that follow:

1. In the Plan tab, click Samples.

2. Enter a search name or label in the text field.

Torrent Suite™ Software 5.6 Help
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3. Click Q , then select Sample set name or Combined library tube label.

Sample Sets
Search name or label Q- | Go Clear
® Sample set name
Select  Set Name Combined library tube label
4. Click Go.

Edit samples

To edit samples:

1. In the Plan tab, click Samples.

2. Click Settings (%) » Edit Set.

i Tube Status

created o B

Plan Run

Library Prep Summary

Delete Set

rroatacd e -

22
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Delete samples b

3. Make any desired changes, then click Done.

Edit Sample Set

Sample Set Name : | 2014-10-28 MSW1

Group Type: | - v
Library Prep Type: | Unspecified v
Library Prep Kit: = ... v

PCR Plate Serial | Opticnal
Number :

Description : | Optional

Delete samples

1. Inthe Plan screen, click Samples.

2. Click Settings () » Delete Set in the row of the sample you want to delete.

Sample Sets
Search name or label a | Go Clear m
Select  Set Name Date # Samples Description Grouping Lib PrepType  Lib Prep Kit PCRPlate Combined Tube Status
Serial # Label
2 2 201511/02 02
K 2014-10-28 01511020236 S
MSW1 PM
20151018 MSW  201SA0180127 B set ‘
' 318 PM Plan Run
201S1012MSW 2011020518, Herary Prep Summary
' HLa P

et 20150925 01:49 e = lon AmpiiSeq Kit

AmanaAnna AnirE A LT ——

3. Click Yes, Delete!.

Confirm Delete Sample Set And 1 Related Sample Association(S)

Are you sure you want to delete this sample set and 1 related sample association(s)
test (1)7

Cancel Yes, Delete!
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Sort samples

To sort samples:

1.

Import samples

24

Click any column header to sort the sample rows alphabetically or numerically.

Sample Sets

Q- Go | | Clear

e W

Select

SetName v Date v # Samples v Description v

Grouping

Lib Prep Type Lib Prep Kit a PCRPlate Serial#a  Combined Tube Label Status &

Click Clear to remove sorting.

In the Plan tab, click Samples, then in the Favorites list, select the application
group that you want to import the sample into.

Click Import Sample from File.

Samples

Import Samples from File Enter Samples Manually Sample Attributes v
Sample Sets 4]

Q- | Go || Clear
Select SetName  Date #Samples  Description  Grouping  Lib Prep
Tupe
2017104119 N
»o@ sLsomwer. o 1 Wi
oL somar 2T7RATS
' —SOMAL gag7pm
2016106106 N
» aLs20res 3B s Wi

Lib Prep Kit PCR Plate

lon Ampliseq
Kitfor Chef
DL

lon Ampliseq
Kitfor Chef
oLe

Serial #

AD40000467

AD40000467

AD40004760

Plan Run

Combined Status

Tube Label
X0000994  libFrep_done | g
X0000994  libFrep_done | g+
00185584 libFrep_done | gk~

In the Import Samples dialog, click Select Sample File to Import, then select the

CSYV file to import.

Click Select a Sample Set to Receive Samples, then click Save & Finish.
The system loads, parses, validates the file, then saves if no errors are found.
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Plan an instrument run

3

About Planned Runs

Planned Runs are the instructions that contain settings and other details used for
sequencing runs, including:

¢ location of the Torrent Suite Server
¢ location of BED and hotspot files

¢ library barcodes

* types of kits

¢ sample information

* types of chips

Differences between templates and planned runs

Templates and planned runs have much the same information.
® Planned runs are created from templates.
¢ Templates do not have sample names and run names.
® Planned runs are executable on the sequencing instrument.
* Add a sample name and run name to a template to create a planned run.

® The planned run wizard opens in the last page, so that if you accept all the
template settings, all you need do is supply are the run name and sample names
and save the new planned run.

¢ The last page of the wizard is different for templates and planned runs. The
planned run last page requires the run name and sample names. (Templates do
not contain this information.)

The wizard pages for a template and a planned run are the same except for the last
page. The planned run last page requires the run name and sample names.

e Template wizard:

Create Template lonReporter

¢ Planned run wizard:

)|
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¢ Plan by sample:

Create Plan lonReporter

Fore more detailed information see “Templates “ on page 391 and “Plan Tab” on
page 394 in the Reference section.

Customizing and Typically you copy a product template and customize the new template with your

editing templates choices for project organization and data export handling. Then you reuse your new
template to create many planned runs, as needed. Each run plan has the correct
settings (from the original template). Or you can edit your template when
experimental or data handling changes are required.

A planned run performs template preparation on the Ion Chef = instrument, executes
sequencing on your Ion sequencing instrument, and automates your decisions for
post-sequencing data analysis and data management.

Create a planned run with AmpliSeq” DNA template

AmpliSeq DNA/Exome/RNA templates (also known as panels) can be downloaded
from AmpliSeq.com. The necessary BED files for those templates are automatically
installed with the templates. Also, you can edit the templates that are downloaded
from AmpliSeq.com or clone those templates to meet your specific needs. The
AmpliSeq DNA templates are used to create planned runs for various AmpliSeq
panels, such as Ton AmpliSeq Exome and Ton AmpliSeq " Inherited Disease Panel.
You can select your Ion Reporter  account, kits, plugins, and parameter settings.

Note: To modify default parameters, see “Configure and select a custom analysis
parameter set” on page 412.

1. In the Plan tab, click Templates, then in the Favorites list, select AmpliSeq DNA.
2. Select a template that matches your panel. For instance, if you are using an Ion

AmpliSeq™ Exome Panel, select the AmpliSeq™ DNA template with the same
name.

The wizard launches and displays the Plan screen.

3. Add samples, ensure that the default settings, enter a plan name, then click Plan
Run.

4. Run the plan on your sequencing system.
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Create a Planned Run with DNA and Fusions templates

The AmpliSeq DNA templates are used to create planned runs for various
AmpliSeq " panels, such as Ton AmpliSeq RNA Lung Fusion Panel and Ton
AmpliSeq " Colon and Lung Fusion Panel. You can select your Ion Reporter account,
kits, plugins, and parameter settings.

Note: To modify default parameters, see “Configure and select a custom analysis
parameter set” on page 412.

1. In the Plan tab, click Templates, then in the Favorites list, select DNA and
Fusions.

2. Select a template that matches your panel. For instance, if you are using an Ion
AmpliSeq™ RNA Lung Fusion Panel, select a template with the same name from
the DNA and Fusions category.

The wizard launches and displays the Plan page.

3. Add samples, confirm the default settings, enter a plan name, then click Plan
Run.

4. Run the plan on your sequencing system.

Plan a run using Human ldentification templates

Human Identification (HID) templates are used to create Planned Runs for various
Applied Biosystems  Precision ID panels. These templates pre-populate your Planned
Run with parameters for the selected panel. You can then select additional settings to
plan your run.

Note: To modify the default parameters, see “Configure and select a custom analysis
parameter set” on page 412.

1. In the Plan tab, click Templates, then in the Favorites list, select Human
Identification.

2. Select a template that matches your panel and sequencer.
The wizard launches and displays the Plan screen.

3. Select the reference and BED files, enter the samples, confirm the default settings,
then enter a plan name.

4. To verify kit information, click the Kits tab.
Note: All templates default to the Ion Chef™ Instrument.
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5.

(Optional) If you are using the Ion OneTouch™ 2 System, select One Touch in the
Template Kit section.

Precision 1D Librany Kit
Template Kit OneTouch (@ lonChef 1A

Frecision 1D Chef Reagents

IMPORTANT! Do not select IA. The IA workflow is not compatible with the
Precision ID panels.

The correct template and sequencing kit should populate.

(Optional) Click in the appropriate box, then select the sample preparation kit,
control sequence, and barcode set from the dropdown list.

When you have completed your selections, click Plan Run at the bottom right of
the Plan tab to save the run. The run is listed on the Planned Runs page under
the name that you specified.

Plan a run with RNA Seq templates

28

RNA Seq templates are used to create Planned Runs for Ion Total RNA Seq Kits.
These templates will pre-populate your Planned Run with parameters for whole
transcriptome and small RNA sequencing applications. You can then select additional
settings to plan your run.

Note: To modify the default parameters, see “Configure and select a custom analysis
parameter set” on page 412.

1.

2.

In the Plan tab, click Templates, then in the Favorites list, select RNA Seq.

Select the template that matches your application.
The wizard launches and displays the Plan page.

Enter the samples, confirm the default settings, and enter a plan name.

To change kit information, click on the Kits step in the Workflow bar.

Note: If you are using Ion PI"™ Hi-Q™ Sequencing Kit or the Ion 540™ Kit with the

™

Ion Chef™ Instrument, select the Ion Chef option next to Template Kit, and select
the kit name. Click on the Details button to select the Whole Transcriptome
RNA workflow, which was optimized in Torrent Suite™ Software 5.2.1.

When you have made all your selections, click Plan Run.

Run the plan on your sequencing system.
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Plan a run using Generic Sequencing template

The Generic Sequencing templates are used to create planned runs for various
applications, such as the System Generic Sequencing or the MuSeek Library. You can

select your Ion Reporter  account, kits, plugins, and parameter settings.

Note: To modify default parameters, see “Configure and select a custom analysis
parameter set” on page 412.

1.

Copy a template

In the Plan tab, click Templates, then in the Favorites list, select Generic

Sequencing.

Select a template that best matches your application. For instance, if you are
using a MuSeek library, select the template with the same name from the Generic
Sequencing category.

The wizard launches and displays the Plan page.

Add samples, confirm or change the default settings, and enter a plan name, then

click Plan Run.

Run the plan on your sequencing system.

You can copy the settings in existing template into a new custom template.

Note: To modify default parameters, see “Configure and select a custom analysis
parameter set” on page 412.

1.

In the Plan tab, click Templates, then in the Favorites list, click Settings
(%£F) » Copy in the row of the template you want to start with.

Fn m “

iy Favorites

5 Recently Created
nAmphsEq DNA
[El Amviisea RNA

B ona and Fusions

O ceneric

Sequencing

Pharmacogenomics
ERNA Seq
Targelieq

[ wnole Genome

The wizard launches and displays the Save page.

Templates

El AmpliSeq DNA

Template Name

CHPv2

Noonan Panel

ExomePanel_Hi-Q

Oncomine Comprehensive
DNA

Instr.

2. Enter a name for the template.

Torrent Suite™ Software 5.6 Help

OTIIC Barcode
Kit
o

A4

Upload Plans AmpliSeg.com @ ~

Reference

L.designed.bed
» Hotspot: CHF2.201310

01 hotspots bed

hg19

» Target: AmpiiSeqExom
220141113 designed.bed

hgig

lon Reporter
Account

lon Reporter
Workflow

| Add New Template | Plan New Rur

Date Source

20T5/08...

s User a
1043 PM ml
usar

Se e
ogi  SetasFavorite
Review
Plan Run
10{  Plan Multple

Copy

204500
oospu O

=
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3. If desired, go back to previous steps in the workflow bar and adjust the settings.

4. In the Save page, confirm your selections, then click Copy Template.

Export a template

You can export the settings in an existing template into a CSV file.

1. In the Plantab, click Templates, then in the Favorites list, click Settings
(%F) » Export in the row of the template you want to start with.

iy Favorites

5 Al
[l Anriseanna
[l amvisearna
[B oNA and Fusions
[ Generic sequencing
[EY Human identification
I Oncology - Liquia Biopsy
[APrarmacogenomics
Brvasea
@ rargetsea
A whole Genome

[ 165 Target sequencing

AmpIiSeq DNA

Template Name

fon AmpliSeq Inherited Disease
Panel

fon AmpliSeq Custom ID

fon AmpiiSeq Custom

fon AmpliSeq Comprehensive
Cancer Panel

fon AmpliSeq Cancer Panel1_0 Lib
Chem

fon AmpliSeq Cancer Panel

Instr.

oTnc

Barcode Kit ~ Reference

hgig
- Tanget 4477093, 1DP_becie
iz ses

hg1g

hg19

- W12 1_regions_
NO_JAK2_NODUPDRd

lon Reporter Account  lon Reporter Workflow  Date Source
cotepsms =
04:35PM ore )

WIEIOE

04:25PM ore

Joiengg  SeLasFavorte

04:35PM |
Review

20160810 PlanRun

04:35PM

Plan Muliple
Copy

2016108

04:35 P

wte0es L

04:35PM o LE

Depending on your browser settings, you may be prompted to save your
template, or the template may be created and downloaded automatically.

2. Double-click on the CSV file to open it in a spreadsheet application such as

™

Microsoft

™

Excel™.

Note: Templates are exported in a format that can be imported back into Torrent
Suite™ Software. You can change the parameters in the CSV file and then re-
import the CSV file.
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Import a template

You can import all the parameters in a template in the form of a CSV file.

Note: The CSV file must be formatted correctly for import. We recommend exporting
a template (see “Export a template” on page 30) and using the exported CSV file as a
model. You can change the parameters in the exported CSV file and then rename and
import the file.

To import a template:

1. In the Plan tab, click Templates, then in the Favorites list, select the application
group that you want to import the template into.

2. Click Upload » Upload Template.

Wy Favorites AmpliSeq DNA AmpliSeq.com ® v | | Add New Template | Plan New Run

Upload Plans
3 Al P

Upload Templip=
[l Amoiseaona Template Name Inst. OTAC Barcode Kit R bn Reporter Date Source
- Workflow:
z
B Ampiisea RuA lon AmpliSeq Inherited Disease 2016/08/08 -
Panel &€ o = 04:35 P bnbomet |0
[B onA and Fusions
2016/08/08
lon AmpiiSeq Custom ID or hg19 torrent -
2 Generic Seauencing pliSeq o o o 04:35 PM ot | |
Human Identification 2016/108/08
lon AmpliSeq Custom ©T hg19 torrent -
pised N @ - 04:35 P L &

[ oncoiogy - Liquia

3. In the Import Plan Template dialog, click Choose File, select the CSV file to
import, then click Load.
The template appears listed in the application group.

Create a template with lon AmpliSeqg.com Import

To create a template for an lon AmpliSeq  panel or an Ion AmpliSeq " custom design,
use the AmpliSeq.com import button. For community and fixed panels (not for
custom panels), the variantCaller plugin is pre-enabled in your new template and the
variantCaller plugin is pre-configured with parameters that are optimized for the
panel. Later you can further customize the variantCaller plugin parameters. There are
three types of Ton AmpliSeq  templates: DNA, RNA, and Exome. Human, animal,
and plant reference genomes are also available. Start with the template group that
matches your experiment type. Your choices of AmpliSeq.com panels to import are
limited the group types (DNA, RNA, or Exome).

1. In the Plan, click Templates.

2. Click the AmpliSeq.com button, then select the type of panel you want to
import: AmpliSeq DNA, AmpliSeq Exome, or AmpliSeq RNA.

fan “ n n

Templates

- Ve
v Favorites

Template Name

nstr.  OTIC Barcode Kit Reference lon Reporter Account  lon Reporter Date
Wittt
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3. Enter your ampliseq.com username and password (if necessary).
4. Select your instrument and chip.

5. The Torrent Browser lists the available panels. Some panels do not have
optimized variantCaller plugin parameter sets available for multiple chips and
sequencers. A caution warning denotes choices for which optimized
variantCaller plugin parameters have not be developed for the selected chip
type, which can lead to suboptimal variant calls. The Show solutions which were not
ordered link appears if you have unordered custom designs. Click this link if you
want to import one of those designs. Enable the checkbox for the panel or panels
you want to import, and click Import Selected.

Design View on AmpliSeq.com

Noonan Panel A PGM-specific parameters not available View

@ CHPv2 View

6. The Torrent Browser opens a download and progress dialog. Refresh your
browser to track the progress, then view the completion status.

Accounts

AmpliSeq

Name Progress Status

hitps:fampliseq. comiwsitmpldesigny 3517 28/download

7. When the Status column shows "Completed”, go back to the Templates tab, and
you see the new template.

Favorit : TV EN BT | AmpliSeq.com @ «
eroetes e2 AmpliSeq DNA —

@ Recently
Created

nAmpIiSeq Template Name Instr. OT/It Barcode Reference IR Account

DNA Kit
hg19
nAmpIiSeq » Target: Colonl
ung.20131001.d
RHA Colon and Lung ﬁ @ .
esigned.bed
Panel
B3 ona -+ rua + Hotspot: Colon
Lung.20121001.
ﬂGeneric hotspots.bed

32 Torrent Suite™ Software 5.6 Help



Plan aninstrument run  E&&
Plan by sample set 1

S
2%

Plan by sample set

When you base your run plan on a sample set, the run plan wizard reads the sample
set information and adds it to the appropriate wizard screens. For barcoded runs, the
barcode information from your sample set is added in the plan wizard. This approach
both saves you time and reduces the probability of error compared to manual barcode
assignments on data sets with many files.

The plan-by-sample-set feature is recommended for the following:

e Ion Reporter  Software users setting up multi-sample analyses

¢ Sample sets that include many samples.

Follow these steps to start a run plan based on your sample set:

1.

Torrent Suite™ Software 5.6 Help

In the Plan tab, click Samples, then find your sample set in the Sample Sets
screen.

Click Settings (%#) » Plan Run for your sample set to start to create a Planned
Run:

Edit Set

Library Prep Summary

Delete Set

Select a workflow that supports the sample set. The wizard opens a popup menu
listing workflows that support your sample set. This example started with a trio
sample set and offers trio-compatible workflows (on this server, there is only one
trio workflow):

Select a Run Template to apply to this experiment :

W

=Add new template:
AmpliSeq Exaome Trio (Trig)

Note: If you do not see the template that you are looking for, select Show All
Templates.

The wizard opens to the Barcoding step in the Workflow bar, with the selected
sample sets displayed in a table at the bottom of the screen.

In the Default Reference & BED Files region of the screen, select the appropriate
reference library and BED files for the target and hotspot regions that are covered
by the selected panel.

Select the barcoding kit that is used from the dropdown list. For tracking

purposes, you can enter any text that is written on the sample tubes in the
Sample Tube Label field.
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6. The Chip ID field can be used to track the barcode number that is printed on the
chip.
7. In the table at the bottom of the screen, select the barcode that is used to prepare
each sample from the dropdown list in the Barcode column.
Enter a sample name for each barcode used (require at least one sample) :
5
# Barcode Sample (required) s Control Type Sample ID Sample Description
E
5
lonXpress_001 ¥ Sample Test Set 1 v No Template Contral ¥ =
(CTAAGGTAAC)
2 Inn¥nrace NN2 K[amnle Teat 8at 2 v v | camnls
8. To identify No Template Control samples, click the Control Type column
heading in the table, then select No Template Control from the dropdown list.
Enter a sample name for each barcode used (require at least one sample) :
5
# Barcode Sample (required) ] Control Type Sample ID Sample Description
§
1 lonXpress_001 (CTAAGGTAAC) ¥ | Sample Test Set 1 v No Template Con... sample estSamplet for impart
2 |lonXpress_001 (CTAAGGTAAC) ¥ | Sample TestSet2 v None sample2 testSample2 for import
1 Inn¥nress NN1 (MTAARRTAAM ¥ | Samnle Test Sat 3 v v s A RatS r7 i
Note: The No Template Control option can be used to indicate negative control
samples.
. . ™ . . .
Include multiple Torrent Suite = software allows multiple samples sets to be used in a single planned

sample sets in one  TUn- The sample sets must correspond to AmpliSeq " library preparations and use the

planned run same barcode kit to be a part of a single planned run.

1. In the Plantab, click Samples.

Samples les Templates Planned Run List
Templates

Planned Run List
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2. Select multiple samples sets, ensuring that they use the same barcode kit.

Sample Sets

Search name or label Q- Go Clear
Select Set Name Date # Samples
) 2015/12/02 04:38
r & Presentation_... 8
PM
. 2015/12/02 01:05
y & Presentation_...

AM

3. Select the Run Template to apply to this experiment, then click Plan Run.

PGx Research Panel

Show All Templates

Select a Run Template to apply to this experiment :

o«

In the Barcoding step in the Workflow bar of the Planned Run wizard, you can now

see the sample sets you added in the barcode table.

m e fpmlesten

5, et onh G O i P g it ettt ~asrad

Kits Plugins Barcoding Projacts Save & Finis

# Barcode Sample Name (required)

4 lonCode_0113 (TCTAACGGAC) B

5 lonCode_0114 (TTGGAGTGTC) v

6 lonCode_0115 (TCTAGAGGTC)

“

7 lonCode_0116 (TCTGGATGAC)

>

8 lonCode_0109 (TGAGCGGAAC) ]
9 lonCode_0101 (CTAAGGTAAC) ]
10 | lonCode_0102 (TAAGGAGAAC) s
11 lonCode_0103 (AAGAGGATTC) $
12 lonCode_0104 (TACCAAGATC) s

Torrent Suite™ Software 5.6 Help

s13 (Presentation_Set_2)
s14 (Presentation_Set_2)
s15 (Presentation_Set_2)
s16 (Presentation_Set_2)
s9 (Presentation_Set_2)
s1 (Presentation_Set_1)
s2 (Presentation_Set_1)
s3 (Presentation_Set_1)

s4 (Presentation_Set_1)

Sample ID Sample Description

a
v

a
v

“

@

a“

a

@

@

]
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| Plan by sample set

Create a planned To plan a run for DNA and Fusion sample pairs and several individual Fusion or
run for mixed DNA samples, start with a fusions template, then alter it to accommodate single

samples with a
template

1. Copy the Ion AmpliSeq™ Colon Lung template.

2. Enter the number of samples.

samples on the same chip. The example that follows is a mixed sample set consisting
of two sample pairs, one DNA-only sample and two Fusion-only samples.

3. Deselect "Same sample for DNA and Fusions" option.

DSame sample for DMA and Fusions?

Numbe

r of barcodes : 7

4. Renumber the samples.

5. Change DNA/RNA selections to match samples.

Barcode

lonSelect-1 (CTAAGGTALS)
lonSelect-2 (TTACAACCTE)
lonSelect-3 (CCTGCCATTCGE)
lonSelect-4 (TGGAGGACGGAC)
lonSelect-5 (TGAGCGGEAALD)
lonSelect-6 (CCTTAGAGTTE)

lonSelect-7 (TCCTCGAATC)

DNA/Fusions

DIRA
Fusions
DIRA
Fusions
DIRA
Fusions

Fusions

36

v

Sample {required)
Sarnple 1
Sarmple 1
Sample 3
Sample 4
Sample 5
Sample B

Sample 7
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Plan an instrument run
Create multiple planned runs

6. Select cancer types to match samples.

lon Reporter Workflow

AmpliSeq Colon Lung v2 with RNA Lung Fusion: ¥
AmpliSeq Colon Lung v2 with RNA Lung Fusion: ¥
AmpliSeq Colon Lung v2 with RNA Lung Fusion: ¥

AmpliSeq Colon Lung v2 with RNA Lung Fusion: ¥

AmpliSeq Exome single sample (Somatic) v
AmpliSeq RNA Lung Fusion single sample v
AmpliSeq RNA Lung Fusion single sample v

7. Select appropriate Ion Reporter workflows.
8. Enter Relation.
9. Enter gender.

10. Enter Analysis set IDs.

11. Click Plan Run.

Create multiple planned runs

Create multiple
planned non-
barcoded planned
runs

You can create multiple planned runs based on a template with a CSV file. A template
version of this file in Torrent Suite™ Software. Each column in the CSV template
represents an individual planned run. Each row contains the plan parameters for each
of the planned runs. Beginning in Torrent Suite™ Software 5.4, you can add
information to the planned runs that is related to Ion Reporter™ Software for each
sample within a run, including account, workflow, and workflow-related attributes
such as gender, relation and SetID.

™

In versions earlier than Torrent Suite™ Software 5.4, data for each planned run was
contained in a row in the CSV template. A column-based format is now used for each
planned run.

Note: The latest Plan Runs from Template CSV file indicates the version of the
template in the top row. This version number is required. When you download the
Plan Runs from Template CSV, the version is automatically included.

You can create multiple planned runs based on a template with a CSV file. To create a
planned run without barcodes, use a single CSV template.

1. In the Plan tab, click Templates.

2. In the row for the template that you want to use to create multiple planned runs,
click Settings (%F) » Plan Multiple.
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Create multiple planned runs

3.

In the Plan Runs from Template dialog, enter the number of planned runs that
you want to create, then click Download CSV for batch planning.

Plan Runs from Template: SurfaceChem_510_400bp_chef_S5

Number of plans to 4

create(required) :
Number of plans to create offline

Note: Single CSV file with sample and plan will be
downloaded.

Cancel Download C SV for batch planning

Download the CSV template file.

* To create multiple planned runs from an non-barcoded template, enter
Template name, Plan name and Sample. In this example, the template creates
four non-barcoded planned runs.

| A | B @ D E
1 [csv version (required) 1 2
Plan Parameters Plan1 Plan2 Plan3 Plana
Template name to plan from (required)  System Generic Seq Template System Generic Seq Template System Generic Seq Template System Generic Seq Template
Plan name (required)
sample (required)
sample Description

el

sample ID

Sample preparation kit name

Library kit name lon Xpress Plus Fragment Librar lon Xpress Plus Fragment Library lon Xpress Plus Fragment Library Kit lon Xpress Plus Fragment Library Kit
10 Templating kit name (required) lon PGM Template OT2 200 Kit lon PGM Template OT2 200Kit  lon PGM Template OT2 200 Kit lon PGM Template OT2 200 Kit

11 Templating Size

12 Control sequence name

13 Sequence kit name lon PGM Sequencing 200 Kitv2 lon PGM Sequencing 200Kitv2  lon PGM Sequencing 200 Kit v2 lon PGM Sequencing 200 Kit v2

14 Chip type (required)

15 Library Read Length

16 Flows 500 500 500 500
17 Sample tube label

18 Bead loading % 30 30 30 30
19 Key signal % 30 20 20 30
20 Usable sequence % 30 30 30 30
21 Reference library hgla hg19 hgl9 hg19

22 Target regions BED file

23 Hotspot regions BED file

24 Plugins FileExporter; FileExporter; FileExporter; FileExporter;

25 Project names

26 Export

27 Notes

28 LIMS Meta Data

29 Chip Barcode

30 IR Account

31 IR Workflow

32 IR Relation

33 IR Gender

34 IR SetID

AT

©

Save the CSV file.
In the Torrent Suite™ Software Plan tab, click Templates.

Click Upload » Upload Template, then click Choose File, then select the edited
CSV template.
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D
O

=
al
7
ad
7

8. Click Load.

The system parses the files, then creates the planned runs.

Planned Runs
All | by Template | by Sample

Q- Go Clear

Select e Run Plan Name & B, d ¥ IIEIF;
NH3F3 Dema 2 lon¥press bl
AJIKF Demo 1 lonXpress
Create multi p[e If you want to create barcoded planned runs, use multiple CSV templates as follows:
barcoded planned * amaster CSV file that you use to specify the plan name, kits, chips, projects, and
runs plugin selections

¢ one sample CSV file for each planned run

1. In the Plan tab, click Templates.

2. Inthe row for a barcoded template that you want to use to create multiple
planned runs, click Settings (#) » Plan Multiple.

hgls

lat o ST 2015712/01 t' -
template 37 ronprass argel. torget | LT AN e ianadin
= Hosspot: hatspatbed

Remove from Favorite

| Review |
Plan Run
I Ptan Muliipie L |
| Copy

| Ean
| Delete |

3. In the Plan Runs from Template dialog, enter the number of planned runs that
you want to create, then click Download CSV for batch planning.

Plan Runs from Template: NextGen_chips_AE_540

Number of plans to enter a whole number between 1 and 100
create(required) :
Number of plans to create offline

Naote: ZIP archive of multiple samples and plan CSV
files will be downloaded

Cancel Download C SV for batch planning

4. Download the compressed file, then decompress it.
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Plan an instrument run
Create multiple planned runs

5.

10.

Open the tsPlan file appended with master.csv and enter the Template name, Plan
name and Sample. In this example, the template creates four barcoded planned
runs.

| A | B & D E

1 [csv version (required) 1 2

Plan Parameters Plan 1 Plan2 Plan3 Plan4
Template name to plan from (required) ~ System Generic Seq Template System GenericSeq Template  System Generic Seq Template System Generic Seq Template

T 1l

Plan name (required)
Ssample (required)

sample Description

sample ID

sample preparation kit name

Library kit name lon Xpress Plus Fragment Librar lon Xpress Plus Fragment Library lon Xpress Plus Fragment Library Kit lon Xpress Plus Fragment Library Kit
10 Templating kit name (required) lon PGM Template OT2 200 Kit lon PGM Template OT2200Kit  lon PGM Template OT2 200 Kit lon PGM Template OT2 200 Kit

11 Templating Size

12 Control sequence name

13 Sequence kit name lon PGM Sequencing 200 Kitv2 lon PGM Sequencing 200Kitv2  lon PGM Sequencing 200 Kitv2 lon PGM Sequencing 200 Kit v2

14 Chip type (required)

15 Library Read Length

16 Flows 500 500 500 500
17 Sample tube label

18 Bead loading % 30 30 30 30
19 Key signal % 30
20 Usable sequence % 30 30
21 Reference library hgls hg19 hgl9 hg19

22 Target regions BED file

23 Hatspat regions BED file

24 Plugins FileExporter; FileExporter; FileExporter; FileExporter;
35 Project names

26 Export

27 Notes

28 LIMS Meta Data

29 Chip Barcode

30 IR Account

31 IR Workflow

32 IR Relation

33 IR Gender

34 IRSetID

©~ e s

w

w
-3
s
[0

Save the CSV file.

Open each of the tsPlan files appended with samples.csv and edit the information
for each barcoded sample, including Sample Name, Sample ID, Sample
Description, and so on, then save each file.

A 8 c D 3 F G H 1 1 K L M N o
1 Csv Versit 2
2 Barcode Control Type Sample Name Sample ID Sample Description DNA/RNA Reference Targetregions Hotspot regions IR Workflow IR Relation IR Gender IR SetID Cancer Type Cellulari
3 lonXpress_001 RNA
4 lonXpress_002 RNA
5 lonXpress 003 RNA
6 lonXpress 004 RNA
7 lonXpress_005 RNA
8 lonXpress_006 RNA
9 lonXpress_007 RNA
10 lonXpress_008 RNA
11 lonXpress_009 RNA
12 lonXpress_010 RNA
13 lonXpress_011 RNA
14 lonXpress_012 RNA
15 lonXpress_013 RNA
16 lonXpress_014 RNA
17 lonXpress_015 RNA
18 lonXpress_016 RNA
19 lonXpress_017 RNA
20 lonXpress_018 RNA
21 lonXpress_019 RNA
22 lonXpress_020 RNA
23 lonXpress_021 RNA
24 lonXpress_022 RNA
25 lonXpress_023 RNA
26 lonXpress_024 RNA
27 lonXpress_025 RNA
28 lonXpress_026 RNA
29 lonXpress_027 RNA -

Add the Master CSV template and all of the Sample CSV templates to a
compressed directory.

™

In the Torrent Suite™ Software Plan tab, click Templates.

Click Upload » Upload Template, then click Choose File and select the
compressed directory of CSV templates.
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Plan an instrument run  E&82
Analyze lon AmpliSeq™ on lon Chef" samples =71

Click Load.
The system parses the files, then creates the planned runs.

Planned Runs

All | by Template | by Sample
Q- Go Clear
Run Lib
Select
Code Run Plan Name . Barcodes Application Pre
NH3F3 Dema 2 lonXpress
AJIKF Demo 1 lonXpress

Analyze lon AmpliSeq" on lon Chef  samples

TIon AmpliSeq  on Ion Chef ' samples can be analyzed.

The process involves creating a Torrent Suite” Sample Set, preparing an Ion Chef
library, creating a Torrent Suite planned run, preparing an Ion Chef or OneTouch2
template, and sequencing on an PGM , Ion Proton , or Ion S5 sequencer.

Create Sample Set:

1.

Torrent Suite™ Software 5.6 Help

Import samples from a file or enter them manually.

Fan oeta

Samples

T |
Sample Sets

Note:
This example imports samples from a file.
In the Plan tab, click Samples, then click Import Samples from File.

On the Import Samples window, click Sample File Format button. A CSV
template downloads.

Import Samples

Select Sample File to Import :
Select file

Sample File (csv)
Sample File Format

Click button to download sample file format

Click it, then enter sample names, PCR Plate positions, and DNA or RNA at
minimum. Save to your desktop.

Now, click the Select File button, select your CSV file, then click Open.
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EoN;

N
,_‘:.:! Analyze lon AmpliSeq™ on lon Chef™ samples
7. Click Add Sample Set.
Import Samples
©O: Select Sample File to Import :
1] Change  Remove
Sample File (csv)
Sample File Format
Click button to download sample file format
©: Select a Sample Set to Receive Samples :
hello
ke aneu preDemo sample set (Self)
dual label ics sample set
md_sampleset (DNA_RNA)
Add Sampip.Set...
8. Name your new sample set.
9. Set Library Prep Type to AmpliSeq on Chef.
10. Set Library Prep Kit to Ion AmpliSeq Kit on Chef DLS.
11. Enter PCR plate serial number, then click Save & Finish The software creates
your new sample set..
Add Sample Set...

Sample Set Name :  swat demo
Group Type: ... j
Library Prep Type: = AmpliSeq on Chef j
Library Prep Kit : lon AmpliSeq Kit for Chef DL8 :]
PCR Plate Serial | 1233434
Number :
Description :
k
T ——

12. In the Plan tab, click Samples » Sample Set. Check its status in the Status
column. Either libPrep_pending, libPrep_reserved, libPrep_done, planned,
Voided, or Run are displayed.

Sample Sets

f Q- Go  Clear

Set Name Date # Samples Description Grouping LibPrepType LibPrepKit  PCR Plate Combined Status
Serial # Tube Label
» ot vsorasoreanu s ) A wowp g | g
L
. wiserasorazeu 1 1) e wem g | | @
13. Notice a new icon for AmpliSeq™ on Ion Chef™ in the Lib Prep Type column.

42 Torrent Suite™ Software 5.6 Help



Plan an instrument run &
Handle a failed analysis run 201

14. Monitor the Ion Chef™ library and templating steps from Monitor » Ion Chef.
When the sequencing run is complete, view the Ion Chef™ run report.

“ Honter

lon Chef

lon Chef

Last Updated

Aug 11,2015, 513 pm
Aug. 11,2015, 513 pm
Aug.7, 2015, 7:57 am.

Aug. 7, 2015,7:57 am.

sample Set Plan
Tracking_Test_34

Tracking_Test_33

chef_log_test_2 chef_log_test_2_pian

chef_log_test_1 chef_log_test_1_plan

Chef Instrument

P00018

CHEF00865

chef-samx

chef-samx

Library Prep Progress

X3
O Refresh

Library Prep Status  Template Prep Progress Template Prep Status

FE—

Run library Main

Compete N conve:

15. Click Data, Completed Runs & Reports, then select your Ion Chef™ run.

16. Scroll to the bottom of the Run Summary screen, then select Chef Summary.

Plugin Summary Test Fragments Chef Summary Calibration Report Analysis Details Support Software Version

17. Review the Chef Library Prep Info and Chef Template Prep Info sections.

Chaf Library Prep Info:

Fachage Verson

Handle a failed analysis run

ADC 10

If an analysis run fails, determine the cause of the failure and, possibly, restart the run.

Torrent Suite™ Software 5.6 Help
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Determine the fault cause

If an analysis run fails, make the following checks:

1. Has the Ion PGM"™ or Ion Proton™ Sequencer completely transferred the data for
the run? Go to the sequencer Data Management screen to ensure complete data
transfer. If you are not sure the data was transmitted. you can retransfer it.

2. In the Data tab, click Completed Runs & Reports tab to ensure that the file
transfer was complete. Also, check if there are any error messages, such as User
Aborted. Look for a status of Error or Pending.

3. If the report was generated, check if there are any messages on the report itself.

4. Click the Support link towards the bottom of the run report (above the Plugin
Summary row of buttons). Click View the Report Log or Download the
Customer Support Archive. You can send the customer support archive to your
Ion Torrent™ contact for review.

5. If you cannot determine the cause of the fault, try restarting the run.

Restart a run

Follow these steps to restart an analysis run:

1. Inthe Data tab, click Completed Runs & Reports, then find the name for the
report that you want to reanalyze.

* In the Table View, click Settings (%) » Reanalyze in the row of the run that
you want to reanalyze:

Mean
Total G20
Flows Reads Fead Bases Cuatput
Length

520 6.3amM 210 105G 1.340G o

Edit

52':' 2.25 r|||1 1':'9 Zrrm P o | T v

* In the list view, click Reanalyze in the row of the run that you want to
reanalyze:
Reference: e_coli_dh10b Reanalyze
sample: chefE2E

Chip: 530 Edit
2B suriace_iunctionaiization
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Restart a run

The main run analysis dialog opens:

Run Name : test_G40-82_cropped

Reanalyze
4 Report Name : |
Run
Analysis Thumbnail only :  [J
Options
Reference & Start reanalysis from : ) Signal Processing @ Base Calling
Barcoding
Plugins Use data from previous test_update [/results/analysis/output/l v
result :
Analysis Parameters : @ Default (Recommended) Custom +

Start Analysis

Torrent Suite™ Software 5.6 Help 45



Plan an instrument run
Restart a run

2. (Optional) Click Reference & Barcoding to display the additional options for

references. Here you can select a different reference for the entire run or a specific
reference for each barcode.

Run Name : test_G40-82_cropped

Reanalyze Run

Default Alignment hg19 (Human (hg19)) v
Analysis Options Reference :
Refi & B di
s & maeedng Default Target Regions v
Plugins BED File :
Default Hotspot v

Regions BED File :

Barcode Set: lonXpress r

Default reference info is used for barcodes with no sample name. Additional options for

#) Use Default Reference & BED files for all barcodes

Barcode Sample Name
lonXpress_057 s1
lonXpress_064 s2
Reference: ¢_coli_dh10b Reanalyze
Sample: SM.OH108

Chip: 318R Edit

Project: L=l

Output  Date Status

3. (Optional) In the Default Alignment Reference section, select a different
reference for this run from the list of available references.

Default Alignment hg19 (Human (hg19}) r
RGN chrM_hg18 (Mitochondria_hg18)

chrom10_hg18 (Chromosome 10 hg18)

C_Jejuni_RM1221_CP000025 (Campylobacter jejuni RM1221)
CON (Custom Oliao nolv GT)
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4. (Optional) Click Analysis Options, then click Custom to modify other options as

appropriate.
Analysis Parameters : Default (Recommended) # Custom -
lon Pl chip analysis arguments (ion_default_P1.1.17) - (¢
BeadFind :
Analysis :

Pre-BaseCaller for BaseCaller --barcode-filter 0.01 --barcode-filter-
calibration : minreads 10 --phasing-residual-filter=2.0 --max-
phasing-levels 2

Calibration : Calibration

BaseCaller: BaseCaller --barcode-filter 0.01 --barcode-filter-
minreads 10 —-phasing-residual-filter=2.0 --max-
phasing-levels 2 —num-unfiltered 1000 --barcode-filter-

ostpone 1
postp p
Alignment : tmap mapall ... stage1 map4
s
lonstats : ionstats alignment

5. (Optional) Click Plugins to select one or more plugins to run.

6. Click Start Analysis.
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Realign a run to a different reference genome

<
28
A%

7. Click Settings (%) » Services to ensure that the job has started and is listed in
Active Jobs:

[ B

About
Analysis Parameters
References

Plugins

lon Mesh

Configure

lon Reporter Configure
Accounts

Updates

Realign a run to a different reference genome

This section describes how to rerun an analysis with alignment to a different reference
genome.

These steps create a new run report.
1.

In the Data tab, click Completed Runs & Reports, then find the name for the
report that you want to reanalyze.

¢ In the Table View, click Settings (%) » Reanalyze in the row of the run that
you want to reanalyze:

Total  MEEN Agp

Flows Reads Fead e Catput
Lenaoth
a20 Bagm 210 108G 134G e 2
Edit
52':' 225 |"."| 1|:|g Zrrm o o |

T

In the list view, click Reanalyze in the row of the run that you want to
reanalyze:

eference: e_coll_dh10b
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Realign a run to a different reference genome

The main run analysis dialog opens:

Run Name : test_G40-82_cropped

Reanalyze

Report Name :
Run
Analysis Thumbnail only :
Options
Reference & Start reanalysis from : Signal Processing # Base Calling
Barcoding
Plugins Use data from previous test_update [results/analysis/output/l

result :
Analysis Parameters : # Default (Recommended) Custom ¥

Start Analysis
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2. (Optional) Click the Reference & Barcoding tab to display the additional options
for references. Here you can select a different reference for the entire run or a
specific reference for each barcode.

Run Name : test_G40-82_cropped

Reanalyze Run

Default Alignment hg19 (Human (hg19}) r
Analysis Options Reference :
Refi &B di
elerence arcoding Default Target Regions r
Plugins BED File :
Default Hotspot r
Regions BED File :
Barcode Set: lonXpress r
Default reference info is used for barcodes with no sample name. Additional options for
| Use Default Reference & BED files for all barcodes
Barcode Sample Name
lonXpress_057 s1
lonXpress_064 s2
Reference: ¢_coli_dh10b Reanalyze
Sample: SM.OH108
Chip: 318R Edit
Project: L=l
Output  Date Status

3. (Optional) In the Default Alignment Reference section, select the reference for
this run from the list of available references.

Default Alignment hg19 (Human (hg19}) r
RGN chrM_hg18 (Mitochondria_hg18)

chrom10_hg18 (Chromosome 10 hg18)
C_Jejuni_RM1221_CP000025 (Campylobacter jejuni RM1221)
CON (Custom Oliao nolv GT)

4. (Optional) Click Analysis Options, then modify other options as appropriate.
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Realign a run to a different reference genome 11|

5. Click Start Analysis.

6. Click Settings (£¥) » Services to ensure that the job has started and is listed in
Active Jobs:

Reanalyze a run

Torrent Suite™ Software 5.6 Help
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Plan an instrument run
Realign a run to a different reference genome

Click Reanalyze to enter a name for the new run report and the reanalysis starting

point:

Click Reanalyze to enter a name for the new run report and the reanalysis starting

point:

Run Name : test_G40-82_cropped

Reanalyze

v Report Name :
Run
Analysis Thumbnail only :
Options
Reference & Start reanalysis from : Signal Processing s Base Calling
Barcoding
Plugins Use data from previous test_update [results/analysis/output/l ~

result :
Analysis Parameters : s Default (Recommended) Custom +

Setting

Description

Report Name

The name of the new run report (the result
of the reanalysis).

Thumbnail only

Displays thumbnail view of report.

Start reanalysis from

The Analysis Pipeline proceeds through
three stages: Signal Processing, Base
Calling, and Alignment. Normally report
generation proceeds through all three
steps. If you have already generated a
report, it is possible to reanalyze the
experiment and skip the earlier stages of
the pipeline.

For example, you can change the genome
that is used for Alignment. After changing
the genome for the experiment on the Runs
screen using the Edit field, you need to
reanalyze data to produce a new report
using the new genome. Because there is no
need to repeat the time consuming Signal
Processing and Basecalling steps, you can
use the output from an existing report as a
starting point for Alignment. The report is
completed much more quickly.

You can restart the analysis from these
points:
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Plan aninstrument run g=as
Realign a run to a different reference genome

Setting

Description

* Signal Processing (Default) Does not
use the Use data from previous report
field. Reprocesses from the DAT files.
You can optionally use both the
Analysis args and Basecaller args
fields.

e Base Calling Uses the Use data from
previous report field and optionally the
Basecaller args field. Reprocesses
from the .wells file. Does not use the
Analysis args field .

Use data from previous result

This option applies only when starting
reanalysis from Base Calling. In this case,
the results from a previous report are used
as input for reanalysis.

Analysis Parameters

Default [Recommended) are the
parameters determined to best fit the
factory template.

Custom interface allows you to change
many aspects of the analysis parameters.
For more information, see“Configure and
select a custom analysis parameter set” on
page 412

The References tab contains these settings:

Setting

Description

Default Alignment Reference

The genomic reference to align to. Use this
menu to change the reference used for
alignment in the new analysis.

Default Target Regions BED File

Targeted regions of interest file. Analysis is
restricted only to regions listed in this file.

Default Hotspot Regions BED File

Hotspots file. The variant caller includes
each hotspot position in its output VCF file.
Variant caller filter scores are provided for
each hotspot position that does not have a
variant called.

Barcode Set

The DNA barcode set.

Torrent Suite™ Software 5.6 Help
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Select specific references for specific sample barcodes.

Run Name : test_G40-82_cropped

Reanalyze Run
Analysis Options

Reference & Barcoding

Default Alighment  hg19 (Human (hg19))
Reference :

Default Target Regions

Plugins BED File :
Default Hotspot
Regions BED File :
Barcode Set: | lonXpress
Default reference info is used for barcodes with no sample name . Additional options for barcoded samples are available on the Edit Run Plan page.
@ Use Default Reference & BED files for all barcodes
Barcode Sample Name Reference Target Regions.
lonXpress_057 s hg19 (Homo sapiens)
lonXpress_064 s2 hg19 (Homo sapiens)
Analysis Options An example Analysis Options dialog is shown here:

Run Name : test_G40-82_cropped

Reanalyze
Run

Analysis
Options

Reference &

Barcoding

Plugins

Library Key : TCAG

TF Key : ATCG

3' Adapter : lon P1B (ATCACCGACTGCCCATAGA ~

Mark as Duplicate
Reads :

Base Calibration Mode : Enable Calibration Standard v

Enable Realignment :

The Analysis Options tab contains these settings:

54
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Setting Description

Library Key Enter the sequence used to identify library
reads. Example: "TCAG".

TF key Enter the sequence used to identify test
fragment reads. Example: "ATCG".

3' Adapter Enter the name and sequence of the 3
adapter.

Mark as Duplicate Reads Enable Filter out PCR duplicates. Useful

when reanalyzing combined BAM files. Do
not use with lon AmpliSeq" data.

Base Calibration Mode Select one of the four options that are
available: Default Calibration, Enable
Calibration Standard, Blind Calibration, and
No Calibration.

Enable Realignment (Optional] Perform realignment, an optional
analysis step that is executed right after
TMAP. This step adjusts the alignment,
primarily in the CIGAR string.

Share a Planned Run among multiple Torrent Servers

If you have multiple Torrent Servers and multiple sequencers, you can create a
Planned Run on one Torrent Server. If the dedicated sequencer is offline, you can now
transfer your Planned Run to another Torrent Server, then run it on a different
sequencer. However, an administrator or an Ion Torrent " field service representative
must first set up this networking capability.

Network

| | |

TS1 | TS 2 TS 3
(O”E'n) _ i (destination) _ i (destination)
: PGM1 %

PGM 2 PGM 3

Using this diagram as an example, a Planned Run and associated chip can be set up
on Torrent Server 1 (TS) 1 and Ion Chef " 1 (IC 1). If Ion PGM " 1 (PGM 1) is offline,
you can transfer the planned run to TS 3, then run it on PGM 3 (or transfer to TS 2 and

run it on PGM 2, if also networked).
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To transfer a Planned Run:

1. On the origin Torrent Server, create a plan for Ion Chef™, execute Ion Chef™ plan,
then monitor the Ion Chef™ run.

2. After the Jon Chef™ run is complete, browse to the Planned Run list in Torrent
Suite™ Software on the origin Torrent Server.

3. Click Settings (&F) for the selected Planned Run, select Transfer, then click the
destination Torrent Server.

Planned Runs
ANl | by Template | by Sample

Q-  Go Clear

i Last
Select  RunCode RunPlanName & Barcades Application Project Sample Sample Tuke Chip o sana
WXEVS testplan lan¥press Testing 4 Samples 2[1)14:1:(‘05 plannea G-
Review
| 47]
mylD myAPicapy lanxpress n testing 3 Samples .. ggla;:; ar
her b 201am1
0USGE  BC_nolR sampie for setl lonXpress m Ivaltest 2 Samples z:’ "9' fube oo P’i Deleis
o e
my local server Transter 2
D7ZAT  oncomine_plan lonXpress 1 Samples . N— T pamer— o~

4. A confirmation window appears. Check the information, then click Transfer.

Confirm Transfer Planned Run

test plan

Are you sure you want to move this Planned Run to Torrent Server test server ?

Transferred planned run will no longer be available on this Torrent Server.

Cancel Transfer

Note: You can no longer access this planned run on the origin server after it has
transferred. A status window appears. If the Planned Run copied successfully, a
green box states what copied correctly. If any BED files are missing on the
destination server, a red box states what is missing. Your Planned Run is
transferred if the copy is successful. However, you need to edit the transferred
Planned Run on the destination server and add the BED files or other missing
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data to have a successful sequencing run. Click the Edit [plan name] link in the
confirmation dialog to correct the Planned Run on the destination server.

Confirm Transfer Planned Run

test plan

Successfully created test plan on Torrent Server test server
....processed Samples: Sample 2, Sample 3, Sample 1
....found BED files: target bed

....found IR account lonEast IR (Version: 4.2 | User: lon User | Org: IR Org)

Planned run data is incomplete, please Edit test plan to fix the following errors
Unable to find bedfile: HSMv12.1_hotspots.bed for reference: hg19

Unable to find bedfile: atarget.bed for reference: hg19

Close

Note: If you need to move the results of a run back to the origin Torrent Server, you
can use the Run Transfer Plugin to move results from the destination Torrent Server to
the origin Torrent Server (or any other networked Torrent Server).
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Execute a Planned Run on your sequencer
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A Planned Run that you create in the Torrent Suite™ Software is executed on the Ion
Torrent™ sequencer by selecting it from the run information dialog. With the Browse
button, you can select a planned run from a list of runs previously created on the

Torrent Suite™ Software. The Change button allows you to select a planned run via its
run code.

The pending run information is populated into the run information dialog. You can
optionally change run information on the Run Info screen. When ready, click Next -->
to start your Ion Torrent™ sequencing run. Your Planned Run is removed from the
Plan » Planned Runs table when you approve the run confirmation.

lon PGM™ System ion torrent , 4....
IRED T I TN IR s:Runivo HIIII

Confirm or enter the run information,

then press Next,
Relerence:hgl 8

Barcode kit none

| Chip Barcode: g IFu:-'l.-Jar-:l Run |

pl lor PGM(imn) 200 5 Equer‘u:mq Librany Kit: |

Punject “
'ﬂm L. . .

—_— Run Name: ULT-337Re ‘ " henge
. Llses Notes: ‘ m

The Planned Run short code can be entered by entering it manually from the touch
screen. You can also type the Planned Run short code (for example, ITHWQ) into the
Pending Run: text field on the run information dialog;:
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On the Ion S5™ Sequencer, select your run from the Run Selection screen.

Run Selection

Choose a run plan

Planned Run: WOSTA - test_barcode

Chip Barcode: |DABF01278

| Enable post-run clean

P ——
Review
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Monitor the sequencing run

In Torrent Suite” Software you can monitor information about instrument runs
through reported metrics, thumbnail graphs, and other indicators. You can also
review the Planned Run settings for a sequencing run that is currently in progress on
the instrument.

Note: Active sequencing runs and all runs completed within the previous 7 days are
available to view.

View the thumbnail graphs and metrics of an sequencing run in progress to quickly
determine whether to abort or continue the sequencing run.

In the Monitor tab, click Runs in Progress, then view run metrics in List View.

Run Started: 01/09/15 02:12 PM
test D9--841 Chip: PI

do Notes:

test_D9--841 92a3aab_20170831131432_noebr_GPU

Completed | Review Run Plan
ol 0 ol 20 alll 22%  alll S alll TR

Flow Transfer: 400 of 400 flows

1to 20 of 90 Next 20
Last 20

During a sequencing run, a temporary thumbnail entry is generated that displays run
metrics and a heatmap image of chip loading as they become available. You can see at
a glance in the heatmap image, and in the thumbnail graphs if any run quality metrics
are flagged (@) as falling below the thresholds defined in your Planned Run.

Metric Description
Loading Addressable wells on the chip which have detectable loading.
Live ISPs Loaded wells which have a live signal.
Library ISPs Live wells with a library template.
Key Signal Average 1-mer signal in the library key.
Usable Seq Percentage of the sequence avaialble for analysis after filtering.
Flow Transfer Progress of the sequencing run expressed as number of the total

number of flows completed.

See “Stop a sequencing Run” on page 301 for more information if you decide to abort
the sequencing run based on the chip loading metrics observed.
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Monitor an lon Chef" run

In the Monitor tab, click Ion Chef.
Runs in the previous 7 days are listed. The listed parameters are shown in the

following table.

Parameter

Definition

Last Updated

Date and time of the currently displayed run status.

Sample Set

See “Samples and Sample Sets” on page 16 for details.

Plan

lon Chef™ run plan in progress.

Chef Instrument

Identity of the lon Chef™ Instrument in use.

Library Prep Progress

Shows the progress of an lon AmpliSeq" library
preparation run. For an lon AmpliSeq" on lon Chef"
run only.

Library Prep Status

Displays the current stage of the library preparation
run. (Not started, In progress, or Complete)

Template Prep Progress

Shows the progress of a template preparation run.

Template Prep Status

Displays the current stage of the template preparation
run. (Not started, In progress, or Complete)

Estimated Time Remaining

Estimated time remaining until the run is completed.

Estimated Time Until User
Intervention

Estimated time and date when the run pauses for QC,
oris completed.

2. For an Ion Chef™ run in progress, check the Estimated Time Remaining or
Estimated Time Until User Intervention to see the time remaining before you
need to remove ISP samples at the QC pause, or remove loaded chips for
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Monitor an lon Chef" run

An Ton Chef " Instrument run must have a status of Planned before an Ion PGM ", Ton
Proton ', or Ton S5 Sequencer can start a sequencing run. If connectivity is
temporarily lost or interrupted between an Ion Chef ' Instrument and Torrent Suite
Software, the status of the Ion Chef ' run might be marked as Reserved, even if you
observe in the laboratory that the Run has completed. To resolve this problem, you
can manually change the status to Planned and enable the run for sequencing.

1. In the Plan tab, click Planned Runs.

There are four status types, which are displayed in the Status column, that can be
assigned to a Planned Run:

Status Description

Pending The Planned Run is available and ready for use by an
lon Chef™ Instrument, and is unavailable for use by a
sequencing instrument.

Reserved The Planned Run is in use by an lon Chef™ Instrument,
and is unavailable for use until the current lon Chef™
run completes.

Planned The Planned Run is available and ready for use by a
sequencing instrument.

Voided The lon Chef™ run is cancelled through the lon Chef™
screen.

2. For the Planned Run of interest, click £ » Completed on Chef.

The status for the Ion Chef™ Instrument Run on the Planned Runs screen
changes from Reserved to Planned. The sequencer can now use the Planned Run
to start a sequencing run.

Torrent Suite™ Software 5.6 Help



Monitor instrument runs &8
Data views for runs in progress .

Data views for runs in progress

In the Monitor tab, click Runs in Progress.

.....

This section has two views:
¢ List View has 20 runs per page, with details shown for each run.

* Table View has 1 run per row in columns that you can sort by clicking a column
head. This view displays only the parameters that are associated with each
report.

Note: Both the List View and Table View show 20 runs at a time. If you have more
than 20 runs, and you can paginate.

™

Also in the Monitor tab, you can click Ion Chef™ to access views of current runs in
Table View.
& arn
lon Chef
Date Plan Chef Instrument Stage Progress Stage Status

MNov. 18, 2014, 152 p.m. chef_monior_IC_200_tampiste_kit_plan chet-sigha Starting UniockDoor

Mov. 18, 2014, 4:12 p.m chef_monitor_IC_200_template_kit_plan? chet-beta2 ‘Starting UnioekDoor

Mov. 18, 2014, 7:20 p.m chef_monior_IC_200_template_kil_pian3 chel-deta-3 Enriching for Template-Positive Beads

Auto Refresh the Monitor tab

Auto Refresh updates your Runs in Progress page every 20 seconds. Without Auto
Refresh, the page is a static display of information at the time you opened the page.

¢ To set the Runs in Progress page to automatically refresh:
a. In the Monitor tab, click Runs in Progress » Auto Refresh.

b. Click Stop Refresh to turn the Auto Refresh feature off.

* To refresh the Ion Chef page:
Note: The Ion Chef page does not automatically refresh.

a. In the Monitor tab, click Ion Chef » () Refresh.
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Review the Planned Run settings

In the Monitor tab you can review the Planned Run settings for a run in progress.

1. In the Runs in Progress List View, click Review Run Plan for the run of interest.

g

user S5DX-0006-70
S5DX-0006

Auto_user_S5DX-0006-70

Signal Processing ||Review Run Planl

il 2

The Review Planned Run dialog displays the Planned Run information and
settings.

Review Planned Run: CX272_Run2

Application Monitoring
Research Application: DNA and Fusions Bead Loading (%) s 30
Research Category: Key Signal (1-100) s 30
Sample Grouping: Self Usable Sequence (%) s 30
Target Technique: AmpliSeq RNA
Sample Set:

Reference

Reference Cas_Finalv2_052617_POLR2A_PGK1_refe

Kits Library:
Target Cas_Finalv2_052617_POLR2A_PGK1.bed
Sample Reai i
Preparation Kit: egions:
. . . . y Hotspot

Library Kit: lon AmpliSeq 2.0 Library Kit

7 e Y Regions:
Library Key: TCAG
3' Adapter: ATCACCGACTGCCCATAGAGAGGC

eREhe Plugins & Qutput -

Close

2. Click Close to return to the Monitor tab, Runs in Progress screen.
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Manage Completed Runs and
Reports

Search for a Run report

You can search, sort, or filter the Completed Runs & Reports list to find a Run report
of interest.

1. In the Data tab, click Completed Runs & Reports.

To... Steps...

Search the list. | Enter a search term in the Search field, then click Go.

Sort the list. Select a sort order from the Sort dropdown list (List View or Table
View], or click on any bolded column header (List View only). Click
on the column header a second time to reverse the sort order.

Limit the list to | In the Date field select a preset range, or click Date Range, then
recent runs. select a Start and End date.

Filter the list. Select from one or more Filter dropdown lists to limit the
Completed Runs & Reports list. Click More Filters to see all
available filters. Within a Filter enter text into the Find field to
limit the filter choices. To remove a filter, de-select the filter
choice or click Clear in the Filter dropdown list.

View favorites. Click i} adjacent to the Search field to limit the list to completed
Runs designated as favorites.

2. Click Clear All to remove filters and restore all results.

Reanalyze a run report

You can reanalyze a run report to correct a setup error such as a default reference
alignment, or assigned barcode, or to optimize analysis parameters.

1. In the Data tab, click Completed Runs & Reports.

2. Search, filter, or sort the list to find your Run report of interest.

See “Search for a Run report” on page 65 for more information.
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Reanalyze a run report
3. In Table View mode, in the row of the Run report of interest, click Settings
(£F) » Reanalyze.
Alternatively, switch to List View, find your Run report of interest, then click
Reanalyze.
4. Enter a Report Name, then select from the available options:
Option Description
Thumbnail only: Select to reanalyze only the thumbnail report. This option is
available only for lon Proton™ System and lon S5" System
data.
Start reanalysis from: | Select Signal Processing to reanalyze from DAT files. Select
Base Calling (default) to reanalyze from 1.wells files.

Use data from Select the previous result from the dropdown list if more

previous result: than one result is available.

Analysis Parameters: | See “Configure and select a custom analysis parameter

set” on page 412 for more information.
5. (Optional) In the menu, click Analysis Options, then edit the fields if needed.
Field Description

Library Key: The sequence that is used to identify library reads.

TF Key: The sequence that is used to identify test fragment reads.

3' Adapter The sequence of the 3’ Adapter used.

Mark as Duplicate Select to have PCR duplicates flagged in the BAM file.

Reads:

Base Calibration Mode: | Base calibration allows for empirical alignments to
influence flow signals to achieve better homopolymer
calibration to improve overall accuracy.

Enable Realignment: Select to use an optional analysis step to adjust the
alignment, primarily in the CIGAR string.

6. (Optional) In the menu, click Reference & Barcoding, then edit the fields if
needed to set the default options.
Option Description

Default Alignment Select the default reference file from the dropdown

Reference: list.

Default Target Regions BED | Select the default Target Regions BED file from the

File: dropdown list.

Default Hotspot Regions Select the default Hotspot Regions BED file from the

BED File: dropdown list.

Barcode Set: Select the default barcode set from the dropdown list.

7. (Optional) In the menu, click Plugins.
a. Select the plugin to include in the reanalysis.
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b. (If needed) Configure the plugin, then click Save Plugin Settings.

See “Plugin configuration” on page 116, or the configuration topic specific
to the selected plugin.

c. Repeat steps a and b to include additional plugins in the reanalysis.

8. Click Start Analysis.
Change the Use the following procedure to change the default alignment reference for an
Default Alignment ~ analysis.
Reference 1. In the Data tab, click Completed Runs & Reports.
2. Navigate to the run of interest.
See “Search for a Run report” on page 65 for help finding an individual run.
3. For that run, click Settings (#¥) » Reanalyze.
4. In the Reanalysis screen for the run, click Reference & Barcoding.
5. Select a new reference from the Default Alignment Reference dropdown list.
Run Name : $5-530 cfDNA
Reanalyze Run | DEVauItRAL\gnmen‘l ng19 (hg1g from zip)
Default Thrge;:;gFi:)‘zs
Default Hotspot
Regions BED File :
Default reference info is used for barcodes with no sample name. Additional options for barcoded samples are available on the Edit Run Plan page.
Note: If different references were selected for each barcode in the first run, use
the per-barcode reference selection utility here as well.
6. Click Start Analysis.

Edit a Run report

You can edit a completed Run report to correct a setup error or optimize parameters
for all future reanalyses.

Note: System default Run templates cannot be edited. Create a copy of the Run
template to make changes.

1.

2.

Torrent Suite™ Software 5.6 Help

In the Data tab, click Completed Runs & Reports.

Search, filter, or sort the list to find your Run report of interest.

See “Search for a Run report” on page 65 for more information.
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Edit a Run report

# Manage Completed Runs and Reports

Open the Edit Run wizard.

* In Table View, click Settings (£F) » Edit in the row of the Run report that you
want to edit.

¢ In List View, identify the Run report of interest, then click Edit.

Note: The Edit Run wizard opens to the Save screen.

Click a step in the workflow bar to access the respective screens where edits can
be entered.

Workflow step Description

lon Reporter Select the lon Reporter Account, Sample Grouping, and lon
Reporter Upload Options.

Research Application | Select the Research Application and Target Technique.

Plugins Select the plugins to be included in the Run.
Projects Select the Project for the Run data.
Save Enter a Run Plan Name, then edit fields if needed.

5. Click Update Run, or Update Run & Reanalyze to start the reanalysis

immediately.
Add or change You can change barcoding when you set up a reanalysis (“Reanalyze a run” on
barcoding for a page 51), but you can also use the Edit option for a completed Run to change

completed Run

barcoding for all future reanalyses. You can:

report * Add barcoding to a Run.

¢ Change the barcode set for a Run.

* Remove barcoding from a Run.

In each case, you must reanalyze the Run after editing the barcode information. These
steps apply only to completed Runs.

1.

2.

68

In the Data tab, click Completed Runs & Reports.

In table or list view, navigate to your Run of interest.

See “Search for a Run report” on page 65 for help finding an individual Run.

Click Settings (¥¥) » Edit for that Run.
The Edit Run screen appears.

Edit the Run Plan Name if desired, make the appropriate barcoding changes,
then click either Update Run, or Update Run & Reanalyze.
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Set the Completed Runs & Reports page to automatically refresh

Auto Refresh updates your Completed Runs & Reports page every 20 seconds.
Without Auto Refresh, the page is a static display of information at the time you

opened the page.
1. In the Data tab, click Completed Runs & Reports » Auto Refresh.
Completed Runs & Reports List View | Table View (More Columns)

2. Click Stop Refresh to turn the Auto Refresh feature off.
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Organize run results with projects

,

Projects are groups of results sets that you can use to organize results into unique
categories that are useful for your organization. A project might contain run results
for the same laboratory project or results from completed runs that you want to
combine. Projects also allow you to combine run results into a single run report. When
you open a list of projects, you can:

* Quickly find and view details for a group of run results

* Search the list by project name or partial name, or by date (date range, current

month, current week, current day, or specific date).
* Rename, or delete a project.

* View a history log for a project.

1. In the Data tab, click Projects to see the list of projects.

2. Select a project in the list to view the results sets that are included in the project.

Search for projects by name

You can search for project by name in the list of projects.

1. Inthe Data tab, click Projects.

mpli| (50 Clear

2. Enter your search criteria Search names field, then click Go. The displayed
information is limited to only names that match or contain the search string.

* The Search names field takes a complete or partial name. For example, the
following project names match the search string "mpli": amplicon,
amplicon33, AmpliSeq, Samplier.

* The search is not case-sensitive. Wildcards are not supported in the search
string.

3. Click Clear to cancel the search, then display unfiltered results.

Sort projects or Click any column heading that is in bold type to sort the list of projects or the result
result set lists sets for projects. Click the heading a second time to reverse the sort.
70
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Add a Run report to a project

You can add a completed run report to a project.

1. In the Data tab, click Completed Runs & Reports.

2. Find the Run report that you want to add to a project. For that report, click
Settings ({) » Add Report To Project

3. Select the project (or projects) to which you want the Run report added:

Pick projects to be associated with selected results:
=0 Add projects
Hame Results  Last Modified

s
[ pre_2012Q1INT2 0 2012106015 04:45 P
[] chip_test 0 2012106115 04:45 PM
[] detergent 0 201210615 04:48 P
lot26h_getest a 2012106015 04:45 P
lot26h_GCtest 0 201210615 04:45 P
[] FCLT 0 2012106115 04:48 PM

[] RD 316 chin test 0 2012106115 04:48 PR ¥

4. Click Add projects. The Run report is added to the selected project or projects.

Filter projects or You can find use dates or date ranges to search for projects, or for results sets that are
result sets by date contained in a project.

1. Do one of the following:

¢ To search for a project, in the Data tab, click Projects.

¢ To search for results sets, click a project name.
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2. Click the Report Date field for a search that takes effect immediately (depending
on server load):

Select one of the following to find use a range of dates in the search:

* Today selection enters the current date in the Start date field and limits the
run table display only to jobs with a run date from the current date.

¢ This week to search a date range from Monday to the current day.
e Last 7 days to search the seven days before today.
¢ This month to search the entire current month.

* Date Range to search with calendars for the range start date and one for the
range end date. The current date is shown in pale yellow. If a date range is
currently selected, those dates are shown in white.

Projects
2012-08-07 - 2012-08-25 Go Clear
INE
15 weel
Last 7 days
|
1S mont
|
| | Date Range ¥
I Start date End date
o August 2012 0 0 August 2012 L+]

|5u Mo Tu We Th Fr 5Sa Su Mo Tu We Th Fr Sa

1 2 3 1 2 | A
5 fi T 8 g 10 11 B i 7 B | 10 1
12 13 4 18 16| 1F 18 2 13 14 5 16 17 8
19 [ 2 3 4 25 18 20 2 2 23 24 25
26 ¥ 18 29 30 N 26 7 28 29 30| 31
Done

— (Optional) Enter a Date Range, or edit the date range in the field.

— (Optional) Click Clear to cancel filtering and return to the full results
listing.
— Click Done to perform the search.
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Add a project to a Planned Run
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You can designate which results sets are included in projects before runs are

completed when you add a project to Planned Run or a run template.

When you create a Planned run, search for and enter project names in the Projects

step in the Workflow bar:

Select the project(s) that will receive data from runs planned in this template, then hit next.

Summary
090A01_IC_reagent_test len Reporter:
0t2_sampleinject_temp Application:

@ 13HQC
15X_ATG
16s

Sample Grouping:
Target Technique:

len Reporter
Workflow:

Search Add Project. lon Reporter Upload
Options:

Sample Preparation

Kit:
Library Kit Type:

See “Plan an instrument run” on page 25 for more details.

Add selected 1. In the Data tab, click Projects to see the list of projects.
results to another . , , , .
project 2. Select a project in the list to view the results sets in the project.

Torrent Suite™ Software 5.6 Help
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AmpliSeq DNA

lon AmpliSeq 2.0 Library
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3. Select the checkboxes for the result sets that you want to add to one or more
other projects, then click Process Selected » Add to Project.

Completed Runs & Results Projects
Projects
5... Hame Status Reference Date «
[] C01.455-R148876  Completed  e_coli_dniDh 3;;1125{DPE,;2D
C01.451-R148730 Completed  e_cali_dh10b Eggﬂg
C01.453-R14872  Completed  e_cali_dh10b 32;2;15;:9

| &l o = |
Combine Selected = Process Selected -

= Addto Project

» Remove from Proje

» Data Management

4. Select the checkbox for each project that the result sets are to be copied to, then
click Add projects.

Manage data for result sets in projects

You can export, archive, or delete data from results that are included in a project.

1. In the Data tab, click Projects to see the list of projects.
2. Select a project from the list to view the results sets in the project.

3. Click Process Selected » Data Management.

For details on how to export, archive or delete data results in the project, see
“Manually export run data” on page 290, “Manually archive run data” on
page 291 and “Manually delete run data” on page 292.
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Combine aligned reads from multiple run reports

You can use projects to combine aligned reads from multiple run reports. The
resulting data set can be treated the same results from a single analysis run, for
example to export or to use as input for a plugin. Use this option when multiple runs
analyze the same tissue sample, for example when a tissue sample is run on more
than one chip. All reports must be aligned to the same reference.

1. In the Data tab, click Projects to see the list of projects.

2. Select a project in the list to view the results sets in the project.

3. Select the result set or sets that you want to combine into a single Run result set.

Option

Description

Mark as
duplicate

For some applications, duplicate reads coming from PCR cause
problems in downstream analysis. The presence of duplicate reads
can create the appearance of multiple independent reads supporting
a particular interpretation, when some reads are in fact duplicates of
each other with no additional evidence for the interpretation.

Torrent Suite™ Software uses an lon-optimized approach that
considers the read start and end positions by using both the 5’
alignment start site and the flow in which the 3" adapter is detected.
Duplicate reads are flagged in the BAM in a dedicated field. Use of
the Torrent Suite” Software method is recommended over other
approaches which consider only the 5" alignment start site.

Marking duplicate reads is not appropriate for lon AmpliSeq™ data,
because many independent reads are expected to share 5" alignment
position and 3" adapter flow as each other. Marking duplicates on an
lon AmpliSeq” run risks inappropriately flagging many reads that are
in fact independent of one another.

Overwrite
sample name

4. (Optional) Click Report to open the summary of the report, or Log to open the log

for the report.

5. Click Combine Selected » Combine Alignments.

The result sets are combined into a single Run report that is added to the list of

projects.

Torrent Suite™ Software 5.6 Help
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Download a CSV file of metrics

You can download a CSV file of analysis metrics for one or more result sets, then
compare results across analyses.

1. In the Data tab, click Projects, then click a project name to open the list of results
sets for the project.

2. Select the checkboxes for the analyses, then click Download Selected CSV.

The analysis metrics file is downloaded through your browser to a directory on
your computer, based on your browser settings.

Remove result sets from project

You can remove a result set from a project.

Note: This option does not delete the selected run reports and their result sets. It only
removes them from the current project.

1. In the Data tab, click Projects to see the list of projects.
2. Select a project in the list to view the results sets in the project.

3. Select the checkboxes of the result sets that you want to remove from the project,
then click Process Selected » Remove from Project.
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Run Reports

A Torrent Suite™ Software run report contains statistics and quality metrics for your

run.

From a run report you can do the following:

Review pre-alignment metrics such as bead loading, Ion Sphere™ Particle (ISP)
density, total number of reads, filtering numbers, and mean read length

Review alignment metrics such as total aligned bases, average coverage, and
mean raw accuracy

Download the result set

Manually run a plugin on the run results

Review the planned run settings

Review the test fragments used with this run and test fragment quality metrics
Review Chef Summary

Review Calibration Report

Review analysis information and Torrent Suite™ Software versions

Review the analysis log

Generate a zip file for technical support

A run report is divided into the following main areas:

Torrent Suite™ Software 5.6 Help

Report header - Use this section to download the run report or summary in PDF
format, to review the planned run settings for the run, to reanalyze the run, and
to upload the run report output files to Ion Reporter™ Software. Also, change to a
different result set for the same sample and use links to move to the Output Files
or Plugin Summary sections of the run report.

Barcode Summary - For barcoded runs, a barcode summary table appears above
the Plugin Summary area.

Unaligned - Metrics taken before alignment, including bead loading, ISP density
and other metrics, read and filtering metrics, and read length.

Aligned - Metrics on the aligned reads.

Plugin Previews - Summary output of completed plugins (only if supported by
the plugins that executed on this analysis).

Output Files - Download read files for both before alignment and after
alignment. Full-chip Ion Proton™ analyses only offer the download of aligned
reads.

Plugin Summary - Links to plugin reports and allows you to run plugins
manually on a completed sequencing run.

Test Fragments - Displays information about the performance of each test
fragment included in the experiment.

Chef Summary - Displays Ion Chef™ templating results.

77



® Run Reports

D .
5 Introduction

e (Calibration Report - Displays pre-base calibration and calibration arguments.

* Analysis Details - Displays a set of information about the sequencing run
environment. For example, run date, sample name, chip type, instrument name,
barcode set, and so on.

* Support - Displays a link to the report log and a link to generate information for
technical support.

T™

* Software Version - Displays the version of Torrent Suite™ Software and its

modules.

Review pre- When determining the quality of a run, first look at the unaligned metrics including:
a lig nment metrics total bases, total reads, and mean and median read length. This information comes
from the primary pipeline, base calling, and signal processing.

1. In the Data tab, click Completed Runs & Reports, then select a report of
interest.

2. In the Unaligned section, review Total Bases, Total Reads and Mean, and Median
Read Length to determine the quality of the run.

Read Summary: Unaligned

806 M 83 6,206,558 130 bp 128 bp 129 bp
Total Bases Key Signal Q Total Reads Mea Median Mode
76 % 73 % Read Length
.ll' 1SP Loading lll' Usable Roads <
ISP Density ISP Summary

76% 24%

Loading Empty Wells
100% [EERZAER] 0%
Enrichment No Template
RL: P 6,651,881 22%
Clonal Polyclonal

1% Test Fragments
93% [CEIE 0% Adapter Dimer . " .
Final Library 6% Low Quality a 0 50 100 150 200 250 300 350

Read Length

For more information on these metrics, see “Run report metrics before
alignment” on page 86.
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The secondary pipeline aligns the run to the reference. Here you can see how many

Review alignment
bases align to the reference.

metrics
1. Inthe Data tab, click Completed Runs & Reports, then select a run of interest.

2. Scroll down to the Aligned to reference name section, then review Total Aligned
Bases, Reference Coverage, Mean Raw Accuracy, and Total Bases Alignment

Quality.

Aligned to Homo sapiens

384 M

393 M 0.1X 99.6%
. . o
‘Average raw (1x) accuracy across each "
3073127 99% O

Ali d B ' l "

] T AQI7 AQ20 Perfect
1%

Unaligned Total Number of Bases [bp] 384M 366M 325M

9% Mean Length [bp] 127 124 113

Reads

% Longest Alignment [bp] 322 313 312
0.1 0.1

Mean Coverage Depth [x] O

Accuracy

94

0 50 100 150 200 250 300 350
Position in Read a =

Count %
90 | | |
Total Reads 3,073,127 — 0 50 100 150 200 250 300 350
Position Q

Aligned Reads 3,065,509 99.8%

Unaligned Reads 7,618 0.2%

For more information on these metrics, see “Run report metrics on aligned
reads” on page 95

Download results You can download the run results in several formats.

set 1. In the Data tab, clickCompleted Runs & Reports, then select a run of interest.

2. Scroll down to the Output Files selection, then choose your output type:
Unaligned reads BAM, or Aligned Reads BAM or BAL

Output Files
File Type Unaligned Reads Aligned Reads
Library BAM BAM BAI

For more information, see the “Output files” on page 101 section.

After your run is complete, you can further your analysis by running various analysis

Manually run a
plugins. For details, see “Manage plugins for data analysis” on page 114.

plugin on the run
results
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You can review the planned run settings of a completed run.

1. Inthe Data tab, click Completed Runs & Reports, then select a run of interest.

2. Click Report Actions » Review Plan.
A Review Plan window appears.

P

Review Plan: CopyOfSystemDefault_proton_demo_data
Report: Auto_proton_demo_data_37

Application Monitoring
Application DNA Bead Loading (%) = 30
Group: Key Signal (1-100) < 30

Sampl? Usable Sequence S 30
Grouping: (%)

Target AmpliSeq

Technique:  Exome

Sample Set: Reference

Reference Library: hg19

Kits Target Regions:
Hotspot Regions:
Sample P 9
Preparation
Kit:
Library Kit:  lon Xpress Plugins & Output
Plus Plugins:
Fragment
Library Kit Projects:  Plv4FlowOrder
Library Key: TCAG Uploaders:
3' Adapter:  ATCACCGA
CTGCCCATA
GAGAGGCT Notes
GAGAC
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If you included key signal test fragments in your run, you can review the test

fragments, then evaluate their quality.

1. In the Data tab, click Completed Runs & Reports, then select a run report of

interest.

2. Scroll down to the bottom of the report, then click Test Fragments.

Plugin Summary | Test Fragments | Chef Summary || Calibration Report

He

Analysis Details | Support | Software Version

e Reats P—— Percent fovs017 FT—
DxTF-1 20,105 7% 95% o |
TF_1 20,200 96% 94% o I
o 1] 1-20f 2 items
For more information, see “Test fragment report” on page 102.
If you used an Ton Chef ' instrument, you can review library and template
information.
1. In the Data tab, click Completed Runs & Reports, then select a run which
incorporated an Ion Chef™ instrument.
2. Scroll to the bottom of the run report, then click Chef Summary.
Here you can review the library preparation and templating information.
Plugin Summary  TestFragments = ChelSummary = CalibrationRepori  Analysis Detalls  Support | Software Version
Chef Library Prep Information:
Library Prep Type AmpliSeq on Chef
Library Prep Plate Type BC 17-24 (Green)
PCR Plate Serial Number A030002638
Combined Library Tube Label 00183293
Last Updated Aug. 18, 2015, 458 p.m
Instrument Name P00217
Tip Rack Barcode 654170051
Kit Type lon AmpliSeq Kit for Chel DL8
Reagent Lot Number 1728589
Reagent Part Number A29025C
Reagent Expiration 28589
Solution Lot Number 1728590
Solution Part Number A29026C
Solution Expiration 28590
Script Version 261
Package Version IC5.0.0.RCS8
Chef Template Prep Information:
Chef Last Updated Aug. 20, 2015, 9:10am
Chef Instrument Name CHEF00865
81
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You can review calibration settings that are applied to a run in the Calibration Report.

1. In the Data tab, click Completed Runs & Reports, then select a run report of
interest.

2. Scroll down to the bottom, then click Calibration Report.

3. View your Pre Base Calibration Arguments and Calibration Arguments.

Plugin Summary Test Fragments Chef Summary Calibration Report Analysis Details Support Software Version

Default Calibration
Pre Base Calibration Arguments

BaseCaller --barcode-filter @.81 --barcode-filter-minreads 1@ --phasing-residual-filter=2.@ --max-phasing-lewvels 2
Calibration Arguments

Calibration

For more information, see “Base Calibration mode options” on page 389.

You can review the analysis details of a completed run.

1. In the Data tab, click Completed Runs & Reports, then select a run report of
interest.

2. Scroll down to the bottom of the report and click Analysis Details.

For more information, see “Analysis details” on page 104.

You can view the report error log when troubleshooting a run. If you need further
help, you can generate a customer support archive to share with customer support.

1. Go to Data » Completed Runs & Reports and select the run report of interest.

2. Scroll down to the bottom and click Support » View the report log to see a list of
errors.

3. If the error report does not help you resolve an issue with the run, click
Download to generate a customer support archive that you can then send to
your customer support representative for assistance.

Plugin Summary || TestFragments Chef Summary || Calibration Report || Analysis Details Support Software Version

Download the Customer Support Archive by clicking here -

The customer support archive contains instrument information for troubleshooting and may be requested by field support

Your Torrent Server is not able to access the support server automatically. If you would like to be able to upload these support files
directly rather than manually attaching them to an email in order to receive support, contact your support representative and ask how
to enable Customer Support Archive upload for your Torrent Server.

View the report log

For more information, see “Support” on page 107.
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Report header

The left side of a run report header contains the following navigation links:
* Output Files Jumps to the Output Files area

¢ Plugin Summary Jumps to the Plugin Summary area (which also has the Test
Fragment, Analysis Details, Customer Support, and Software Version buttons)

Completed Runs & Results

| Output Files | |PIL|;_|in Summary |

The right side of run report header contains buttons for the following:
* Upload to IR Copies the run report's output files to Ion Reporter™ Software.

* Report Actions

— Review Plan Opens a summary page of the planned run information for this
run

— Edit Run Plan Opens an Edit Run page

— Copy Plan Opens the run plan wizard with a copy of the run plan
information for this run

— Select plugins to run Opens the Select a plugin window

— Reanalyze Starts a reanalysis of the run (you have the opportunity to
changes settings first)

- Data Management Opens the Data Management app, which you use to
delete, archive, export, or mark as do-not-delete the files for this run report

* Reports Opens the run report of a different result set for the same sample

e — Summary PDF Downloads the run report summary in PDF format
— Plugins PDF Downloads a summary of the plugin results in PDF format

— Classic Report Opens the run report in Torrent Suite™ Software 2.x format

Upload to IR « Report Actions Reports =
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Drop-down options shown below:

Uploadto IR = Report Actions « Reports v

IRProduction [ | EditRunPlan _ Plugins PDF

Copy Plan Classic Report

Configure IR accounts Select plugins to run
Reanalyze

Data Management

Compare run reports

From a project listing page, you can compare report metrics for multiple runs side-by-
side.

Run report metrics

Run metrics
overview

84

This section provides background information on run metrics and detailed
descriptions of a run report.

For analyses that are members of a project, you can download a CSV file of run
metrics.

This section provides background information on quality metrics, read lengths, and
alignment. These concepts are required to understand your run report.

The Torrent Browser Analysis Report gives performance metrics for reads whose first
bases match the library key.

IMPORTANT! These reads are generated from the input library, not from the positive
control Test Fragments.

Performance is measured based on either predicted quality or quality as measured
following alignment. Q20 and AQ20 are explained as examples of predicted quality
and quality following alignment.
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The number of called bases with a predicted quality of Q20 is reported. The predicted
quality values are reported on the Phred scale, defined as -10 1og10 (error
probability). Q20, therefore, corresponds to a predicted error rate of one percent.

Note: Refer to http://en.wikipedia.org/wiki/Phred_quality_score for a more
complete description of Phred values.

You can use Read Alignment to evaluate the quality of the sequencing reaction and
the quality of the underlying library where an accurate reference is available. Reads
are aligned to a reference genome. Any discrepancy in alignment to a reference
(whether biological or technical, meaning a real variant or a sequencing error) is listed
as a mismatch. Alignment performance metrics are reported depending on how many

misaligned bases are allowed. Torrent Suite™ Software reports alignment performance
at two quality levels:

e AQ20
e Perfect

Aligned read length calculation

The aligned length of a read at a given accuracy threshold is defined as the greatest
position in the read at which the accuracy in the bases up to and including the
position meets the accuracy threshold. Accuracy is specified using the Phred -10log10
transformation. As a result, 20 refers to an error rate of 1%, 17 refers to an error rate of
2%, and so on.

For example, the AQ20 length is the greatest length at which the error rate is 1% or
less, and the AQ17 length is the greatest length at which the error rate is 2% or less.
The "perfect" length is the longest perfectly aligned segment.

For all these calculations, the alignment is constrained to start from position 1 in the
read - that is, no 5' clipping is allowed. The underlying assumption is that the
reference to which the read is aligned represents the true sequence that is seen.

Appropriate caution must be taken when interpreting AQ20 values in situations
where the sample sequenced has substantial differences relative to the reference used,
such as working with alignments to a rough draft genome or with samples that are
expected to have high mutation rates relative to the reference used. In these situations,
the AQ20 lengths might be short even when sequencing quality is excellent.

Specifically, the AQ20 length is calculated as follows:

* Every base in the read is classified as being correct or not correct according to the
alignment to the reference.

* Atevery position in the read, the total error rate is calculated up to and including
that position.

¢ The greatest position at which the error rate is one percent or less is identified
and that position defines the AQ20 length.

For example, if a 100-bp read consists of 80 perfect bases followed by 2 errors
followed by 18 more perfect bases, the total error rate at position 80 is zero percent. At
position 81 the total error rate is 1.2% (1/81), at position 82 the error rate is 2.4%,
continuing up to position 100 where it is two percent (2/100). The greatest length at
which the error rate is one percent or less is 80 and the greatest length at which the
error rate is two percent or less is 100, so the AQ20 and AQ17 lengths are 80 and 100
bases, respectively.
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Alignment

T™

In Torrent Suite™ Software, the goal is to provide you with a view on alignment that
helps determine run and library quality.

There are many alignment algorithms available in the marketplace and you are
encouraged to consult with a bioinformatician for the most appropriate alignment
algorithm for your downstream analysis needs. Alignment algorithms are also

embedded in many commercial software tools available in the Ion Torrent™ Web store.
You are also encouraged to experiment with these tools.

T™

Alignment in Torrent Suite™ Software is performed using TMAP. TMAP is currently

an unpublished alignment algorithm, created by the authors of the BFAST algorithm.
Contact your Ion Torrent™ representative or Technical Support for more information

on TMAP.

Although TMAP is unpublished and a reference is not currently available, the
precursor to TMAP, BFAST, is based on the ideas in the following publications:

Homer N, Merriman B, Nelson SE.BFAST: An alignment tool for large-scale genome
resequencing. PMID: 19907642PLoS ONE. 2009 4(11): e7767. http://dx.doi.org/10.1371/
journal.pone.0007767

Homer N, Merriman B, Nelson SF. Local alignment of two-base encoded DNA
sequence. BMC Bioinformatics. 2009 Jun 9;10(1):175.PMID: 19508732. http://
dx.doi.org/10.1186/1471-2105-10-175

Which reads are used in the alignment process

The alignment stage involves aligning reads produced by the pipeline to a reference
genome and extracting metrics from those alignments. By default, Torrent Suite™
Software aligns all reads to the genome, however there may be situations, particularly
with large genomes, where the alignment takes longer than you are willing to wait. So
for such circumstances the Torrent Suite™ Software also can define on a per-reference
basis the maximum number of reads that are aligned from a run.

When the number of reads in a run exceeds a genome-specific maximum, a random
sample of reads is taken and results are extrapolated to the full run. By sampling a
quickly-aligned subset of reads and extrapolating the values to the full run, the
software gives you sufficient information to be able to judge the quality of the sample,
library, and sequencing run for quality assessment purposes.

The output of the alignment process is a BAM file. The BAM file includes an
alignment of all reads, including the unmapped, with exactly one mapping per read.
When a read maps to multiple locations, the mapping with the best mapping score is
used. If more than one such mapping exists, a random mapping is used and given a
mapping quality of zero.

The Unaligned area in the Run Summary section provides before-alignment metrics.
There are three sections in the Unaligned area:

¢ ISP Density
¢ ISP Summary
* Read Length

Note: Click the magnifying glassicon Q in the run report to open a larger image.
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ISP density
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This table describes the Ion Sphere™ Particle (ISP) density metrics:
Metric Description
Total Bases Number of filtered and trimmed base pairs

reported in the output BAM file.

Key Signal Percentage of Live ISPs with a key signal
that is identical to the library key signal.

Bead Loading Percentage of chip wells that contain a live
ISP. (The percentage value considers only
potentially addressable wells.)

The ISP Density image is a pseudo-color image of the Ion Chip Plate showing percent
loading across the physical surface.

Click on the image (or the magnify icon Q) to open a larger version.
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Click the magnify icon in the Key Signal area .". . to open the key incorporation

graphs:
Key Incorporation Traces

Consensus Key 1-Mer - Library Ave. Peak = 70

Count
g 8
i

4]
Flows

Close
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The key incorporation graph show the average signal readings for flows of the bases
T, C, and A in the library key.

ISP Density

B31-583--R179409-Pil8_DS1_modTOP3-CF
Loading Density [Avg ~ 84%)
- 100 %

-
.

90 %
800 80 %
470 %
@ BO0 i A - 60 %
E .
= 150 %
(=]
r~ L
™ 400 @ 40 %
30 %
200 20 %
L 10 %
0 RN 0%
(1] 100 200 300 400 500 600 700 800

3392 wells

Close

Torrent Suite™ Software 5.6 Help

89



90

x O

un Reports
un report metrics

ISP summary

84%

Loading

100%

Enrichment

79%

Clonal

87%

Final Library

9,514,769

1,527,145

6,514,316

6,514,316

Total Reads

69 %
Usahle Reads

9,517,149

16%

Empty Wells

0%

No Template

21%

Polyclonal

0% Test Fragments
0% Adapter Dimer
13% Low Quality (o}

In the lower rows, the percentages are relative to the total in the next higher row. The
first row gives percentages of loaded wells and empty wells, relative to the number of
potentially addressable wells on the chip.

This table describes the ISP summary metrics:

Metric

Description

Calculation

Total Reads

Total number of filtered and
trimmed reads independent
of length reported in the
output BAM file.

(Not calculated)

Usable Sequence

The percentage of library
ISPs that pass the
polyclonal, low quality, and
primer-dimer filters.

Final Library ISPs/ Library
ISPs

Loading

Percentage of chip wells
that contain a live ISP. (The
percentage value
considersonly potentially
addressable wells.)

No. of Loaded ISPs / No. of
potentially addressable
wells
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Metric

Description

Calculation

Empty Wells

Percentage of chip wells
that do not contain an ISP.
(The percentage value
considers only potentially
addressable wells.)

(No. of potentially
addressable wells minus
No. of Loaded ISPs) / No. of
potentially addressable
wells

Enrichment

Predicted number of Live
ISPs thathave a key signal
identical to the library key
signal.The Percent
Enrichment value reported
is the number of loaded ISPs
that are Library ISPs, after
taking out Test Fragment
ISPs.

Library ISPs / (No. of Loaded
ISPsminus TF ISPs)

No Template

Percentage of chip wells
that do not contain a DNA
template.

(No. of Loaded ISPs minus
TF ISPs) minus (Library
ISPs) / (No. of Loaded ISPs
minus TF ISPs)

Clonal

Percentage of clonal ISPs
(all library and Test
Fragment ISPs that are not
polyclonal).

An ISP is clonal if all of its
DNA fragments are cloned
from a single original
template. All the fragments
on such a bead are identical
(and they respond in unison
as each nucleotide is flowed
in turn across the chip).

No. of ISPs with single
beads / No. of Live Wells

Polyclonal

Percentage of polyclonal
ISPs (ISPs carrying clones
from two or more
templates).

Polyclonal ISPs / Live ISPs

Final Library

Percentage of reads which
pass all filters and which are
recorded in the output BAM
file.This value may be
different from the Total
Reads due to technicalities
associated with read
trimming beyond a minimal
requirement resulting in
Total Reads being slightly
less than Final Library.

Final Library / Clonal ISPs
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Metric

Description

Calculation

% Test Fragments

Percentage of Live ISPs with
a key signal that is identical
to the test fragment key
signal.

Test Fragment ISPs / Clonal
ISPs

% Adapter Dimer

Percentage of ISPs with an
insert length of less than 8
bp.

Primer-dimer ISPs / Clonal
ISPs

% Low Quality

Percentage of ISPs with a
low or unrecognizable
signal.

Low quality ISPs / Clonal
ISPs

Click the ISP Summary magnify icon Q to open a larger version with also a table of

metrics:

These metrics are described in this table:

Metric

Description

Calculation

Addressable Wells

Total number of addressable
wells.

(Not calculated)

With ISPs

Number (and percentage of
addressable wells) of wells
that were determined to be
"positive” for the presence
of an ISP in the well.
"Positive” is determined by
measuring the diffusion rate
of a flow with a different pH.
Wells containing ISPs have a
delayed pH change due to
the presence of an ISP
slowing the detection of the
pH change from the
solution.

Wells with ISPs / Total
Addressable Wells

Live

Number (and percentage of
wells with ISPs) of wells that
contained an ISP with a
signal of sufficient strength
and composition to be
associated with the library
or Test Fragment key. This
value is the sum of the
following categories:

e Test Fragment

e Library

Live ISPs / Wells with ISPs
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Description

Calculation

Test Fragment

Number (and percentage of
Live ISPs] of Live ISPs with a
key signal that was identical
to the Test Fragment key
signal.

Test Fragment ISPs / Live
ISPs

Library

Number (and percentage of

Live ISPs] of Live ISPs with a
key signal that was identical
to the library key signal.

Library ISPs / Live ISPs

Library ISPs

Predicted number of Live
ISPs that have a key signal
identical to the library key
signal (the same value as
shown in the well
information table on the
right).

Library ISPs

Filtered: Polyclonal

ISPs carrying clones from
two or more templates.

Polyclonal ISPs / Library
ISPs

Filtered: Low quality

Low or unrecognizable
signal.

Low quality ISPs / Library
ISPs

Filtered: Primer-dimer

Insert length of less than 8
bp.

Primer-dimer ISPs / Library
ISPs

Final Library ISPs

Number (and percentage of
Library ISPs) of reads
passing all filters, which are
recorded in the output BAM
file. This value may be
different from the Total
number of reads in the
Library Summary Section
due to technicalities
associated with read
trimming beyond a minimal
requirement resulting in
Total number of reads being
slightly less than Final
Library Reads.

Final Library / Library ISPs

Torrent Suite™ Software 5.6 Help
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Read length

249 bp 262 bp 263 bp
Mean Median Mode
Read Length
0 50 100 150 200 250 300 350
Read Length
]
This table describes the read length metrics:
Metric Description

Mean Read Length

Average length, in base pairs, of called
reads.

Median Read Length

Median length of called reads.

Mode Read Length

Mode length of called reads.

The read length histogram is a histogram of the trimmed lengths of all reads present

in the output files.
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Click on the histogram to open a larger version:

Read Length Details

Read Length Histogram
250000 . . .

200000

150000 1

Count

100000 .

50000 1

0 50 100 150 200 250 300
Read Length

Close

Run report The run report provides metrics on aligned reads.
metrics on aligned
reads
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Total aligned bases

1.6 G

Total Aligned Bases

6,514,317

Reads

345.7X

Reference Coverage

99%

Aligned Bases

0 50 100 150 200 250 300 350

Position in Read @
Count U
Total Reads 6,514,316 —
Aligned Feads 6,495 971 99 7%
Unaligned Reads 18,345 0.3%

The following table describes metrics in the Total Aligned bases area.

Metric

Description

Total Aligned Bases

Number of filtered and trimmed aligned
base pairs reported in the output BAM file.

Total number of bases aligned to the
reference sequence. Excludes the library
key, barcodes, and 3" adapter sequences.

Reference Coverage

The average of the number of reads that
cover each reference position: total aligned
bases divided by the number of bases in the
reference sequence.

Does not consider enrichment.

Torrent Suite™ Software 5.6 Help
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Metric Description
% Aligned Bases Percentage of Total Aligned Bases out of all
reads.
% Unaligned Percentage of bases not aligned to
references.
Total Reads Number of reads generated during

basecalling.

Aligned Reads Number of reads that aligned to the
reference genome.

Unaligned Reads Number of reads that did not align to the
reference genome.

The graph in the Total Aligned reads column plots number of aligned (in blue) and
unaligned (in purple) bases byposition in an aligned sequence. (The purple area
cannot be seen easily when it is under 3 or 4 percent.)

Alignment summary

99%

Aligned Bases

6.5M

1%

Unaligned

5.0M
€ 4.0M
3.0M
2.0M

1.0M

0 50 100 150 200 250 5E-|'Cl 350
Position in Read

For each position in an aligned sequence, the height of the blue area shows the
number of aligned bases at that position. The purple area shows the number of
unaligned bases at that position. Unaligned bases are not shown by the absolute
height on the number of bases axis, but by the difference between the purple height
and the blue height.
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Raw accuracy

The graph in the Raw Accuracy column plots percent accuracy for each position in an
aligned sequence:

99.6%

Mean Raw Accuracy 1=

100 - =
b _.a-"‘\

E 98 - -
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&
* 96 - =
o
=
o
= 94
(W]
L
<I

92 - :

90L JA

0 50 100 150 200 250 300 350
Position in Read ®
Metric Description
Mean Raw Accuracy 1x Average raw accuracy of 1-mers plotted by

their position in the read.
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Alignment quality calculations include the following:

1.5G

Alignment Quality

Total Number of Bases [bp]
Mean Length [bp]
Longest Alignment [bp]

Mean Coverage Depth [x]

AQ1T AQ20 Perfect

18G5 156G 1206

245 242 202

336 327 321

3403 3292 26B.S

Metric Description
AQ17 An error rate of 2% or less.
AQ20 An error rate of 1% or less.
Perfect The longest perfectly aligned segment.

Total Number of Bases

Total number of bases at the quality level.

Mean Length

Average segment length at the quality level.

Mean Coverage Depth

Average coverage at the quality level.

Torrent Suite™ Software 5.6 Help
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Barcode reports

100

Barcode reports are included in the Run Summary runs that use barcodes. It shows
key performance metrics for each barcode included in the run.

The number of barcodes in the barcode report reflects the barcode set that was used in

the run and the barcodes that are present in the sample. Data is included only for

barcodes that are present in the run.

The barcode section of a run report displays the following information per barcode:

Mean

Barcode Sample Bases >=()20 Bases Reads Read feﬁih Files

Name Length Histogram

Mo barcode None 484 500694 405,333 472 2602234 186 bp 'e--am UBAM BAM BA

lonXpress_001 none 8340933542 7.051,250.074 445832336 185Dbp S BAM BAM BAI

lonXpress_002 none 7872283621 6684591505 41982000 187Dbp L UBAM BAM BAI

<@ 10 * items per page 1-30f 3 items
Column Description

Barcode Name

The individual
barcode in the
barcode set.

The row labeled as
No barcode reports
on unclassified
barcodes, which are
reads that could not
be classified as
matching one of the
expected barcodes in
the barcode set.

Sample Name of the sample
that was sequenced
on instrument.

Bases Post filtering base
output per barcode.

% 2 Q20 The percentage of

reads that have a
predicted quality
score of Q20 or
better.

A Q20 score is the
predicted quality of a
Phred-like score of
20 or better, or one
errorin 100 bp.
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Column

Description

Reads

Total number of
filtered and trimmed
library reads
(independent of
length). This number
is reported in the
barcode BAM file.

Mean Read Length

The average read
length, in bp, of all
filtered and trimmed
library reads
reported in the
barcode BAM file.

Read Length Histogram

A thumbnail
histogram of the
read lengths for this
barcode. Click the
thumbnail histogram
to open a larger
image.

Files

Provides links to
download the UBAM,
BAM and BAM index
files (BAI) for this
barcode. The BAM
file contains aligned
reads sorted by
reference location.

report.

Output Files
File Type Reads
Libirany BAM
Barcodes BamM

Torrent Suite™ Software 5.6 Help

These links allow you to directly download the data and report files. Some files are
compressed, using ZIP, to provide data integrity and to reduce download time.

Click a file type to save the file to your local computer. Most output files can be loaded
into third-party viewers (such as IGV) for visualization. The barcode row only
appears for runs on barcoded data.

Files in the barcode row are zips of one file per active barcode. To download only
BAM and BAl files for a single barcode, go to the barcode section at the top of the run

Alinned Reads

BAM

BAM

Bal

Bal
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The BAM format

Column Description
Reads Files with unaligned reads (before
alignment]
Aligned Reads Files with aligned reads
File type Reads Aligned reads
BAM Unaligned reads in BAM Aligned reads sorted by
format. reference location.
In this release, the BAM file
contains some flow space
information.
BAI BAM index file

Binary Sequence Alignment/Map (BAM), is a compressed, binary form of the SAM
format. BAM files can be indexed, using the BAM Index file, for fast access to
sequence alignment data. See http://samtools.sourceforge.net for a more detailed
description of the SAM/BAM file format. Many tools are available for working with
SAM files.

FASTQ file format generation
The FASTQ file format is not produced by the default analysis pipeline.

The FileExporter plugin generates files that use the FASTQ format that contain data
that is organized in a per-base basis, including quality scores. The reads contained in
the file are unaligned reads.

IMPORTANT! The FASTQ files that are created by the FileExporter plugin can be
downloaded after a sequencing run that uses the plugin. For details on how to
download the files, see “FileExporter plugin” on page 144.

Rename your output files

You can rename your output files with the FileExporter plugin. This plugin also
optionally create and download versions of the files that use BAM, VCF, XLS, or
FASTQ formats. You can also download compressed versions of the results files. For
details, see “FileExporter plugin” on page 144.

Test fragment report

102

The Test Fragment Summary section of the Analysis Report provides information
about the performance of each Test Fragment included in the experiment.

Test Fragments are used during analysis to predict the CF/IE/DR values for each Test
Fragment, regionally. Analysis results for a Test Fragment are displayed when there
are at least 1000 high-quality Test Fragments, where there is an 85% match against the

Torrent Suite™ Software 5.6 Help
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appropriate template in the Test Fragment list. This includes CF/IE/DR estimates and
performance calculations.

IMPORTANT! The number of TFs reported includes lower quality TFs, down to 70%
match, to better represent the run quality from all TF's.

Open the test Click Test Fragments near the bottom of the run report to open the test fragment
fragment report report:

Plugin Summany Test Fragments Anahysis Details Support

Test Fragment  Reads Fercent 504217 Fead length histogram

TF_D 16,060 96%
TTGCGCGCGCTGT GAA
0 10
Test fragment The Test Fragments report displays the following information:
metrics -
Parameter Description
Test Fragment Test fragment name (defined in the Admin >
References tab of Torrent Browser]).
Reads Number of filtered & trimmed reads
identified for this test fragment.
Percentage 50AQ17 The percentage of reads for this test
fragment with a minimum of 50 base pairs
in length and an error rate of 1in 50,
Phred-like 17, or better. Quality is based on
alignment, not predicted quality.

The test fragment sequence is also shown in the read length histogram.
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Read length This is a histogram of read lengths, in bpunits, that have a Phred-like score of 17 or
histogram1 better, or one error in 50 bp (the ends only are shown because of width
considerations):
-
TTGCGCGCGCTGTGAATGCGCT GACTGCCAAGGCACACAGGGGAT AGG
0 10 20 70 80 a0
TGTTTTAGGGT CCCCGGGGTTA AGACTGCCAAGG CACACAGOLGGATAGG
0 10 20 70 80 20

Distributions skewed to the right are ideal, showing longer read lengths (test
fragments are a discrete length). It is likely that the sequence can extend all the way
through the test fragment, if enough flows are run, so the histogram only displays a
maximum size based on the length of the test fragment.

View Analysis Details of a report

To access the Analysis Details of a report:

1. In the Data tab, click Completed Runs & Reports.

2. Scroll to the bottom of the screen, then click Analysis Details.

Analysis details The Analysis Details report displays the following information:
Parameter Description
Run Name Name of the run.
Run Date Date and time the lon PGM™ or lon Proton™ run was
started.
Run Cycles Number of lon PGM™ or lon Proton™ cycles analyzed for

this report. Note that this number can differ from the total
number of cycles run on the sequencer.

Run Flows Number of lon PGM™ or lon Proton™ nucleotide flows
analyzed for this report. Note that this number can differ
from the total number of flows occurring on the sequencer.

Project Names of the projects the result set is a member of.
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Parameter

Description

Sample

Name of the sample assigned to the run used to generate
this analysis. This is assigned on thelon PGM™ or lon
Proton™ Sequencer.

Sample Tube Label

The label or written text on a sample tube used to track
each sample through the sequencing workflow.

Reference

Name of the library assigned to the run used to generate
this analysis. This library name is used to specify the
reference genome used for alignment.

Instrument

Name of the sequencing instrument on which the run was
performed.

Flow Order

Flow order selected on lon PGM™ or lon Proton™ lon
Proton™ Sequencer: Samba =
TACGTACGTCTGAGCATCGATCGATGTACAGC
[Default]Regular = TACG The "regular” flow order adds
bases most rapidly to sequenced molecules but is
vulnerable to phase errors. The Samba flow order consists
of a 32-base sequence, repeated. This flow order resists
phase errors by providing opportunities for out-of-phase
molecules to catch up and is designed to sample all dimer
(nucleotide pair) sequences, efficiently. Samba is the
default flow order because it improve sequencing accuracy
for longer reads by resisting phase errors.

Library Key

A short known sequence of bases used to distinguish the
library fragment from the test fragment. Example: "TCAG"

TF Key

A short known sequence of bases used to distinguish the
test fragment.

Chip ID

The ID number of the chip that appears on the chip
barcode label.

Chip Check

A series of tests on reference wells (about 10% of the chip
in non-addressable areas) is performed to ensure that the
chip is functioning at a basic level. The value of this field is
either Passed or Failed.

Chip Type

Type of chip used on the lon PGM™ Sequencer. Usually,
314, 316, or 318 (for the lon 314" chip, lon 316" chip, and
lon 318™ chip.) A letter follows the numbers, indicating the
chip version.

Chip Data

In this release, the value is single, for a forward run.

Chip Lot Number

The lot number of the chip as scanned by the lon Proton™
Sequencer or lon S5 Sequencer. Not available for lon
PGM™ runs.

Barcode Set

The name of the barcode set assigned to the run. Blank for
non-barcode libraries.

Torrent Suite™ Software 5.6 Help
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Parameter Description

Analysis Name Name of the analysis provided in Torrent Suite™ Software
when the analysis was started. If the analysis was
scheduled to auto-start, this is the default analysis name.

Analysis Date Date the analysis was performed.

Analysis Flows Number of lon PGM™ orlon Proton™ nucleotide flows
analyzed for this report. Note that this number can differ
from the total number of flows occurring on the lon PGM™
orlon Proton™ Sequencer.

runiD The run code that the Torrent Suite™ Software assigned to
the planned run for this analysis.

(/section>

Software version The Software Version report display includes version information for the modules

installed on your Torrent Server.

IMPORTANT! The version numbers shown in the example may be different from
your current version of the software depending on the age of the analysis. See the
About tab in the Torrent Browser for a complete list of modules and version on your
server. See the Torrent Suite™ Release Notes for the package versions in a specific

release.
Parameter Description
Torrent Suite™ Version of Torrent Suite™ Software software
used to generate the analysis.
Datacollect Version of the Datacollect package.
LiveView Version of the LiveView package.
Script Version of the Script package.
ion-alignment Version of the Torrent Suite™ Software
alignment module used for this analysis.
ion-analysis Version of the Analysis Pipeline used to
generate the analysis.
ion-db reports Version of the ion-dbreports package.
ion-gpu Version of the NVIDIA® Tesla® GPU driver.
ion-plugins Version of the pre-installed plugins.
ion-torrentR Version of the TorrentR stats package.
tmap Version of the TMAP alignment package.
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Support The Support button opens links to the following:

View Analysis Details of a report 51
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* Download the Customer Support Archive Download a ZIP archive containing
the PDF and HTML version of the run report as well as useful logs in case
troubleshooting is required. See Customer Support Archive for a description of

the archive and its contents.

* Download the New Customer Support Archive Generate a new customer

support archive and download it.

* View the Report Log View the error log for this run report.

Plugin Summary || Test Fragments | Analysis Details

« [Download the Customer Support &rchive
+ Download the New Customer Support Archive
+ Yiew the report log

Torrent Suite™ Software 5.6 Help
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An example report log is shown below (chopped for width considerations):
Report Error Log ~«frech the nane 1o ses updates

v s o0y — —

P W [ VA A I A T I Y 0

P N T T T Y [ O W . W

PV WL N I (A PR I WO Y . N Y A D [
|__#

Hostname = mooreall

Start Time = Sun Aug 19 17:@7:12 2912

Version = 2.9-9+1 (4@185) (2912p817154@)

Command line = &nalysis --librarykey=TCAG --tfkey=ATCG --no-subdir --out
dat source = fresults-nas9/2-4-RegressionTests /C25-336
SystemContext::SetUpfnalysisLocation... experimentName=/ results2/analysi

SystemContext::SetUpfnalysislocation... analysislocation =/results2fana
SystemContext::SetUpAnalysislocation... baseName msipproc_results
SystemContext::SetUpfnalysislocation... runld =MAT2D

Found chip id 318

Use dud and empty wells as reference: no

Proton 1.wells correction enabled : no

Empty well normalization enabled : no

Per flow t-mid-nuc tracking enabled : no

Regional Sampling : no

Inage gain correction enabled : no

Col flicker correction enabled : no
SystemContext::SetUpfnalysislocation... experimentMame=/results2fanalysi
SystemContext::SetUpfnalysisLocation... amalysisLocation =/results2fana

SystemContext::SetlUpfnalysislocation... baselame =sigproc_results
SystemContext::SetUpfnalysislocation... runld =HAT2D
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Introduction

Torrent Suite™ Software supports many research applications. In this section, we
highlight some of the main ones.

Oncology - Liquid Biopsy

The Oncology — Liquid Biopsy application supports tumor and liquid biopsy
oncology research applications, for the following sample types: lung, breast and
colon. The corresponding Planned Run templates for related panels are named as
follows:

Name

Oncomine™ Colon Tumor DNA

Oncomine™ Colon Liquid Biopsy DNA

Oncomine™ Breast Tumor DNA

Oncomine " Breast Liquid Biopsy DNA

Oncomine™ Lung Tumor DNA

Oncomine™ Lung Liquid Biopsy DNA

The following instructions provide a basic overview of how to set up a planned run
for the related panels.

Plan an Oncology 1. In the Template Name column, click on the template and the wizard opens on the
- Liquid Biopsy Plan tab.

run from template 2. In the Ion Reporter tab, select None, and click Next.

3. In the Application tab, confirm Oncology - Liquid Biopsy and Tag Sequencing
are selected. Click Next.

4. In the Kits tab, select Oncomine cfDNA Assay. Click Next.
5. In the Plugins tab, select variantCaller_cfDNA. Click Next.
6. (Optional) on the Projects tab, select a project. Click Next.

7. In the Plan tab, enter a name for your run and add samples. Click Plan Run.
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Create an

Oncology - Liquid
Biopsy Planned

Run template

Review
Oncomine™ cfDNA
assay run results
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In the Plan tab, click Templates, then select the Oncology — Liquid Biopsy
category under Favorites.

Create a copy of the appropriate factory template, either Oncomine™ Lung
Tumor DNA or Oncomine ™ Liquid Biopsy DNA.

a. Click Settings (%#) » Copy in the row of the appropriate template.

Define your template on the Copy Template page.
a. Enter a name for the template.

b. Verify the DNA Reference Library.
c. Add DNA Target Regions .bed file.
d. Enter a note about the template (if desired).

e. Click Copy Template.
Your new template appears under the Template Name column.

After the run is complete, in the Data tab, click Completed Runs & Reports, then
click the Run Report for your results.

To view a summary of the variant analysis, scroll down to the variantCaller
section, then click the appropriate button to download variant calls in .vcf or .xls
formats.

variantCaller (v5.4 variantCaller.html Completed  ~

Library type: tagseq

Reference genome: hg19

Targeted regions: Oncomine_BCCNV_v4.1_cfDNA.06122017.Designed

Hotspot regions Oncomine_BCCNV_v4.1_cfDNA.06122017.Hotspots

Configuration: Oncomine Liquid Biopsy DNA - PGM (318) or S5/S5XL (5xx)

Output directory: variantCallerBeta_out.71329

Download all barcodes: VCFZIP | XLSZIP  XLS  COV

Please note: Variant calling was carried out for all barcodes with reference genome as specified above

Barcode Name Sample Median Read Cov Median Mol Cov LOD%  Variants C::.if.:; Downloads
0.0577 -

lonCodeTag_0111 CNV_2 215 2,601 00509 1 1 VCFGZ = VCFGZTBI  XLS
0.0623 -

lonCodeTag_0112 CNV_2 28,561 2,407 0073 2 1 VCFGZ = VCFGZTBI  XLS
0.0567 -

lonCodeTag_0113 CNV_2 25542 2,647 00705 4 2 VCFGZ = VCFGZTBI  XLS
0.053-

lonCodeTag_0114 CNV_2 29748 2,829 00651 3 2 VCFGZ = VCFGZTBI  XLS

N 0.0414-
lonCodeTag_0115 CNV_2 38,691 3621 00801 2 2 VCFGZ = VCFGZTBI  XLS
(1) 20 v 1-50f 5 items

Torrent Suite™ Software 5.6 Help



PO
N2
g
ANADL

Applications
Oncology - Liguid Biopsy

3. Review the results in the Median Read Cov, Median Mol Cov, and LOD %
columns.

Column Description

Median Read Coverage Reports median coverage across targets.
Median Molecular Coverage reports
median number of individual
interrogated DNA molecules across
targets.

Median Molecular Coverage Directly influences the limit of detection
in a sample run. We always require two
independent molecular families to
identify a variant for it to be called. Lower
median molecular coverage values result
in less sensitive detection of variants at
0.1% frequency, although still sufficient
for sensitive detection of variants with
higher frequency. For example, Median
Molecular Coverage of 700 is sufficient
for accurate detection of variants at 0.5%
frequency.

LOD % A segment (e.g., 0.02-0.03) where 0.02
represents the median value across all
targets, and 0.03 represents the limit of
detection (LOD) for the 80th percentile
targets. If both numbers are <0.1% then
the sequencing run is of acceptable
quality for 0.1% LOD.

For sensitive variant detection down to 0.1% frequency, we see optimal results
when targeting a Median Read Coverage >25,000, Median Molecular Coverage
>2,500, and both numbers of the LOD % segment are <0.1.

4. Click a Barcode Name of interest to review Variant Calls by Allele.

Variant Calls by Allele

Allele Name Gene ID Region Name Allele Source

By default only hotspot alleles calls are shown in the variant table. We do not
report hotspot alleles that did not meet our criteria for calling. However, we do
provide at least one record for each hotspot position. This can include: novel
allele call at hotspot position, hotspot allele call, or absent call when the first two
are missing.
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Column Description
Frequency Reports the observed frequency of hotspot allele.
LOD Reports limit of detection at hotspot position, which is

based on the number of interrogated DNA molecules
(fragments) containing target.

We use the term 0.1% LOD to mean we have data to
support specific sensitivity and specificity claims (90%
and 98%) at the 0.1% allelic frequency. By default, our
analysis tool uses minimum alternative allele
frequency threshold of 0.05% and we have a technical
lower limit of detection of 0.03% for this method.

Observed frequency can be lower than LOD due to sampling nature of the assay.

If selected to display hotspot positions with absent variant call, then only one
record per hotspot position is displayed and only one of the hotspot alleles at
that position is displayed under "Allele Name".

5. Click View Coverage Metrics to view the total number of interrogated DNA
molecules at hotspot positions (Molecular Coverage), and the number of
molecules containing the variant (Allele Mol Cov).

Variant Calls by Allele

Chrom ~ | Position to Allele Name Gene ID Region Name. Allele Source

Type * | Alele Call|_Heterozygous (15). Ho ~ | var Freq to % Total Cov >

6. You can modify the types of calls that are displayed in the Allele Calls dropdown
list, by selecting or deselecting Absent, Heterozygous, Homozygous, or No Call
No calls are variant calls that are classified as systematic errors.

Variant Calls by Allele

Chrom ¥ Position to Allele Name Gene ID

Region Name Allele Source ~ | Type - |allele can| Heterozygous (14), Hc~

Total Cov = Absent (0)
Heterozygous (14)  «
Homozygous (0) 4

No Call (0)
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165 Metagenomics application 5501
Select Absent in the Allele Call .
dropdown list to visualize hotspot Absent (0), Heterozyge -
positions without a valid variant call that
meets our analysis criteria. We report Absent (0) o
one record per hotspot position with s
missing alternative call, and the Heterozygous (15) W
alternative allele is an arbitrary value '
distinct from reference. LOD and Homozygous (0) v
molecular coverage metrics at those . '
positions are measurements for variant Mo Call '.LE'_J
absence among many interrogated
molecules.

To view novel alleles, select Novel (sequenced allele that is different from the
expected allele defined in the panel hotspot file) in the Allele Source dropdown
list.

Variant Calls by Allele

Chrom ™ | Position to Allele Name
Region Name Allele Source Ml
Total Cov = Novel (3)

Hotspot (101)

16S Metagenomics application

Plan a run using The Ion 16S™ Target Sequencing templates are used to create planned runs for the Ion
lon 16S™ Ta rget 165" Metagenomics Kit. You can select your Ion Reporter  account, kits, plugins, and
Sequencing parameter settings.
template Note: To modify default parameters, see “Configure and select a custom analysis
parameter set” on page 412.
1. In the Plantab, click Templates, then in the Favorites list, select 16S Target
Sequencing.
2. Select the Ion 16 S Metagenomics Template.
The wizard launches and displays the Plan page.
3. Add samples, confirm or change the default settings, and enter a plan name, then
click Plan Run.
4. Run the plan on your sequencing system.

Torrent Suite™ Software 5.6 Help
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Manage plugins for data analysis

T™

You can expand the analysis capabilities of Torrent Suite™ Software with plugins that
are pre-installed with the software. Additional plugins can be downloaded and
installed from the Thermo Fisher Cloud. The plugin results are added to the report
summary and can be used for a variety of purposes.

Install or upgrade plugins

On Thermo Fisher Cloud, you can install or upgrade the following:

8.

Upgrades for a plugin that is pre-installed in Torrent Suite Software. For details
about plugins that are included with Torrent Suite Software, see “Pre-installed
plugins” on page 121.

The RNASegAnalysis plugin and smallRNA plugin. These plugins that are

supported by Thermo Fisher Scientific, but not pre-installed in the Torrent Suite
Software.

. Sign in to the Thermo Fisher Cloud.

Click on the Apps icon (328).
In AppConnect, under Resource Libraries, click Plugins.

(Optional) Click a category at the top of page.
The list of plugins is narrowed to only plugins included in the selected category.

Click ¥, to download the plugin. Enable the checkbox next to indicate that you
agree to the terms and conditions, then click Download Plugin.

Either a compressed directory or a debian file that contains the plugin is
downloaded to your local machine.

Click Settings (£}) » Plugins » Install or Upgrade Plugin in Torrent Suite™
Software.

Click Select File, then browse to the location where you downloaded the plugin
file, select the file, then click Open.

In the Install or Upgrade Plugin dialog, click Upload and Install.

The plugin is now visible in Torrent Suite " Software.

114
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Enable an
installed plugin

IMPORTANT! To make a plugin available to users, you must enable the plugin. The
plugin must be installed before it can be enabled.

Follow these steps to enable an installed plugin:

1.

Sign in to Torrent Suite™ Software.

2. Click Settings (£¥) » Plugins.
The installed plugins are listed.

Plugins

Enabled

vl
o
vl
o
o
vl
o
vl
o

Disabled Either Clear

Name Selected by Default

variantCaller

RunTransfer

DataExport

RNASeqAnalysis

FieldSupport

FilterDuplicates

ERCC_Analysis

AssemblerSPAdes

FileExporter

Version

54031

5404

5400

5.4.0.1

5.4.0.1

5200

5400

5400

54.00

Install or Upgrade Plugin

Installed Date »

2017/03/13 D8:35 AM

2017/03/13 08:35 AM

2017/03/08 0820 AM Y

2017/03/08 08:29 AM

2017/03/08 D829 AM Y

2017/03/08 D829 AM

2017/03/08 D829 AM Y

2017/03/08 D829 AM

2017/03/08 0829 AM Y

lon Supported

Yes

Yes

Rescan Plugins for Changes

Manage

3. Click the Enabled checkbox next to any installed plugin, to make it available to

Uninstall a plugin

1.

N

Torrent Suite™ Software 5.6 Help

users.

Changes to the settings described in this procedure take effect immediately.

Sign in to your Torrent Browser.

Click Settings (%) » Plugins. The installed plugins are listed.

To uninstall a plugin from your Torrent Suite = Software:

In the row of the plugin you want to remove, click Settings (¥ ¥) » Uninstall.

Click Yes, Uninstall! to confirm you want to uninstall the plugin.
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Plugin configuration

Plugin configuration

Configure plugins
globally

116

Some plugins have settings that can be configured by users. For these plugins, there
are typically three different ways they can be configured:

The

Global configuration: For plugins that can be configured globally, administrator-
level users can change the settings for all users of the software on a particular
server (see “Configure plugins globally” on page 116). These default settings can
be overridden when setting up a Planned Run or Planned Run template, or when
running the plugin manually.

Note: Some plugins require configuration, and will fail unless a user first enters
certain settings. For example, some plugins require that a user enter a file
directory for output files.

Planned Run configuration: Some plugins can be configured when setting up a
Planned Run or Planned Run template. These options are available under
Plugins in the Planned Run Workflow bar. Settings that are selected here
override the global settings.

Manual configuration: Some plugins can be configured when they are selected to
run on the data from a sequencing run after the run is complete. These plugins
can be configured and run from the Run Summary screen. Settings that are
selected here override the global settings or any Planned Run settings.

following pre-installed plugins can be configured globally:
Data Export

ERCC Analysis

File Exporter

Ion Reporter Uploader

Run Transfer

Note: Some plugins that cannot be configured globally can be configured when you
set up a Planned Run or Planned Run template, or if you run the plugin after a
sequencing run.

To change the global configuration of a plugin that is listed above, perform the
following steps:

1.

2.

Sign in as an administrator, then click Settings (£¥) » Plugins.

In the Manage column for the plugin of interest, click Settings (&) » Configure.

7 RunTransfer 5405 2017/03/22 08:57 AM  Yes
@ PGxAnalysis 5401 2017/03/22 0857 Al @

The settings in the configuration dialog vary depending on the plugin. See the
plugin-specific configuration topic for more information.

To save your changes, click Submit or Save Configuration.
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Configure a plugin  You can use the following settings for any plugin that is installed in your Torrent
to run by default Suite”" Software, whether it is pre-installed or if it is downloaded from the Thermo

after every run

Fisher Cloud.

Note: If a plugin runs automatically, you can still rerun the plugin manually after a
sequencing run is completed. For details, see “Run a plugin manually from the
sequencing run report” on page 118 .

¢ To set the plugin to run automatically after every run:

a.

b.

C.

Click Settings (¥¥) » Plugins.

Ensure that the Enabled checkbox next to the plugin name that you want to
run by default is selected.

Install or Upgrade Plugin | Rescan Plugins for Changes

Plugins
Enabled  Disabled Either Clear

Name Selected by Default | Version Installed Date ¥ lon Supported Manage

v RunTransfer Updates Available! @ 5604 Aug 12017 Yes &~
v ampliSeqRNA Updates Available! 560.2 Aug 12017 Yes o~

2 FileExporter v 5600 Jul 212017 Yes &~

Select the Selected by Default checkbox next to the plugin name.

The plugin is now set to perform its function after every sequencing run.

Note: Deselect the Selected by Default checkbox to disable automatic execution
of the plugin.

¢ To set a plugin to run automatically as part of a Planned Run or run template (not
required if you previously set the plugin to run by default after every run):

a.

Torrent Suite™ Software 5.6 Help

Under the Plan tab, in the Templates screen, select an application in the left
navigation menu.

. Select an existing Planned Run template from the list. Alternatively, select

Add New Template, or Plan New Run to create a new Planned Run
template or Planned Run.

Click Plugins in the workflow bar.

. Select the plugins that you want to run automatically after a run.

Note: If Configure appears after selecting the plugin, be sure to click the
link and configure the plugin before starting the run. For detailed plugin
configuration information for available plugins, see “Pre-installed
plugins” on page 121.

. Click Next, or another tab in the workflow bar to make further changes to

your Planned Run.

When all changes to the Planned Run have been made, click Plan in the
workflow bar, then click Plan Run.
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The plugin is now set to run after every sequencing run that uses the Planned
Run or Planned Run template.

Run a plugin manually from the sequencing run report

1. In the Data tab, click Completed Runs & Reports, then click the Report Name
link for the completed sequencing run.

2. Click Plugins » Select Plugins to Run, then click the name of the plugin that you
want to run.

3. Configure the plugin if needed. If prompted, select the desired plugin options,
then click Submit to start the analysis. Alternatively, click Close to close dialog
without running a plugin. For detailed plugin configuration information for
available plugins, see “Pre-installed plugins” on page 121.

Note: If the plugin does not require configuration, analysis starts immediately
without a confirmation screen. To cancel a plugin run that is in progress, click
Stop.

View plugin run status

After a plugin run is started, it is listed in the Plugin section of the run report. You can
view the status of a plugin run to determine whether the run has completed. You can
also stop a plugin run in progress, view a log for the plugin run, or delete the
completed plugin report.

1. In the Data tab, click Completed Runs & Reports, then click the Report Name
link for your completed sequencing run.

2. In the left navigation menu, click the plugin name, or scroll to the Plugins section
of the run report.

The plugin run status (Queued, Started, or Completed) is listed under the name
of each plugin.

Stop a plugin run You can stop a plugin run that is in progress.

1. In the left navigation menu, click the name of the plugin you want to stop, or
scroll to the appropriate plugin section in the run report.

2. In the Data tab, click Completed Runs & Reports, then click the Report Name
link for your completed sequencing run.

3. In the left navigation menu, click Plugins, or the name of the plugin results to be
deleted.

4. Click Stop to cancel a plugin run that has started.
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Open a plugin log

Delete a plugin
result

Manage plugins for data analysis ~E=88
View plugin run status |

If a Plugin report indicates that an error occurred during a plugin run, you can view a
log that contains details about the plugin run.

1. In the Data tab, click Completed Runs & Reports, then click the Report Name
link for your completed sequencing run.

2. In the left navigation menu, click Plugins, or the name of the plugin that has the
log you want to view.

3. Click View Log to the right of the plugin name.
The log for the plugin run opens.
You can delete plugin results from the Plugins section of the run report.

1. In the Data tab, click Completed Runs & Reports, then click the Report Name
link for your completed sequencing run.

2. In the left navigation menu, click Plugins, or the name of the plugin results that
you want to delete.

3. In the Data tab, click Completed Runs & Reports, then click the Report Name
link for your completed sequencing run.

4. In the left navigation menu, click the plugin name, or scroll to the Plugins section
of the run report.

5. Click Delete to the right of the plugin name.
The plugin results are deleted from the run report.
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Rescan a plugin When you rescan a plugin, the files for the plugin are updated with any changes. For

example, if you uninstalled and reinstalled the plugin, you can rescan the plugin to
ensure that all files from the previous installation were removed.

™

1. Sign in to Torrent Suite™ Software.

2. Click Settings () » Plugins. The installed plugins are listed.

Enabled  Disabled = Either Clear
Installed
Enabled Name Selected by Default  Version o lon Supported Manage
v
v variantCaller 5604 Aug 10 2017 Yes [- 4
"] RunTransfer | 5.6.0.6 Aug 10 2017 Yes o~
! ampliSeqRNA 5603 Aug 10 2017 ] [- g
el lonReporterUploader Updates Available! 56030 Aug 102017 Yes o~
= Usage
w smallRNA 5600 Aug 12017 -
v samplelD 56.0.1 Jul212017  yg  Configure |
Upgrade to Latest
! coverageAnalysis 5.6.0 Jul 21 2017 Ye nstall 5.2.0.66 |
nstall 5.2.1.0
DataExport 56.0.1 Jul 24 2017 e
i S . § Install 5212 |
nstall 5.4.0.41 -
] PGxAnalvsis RANND Jul 21 2017 Y& 1

3. Click Settings (£¥)Rescan.

You cannot complete other operations in Torrent Suite™ Software until the rescan
is complete.

Note: You can also rescan the output files from the list of reports when you view
the usage for a plugin. For details see, “View IonReporterUploader plugin status
details” on page 187.
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The following table describes the plugins that are pre-installed with Torrent Suite

Software.

Manage plugins for data analysis E&82
Pre-installed plugins

™

Plugin name

Description

ampliSegRNA

Generates statistics, downloadable data files, and
interactive visualizations that represent targeted
RNA transcripts for sequencing runs that use the lon
AmpliSeq ™ Transcriptome Human Gene Expression
Kit or lon AmpliSeq™ RNA panels.

For details, see "ampliSeqRNA plugin” on page 122.

AssemblerSPAdes

Performs an initial level analysis on assembly and
provides metrics. The plugin is ideal for genomes
less than 50 megabases in size.

For details, see "“Assembler SPAdes plugin” on
page 126.

coverageAnalysis

Generates statistics and graphs to describe the level
of sequence coverage that is produced for targeted
genomic regions.

For details, see “coverageAnalysis plugin” on
page 130.

DataExport

Exports data from a sequencing run to an external
hard drive or a removable media, such as a USB
drive.

For details, see “DataExport plugin” on page 140.

ERCC_Analysis

Indicates whether a problem exists with library
preparation or sequencing for runs that use the
ERCC RNA Spike-In Mix.

For details, see "ERCC_Analysis plugin” on
page 141.

FieldSupport

Provides assistance with technical support. Enable
and run this plugin only under the guidance of
Thermo Fisher Scientific Technical Support. If you
have questions about this plugin, contact technical
support or your Field Application Scientist.

FileExporter

Customizes the output file names of an analysis run.
This plugin allows you to rename output files. Also
generates a FASTQ format file of the analysis output,
renames Variant Caller plugin output files (when
available), and compresses output files.

For details, see “FileExporter plugin® on page 144.

Torrent Suite™ Software 5.6 Help
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Pre-installed plugins

Plugin name Description

FilterDuplicates Removes duplicate reads and creates BAM files that
do not contain the duplicate reads.

For details, see “FilterDuplicates plugin” on
page 147.

immuneResponseRNA Use the immuneResponseRNA plugin to quantify
gene expression levels for the Oncomine™ Immune
Response Research Assay.

For details, see “immuneResponseRNA plugin” on
page 148.

lonReporterUploader Transfers run results files to lon Reporter™
Software.

For details, see “Integration with lon Reporter™
Software” on page 171.

PGxAnalysis Used with the lon AmpliSeq" Pharmacogenomics
Research Panel, which is a targeted gene panel that
allows the interrogation of pharmacogenomics
variants in samples for genotyping and CYP2Dé copy
number detection.

For details, see “PGxAnalysis plugin” on page 151.

RunTransfer Transfers the signal processing output of a
completed sequencing run from one Torrent Server
to another Torrent Server, then runs an analysis of
the transferred files on the receiving Torrent Server.

For details, see “RunTransfer plugin” on page 152.

samplelD Uses sample fingerprinting to identify any cross-
contamination between samples or between
barcodes in a run.

For details, see “samplelD plugin” on page 154.

variantCaller For details, see “variantCaller plugin” on page 155.

The ampliSeqRNA plugin is used with the Ion AmpliSeq™ Transcriptome Human
Gene Expression Kit or Ion AmpliSeq™ RNA panels. The plugin generates statistics,
downloadable data files, and interactive visualizations that represent targeted RNA

transcripts.

Use the ampliSeqRNA plugin on runs that are aligned to the
hg19_AmpliSeq_Transcriptome_ERCC_v1 reference (see “References Management
Guide” on page 224) and appropriate targets panel, such as
hg19_AmpliSeq_Transcriptome_21K_v1 (see “Manage Target Regions Files and
Hotspot Files” on page 235).
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ampliSeqRNA plugin configuration

The configuration options for the ampliSeqRNA plugin are described in the following
table.

Note: This plugin cannot be configured globally. The configuration options are noted
in the table.

Setting Description

The following settings can be configured when you run this plugin manually, or select
it as part of a Planned Run or Planned Run template.

Filter Barcodes Select this checkbox to remove whole barcodes from
subsequent analyses if they have a relatively low number
of reads, such as those that might result from barcode
contamination. A warning appears in the barcode summary
report if any barcodes were discounted from the analysis.
This setting is ignored for runs not employing barcodes.

Typically, the Filter Barcodes option is not needed if your
Planned Run specifies which samples to associate with
specific barcodes.

ERCC Tracking Select this checkbox if your lon AmpliSeq™ RNA targets
(amplicons) were spiked with ERCC tracking targets.

Reference Genome The short name of the reference genome (or DNA
sequences) used to generate the current run report. It will
be used for coverage analysis. See “References
Management Guide™ on page 224.

Library Type Select AmpliSeqRNA, which is the library type that was
sequenced.
Targeted Regions Select the appropriate target regions file for your desired

analysis. See “Manage Target Regions Files and Hotspot
Files” on page 235. This setting can only be configured
when you run this plugin manually.

Review ampliSeqRNA plugin results

The ampliSeqRNA plugin generates an initial summary report that lists the samples,
the number of mapped reads, the percent of valid reads, and the percent of targets
detected. A series of log2 reads-per-million (RPM) pair correlation plots are included
for rapid correlation analysis. Microsoft Excel -compatible reports are also
generated, including differential expression tables. Additional details about read
coverage are also provided on a per-barcode basis, along with a list of gene
annotations for each sequenced region.
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After the sequencing run completes, review the plugin results in the report summary.

1.

2.

In the Data tab, click Completed Runs & Reports.

In the list of runs, locate the run of interest, then click the link in the Report

Name column.

In the left navigation menu, click ampliSeqRNA to view the plugin results.

Target regions: hg1%_AmpliSeq_Transcrptome_21K_v1

Read filters: Alignment length (17+)

Barcode Name

lonXpress_049
lonXpress_051
lonXpress_053
lonXpress_055
lonXpress_057
lonXpress_053
lonXpress_061

lonXpress_063

lonXpress_ 085

Sample

T items per page

Mapped Reads

7240144

* C(lick the ampliSeqRNA.html link to open the ampliSeqRNA Report —

Barcode Summary for all barcodes.

¢ In the barcode table, click individual barcode names to see the results for an

individual barcode.

® C(Click the Distribution Plots, Correlation Heatmap, Correlation Plot, and
Gene Heatmap tabs to review the data graphically.

Graphical report

Description

Distribution Plots

Reads Alignment Summary

A graphical summary of the number of
mapped and unmapped reads across
barcodes, as reported in the Barcode
Summary table.

Distribution of Gene Reads

Distribution of genes across barcodes
showing the frequency of numbers of
genes having similar log10 read counts.
All curves are plotted on the same axis
scale. The counts data are fitted to a
Gaussian kernel using the default R
‘density’ function.
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Graphical report

Description

Correlation Heatmap

A heatmap of Spearman correlation r-
values for comparing log2 RPM reads
pair correlation barcodes, with
dendrogram reflecting ordering of
barcodes as being most similar by
these values.

Correlation Plot

Barcode read pair correlation plot

Lower panels show log2(RPM+1] values
plotted for each pair of barcodes, with
linear least squares regression line
overlaid and line slope reported. Upper
panels show Pearson correlation r-
values for the regression line. Diagonal
panels show the frequency density plot
for the individual log(RPM+1] values for
each barcode. (If only one barcode has
reads, a density plot is displayed.) Click
the plot to open an expanded view.

Gene Heatmap

Gene Representation Heatmap

Displays 250 genes showing the most
variation in representation across
barcodes as measured by the
coefficient of variation (CV) of
normalized read counts for genes that
have at least one barcode with at least
100 RPM reads, plotted using log10 of
those counts. For this plot, barcodes
are omitted if they have <10° total
reads.

* Click the links at the bottom of the report to download associated report files.
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ampliSeqRNA plugin reports

The following ampliSeqRNA plugin reports are available for download from the
results screen as tab-delimited text files, compatible with Microsoft Excel " or similar
applications.

Report Description

Barcode Summary Report A table listing each barcode’s sample
name, total reads, aligned reads, and
percent aligned.

Absolute Reads Matrix A table listing absolute reads for the genes
found on each barcode.

Absolute Normalized Reads Matrix A table listing absolute normalized reads
for the genes found on each barcode.

CHP files normalized by RPM A file format designed for use with
Affymetrix " software to produce additional
reports.

Differential Expression for Barcode Pair A pop-up window that allows you to
compare two barcodes. You can set a
threshold for minimum read count and
exclude targets from the differential
expression table. Differential expression for
each target will be represented as the log?2
of the ratio of RPM reads of the experiment
barcode to the control barcode.

The Assembler SPAdes plugin is a De-Bruijin graph assembler. The plugin breaks
sequence reads into kmers of defined length, makes a connected graph, and traverses
through that graph to produce contigs. The plugin report includes basic analysis
metrics such as number of contigs, N50, length of the longest contig, and a
downloadable FASTA file of the assembled sequences. The plugin assumes a haploid
genome, and is ideal for genomes under 50 megabases in size. For multiploid
genomes, reads from different copies of a chromosome tend to assemble into different
contigs.

Note: For de novo assembly, use a Generic Sequencing application Planned Run
template for the Torrent Suite™ Software analysis.
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Assembler SPAdes plugin configuration

The configuration options for the Assembler SPAdes plugin are described in the

following table.

The following settings can only be configured when you select this plugin to run
manually from the Run Summary screen. After you select the plugin, click Advanced
Settings + to display these options.

Setting

Description

Fraction of reads to use

The default setting of 100% is recommended, and handles
most changes in coverage. If you enter a value of less than
100%, the reads are randomly sub-sampled.

Only process barcodes

By default, the plugin processes all barcodes in the
analysis and produces a separate set of contigs for each
barcode. To limit plugin analysis to only specific barcodes,
list those barcodes here (separated by commas and no
spaces. For example,
lonXpress_001,lonXpress_002,lonXpress_003).

Skip barcodes with fewer
than __ reads

The software ignores barcodes whose number of reads do
not meet the threshold specified here. The default
threshold is 500 reads. This setting is intended to filter out
barcode classification problems with noisy data.

RAM to allocate

The plugin attempts to allocate the specified amount of
RAM when it runs. The default is 32 GB. With larger
amounts of memory, the plugin runs faster. With less
memory, the plugin takes longer to complete.

Note: The plugin crashes if the memory allocation fails.

SPAdes version

Select the version that you prefer. Select the default of
3.1.0 if you are not sure.

Torrent Suite™ Software 5.6 Help
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Setting

Description

Assembly settings

Set this menu as follows:

» Uniform coverage (default setting)—This is used for
data with average GC (35-68%) content. This setting
uses the default kmers.

¢ Non-uniform coverage—Choose this setting for data
with low GC (<35%]) content. This setting uses the
default kmers.

¢ Highly non-uniform coverage—Choose this setting
for data with high GC (>68%) content. This setting
uses a different set of kmers.

e Custom...—Choose this setting to enter user-defined
K and Mode settings.

- K—Enter values (separated by commas, no
spaces) to determine the size and number of
kmers to be used in the analysis. Enter short
kmer values to improve error-prone or low-
coverage regions, long kmers to resolve
repetitive regions, or a combination of kmer
values to account for both situations.

Note: Each additional kmer adds a fixed amount
to the processing time (for example, using
2 kmers takes twice as long as 1 kmer].

- Mode—Select Multi-cell (default) for data with
average or low GC content. Select Single-cell for
data with high GC (>68%) content.

Run read correction before
doing assembly

This setting is enabled by default, which is recommended.

Skip assembly if previous
results exist

Select this checkbox to detect whether assembly results
already exist and you do not want to overwrite the results.
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Review AssemblerSPAdes plugin results

After the sequencing run completes, review the plugin results in the report summary.

1.

2.

Torrent Suite™ Software 5.6 Help

In the Data tab, click Completed Runs & Reports.

In the list of runs, locate the run of interest, then click the link in the Report
Name column.

In the left navigation menu, click AssemblerSPAdes to view the plugin results.

View Results : | lonXpress_002. TAAGGAGAAC v

Downloads

Download all your assembly result files.

Assembled Contigs (FASTA) | Assembled Scaffolds (FASTA) | SPAdes Log (TXT) | QUAST report (HTML

Assemblv Statistics

Assembly summary statistics for TonXpress 001.CTAAGGTAAC.

Parameter Value

SPAdes Version 3.1.0
Options -k 21,33,55,77.99

Metric Large Contigs (> 500bp) All Contigs
Largest Contig 120,785
Total Length 4,364,216 4,634,555
Number of Contigs 185 1.461
N50 40,185 38.038
N75 22,507 19,060
N90 12,935 7,412
N95 8.449 243

Metric Large Scaffolds (> 500bp) All Scaffolds
Largest Scaffold 120,785
Total Length 4,364,686 4,635,025
Number of Scaffolds 180 1,456
N50 40,185 38,949
N75 22,963 19,700
N90 13,825 7.923
N95 8.611 243

The plugin results show assembly statistics for the selected barcode.

To show assembly statistics for an individual barcode, select a barcode in the
View Results menu.

To download results for all barcodes used in the run, click Downloads.

To download a FASTA file of the assembled contigs, click Assembled Contigs
(FASTA).

To download a FASTA file of the Assembled Scaffolds, click Assembled
Scaffolds (FASTA).

To download a copy of the Summary Statistics, click Assembly Statistics.

Note: You can also click SPAdes Log (TXT) to view the execution file for the
AssemblerSPAdes plugin, or click QUAST report (HTML) to view a QUAST
report.
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coverageAnalysis Use the coverageAnalysis plugin to view statistics and graphs that describe the level

plugin of sequence coverage produced for targeted genomic regions. The results in the
Summary screen for a run analyzed with the plugin vary based on the library type
that you select when you configure the plugin. You can export some charts as
graphics, such as the Amplicon and Reference Coverage charts.

coverageAnalysis plugin configuration

The coverageAnalysis plugin uses the following settings:

Setting

Description

The following settings are available for all library types.

Reference Genome

The reference genome selected in the Planned Run.

Library Type

The default value is the library type selected in the Planned Run,
and it can only be changed if the plugin is run manually. If the
library type is changed, a different report will be generated.

Targeted Regions

The targeted regions are selected in the Planned Run, and can
only be changed after the run is complete if the plugin is run
manually. Target regions can be overwritten by the specific
barcode targets.

Select the targeted regions file from the dropdown list. For whole
genome and lon Total RNA-Seq sequencing runs, you typically
select None.

Barcode-specific
Targets

Determines type of report generated for individual barcodes.
Barcode-specific targets are selected in the Planned Run, and can
only be changed after the run is complete if the plugin is run
manually. No reports are generated for individual barcodes that
have target regions that are specified as None for targeted
applications.

Select the checkbox to assign specific target region files to
individual barcodes.
1. Select a specific barcode from the Barcode dropdown list.
2. Select the specific targeted regions file from the dropdown
list to associate with the selected barcode.
3. Click Add.

4. Repeat steps 1-3 to associate additional barcodes with
specific target region files.

Note: Alternatively, you can copy and paste the barcode/target file
pairs manually.

Minimum Aligned
Length

Specify the minimum aligned length that is required to ensure that
the read is included in an analysis.

Minimum Mapping
Quality

Specify a minimum value that reads must exceed to be included in
the analysis.
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Setting Description

The following settings are available only with specific library types.

Sample Tracking The lon AmpliSeq™ Sample ID Panel is a companion panel of

9 primer pairs that can be added to any lon AmpliSeq" human
gDNA panel during target amplification to generate a unique
identification tag for research samples. Select this checkbox if you
added the lon AmpliSeq™ Sample ID Panel to your library.

Target Padding Enter a number to pad the target by the number of bases entered.
If you do not enter a number, the default of 0 is used.

Use Only Uniquely Select the checkbox to enable the plugin to examine unique starts

Mapped Reads only.
Use Only Non- Select the checkbox to avoid duplicates. The analysis must have
duplicate Reads included alignments with Mark Duplicates enabled.

Review coverageAnalysis plugin results

The coverageAnalysis plugin generates a Coverage Analysis Report. This report
includes read statistics and several charts. The statistics and charts presented depend
on the library type for the analysis.

The report lists the samples, the number of mapped reads, the percent of valid reads,
and the percent of targets detected. A series of log2 RPM pair-correlation plots are
included for rapid correlation analysis. Microsoft ~ Excel -compatible reports are also
generated, including differential expression tables. Additional details around read
coverage are also provided on a per-barcode basis, along with a list of gene
annotations for each sequenced region.

You can download statistics files and the aligned reads BAM file from the file links at
the bottom of the Coverage Analysis Report.

After the sequencing run completes, review the plugin results in the report summary.

1. In the Data tab, click Completed Runs & Reports.

2. In the list of runs, locate the run of interest, then click the link in the Report
Name column.

3. In the left navigation menu, click coverageAnalysis to view the plugin summary.

A summary table of the coverage analysis, by barcode, is included in the
Summary screen.

4. Click alink in the Barcode Name column of the summary table to open a
detailed Coverage Analysis Report window for that barcoded sample.
Alternatively, click the coverageAnalysis.html link to open the summary table
for all barcodes in a new window.

9. Click the links at the bottom of the Coverage Analysis Report to download
associated statistics and summary files for each barcoded sample in the run.
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Example statistics
The following is an example of the plugin statistics for an ITon AmpliSeq  run.

Note: Almost every statistic, plot, link, and functional widget in the report provides
tooltips with definitions. Hover over a heading or description in the report to view the
tooltip.

Coverage Analysis Report
Sample Name: T3

Library type: AmpliSeq Exome
Reference: hgl9 (DNA)
Target regions: AmpliSeqExome 20131001 designed

3 - Number of mapped reads 40,285,453
i~ Percent reads on target 94 .86%
E - Average base coverage depth 110.0
: EEEEL H ) IR H] : I ¢ i 1 Uniformity of base coverage 92.05%
Rowessc Lo
Amplicon Read Coverage Target Base Coverage
Number of amplicons 293,903 Bases in target regions 57,742,646
Percent assigned amplicon reads 94 86% Percent base reads on target 94.86%
Average reads per amplicon 130.0 Average base coverage depth 110.0
Uniformity of amplicon coverage 93.33% Uniformity of base coverage 92.05%
Amplicons with at least 1 read 99.50% Target base coverage at 1x 99.20%
Amplicons with at least 20 reads 9521% Target base coverage at 20x 92.92%
Amplicons with at least 100 reads  56.84% Target base coverage at 100x 46.00%
Amplicons with at least 500 reads 0.30% Target base coverage at 500x 0.19%
Amplicons with no strand bias 90.41% Target bases with no strand bias 76.69%
Amplicons reading end-to-end 19.19% Percent end-to-end reads 51.22%

The Reference Coverage chart is an overlay of where target regions are defined and
overlap on the reference.

Reads statistics

The library type determines which statistics are presented. This table shows the
statistics for an Ton AmpliSeq DNA report. Some of these statistics are not available
for other library types or can be replaced by alternative statistics. Definitions are in

tooltips.
Statistic Description
Number of mapped reads Total number of reads mapped to the reference.

Number of reads on target | Total number of reads mapped to any targeted region of
the reference. A read is considered to be on target if at
least one aligned base overlaps a target region. A read that
overlaps a targeted region but where only flanking
sequence is aligned, for example, due to poor matching of
5" bases of the read, is not counted.

Target Base Coverage Summary statistics for targeted base reads of the
reference. A base covered by multiple target regions is only
counted once per sequencing read.

Bases in target regions The total number of bases in all specified target regions of
the reference.
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Statistic

Description

Percent of reads on target

The percentage of reads mapped to any targeted region
relative to all reads mapped to the reference.

Total aligned base reads

The total number of bases covered by reads aligned to the
reference.

Total base reads on target

The total number of target bases covered by any number of
aligned reads.

Percent base reads on
target

The percent of all bases covered by reads aligned to the
reference that covered bases in target regions.

Bases in targeted reference

The total number of bases in all target regions of the
reference.

Bases covered [at least 1x)

The total number of target bases that had at least one read
aligned over the proximal sequence. Only the aligned parts
of each read are considered. For example, unaligned (soft-
cut) bases at the 5’ ends of mapped reads are not
considered. Covered target reference bases can include
sample DNA read base mismatches, but does not include
read base deletions in the read, nor insertions between
reference bases.

Average base coverage
depth

The average number of reads of all targeted reference
bases.

Uniformity of base coverage

The percentage of bases in all targeted regions (or whole
genome) covered by at least 0.2x the average base
coverage depth.

Average base read depth

The average number of reads of all targeted reference
bases that were read at least once.

Genome Base Coverage

Summary statistics for base reads of the reference
genome.

Genome base coverage at N
X

The percentage of reference genome bases covered by at
least Nreads.

Target coverage at N'x

The percentage of target bases covered by at least M reads.

Targets with no strand bias

The percentage of all targets that did not show a bias
towards forward or reverse strand read alignments. An
individual target is considered to have read bias if it has at
least 10 reads and the fraction of forward or reverse reads
to total reads is greater than 70%.

Amplicon Read Coverage

Summary statistics for reads assigned to specific
amplicons. Each sequence read will be assigned to exactly
one of the amplicons specified by the targets file. Reads
are assigned to particular amplicon targets based if their
(5') mapping location being sufficiently close to the end of
the amplicon region, taking the read direction (mapping
strand) in to account.
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Statistic

Description

Number of amplicons

The number of amplicons specified in the target regions
file.

Percent assigned amplicon
reads

The total number of reads that were assigned to individual
amplicons. A read is assigned to a particular (inner]
amplicon region if any aligned bases overlap that region. If
a read might be associated with multiple amplicons this
way it is assigned to the amplicon region that has the
greatest overlap of aligned sequence.

Average reads per amplicon

The average number of reads assigned to amplicons.

Uniformity of amplicon
coverage

The percentage of bases in all targeted regions (or whole
genome)] covered by at least 0.2x the average base read
depth.

Amplicons with at least N
reads

The percentage of all amplicons that had at least Mreads.

Amplicons with no strand
bias

The percentage of all amplicons that did not show a bias
towards forward or reverse strand read alignments. An
individual amplicon is considered to have read bias if it has
at least 10reads and the fraction of forward or reverse
reads to total reads is greater than 70%.

Amplicons reading end-to-
end

The percentage of all amplicons that were considered to
have a sufficient proportion of assigned reads (70%) that
covered the whole amplicon target from ‘end-to-end’. To
allow for error, the effective ends of the amplicon region
for read alignment are within 2 bases of the actual ends of
the region.

Amplicon based composition
bias

A number that represents the proportion of amplicons
showing low representation (<.2x mean reads] in the lower
and/or upper quartiles of amplicons ordered by increasing
G/C base pair content of their insert sequences. The value
is relative to that in the center 50th percentile of amplicons
and weighted by the standard deviation of representation
over all amplicons.
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Example charts

Many of the charts that are generated by the coverageAnalysis plugin include a Plot
menu that allows you to change characteristics of the chart. For example, you can
show both strands.

The S button (in the top right corner of a chart) opens the chart Viewing Options
panel. The # button opens a description of the chart.

= Dapth of Covarags Chart Plot  acrmrs Sead Daplh Toomud |
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3
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Base Read Depth

In the Depth of Coverage chart above, the left Y-axis (% reads) is the number of reads
at a particular read depth (or bin of read depths) as a percentage of the total number
of base reads. The right Y-axis (% cumulative reads) is the cumulative count of the
number of reads at a given read depth count is at least read depth, as a percentage of
the total number of reads. If your analysis includes a regions of interest file, this chart
reflects only target regions (reads that fall within a region of interest).

In most charts you click on a data point to open a detail panel for that data:

Reads at depths 310-314. *
Mumber of target base reads: 216 632
Fraction of all target base reads: 4.62%

In this chart, the blue curve measures the cumulative reads at that read depth or

greater. Click a point on the blue curve to open the blue detail panel for that read
depth:

Cumulative Feads at depth 322 *
Mumber of target base reads: 1,112,751
Fraction of all target base reads: 23 89%

200 250 300 350
Base Read Depth
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The following Reference Coverage Chart is shown with the Strand Base Reads
option:

« Reference Coverage Chart Plot: Totsl Base Reads v | Owerlay: None

¥ | ZoomOut ) ? 0
“Wiew Options: Show Legend: (| Show Targets: v/ Bars/Points: 200 ‘Ex;l:rt’:l
Reference Region: ChromiContig: ch7 ¥ (25) Range: o2238,075-02.453.195 iew in GV ]
¢ ] >
4000 i & I I I I [EE|

P1_CDK6_4, P1_CDK6_5

nl |

chr7: 92,239,076 - 92,453,196 (214,121 bases)

Base Read Depth
g 8

g

You can also zoom in on a region of interest.

+~ Reference Coverage Chart Plot:  Strand Base Reads ¥ Owverlay: | Mone
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“View Options: Show Legend: || Show Targets: & Bars/Points: 200 Export |
Reference Region: ChromiContig: o7 ¥ (25) Range: 02272 803.02,273,422
© o >
PL_CDEG 3
10000
£
& 5000
(]
ks
@
¥ 0
)
w
]
D 5000
10000
chr7: 92,272,893 - 92,273,422 (530 bases)
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You can download plugin results file from links contained in the File Links section.

Note: Sometimes the file name may be too long to open in applications such as
Microsoft " Office Excel . To resolve this issue, you can right-click on the file and click

Save As to rename the downloaded files.

Click a question mark next to the file # to open a description of the file:

Base depth of coverage file

It has a named fields:

reads.

Thizs is a tab-separated-values text file with a xls filename extensian.

read_depth: The depth atwhich a {argeted) reference base has heen read.

hase_cov: The number oftimes any base was read (covered) at this depth. ?
hase_cum_cow: The cumulative number of reads (coverage) at this read depth or greater. %
narm_read_depth: The normalized read depth (depth divided by average hase read depth).
po_hase_cum_cov: As base_cum_cov but represented as a percentage of the total base

| Uownload the aligned reads oAl Tle.

The list of files depends on the application type selected. The following list is for an

AmpliSeq DNA run.

File

Description

Coverage statistics summary

A summary of the statistics presented in
the tables at the top of the plugin report.
The first line is the title. Each subsequent
line is either blank or a particular statistic
title followed by a colon (:) and its value.

Base depth of coverage

Coverage summary data used to create the
Depth of Coverage Chart. This file contains
these fields:

e read_depth The depth at which a
(targeted) reference base has been
read.

e base_cov The number of times any
base was read (covered) at this depth.

e base_cum_cov The cumulative
number of reads (coverage] at this
read depth or greater.

e norm_read_depth The normalized
read depth (depth divided by average
base read depth).

e pc_base_cum_cov As base_cum_cov
but represented as a percentage of the
total base reads.
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File

Description

Amplicon coverage summary

Coverage summary data used to create the
Amplicon Coverage Chart. This file contains
these fields:

contig_id The name of the
chromosome or contig of the reference
for this amplicon.

contig_srt The start location of the
amplicon target region.

Note: This coordinate is 1-based,
unlike the corresponding 0-based
coordinate in the original targets BED
file.

contig_end The last base coordinate of
this amplicon target region.

Note: The length of the amplicon
target is given as tlen = (contig_end -
contig_srt + 1).

region_id The ID for this amplicon as
given as the 4th column of the targets
BED file.

gene_id The gene symbol as given as
the last field of the targets BED file.

gc_count The number of Gand C
bases in the target region. Hence, %GC
=100% * gc / tlen.

overlaps The number of times this
target was overlapped by any read by
at least one base.

Note: Individual reads might overlap
multiple amplicons where the
amplicon regions themselves overlap.

fwd_e2e The number of assigned
forward strand reads that read from
one end of the amplicon region to the
other end.

rev_e2e The number of assigned
reverse strand reads that read from
one end of the amplicon region to the
other end.

total_reads The total number of reads
assigned to this amplicon. This value
equals (fwd_reads + rev_reads) and is
the field that rows of this file are
ordered by (then by contig id, srt and
end).

fwd_reads The number of forward
strand reads assigned to this
amplicon.
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Description

e rev_reads The number of reverse
strand reads assigned to this
amplicon.

e ¢cov20x The number of bases of the
amplicon target that had at least 20
reads.

e ¢cov100x The number of bases of the
amplicon target that had at least 100
reads.

e ¢covb00x The number of bases of the
amplicon target that had at least 500
reads.

Chromosome base coverage summary

Base reads per chromosome summary data
used to create the default view of the
Reference Coverage Chart. This file
contains these fields:

e chrom The name of the chromosome
or contig of the reference.

e start Coordinate of the first base in
this chromosome. This is always 1.

¢ end Coordinate of the last base of this
chromosome. Also its length in bases.

¢ fwd_reads Total number of forward
strand base reads for the
chromosome.

e rev_reads Total number reverse
strand base reads for the
chromosome.

» fwd_ontrg (if present) Total number of
forward strand base reads that were in
at least one target region.

* seq_reads Total sequencing (whole)
reads that are mapped to individual
contigs.

Aligned reads BAM file

Contains all aligned reads used to generate
this report page, in BAM format. This is the

same file that can be downloaded from the

main report (for the specific barcode). Refer
to the current SAM tools documentation for
more file format information.

Aligned reads BAl file

Binary BAM index file as required by some
analysis tools and alignment viewers such
as IGV. This is the same file that can be
downloaded from the main report (for the
specific barcode).
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DataExport plugin Use the DataExport plugin to export data from a sequencing run to a network drive,
an external hard drive, or a removable media device, such as a USB drive. The
exported data can be used to create backups, or to quickly transfer files to another
system. When you configure the plugin, you select which files categories from the run
are included in the export.

Note: Before you use the DataExport plugin, a software administrator must configure
the path to the directory that is used for the export. The Destination Path to the
external drive is then available in the global settings for the plugin.

DataExport plugin configuration

The DataExport plugin can be configured to set the destination path of the exported
files, as well as specify the file types to be exported.

The configuration options for the DataExport plugin are described in the following

table:

Setting

Description

Destination Path

Designates the location of the network drive, external hard
drive or removable media device to which the files will be
exported

Signal Processing Input

Exports DAT files

Basecalling Input

Exports WELLS files

Output Files

Exports all output files, including BAM files, reports, and
analysis files

Intermediate Files

Exports files used for troubleshooting by qualified system
engineers

Review DataExport plugin results

After the sequencing run completes, review the plugin results in the report summary.

1. Inthe Data tab, click Completed Runs & Reports.

2. In the list of runs, locate the run of interest, then click the link in the Report

Name column.

3. Inthe Summary, click DataExport to view the plugin summary.

4. After export is complete, the report appears in the DataExport pane. The
following parameters are shown.

Parameter

Description

FILE CATEGORIES

Lists the categories for the file types that are included in the
export.

DESTINATION

Is the location to which the files are exported after the plugin is
run.

STATUS

Shows the status of the file transfer.

140
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Use the ERCC_Analysis plugin to determine if a problem exists with either the library
preparation or the sequencing instrument run. The ERCC_Analysis plugin determines

the relative abundance of the actual versus expected number of ERCC transcript reads
for sequencing runs that include ERCC RNA Spike-in Controls.

The ERCC_Analysis plugin takes approximately 2-3 minutes to complete for
sequencing runs with <1,000,000 total reads, and 1-2 minutes longer for each
additional million total reads. For example, a run with 5 million total reads can take
10-15 minutes. If the Torrent Suite™ Software is busy performing additional
processing functions, plugin run times are longer.

Note: You can configure the ERCC_Analysis plugin to run automatically. However,
automatic execution is not recommended, unless most of the analyses on the Torrent
Server include ERCC controls.

ERCC_Analysis plugin configuration

The configuration options for the ERCC_Analysis plugin are described in the

following table.

Setting

Description

Use only forward strand
reads

Available when manually running the plugin.

Passing R-squared value

To optionally change the R-squared value to set a default
value for the summary report screen, enter a value
between 0 and 1 as your minimum acceptable R-squared
value (a lower value is indicated by a red light in the
summary report).

The value you enter on the ERCC Plugin Configuration
screen is used when the plugin is auto-run and when a
user manually launches the plugin without entering a

value. Users can override this value on a per-run basis
when they manually launch the plugin.

Minimum transcript counts

The minimum number of reads that a given ERCC
transcript must have to be included in the analysis.

ERCC pool used

Select the ERCC transcript pool used when preparing the
library.

Barcodes of interest

IMPORTANT! If you configure a Planned Run or Planned
Run template to execute the ERCC_Analysis plugin, and
your experiment uses the lon Total RNA-Seq Kit v2, you
must select a barcode option:

+ Select lonXpressRNA if your experiment uses this kit.
+ Select RNA_Barcode_None if your experiment does
not use a barcode kit

Torrent Suite™ Software 5.6 Help
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Review ERCC_Analysis plugin results

After the sequencing run completes, review the plugin results in the report summary.

1. In the Data tab, click Completed Runs & Reports.
2. Inthe Completed Runs & Reports screen, click the report name to open.

3. In the Summary, click ERCC_Analysis to see the ERCC_Analysis pane. The
following settings are shown.

4. After the analysis is complete, click the ERCC_Analysis.html link or individual
Barcode Name link to open the ERCC Report and view the analysis results. The
following table describes the settings that are shown.

Setting Description

Use only forward strand | Available when manually running the plugin.
reads

Passing R-squared value | To optionally change the R-squared value to set a
default value for the summary report screen, enter a
value between 0 and 1 as your minimum acceptable R-
squared value (a lower value is indicated by a red light
in the summary report).

The value you enter on the ERCC Plugin Configuration
screen is used when the plugin is auto-run and when a
user manually launches the plugin without entering a

value. Users can override this value on a per-run basis
when they manually launch the plugin.

Minimum transcript The minimum number of reads that a given ERCC

counts transcript must have to be included in the analysis.

ERCC pool used Select the ERCC transcript pool used when preparing
the library.

Barcodes of interest Select a barcode from the dropdown list for Add a

specific barocde.

IMPORTANT! If you configure a Planned Run or
Planned Run template to execute the ERCC_Analysis
plugin, and your experiment uses the lon Total RNA-
Seq Kit v2, you must select a barcode option:

Interpret the ERCC Dose Response plot

The axes of the ERCC Dose Response plot are log (base 2), with the raw read counts
for each ERCC transcript on the y-axis and the known relative concentration of the
ERCC transcripts on the x-axis. In the plot, the points are color-coded —based on
mapping quality —and there is also a line of best fit, the parameters (slope, y-
intercept, and R-squared value) of which are shown in tabular form to the right of the
graph (N = the number of points (ERCC transcripts) included in the regression
analysis). Ideally, the points all fall on a straight line. However, the raw counts and
relative concentration should at least correlate with a high R-squared (e.g., 20.9) value.
Although there are 92 transcripts in the ERCC mibx, it is not expected that all 92 are
detected. The number of transcripts detected depends on the sequencing depth.
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View ERCC transcript details

There are two ways to look at the details of a particular ERCC transcript. To view all
the details about a particular ERCC transcript, you should view both.

¢ Hover your mouse-cursor over a point in the ERCC Dose Response plot to
display a popup window that shows details about that transcript. Overlapping
points on the plot can be resolved by zooming in on the plot to more easily
distinguish points.

Torrent Suite™ Software 5.6 Help

a. Tozoom in on a selected area, click-drag your mouse to highlight the area of

interest.

b. Double-click in the plot, or click the Reset Zoom button to zoom out to the
full view of the ERCC Dose Response plot.
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Parameter

Description

log2 relative
ERCC
concentration

The log (base 2] of the relative ERCC transcript concentration.

log2 ERCC The log (base 2) of the mapped reads to an ERCC transcript.
counts

transript The ERCC transcript identifier including length in base pairs (bp).
reads The number of reads that map to the particular transcript.

mean mapping
quality

. Points in the display are color coded based on the mapping
quality.

Scroll to the particular transcript, then click the [+] next to the transcript name.

Parameter Description
Reads The number of reads that map to the particular transcript.
Coverage The minimum and maximum number of reads covering bases in
Depth the transcript. If coverage is 100%, the minimum value will be > 0.
Coverage The number of base positions covered by at least one read. Also
expressed as a percentage of the full length.
Start Sites The number of base positions that are the start site for a read.
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Parameter Description
Unique Start The number of base positions that have only one read starting at
Sites the position.
Coverage CV Coefficient of Variation for coverage = average coverage / standard

deviation coverage for the entire transcript.

Definitions

This section defines terms used in the plugin output.

* Coverage Depth The minimum and maximum number of reads covering bases in
the transcript. If coverage is 100%, the minimum value will be > 0.

* Coverage The number of base positions covered by at least one read.
* Start Sites The number of base positions that are the start site for a read.

¢ Unique Start Sites The number of start sites that have only one read starting at
the site.

e Coverage CV Coefficient of Variation for coverage = average coverage / stddev
coverage for the entire transcript.

ERCC resources

The External RNA Controls Consortium (ERCC) is hosted by the U.S. National
Institute of Standards and Technology.

For more information on ERCC RNA Spike-In Control Mixes (Cat. Nos. 4456739 and
4453740), see the ERCC RNA Spike-In Control Mixes User Guide (Pub. No. 4455352).

For more information on ERCC analysis, see the ERCC_Analysis Plugin User Bulletin
(Pub. No. 4479068).

The FieldSupport plugin is used for technical support purposes only. For details,
contact Technical Support or your Field Application Scientist. Enable and run this
plugin only under the guidance of Thermo Fisher Scientific Technical Support.

IMPORTANT! Enable and run this plugin only when directed by Thermo Fisher
Scientific Technical Support or your Field Applications Scientist.

™

Use the FileExporter plugin to rename the output files from the Torrent Suite
Software runs.

The plugin also offers the following options:
* Generates files of the analysis results that use BAM, VCF, XLS, or FASTQ formats.
* Renames variantCaller plugin output files (when available).
* Compresses the analysis results files.

¢ Provides links that allow you to download the results files.

Torrent Suite™ Software 5.6 Help
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Configure the FileExporter plugin

1.

Torrent Suite™ Software 5.6 Help

Select from the following options to choose the file types that you export:

Option

Description

Include | Select to generate a separate link for the file in the plugin results.

format.

Archive | Select Archive for each file type that you want to include in a compressed
file. You can export a standard compressed directory in a .zip or tar.bz2

For each option, you can choose to include or archive the following file types:

File types

Description

BAM

Native file format for data generated by lon
instruments.

Variant Call Format (VCF)

File containing only the differences between the BAM
file and a reference file.

Variant Caller File (XLS)

Microsoft™ Excel™ format of VCF.

FASTQ

Text format of the nucleotides.
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2. Name the file. Select one of the following:

* Select a unique file name by entering the desired name in the Custom Name
text box.

* Create a name using parameters of the run. Drag and drop components from
the selections pane onto the name pane row. The naming options are in the
blue boxes. The name appears under Example Name.

¢ Select the delimiter used between metadata fields. Support delimiters are dot,
dash, and underscore (a naming pattern uses only one delimiter).

Name Options:

Custom Name Option:  |enter Text Here Update

selections:

Report Chip Type
Date
Sample Barcode Custom
Name Name Name
@ Report Sequencer
Name Name

Delimiters:

Example Name:

report_name-instrument. bam

(D Name pane row

3. Click Save Configuration.

Review FileExporter plugin results

After the sequencing run completes, you can download the following files after you
run the FileExporter plugin from the report summary:

e Any of the Torrent Suite” Software Software analysis output files that use BAM,
VCEF, XLS, or FASTQ formats.

* A compressed file that contains the analysis output files.

1. In the Data tab, click Completed Runs & Reports.

2. In the list of runs, locate the run of interest, then click the link in the Report
Name column.

3. In the left navigation menu, click FileExporter to view the plugin summary.

Note: The BAM files load quickly so may appear first in the list of links. The
other file formats take longer to download.
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4. Verify that the status of the plugin run is Completed. You can click
Plugins » Refresh plugins at the top of the Summary if the status is not
completed or the list of files does not include all of the files that you selected
when you configured the plugin.

5. When the list contains all of the files that you want to download, click on a file
name link under Output Files to download.

6. Toreview the parameters that were used for the files, click Show Parameters

FilterDuplicates The FilterDuplicates plugin allows you to remove duplicate reads from merged data
plugin after a run is completed. The removed BAM files are saved in the FilterDuplicates
directory. The original BAM files in the main analysis directory are not modified.

Note: The Mark Duplicate feature in the main analysis pipeline, enabled in the Kits
step of Planned Run creation, marks reads as duplicates but does not remove them
from the BAM files.

Review FilterDuplicates plugin results

After the sequencing run completes, review the FilterDuplicates plugin results, and
download the BAM files with duplicate reads removed.

1. In the Data tab, click Completed Runs & Reports.

2. In the list of runs, locate the run of interest, then click the link in the Report
Name column.
3. In the left navigation menu, click FilterDuplicates to view the plugin summary.

Note: The BAM files load quickly, so you might see these in the list of links first.
The other file formats take longer to download, so you might have to wait for the
links to the VCF, XLS, and FASTQ formats to appear.
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4. In the FilterDuplicates section, click FilterDuplicates.html to open the BAM
Files with Duplicate Reads Removed report in the browser.

Note: BAM files load quickly, so you might see these files first in the list of links.
The other file formats take longer to download, so you might have to wait for the
links to the VCF, XLS, and FASTQ formats to appear.

FilterDuplicates ViewLog  Delete
Compleled 6.88 GB

~FilterDuplicates. htmi

Bam Files with Duplicate Reads Removed

Filtered Bam File Percent Duplicate Reads Removed | Percent Reads Reaching Adapter

lonXpress 001 rawlib.bam | 7% 96%

8% 96%

The plugin output contains links to the BAM files that have duplicate reads
removed. This table also shows the percentage of reads that were removed and
the percentage of all reads that reached the adapter.

5. To download the Filtered BAM Files, click the link for each file listed that you
want to download.
The BAM files are downloaded to the directory that you use to download files
from the browser. This location will depend on your browser settings.

Use the immuneResponseRNA plugin to quantify gene expression levels for the
Oncomine™ Immune Response Research Assay. This plugin produces gene transcript
quantification from sequence read data. The plugin summary includes gene
expression counts (number of aligned reads to a given gene target), a data analysis
summary, and QC plots. The normalized, gene-level count data from the run are

available to download for further analyses with Affymetrix™ Transcriptome Analysis
Console (TAC) 3.1 software.

The immuneResponseRNA plugin requires a Target Regions BED file and an
associated Reference Library FASTA file. See “Reference Management” on page 223
for more information on installing these files.

The plugin also accepts a second —optional —BED file that specifies a subset of target
genes allowing sample clustering.

immuneResponseRNA plugin configuration

The configuration options for the immuneResponseRNA plugin are described in the
following table:

Setting Value
Library Type AmpliSegRNA
Targeted Regions ImmuneResponse_v3.1_target_designed_20160908.bed

(Optional/ Add new gene list | Select your target gene subset BED file in the Add genes of
interest list.

Torrent Suite™ Software 5.6 Help
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Review immuneResponseRNA plugin results

After the sequencing run completes, review the plugin results in the report summary.

1. In the Data tab, click Completed Runs & Reports.

2. In the list of runs, locate the run of interest, then click the link in the Report
Name column.

3. In the left navigation menu, click immuneResponseRNA to view the plugin
summary.

4. In the immuneResponseRNA section, click the immuneResponseRNA.html
link to open the immuneResponseRNA Report for all barcodes.
Note: The BAM files load quickly so may appear first in the list of links. The
other file formats (VCF, XLS and FASTQ) take longer to download.

5. Inthe Analysis Summary, review your Mapped Reads, Valid Reads, and
Targets detected by barcode.

Column Description
Barcode Name The barcode used for the sample.
Sample Sample name as it was entered in the sequencing Run
Plan.
Mapped Reads Number of reads that map to the reference sequences.
Valid Reads Percentage of mapped reads 250% amplicon length.
Targets 1 reads Number of targets/genes with at least 1 read.
Targets »2 reads Number of targets/genes with at least 2 reads.
Targets 210 reads Number of targets/genes with at least 10 reads.

6. Click an individual barcode name to view the results for that barcode.
7. Scroll down then click the Sample Characteristics, Sample Correlation,
Analysis of Selected Targets (only present if a Genes of interest subset .bed file

was selected), or Analysis of All Targets tabs to review the data graphically.

Sample Characteristics Sample Correlation Analysis of Selected Targets Analysis of All Targets

Distribution of Gene Expression

House Ketping Genes

W CRS-1280-6

© CR4-1296-7

W CR9-1251-6

O NP16585-4

= 131503T_2_6 1

B lonXpress_070 10l
W CR4-1258:2

0 lonXpress_074

F4

3

Frequency
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Downloadable reports

The following reports are available for download as tab-delimited text files,
compatible with Microsoft  Excel " or similar applications.

At the bottom of the screen are links for downloading raw analysis output files:

Report hyperlink

Description

Download Barcode
Summary Report

A table listing each barcode’s sample name, total reads,
aligned reads on targets, and number of targets detected.

Download absolute read
counts data

A table listing read counts for each barcoded sample along
with gene annotations.

Download RPM data
(normalized by total read
counts)

A table listing RPM (Read count Per Million mapped reads)
for each barcoded sample along with gene annotations.
RPM is calculated as:

(read count) x 10%/ total number of mapped reads

Download mean
housekeeping scaled log?2
RPM data

A table listing housekeeping-gene normalized, log2-
transformed read counts for each barcoded samples along
with gene annotations. Conceptually, these values are read
count normalized by the average expression of
housekeeping (4] genes rather than by the total number
of mapped reads as described above. The values are
calculated as:

2 (log2 (hk counts+1))
number of hk gene

log2(count +1)— +10g2(10%)

These values are useful for differential analysis when a
large proportion of the target genes (non-housekeeping
genes) are expected to be differentially expressed or when
the expression levels of the housekeeping genes in the 2
groups differ significantly.

Download CHP files
normalized by RPM

The RPM data is converted to CHP file format for use with
Affymetrix™ Transcriptome Analysis Console (TAC)
software. The downloaded .ZIP file contains all the CHP
files from the sequencing run. Each barcoded sample has
1 CHP file.

Download CHP files
normalized by mean
housekeeping genes

Similar to the above CHP file, but data in these CHP files
are normalized by housekeeping genes.

Download background
expression from genomic
DNA and H,0 neg_control

A table containing background expression (in absolute read
count] from 4 experiments using genomic DNA and H,0 as
negative control samples.
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Analysis files that are generated in the Torrent Suite™ Software can be directly

transferred to an Ion Reporter account in Ion Reporter™ Software with the
IonReporterUploader plugin.

Ion Reporter™ Software uses the Torrent Suite™ Software output BAM file for analysis.
The Ion Reporter™ Software annotation-only workflow also accepts the VCF output
file of the variantCaller plugin. Use the IonReporterUploader plugin to transfer these
BAM and VCF output files to Ion Reporter™ Software.

For details about the IonReporterUploader plugin, see “Integration with Ion
Reporter™ Software” on page 171

The PGxAnalysis plugin analyzes sequencing output from the Ion AmpliSeq™
Pharmacogenomics panel, a hotspot panel that interrogates pharmacogenomically
relevant variants in samples for genotyping and CYP2D6 copy number detection. It
requires two other Torrent Suite plugins: the variantCaller plugin for genotyping and
coverageAnalysis plugin for CYP2D6 copy number detection.

The figure below describes the pipeline of analyses.

Assay Design: Hotspot TVC parameters
Target BED file BED file ison file

pd

AN I
AERNYE"%

Sequencingon Run Plan with il \ Exoort Fil D +
AmpliSeq Panel Custom Mapping Xport Files ownstream

Coverage VCF Star allele
Analysis OpenArray translation
¢ tools

CNV

\ Analysis /

E = Customized during development
™

For details about how to set up Torrent Suite™ Software Planned Runs that
incorporate the Ion AmpliSeq™ Pharmacogenomics template and the PGxAnalysis
plugin, see the following documents at the Thermo Fisher Scientific website
(thermofisher.com):

* Customization Guidelines for Ion AmpliSeq™ Pharmocogenomics Research Panels
(Pub. No. MANO0014300)

* Create a Planned Run using the Ion AmpliSeq™ Pharmocogenomics Research Panel
Plugin (Pub. No. MAN0013730)
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Review PGxAnalysis plugin results

After the sequencing run completes, review the plugin results in the report summary.

1. In the Data tab, click Completed Runs & Reports.

2. In the list of runs, locate the run of interest, then click the link in the Report
Name column.

3. In the left navigation menu, click the PGxAnalysis link to view the plugin
summary.

4. Click the PGxAnalysis.html link to open the Pharmacogenomics Analysis
Report.

5. View the plugin analysis reports.

* C(lick the variantCaller_out link to view the Variant Caller Report. See
“Variant calls in Torrent Suite Software” on page 193 for details on
variantCaller plugin results interpretation.

¢ C(lick the coverageAnalysis_out link to view the Coverage Analysis Report.
See “Review coverageAnalysis plugin results” on page 131 for details on
coverageAnalysis plugin results interpretation..

RunTransfer Use the RunTransfer plugin to complete the following:

plugin ¢ Transfer the signal processing output files from a completed run to a different
Torrent Server.

* Rerun an analysis of the transferred signal processing files on the new server. The
Run Summary that includes the transferred files is listed in the Completed Runs
& Reports for the server that receives the transfer, as if it is generated on that
server. The results of the analysis are contained in the ISP images of the Run
Summary.

Note: The files that are transferred are the BaseCaller Input category of files,
including the 1.wells file. This file contains observations from the instrument that are
captured electronically.

For Ion Proton™ analyses, you can configure the option to transfer thumbnail files
only or transfer the 96 block files in a full chip run.

RunTransfer plugin configuration

The RunTransfer plugin requires global configuration to connect to the Torrent Server
that receives transferred files.

The following configuration settings are used by the plugin:

Setting Description

IP address or fully qualified | The IP address or fully qualified host name of the receiving
hostname Torrent Server.

Remote TS Username The username of the administrator-level user on the
(default ionadmin) receiving Torrent Server. The default administrator

username on a new Torrent Server is ionadmin, but this
can be changed.
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Setting

Description

Password

The password of the administrator-level user on the
receiving Torrent Server.

Upload Path
(default /results/uploads/)

The path of the directory used to store transferred files and
analyses on the receiving Torrent Server.

Data set type

Select an option based on the following considerations:

¢ Thumbnails/PGM: This option will transfer all files,
including thumbnails. However, the plugin will not run
if full chip sequencing runs were performed on thelon
Proton™ System and lon S5 System. With this
setting, a warning will be issued and the plugin will
not run, if the instrument used a Full Chip run.

¢ Thumbnails/PGM and Full Chip:This option transfers
only thumbnails of lon Proton™ System, lon S5
System, and lon PGM™ System data sets. Use this
option if disk space on the destination or network
bandwidth is limited.

Torrent Suite™ Software 5.6 Help
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Review RunTransfer plugin results

After the sequencing run completes, you can review information about the run
reports that were transferred to another Torrent Server.

1. In the Data tab, click Completed Runs & Reports.

2. In the list of runs, locate the run of interest, then click the link in the Report
Name column.

3. In the left navigation menu, click RunTransfer to view the plugin summary.
4. Click the Report Name link to open the summary for your report.

5. To view the plugin summary, click the RunTransfer link.
In the RunTransfer section, you can see a list of the files that were transferred. If
the plugin is configured to use the data type set as Thumbnails/PGM, you will
see these files:

1.wells
analysis.bfmask.bin
processParameters.txt
avgNukeTrace ATCG.txt
avgNukeTrace_TCAG.txt
bfmask.stats', 'bfmask.bin’
analysis.bfmask.stats
analysis_return_code.txt
sigproc.log
avgNukeTrace ATCG.txt
avgNukeTrace_TCAG.txt
analysis.bfmask.stats
explog.txt
Bead_density_20.png
Bead_density_70.png
Bead_density_200.png
Bead_density_1000.png
Bead_density_raw.png
Bead_density_contour.png

Use the samplelD plugin to track samples or possibly identify misassignment or mix
up between samples and barcodes in a sequencing run. The samplelD plugin
produces a unique identification code (SamplelD) for each barcode in a sample.

™

The plugin can be used with the Ion AmpliSeq” Sample ID Panel is a human SNP
genotyping panel to ensure that the accuracy of samples increase confidence in
sample data management. The Ion AmpliSeq™ Sample ID Panel is composed of the
identified human sample gender and IUPAC base letters for eight high-frequency
non-coding SNPs. The Sample ID panel contains nine primer pairs that can be
combined with any Ion AmpliSeq™ Ready-to-Use or Custom Panel.

For the samples to work with this plugin, the Ion AmpliSeq™ library must have be

™

prepared with Ion AmpliSeq™ sample tracking amplicons.
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Note: The samplelD plugin is pre-configured and does not require input.

Review samplelD plugin results

After the sequencing run completes, review the plugin results in the report summary.

1. Inthe Data tab, click Completed Runs & Reports.

2. In the list of runs, locate the run of interest, then click the link in the Report
Name column.

3. In the left navigation menu, click samplelD to view the plugin summary.

4. Click sampleID.html to open the samplelD report in the browser tab. Then, you
can open a detail report and other data files:

5. (Optional) Scroll to the File Links table, and click on a link to:

* Download a PDF image of the report

* Download all variant calls as a table file

¢ Download the tracking target regions file

* Download the tracking loci regions (SNPs ) file

* Download the aligned tracking reads (BAM) file

* Download the aligned tracking reads index (BAI) file

6. (Optional) Click Download Barcode Summary Report to open the data in a
downloadable tab-separated spreadsheet, or PDF report.

7. To return to Torrent Suite™ Software, click back in the browser.

The variantCaller plugin calls single-nucleotide polymorphisms (SNPs), multi-
nucleotide polymorphisms (MNPs), insertions, deletions and block substitutions in a
sample across a reference or within a targeted subset of that reference.

This plugin provides optimized pre-set parameters for many experiment types. It can
also be customized. After you find a parameter combination that works well on your
data and that has the balance of specificity and sensitivity that you want, you can save
that parameter set and reuse it in your research. Customization is supported when
you run the plugin after a sequencing run and when the plugin is run through a
Planned Run.

For details about the variantCaller plugin, see “Variant calls in Torrent Suite
Software” on page 193.
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There are two plugins that are supported by Thermo Fisher Scientific and available on
the Thermo Fisher Cloud. These plugins are not pre-installed in the Torrent Suite
Software. For details about plugins that are included with Torrent Suite Software, see
“Pre-installed plugins” on page 121.

Plugin name Description

RNASeqAnalysis Analyzes cDNA reads. This plugin is an RNA

transcript alignment and analysis tool for

use with the reference genomes hg19 and
mm10.

For details, see “RNASeqAnalysis
plugin” on page 157.

smallRNA Analyzes small RNA reads with an
emphasize on micro RNA molecules. Use
with reference genom hg19 only.

Use this plugin to analyze micro RNA reads. Reads are aligned to mature micro
RNAs using the tmap or bowtie2 alignment software. Unmapped reads are further
aligned to the whole genome to rescue miRbase unaligned reads and count other
RNA molecules (tRNAs, rRNAs, mRNAs, and so on). miRNA raw counts are
generated using featureCounts software.

smallRNA plugin

The RNASeqAnalysis plugin can be configured with the either the hg19 reference
genome when you plan a run.

Setting Description

microRNA reference mirbase (build 20) Use to align against a mirBase
reference, constructed from the mirBase GFF file with 10
bp padding.

genome Use to align against the whole genome.

Rescue reference hg19

Review smallRNA plugin results

After your sequencing run completes, review plugin results in the report summary.

1. In the Data tab, click Completed Runs & Reports.

2. In the list of runs, locate the run of interest, then click the link in the Report
Name column.

3. In the left navigation menu, click smallRNA to view the plugin results.
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4. In the smallRNA section, click smallRNA.html link to open the smallRNA
Analysis Report for all barcodes.

¢ In the barcode table, click individual barcode names to see the results for an
individual barcode.

Report

Description

Download the Statistics Summary

An overview of read mapping
statistics and smallRNA molecules.

mirBase mapping quality (page_)

Mapping quality output from
Qualimap.

Download the mirRNA Mature
Counts

A table with per mature RNA read
counts.

Download the miRNA Per Precursor
5p-3p Counts

A table with 5p-arm and 3p-arm read
counts on the same line.

Download the miRNA High
Confidence Mature Counts

A table with per mature read counts
for miRNAs identified as high
confidence miRNAs in mirBase build
21

Download the miRNA Per Precursor
5p-3p Counts

A table with 5p-arm and 3p-arm read
counts on the same line. Restricted
to miRNAs identified as high
confidence miRNAs in mirBase Build
21.

Download the mirBase alignments
(BAM] file (genomic coordinates)

mirBase alignments converted to
genomic coordinates when mirBase
was used as reference.

Download the mirBase alignments
index (BAI) file

Index file for the mirBase alignment.

Download Output files (page)

A page which provides the ability to
download all output files individually.

* Click Download Barcode Summary Report to download the data into
downloadable tab-separated spreadsheet, or PDF report.

¢ C(lick Download absolute reads matrix to download a table that lists absolute
reads for the genes found on each barcode.

Torrent Suite™ Software 5.6 Help

The RNASeqAnalysis plugin is an RNA Transcript Alignment and Analysis tool for
use with reference genomes hg19 and mm10.

Note: In order to use the mm10 genome with this plugin, the mm10 genome
reference must first be uploaded to Torrent Suite™ Software.

Use this plugin to analyze cDNA reads, as produced by RNA-Seq. Reads are aligned
to the reference genome using STAR and bowtie2 aligners to find full and partial
mappings. The alignments are analyzed by HTSeq and Picard tools to collect assigned
read counts and cufflinks to extract gene isoform representation. For barcoded data,
comparative representation plots across barcodes are created in addition to individual
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reports for each barcode. All alignment, detail and summary report files are available
for download.

BAM
- 2-step alignment
!
unmapped
Fastq STAR Bowtie2*
L
. Mapped
Ny
Transcript Counts Merged Gene Counts
(Cufflinks) BAM (HTSeq and Picard)
\_/n/_
A
Isoform/transcript ac Gene
expression ) Expression )

C=file [ ] =tool [J=results

* A secondary alignment is performed against rRNA sequences for reporting the fraction of total reads represented by ribosomal RNA species. This
serves as a useful QC metric to estimate effectiveness of rRNA depletion procedures and/or effects on detection sensitivity for mMRNAs of interest.

RNASegAnalysis plugin configuration

The RNASeqAnalysis plugin can be configured with the either the hg19 or mm10
reference genome when you plan a run.

Note: This plugin requires the use of the Ion AmpliSeq " application for sequencing
Runs. When you run the plugin manually, you will receive an error if the Ion
AmpliSeq " application was not used.

Setting Description
Reference Genome Select from the dropdown list:
hg19
mm10

Note:
In order to use the mouse mm10 Reference Genome with this plugin, it must first be
uploaded to Torrent Suite " Software.

Review RNASegAnalysis plugin run results

After your sequencing run completes, review plugin results in the report summary.

1. In the Data tab, click Completed Runs & Reports, then click the Report Name
link for your completed sequencing run.

2. In the list of runs, find the run of interest, then click the link in the Report Name
column.
Reports for any plugins that have completed analysis are included in the
Summary.
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3. In the left navigation menu, click RNASeqAnalysis to view the plugin results.

4. In the RNASeqAnalysis section, you can view the Barcode Summary for the
RNASeqAnalysis plugin. The summary includes columns for Barcode Name,
Sample, Total Reads, Aligned Reads, Percent Aligned, Mean Read Length, Genes
Detected, and Isoforms Detected. Click the RNASeqAnalysis.html link to open

the report in the browser tab.

¢ C(lick the RNASeqAnalysis.html link to view the RNASeqAnalysis Report

for all barcodes.

e - C(lick the links at the bottom of the report to download associated report
files.
Link name Download description

Barcode Summary Reportaligned.

A table that lists the sample name
for each barcode, total reads, aligned
reads and percent

absolute reads table

A table that lists absolute reads for
the genes found for each barcode.

absolute normalized reads table

A table that lists absolute normalized
reads for the genes found for each
barcode.

aligned reads distribution table

A table that lists the distribution of
genes across barcodes to show the
frequency of numbers of genes
having similar log10 read counts.

isoform FPKM values table

The isoform gene heatmap in a table
format.

— Click the links at the bottom of the RNASeqAnalysis Report to
download raw analysis output files for the selected barcode. For
examples, see “Individual barcode view” on page 163.

Link name

Raw analysis output file description

Download the Statistics Summary

An overview of the individual
barcodes from the RNASegAnalysis
plugin results.

Gene Read Counts

A table that lists the number of times
a gene was counted for the individual
barcodes.

Output Files

A directory for various output files for
the selected barcode.

Cufflinks Output Files

A list of links to Cuflinks output files.

Torrent Suite™ Software 5.6 Help
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— Click individual barcode names to see graphs for the selected barcode.
For examples, see “Downloadable reports for individual
RNASeqAnalysis plugin barcodes” on page 161.

Link name

Download description

Reference table

Plot that shows the number of genes
that have reads in log10 counting
bins.

Gene Mapping Summary

Summary of reads mapped to genes
of the annotated reference.

Base Mapping Summary

Summary of base reads aligned to
genetic features of an annotated
reference.

Normalized Transcript Coverage

A plot of normalized transcript
coverage that shows the frequence of
base reads with respect to the length
of individual transcripts as they are
aligned to in the 3" to 5" orientation.

Gene Isoform Expression

Box plots showing variation of
isoforms expressed at FPKM > 0.3
for each set of genes grouped by the
number of anticipated (annotated)
isoforms. Whiskers are defined by
points within Q1-1.5xIQR to
Q3+1.5xIQR. Only genes with 25 or
less isoforms are represented in this
plot. The data and a plot for all genes
are available for download using the
download reports links at the bottom
of the screen.

¢ (lick the Distribution Plots, Correlation Heatmap, Correlation Plot, and
Gene Heatmap tabs to review the following data graphically.

Graphical report

Description

Distribution Plots

For details, see “Distribution Plots” on
page 165.

Correlation Heatmap

For details, see “Correlation
heatmap” on page 167.

Correlation Plot

For details, see “Correlation plot” on
page 168.

Gene Heatmap

For details, see “Gene heatmap” on
page 168.

Isoform Heatmap

For details, see “Gene heatmap” on
page 168.
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Downloadable reports for individual RNASegAnalysis plugin barcodes

You can download raw analysis output files for individual barcodes if you click the
links at the bottom of the RNASeq Analysis Report:

» Download the Statistics Summary
s Download the Gene Read Counts
» Download Output Files (page)

s Download Cufflinks Output Files (page)

Statistics Summary - Provides an overview of the individual barcodes RNA Seq
Analysis results.

RNASegaAnalysis Summary Report

Sample Name: None

Reference Genome: hgl9

Adapter Sequence: MNone

Reads Sampled: 18@.8%

Alignments: IonXpress_81@_R_2015 @2_12 15 16_34 sc_P19-753-P2bead_on_pl--R79599_ Update_for_less_barcodes

Total Reads: 11283208
Aligned Reads: 18097469
Pct Aligned: 97.47%

Mean Read Length: 182.4
strand Balance: @.4980

Reference Genes: 55765

Reads Mapped to Genes: 7398786
Genes with 1+ reads: 26969
Genes with 18+ reads: 16626
Genes with 108+ reads: 9531
Genes with 1888+ reads: 1429
Genes with 18888+ reads: 35

Total Base Reads: 1155834791
Pct Aligned Bases: 79.14%
Pct Usable Bases: 63.081%
Total Aligned Bases: 914778477

Pct mRHA Bases: 79.61%
Pct Coding Bases: 30.68%
Pct UTR Bases: 39.93%

Pct Ribosomal Bases: ©.94%
Pct Intronic Bases: 15.65%
Pct Intergenic Bases: 3.98%

Isoforms Annotated: 238756
Isoforms Detected: 58457
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Gene Read Counts - Lists the number of times a gene was counted for the individual

barcode.
A B
1 Gene Reads
2 |55 rRNA 3
3 | 75K 547
4 Al1BG 3
:lAlBG As1 34
A1CF 0
7 AZM 14
8 |AZM-AS1 16
9 AZML1 45
10 AZML1-AS 0
11 AZML1-AS 0
12 AZMP1 0
13 A3GALT2 0
14 A4AGALT 45
15 A4GNT 0
16 AAAS 492

Output Files - Provides a directory for various output files for this barcode.

File Size  Date File

871IM  2015-06-02 alignedSTAR bam

72M 2015-06-02 Chimeric.out junction

495M  2015-06-02 Chimerie.out.sam

20 2015-06-02 IonXpress 010 _R_2015_02_12_15_16_34_sc_P19-753.P2bead_on

27K 2015-06-02 IonXpress_010_R_2015_02 12_15_16_34_sc_P19-753-P2bead_on

19K 2015-06-02 IonXpress 010_R_2015 02 12 15 16_34_sc_P19-753-P2bead_on

13M  2015-06-02 lonXpress 010 R_2015_02 12 15 16_34_sc P19-753-P2bead _on

660K 2015-06-02 IonXpress 010_R_2015 02 12 15 16_34 sc P19-753-P2bead_on

44K 2015-06-02 JonXpress 010 R_2015_02_12_15_16_34_sc_P19-753-P2bead_on

129 2015-06-02 IonXpress 010 R_2015 02 12 15 1634 sc_P19-753-P2bead_on

132

19K 2015-06-02 lonXpress 010 R 701\ 02 1" 1< 16 34 sc ] P19-"<3 PZbe’\:l on 79599 Uochre for_less 1 barcodesmarcads.pn
107 2015-06-02 IonXpress 010 R 2015 02 12 15 16 34 sc P19-753-P2bead on_pl--R79599 Uochre for less barcodesrnareads.xls
121 2015-06-02 TonXpress 010 R 2015 02 12 15 16 34 sc P19-753-P2bead on i
13G  2015-06-02 JonXpress

3.5M 2015-06-02 IonXpress (

660K 2015-06-02 TonXpress_(

20K 2015-06-02 TonXpress |

29K 2015-06-02 IonXpress |

897

125 2015-06-02 Ioan:sx 010 R 2015 0271773716 3475c P19-753- Plbﬂd on,

17K 2015-06-02 Log.final.out

12K 2015-06-02 Log.out

32K 2015-06-02 output_cufflinks

19K 2015-06-02 maseq.log

5.0M  2015-06-02 Slout.tab

92 2015-06-02 xrRNA.bam

2015-06-02

xrRNA basereads

Cufflinks Output Files - Provides a list of links to Cufflinks output files.

File Size  Date File

5.5M

24M 2015-06-02 IouXmes: 010 R 2015 02 12 15 16 3-! _sc | PIQ-"‘S P2be1d on_pl--R79599 Upchte for ]C:S Im Jes isoform: fDlG]liu.a kin,
0 2015-06-02 IonXpress 010_R_2015_02_12 15_16_34_sc_P19-753-P2bead_on_pl--R79599 Update_for_less barcodes.skipped.gtf

305M  2015-06-02 JonXpress 010 R 2015 02 12 15 16_34 sc P19-753-P2bead on_pl--R79599 Update for_less barcodes.transcripts.gtf
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Click on any barcode of interest in the RNASeqAnalysis Report to see graphs for the

selected barcode.

Reference table - Plot showing the number of genes with reads in log10 counting

bins.

Reference: hg19

Representation Overview

:

°
<1

Number of Genes.

0 10-100 100-1K

Binned numbers of reads

TK10K  10K-100K 100K+

Total reads 11,283,208
Aligned reads 10,997,469
Percent aligned reads 97.47%
Mean read length 102.4
Genes Detected 16,626
Isoforms Detected 58,457

Gene Mapping Summary - Summary of reads mapped to genes of annotated

reference.

Gene Mapping Summary

Reference genes 55,765
Reads mapped to genes 7,390,706
Genes with 1+ reads 26,969
Genes with 10+ reads 16,626
Genes with 100+ reads 9,531
Genes with 10,00+ reads 1,429

Genes with 10,000+ reads 35
Isoforms Annotated 230,756
Isoforms Detected 58,457

Base Mapping Summary - Summary of base reads aligned to genetic features of an

annotated reference.

Base Mapping Summary

Total base reads 1,155,834,791

Total aligned bases 914,778,477
Percent aligned bases 79.14%
Percent coding bases 39.68%
Percent UTR bases 39.93%
Percent ribosomal bases 0.94%
Percent intronic bases 15.65%
Percent intergenic bases 3.98%
Strand balance 0.4980
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Normalized Transcript Coverage - A plot of normalized transcript coverage; the
frequency of base reads with respect to the length of individual transcripts they are
aligned to in the 3' to 5' orientation.

Normalized Coverage

0.4

08 1.0 1.2
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0.2
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|

Normalized Transcript Coverage

Ribosomal 0.9% .

UTR 39.8%

T T T T T
0 20 40 60 80 100
Normalized Distance Along Transcript

'Coding 39.6%

- Intergenic 4%

Intronic 15.6%

Gene Isoform Expression - Box plots showing variation of isoforms expressed at
FPKM 2 0.3 for each set of genes grouped by the number of anticipated (annotated)
isoforms. Whiskers are defined by points within Q1-1.5xIQR to Q3+1.5xIQR. Only
genes with 25 or less isoforms are represented in this plot. The data and a plot for all
genes are available for download using the download reports links at the bottom of
the screen.

Isoforms Expressed Per Gene

Gene Isoform Expression

25 |

20

L N O I O B B O B B
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Annotated Isoforms Per Gene
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Distribution Plots

Reads Alignment Summary- A graphical summary of the number of mapped and
unmapped reads across barcodes, as reported in the barcode summary table.

Reads Alignment Summary

& Mapped Reads &1 Unmapped Reads

lonXpress_001
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lonXpress_006

lonXpress_007
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lonXpress_010

lonXpress_011

lonXpress_012

lonXpress_013

lonXpress_014

Milion Reads

Alignment Distribution - A graphical summary of the distribution of reads to
genomic features.

Alignment Distribution
£ Coding O Ribosomal = UTR = Intronic & Intergenic
lonXpress_001
lonXpress_004
lonXpress_005
lonXpress_006
lonXpress_007

lonXpress_008

r T T T T 1

200 400 600 800 1000
Milion Base Reads

)
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Normalized Transcript Coverage - An overlay of individual normalized transcript
coverage plots for each barcode.

Normalized Coverage

Normalized Transcript Coverage

0 20 40 60 80 100
Normalized Distance Along Transcript
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Distribution of Gene Reads - Distribution of genes across barcodes showing the
frequency of numbers of genes having similar log10 read counts. All curves are
plotted on the same axis scale. The counts data is fitted to a Gaussian kernel using the
default R 'density’ function.

Frequency of Genes with N Reads (N > 0)

Distribution of Gene Reads

Number of Reads : log10(N)

B [onXpress_001
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3 lonXpress_012
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Torrent Suite™ Software 5.6 Help



Plugins available on only Thermo Fisher cloud 201

Manage plugins for data analysis @E
|

Distribution of Isoform Reads - Distribution of transcript isoforms across barcodes
showing the counts of isoforms having similar FPKM values. All curves are plotted on
the same y-axis, normalized to the highest count and scaled for FPKM values 20.3.

Distribution of Isoform Reads

W keipenss_001
@ lonXpress 004
B kedpeosa 005
1 B keeXpeoss_ D06
® lonXpress 007
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W konXpress_010
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| W konXpress_013
1 lon¥press 014

Frequency of Isoforms with FPKM »= 0.3

Reprasantation : log10(FPKEMs+1)

Correlation heatmap

A heatmap of Spearman correlation r-values for comparing log2 RPM reads pair
correlation barcodes, with dendrogram reflecting ordering of barcodes as being most
similar by these values.

Correlation Heatmap
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Correlation plot

Barcode read pair correlation plot. Lower panels show log2(RPM+1) values plotted for
each pair of barcodes, with linear least squares regression line overlaid and line slope
reported. Upper panels show Pearson correlation r-values for the regression line.
Diagonal panels show the frequency density plot for the individual log(RPM+1)
values for each barcode. (If only one barcode has reads, a density plot is displayed.)
Click the plot to open an expanded view in a new window.
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Gene heatmap

A gene representation heatmap of 250 genes showing the most variation in
representation across barcodes as measured by the coefficient of variant (CV) of
normalized read counts for genes that have at least one barcode with at least 100 RPM

Torrent Suite™ Software 5.6 Help



Manage plugins for data analysis 3

Plugins available on only Thermo Fisher cloud 251

reads, plotted using log10 of those counts. For this plot, barcodes will be omitted if
they have less than 100,000 total reads.

Gene Representation Heatmap
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Representation: log10{RPM+1)

Isoform heatmap

A transcript isoform representation heatmap of up to 250 gene transcript isoforms
showing the most variation in representation across barcodes as measured by the
coefficient of variation (CV) of FPKM values for isoforms that have an FKPM value >
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100 for at least one barcode, plotted using log10 of FKPM+1. Barcodes are excluded if
they have less than 1,000 isoforms detected at FPKM values > 0.3.

Transcript Isoform Representation Heatmap
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Analysis files that are generated in the Torrent Suite™ Software can be directly
transferred to an organization in Ion Reporter™ Software with the
IonReporterUploader plugin.

™

Ion Reporter™ Software uses the Torrent Suite™ Software output BAM file for analysis.
The Ion Reporter™ Software annotation-only workflow also accepts the VCF output
file of the variantCaller plugin. Use the IonReporterUploader plugin to transfer these

™

BAM and VCF output files to Ion Reporter™ Software.

There are two ways to run the IonReporterUploader plugin:

* Configure the IonReporterUploader plugin to run by default after every
sequencing run. Torrent Suite™ Software results files are transferred to Ion
Reporter™ Software and are defined as samples in Ion Reporter™ Software when

the plugin is run manually.

* Run the plugin manually. Results files are also defined as samples in Ion
Reporter™ Software when the IonReporterUploader plugin is run as part of a
Planned Run or Run template. In addition, the workflow of your choice Ion

Reporter™ Software is automatically launched on your newly transferred samples
Ion Reporter™ Software.

T™

The Ion Reporter™ Software is not included with Torrent Suite™ Software and is
available under separate license. Before you run the IonReporterUploader plugin, you
must add a valid Ion Reporter™ Software account.

™

Note: When the IonReporterUploader plugin defines samples in Torrent Suite
Software for your newly-transferred files, the plugin also defines sample relationships
for paired and trio samples and defines sample attributes. For details, see “Sample
gender” on page 182
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Transfer limitations

Transfer limitations

The IonReporterUploader plugin transfers results files for a completed run plan that
executed on the Torrent Server where the plugin is configured. The following
limitations apply to the IonReporterUploader plugin:

* You cannot add supplemental files to the results files of a run, to have the plugin
transfer those files.

e For barcoded runs:

— For sequencing runs that use barcoded data, the IonReporterUploader plugin
only transfers samples if the barcode kit selection is correct. If you correct or
add the barcode kit selection on the sequencing instrument, the
IonReporterUploader plugin still uses the original run plan information and
the results file transfer fails.

— For manual launches of the IonReporterUploader plugin on barcoded data,
the IonReporterUploader plugin uses the barcode kit that you select on the
sequencing instrument.

Install the lonReporterUploader plugin on your Torrent Server

172

The IonReporterUploader plugin is automatically installed on Torrent Server when
you update to a new release.

To update the IonReporterUploader plugin on a Torrent Server that is connected to
the Internet, you can use the off-cycle plugin upgrade process. For details, see “Enable
off-cycle product updates” on page 305 and “Update off-cycle release plugins” on
page 306.

If you do not have an internet connection, then download and install the latest version
that is named IonReporterUploader <version>.deb from http://
iru.ionreporter.thermofisher.com/.

Note: An administrative ionadmin account is not required for this procedure.

™

1. Sign in to Ion Reporter
Reporter Uploader.

Software, then click Settings (%) » Download Ion

lon Reporter

e m m m

Dashboard

2. Click the filename IonReporterUploader.zip, then download the file to your local
machine.

Plugins

3. Sign in to Torrent Suite™ Software, then click Settings (%) » Plugins.
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4. Click Install or Upgrade Plugin.

5. Click Upload a Plugin file, then browse to the IonReporterUploader.zip file that
you downloaded. Click Open, click Upload, then Install.

Set up an account for lonReporterUploader plugin

Before you use the IonReporterUploader plugin, you must configure it with a valid
Ion Reporter Software account. Torrent Suite Software uses the account information
to transfer analysis files to an Ion Reporter Software organization.

You can add more than one account for the IonReporterUploader plugin. When you
add multiple accounts, any available account can be selected when the plugin is run.
You can then upload the Torrent Suite” Software output files to more than one Ion
ReporterTM Software account.

IMPORTANT! When you upgrade to a new version of Ion Reporter  Software you
must reconfigure your IonReporterUploader plugin with a Ton Reporter  Software
account that is set up for the new version of Ion Reporter ~ Software. This account
must be set up before you can access the lonReporterUploader plugin from the
updated software,

1. Sign in to Torrent Suite™ Software as either an Administrative user (ionadmin)
or a standard user.

2. Click Settings (¥#) » Ion Reporter Configure:

Plugins

lon Mesh

Configure

i g
A

counts

Updates

The Ion Reporter™ Uploader account configuration screen opens.

3. Click Add Account, then select an account type:

Option Description
lon Reporter” Software on Thermo Fisher Cloud Select lon Reporter Cloud
lon Reporter” Software on lon Reporter” Server Select lon Reporter
lon Reporter” Software on Thermo Fisher Cloud— | Select lon Reporter Cloud -
China version China

4. In the Add Ion Reporter account screen:

a. Enter your name and password. The Server and Port fields are pre-
populated.
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b. Enter this information for the hosted cloud Ion Reporter™ Software solution:

Setting Description
Server Type Enable HTTPS.

Display Name Enter a name of your choice for the
account. This name can be selected
when you configure a run plan template
or run the lon Reporter Uploader plugin
manually. Use only the alphanumeric,
dash, underscore, and space characters.

Server Enter:
40.dataloader.ionreporter.iontorrent.com,
or the address for your local lon
Reporter” Software server.

Port Enter: 443

Username Enter your lon Reporter Software
username (your email address)

Password Enter the password you use to Sign in to
lon Reporter” Software

™

Note: For alocal Ion Reporter™ Server, these entries depend on the system
configuration. Ask your local Ion Reporter™ Server system administrator for
values for: Server Type (HTTP or HTTPS), Server, and Port.

5. Select one of the following options:

* Default Account The account that is configured by default in the run
templates and run plans. If the main account is for file transfers, enable the
Default Account checkbox. You can change the default account later when
you use the run plan template wizard, or the Upload to IR link.

¢ Get Versions Select an available version of the software.

™

Note: This option is available if multiple versions of Ion Reporter™ Software are
available and multiple accounts are configured.

6. Click Add.

7. (Optional) The IonReporterUploader plugin can manage multiple configurations.
To add another configuration, repeat the process.
Two email notifications are sent each time that a lonReporterUploader plugin
finishes a run. The first is sent when the plugin run starts. Another is sent when
the upload to Ion Reporter™ Software is finished. The notifications are sent to the
email address of the Ion Reporter™ Software user whose is signed in when the
IonReporterUploader plugin is launched.

When at least one account is successfully configured, the IonReporterUploader plugin
is ready to transfer files and launch Ion Reporter ~ Software analyses. If you set up
multiple accounts, there is list of accounts for: data transfers, planned run creation,
manual runs of the plugins, and the Upload to IR link in the Run Summary.
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When you change your Ion Reporter™ Software account password or upgrade the
account, you can see the status column of the Ion Reporter™ Uploader account.

I T = -

lon Reporter Configure

lon Reporter Uploader account configuration

4 Add Account v

Name Default Status. Edit
prod.ion (Version: 4.0 | User: Dayu Yang | Org: LifeTech_Test) ® @

UAT (Version: 4.0 | User: lon User | Org: IR Org) E ]

If you changed your password, click Edit and enter your new password.

If you upgraded your account to a new version, click Edit, then delete your old
account and create a new account for the new version.

If IonReporterUploader plugin is not yet configured to transfer to your Ion Reporter™
Software organization, you can add an account and configure the plugin.

If any of the following circumstances occur, you must add an Ion Reporter™ Software
account:
® There is no account to select when you add the IonReporterUploader plugin to a
Planned Run, or a run template.
If you click Ion Reporter in the workflow bar or if you select None, the Ion
Reporter™ Software workflow selection menu does not appear. Also, Ion
Reporter™ Software accounts are not listed.

Flan Runs Samples Templates Flanned Run

Plan

lonReporter Application Kits

Select the lonReporter workflow to use. o

@ Mone Sample
Grouping

For details on how to configure the account, see “Run a plugin manually from the
sequencing run report” on page 118.
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e If you try to configure it globally, you are prompted to add an Ion Reporter™
Software account.

Configure

lon Reporter Uploader account configuration & Add Account

At least one lon Reporter account is needed. Please add one now.

Close

For details on how to configure the account, see “Configure plugins globally” on
page 116.

¢ If you click the plugin name for a manual run, there are no accounts listed under
Select Ion Reporter account.

Fat
Selectlon Reporter account
Upload Options : O bam anly
O vt anly
& wvofand bam
W
£ >
X

For details on how to configure the account, see “Run a plugin manually from the
sequencing run report” on page 118.
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lonReporterUploader plugin configuration

The following settings are configured when you set up accounts for the

IonReporterUploader plugin:

Setting

Description

Server Type

Enable HTTPS.

Display Name

Enter a name of your choice. This name can
be selected when a run plan template is
created or edited and is visible to other
Torrent Browser users. Use only the
alphanumeric, dash, underscore, and space

characters.
Server Enter:
40.dataloader.ionreporter.iontorrent.com
Port Enter: 443
Username Enter your lon Reporterw Software
username (your email address)
Password Enter the password you use to sign in to lon
Reporter ~ Software
Default Enable if this account is for automatic
analyses in lon Reporter™ Software.
Version Select the version for use with each

account.

The following settings can be configured when you run the IonReporterUploader

plugin manually:

Note: You can select barcodes for the samples or samples that were used in the
sequencing run. By selecting these barcodes, you can select which samples that you
want to upload to Ton Reporter Software. For details, see “Run IonReporterUploader
plugin manually” on page 178.

Setting

Description

Barcode Sample Settings

Select the barcodes for the sample or samples used in the
sequencing run that you want to upload to lon Reporter”
Software.

Select lon Reporter™
Software account

Select the lon Reporter” Software account that you will
use to upload files to lon Reporter™ Software

Upload Options

BAM

Select this option to upload BAM files only

VCF

Select this option to upload VCF files only

BAM and VCF

Select this option to upload both BAM and VCF files

Torrent Suite™ Software 5.6 Help
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22e Run lonReporterUploader plugin manually
Setting Description
Advanced Settings For details on these settings, see “Tune lon Reporter Software
speed parameters” on page 178.
Number of Parallel Set the Number of Parallel Streams to Default (the
Streams recommended optimal speed) or select 1-5 to slow down
upload
File Segment Size Set File Segment Size to Default (recommended), or 16MB,
32MB, 64MB, or 128MB
Tune lon You can adjust speed parameters for the Ion Reporter  Software plugin to change the
Reporte r rate at which files are uploaded.
Software speed Note: Update these settings only if file transfers from Ion Reporter  Software plugin
parameters are difficult or slow with the default settings.

T™

1. In Torrent Suite™ Software, in the Data tab, click Completed Runs & Reports.

2. Click Plugins » Select Plugins to Run, then select IonReporterUploader.

3. Click Advanced Settings.

a. Set the Number of Parallel Streams to Default (the recommended optimal
speed) or select 1-5 to slow down upload.

Click here to leam about the Advanced setfing attributes

- Advanced Settings

Number of Parallel Streams Default v

File Segment Size Default v

b. Set File Segment Size to Default (recommended), or 16MB, 32MB, 64MB, or
128MB.

Run lonReporterUploader plugin manually

You can run IonReporterUploader plugin manually from a completed run report in
Torrent Suite Software. This process transfers data from a completed sequencing run
to Ion Reporter Software.

When you run the plugin manually, you can select whether to upload only VCF files,
BAM files, or both VCF and BAM files. You might want to run IonReporterUploader
plugin manually if after a sequencing run is completed, for example, you want to
annotate variants only and therefore upload only VCF files. This option is not
available when the plugin is run from the Planned Run or run template; instead both
BAM and VCF files are uploaded to Ton Reporter  Software.
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You can also see the barcoded samples that were used the sequencing run. You have
the option to upload any barcoded sample that includes a sample name.

1.

Torrent Suite™ Software 5.6 Help

In the Data tab, click Completed Runs & Reports, then click the Report Name
link for your completed sequencing run.

Click Plugins » Select Plugins to Run link, then select lonReporterUploader .

For runs that include barcoded samples, click Barcode Sample Settings.
You can select one or more samples to upload to Torrent Suite™ Software.

IMPORTANT! To upload a sample with a barcode, the barcode must include a
Sample name. If you select a barcode for a sample that is not named,
IonReporterUploader will not upload the sample.

a. Select the checkbox for barcodes for the sample or samples that you want to
upload. By default, all samples that include sample names are selected for
upload.

(Optional) To adjust speed parameters Ion Reporter™ Uploader that change the
rate at which files are uploaded, click Advanced Settings.

a. Set the Number of Parallel Streams to Default (the recommended optimal
speed) or select 1-5 to slow down upload.

b. Set File Segment Size to Default (recommended), or 16MB, 32MB, 64MB, or
128MB.

In the Upload Options section of the Select Ion Reporter account dialog, select
the file types that you want to upload: BAM, VCF, or BAM and VCF. Then click
Launch IRU in the row next to the Ion Reporter™ Software account that you want
to use for the upload.

Click Yes to confirm that you want to upload the data.

Your upload begins. Upload times vary depending on the speed of your internet
connection and the size of the dataset being transferred. You will receive an email
notification when the upload is complete. When the upload completes, you can

™

sign in to Ion Reporter™ Software, then launch an analysis on the new datasets.
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Automatically transfer Torrent Suite” Software output to lon
Reporter  Software

To transfer output files from a Torrent Suite Software analysis to Torrent Suite
Software automatically, configure the IonReporterUploader plugin when you create a
Planned Run.

Your results files are transferred to Ion Reporter  Software and defined as samples.
Your selection of Ion Reporter = Software workflow is automatically launched on your
newly transferred samples.

Note: The IonReporterUploader plugin must be added to a Planned Run, or run
manually.

For sequencing runs that use barcoded data, select the correct barcode kit under Kits
in the workflow bar. When you select a barcode kit, a sample name field for each
barcode is generated.

We recommend that you use the plan by sample set feature when you configure the
Ton Reporter  Software in your Planned Run or template. For details, see “Plan by
sample set” on page 33.

1. In the Plan tab, click Templates, then in the Favorites list, select an application.
For example, AmpliSeq DNA.

2. Select a template that matches your panel. For instance, if you are using an Ion
AmpliSeq™ Exome Panel, select the AmpliSeq" DNA template with the same
name.

3. Add samples, ensure the default settings, then enter a plan name, then select Ion
Reporter in the workflow bar.

Fan m - ﬂ n

Create Plan from IC540_ AmpliSeqExome_05152017
View Report Log
View Report Log

Create Plan lon Reporter

Select an lon Reporter account, workflow and sample grouping, then hit next. Summary b
3 Refrash # Configure.
lon Reporter: Mone
| lon Reporter Account Sample P
Grouping Research Application:  DNA
® Mone -
balrog (version: 4.2 | User: lon User | Org: IR Org Sample_Control Research Category:
| ir-ioneast pversion Self Sample Grouping:
ir-ionwesf umor_Normal Target Technique: AmpliSeq Exome

ir-maitai1 version e lon Reporter Workflow:

Other

N . lon Reporter Upload
DNA and Fusions Options:

Single Fusicns

SEND FEEDBACK
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If multiple Ion Reporter™ Software accounts are available, select the account that
you want to use for the transfer of analysis files to Ion Reporter™ Software. The
selected account is the one that you will use to view and further analyze the files

in Ion Reporter™ Software.

Note: To add another Ion Reporter™ Software account, click Configure, then use
the steps in “Set up an account for IonReporterUploader plugin” on page 173.

Select a Sample Grouping that corresponds to the sample relationship in Ion
Reporter™ Software. When you select a Sample Grouping, the workflow menu
in Ion Reporter™ Software displays only workflows that match the type of
workflows selected.

In the Existing Workflow menu, select your Ion Reporter™ Software analysis
type. When you select a workflow from this menu, the Sample Grouping
sections show the sample relationship that is required by that workflow.

(Optional) Click Create New Workflow to open Ion Reporter™ Software in a new
browser window. In Ion Reporter™ Software, create your new workflow, then
save it.

When you return to your Torrent Suite™ Software, refresh your browser. You can
then select the newly created workflow in the Existing Workflow menu.

Click Kits in the workflow bar to select the following;:

a. Chip Type (required). If the template contains the chip type, that
information is pre-populated in the Chip Type field. Otherwise, select the
Chip Type.

b. If your sequencing run uses a barcode kit, select that kit. Based on your
barcode kit selection, a sample field for each barcode is added to Plan in the
workflow bar.

If appropriate, enter the gender of a sample. For details, see “Sample gender” on
page 182.

Note: If the gender of a sample is not specified or if the sample gender is
specified as "Unknown", IGV assumes that the gender of a sample is female.

To save the Planned Run or Planned Run template, do one of the following in the
workflow bar:

¢ (lick Save for a new Planned Run template, enter the new template name,
and optionally mark it as a favorite.

* (lick Save & Finish if you used Plan by sample set, then enter the new
Planned Run name.

e (lick Plan Run for a new Planned Run, then enter the new run plan name
and sample information.

The Planned Run is ready to run on your sequencing system.
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You can reduce the number of Ion Reporter  Software workflows that are listed when
you create a Planned Run or Run template during in Torrent Suite” Software. To do
so, use the Tag for IRU label in Ion Reporter Software.

None

Create Plan lonReporter

Select an lonReporter account and workflow to use:o £

IMaitai (Version: 4.6 | User: lon User | Org: IR Org)

maitai1.chd (Version: 4.6 | User: lon User | Org: IR Org)

® ir-carlsbad (Version: 4.4 | User: lon User | Org: IR Org)

think1 (Version: 5.0 | User: lon User | Org: IR Org)

@ Existing Workflow

ReproSeq_Veriin_JMK-base_WF_4-23-- v

L)

4.

Create New Workflow

Sign into Ion Reporter™ Software .

In the Workflows tab, click Overview.

Sample Grouping

® Self

Tumor_Normal
Trio

Sample_Control

Select a workflow, then click Actions » Tag for IRU.

ﬁi(; Workflows

Application v | Workflow -

Target v | Group v | \Version

Workflow Name

Search

& | ontorrent Application Version Sample Group Modified On Details
vl H Aneuploiay Custom LGWG Aneuploidy sonal 50 Single Aug 18 2015

02:49 PM

H Aneuploiay TestReproSeq LOWG Aneuploidy workflow sonal 50 Single Aug 19 2015 & DNA
02:45 PM

8 DNA NO_PLUGINS_ALLOWED_oDSOTWWWilyujDX05Rrc 50 Single Aug 192015 DGMUKXWKZ
01:57 P DDahNAIYIE Ml

8 DNA testThatapplicationTypesAreReadOnlygnZdvmngmC 50 Single Aug 192015 e
01:56 PM

NO_PLUGINS_A  Edit

Tag for IRU

Create Workfl

o L

Copy

Delete

Launch Analysis

Lock

The Tag for IRU in the Details section for the workflow is changed to Yes. Only
the Tag for IRU workflows are listed when you plan instrument runs in Torrent

Suite™ Software.

To undo, select Untag for IRU.

Several workflows in Ion Reporter ~ Software, especially copy number variation
detection and genetic disease screening (GDS), are limited when the sample gender is
unknown, and they return unexpected results when the gender is incorrectly
specified.

For example, in the GDS workflow, when the gender of the proband is not known,
variants cannot be assigned in the categories HasMaleMaternalX and HasUnknownX.

If a sample with no gender was transferred from Torrent Suite” Software to Ion
Reporter  Software, go to the Sample » Sample Management screen in Ion Reporter
Software and edit the sample to specify the gender attribute.
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Note:

- You cannot edit samples that have been launched in an Ion Reporter  Software
analysis. Instead, define new samples from the raw data files, and add the correct
gender metadata to the new samples.

- If the gender of the sample is not specified or specified as "Unknown", the
Integrative Genomics Viewer (IGV) uses female as the gender.

You can set an option to review the results of a lonReporterUploader plugin run,

results option in before data is transferred to Torrent Suite” Software. When you set this option in the

Run template

Torrent Suite™

Planned Run template, you can review the details about the file transfer, then
manually upload the data to Ion Reporter  Software. Use this procedure to change
the setting in a Planned Run template, then reanalyze the run and use the Review
results option.

1. In the Plan tab, click Templates, then click the template of interest.

2. In the Ion Reporter workflow bar, select your Ion Reporter server or cloud
account.
Note: If no Ion Reporter account is listed, see “Set up an account for

IonReporterUploader plugin” on page 173.

3. Select an existing workflow, then select Review results after run completion,
then upload to Ion Reporter.

Create Plan lon Reporter
Select an lon Reporter account, workflow and sample grouping, then hit next. £ Refresh || J Configure
lon Reporter Account Sample Grouping
Mone Self
balrog (wersian: 4.2 | User lon Liser | Crg: IR © Tumor_Mormal

% ir-ioneast perion oy Trio

- Zample o
ir-ionwest peersion Sample_Control

on Reperter Upload Opticns

SF_=a S (Wersion: 4.5 | User: Dalla COhingra | Ong: ApplicationsTeam) . - N
—BRPS | e Review results after run completion, then upload to lon Reporter *
SF_apps_2 (verelon: £.4 | Usar: langing zhang | ¢ pilcailans Team) - - -
SF_apps_2 (version: T: Janging zhang SansTeam)| ® Automatically uplead te lon Reporter after run completion
*“Wthen you a
OExisting Workflow "Upload to IR —=

Upload Only v

Create New Workflow o Refresh List

4. Make any other required changes, name your template, then click Save, then
Finish.

5. In the Plan tab, click Templates, find your new template, click Settings
(¥¥) » Plan Run.
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6. Execute the run on the sequencer.

After run is completed, the Plugin report indicates that the IonReporterUploader
plugin status as completed. See “View plugin run status” on page 118 for details.

IMPORTANT! To proceed with the IonReporterUploader upload, you must do
the next steps.

a. In the Data tab, click Completed Runs & Reports.

b. In the list of runs, find the run of interest, then click the link in the Report
Name column.

c. In the left navigation menu, click IonReporterUploader to view the plugin
results.

d. Review the Run results. If results are acceptable, click Upload to
IR » Upload as Planned.

“ m ot m n

Completed Runs & Results

Output Files Plugin Summary Upload to IR + Report Actions v Reports~

Run Summary: R_2013_02_18_15_06_59_user_C22-686-R165720-314 HSMgl |
Reports : | Reanalyze_SP_C224 - §(438) v
Configure IR accounts
Notes OT2 058b03_12 Lib7555 200bp 053a01_12 314TIN
Read Summary: Unaligned
A confirmation dialog appears.
* Select Yes to upload as planned.
* Select No to cancel.
¢ Select Review-Plan to look at the run results.
Set Review You can set an option to review the results of a IlonReporterUploader plugin run,
. . ™ . . . .
results option in before data is transferred to Torrent Suite = Software. With this option, you can review

the details about the file transfer, then manually upload the data to Ion Reporter
Software. Use this procedure to change the setting in an existing Planned Run, then
reanalyze the run and use the Review results option.

Planned Run

1. In the Data tab, click Completed Runs & Reports.

2. In the list of runs, find the run of interest, then click the link in the Report Name
column.

3. Click Report Actions » Edit Run Plan.

4. Click Ion Reporter in the workflow bar, then select your Ion Reporter™ Server or
cloud account.
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5. Note: If no Ion Reporter account is listed, see “Set up an account for
IonReporterUploader plugin® on page 173.

Select an existing workflow, then select Review results after run completion,
then upload to Ion Reporter.

Edit Run lon Reporter Research Application Kits Plugins
Select an lon Reporter account, workflow and sample grouping, then hit next. S Refresh | Configure
lon Reporter Account Sample Grouping
Mone Tumer_Mormal
® balrog (version Self
ir-ioneast e Trio

= 0
ir-ionwest pve Sample_Control

Q ir-maitail jvereion lon Reporter Upload Options:
S5F_apps

an: 4.6 F-lonAgplications Team

® Review results after run completion, then upload to lon Reporter =
SSF_apps_2 (version: 4.4 | Usar: Jlanping zhang | Org: SSF-lonApplications Tezm)

Autemnatically upload to len Reporter after run completion

@Existing Workflow
Upload Only v

Create New Workflow £ Refrech List

Next —

6. Make any other necessary changes, then click Update Run & Reanalyze.

After run is completed, the Plugin report indicates that the IonReporterUploader
plugin status is complete. See “View plugin run status” on page 118 for details.

IMPORTANT! To proceed with the IonReporterUploader upload, you must do
the next steps.

a. In the Data tab, click Completed Runs & Reports.

b. In the list of runs, find the run of interest, then click the link in the Report
Name column.

c. In the left navigation menu, click IonReporterUploader to view the plugin
results.

d. Review the Run results. If results are acceptable, click Upload to
IR » Upload as Planned.

“ ot m n

Completed Runs & Results

Output Files  Plugin Summary UploadtolR~  ReportActions~  Reports=

Upload as Planned

cleanirs2 |
Reports : | Reanalyze_SP_C22.| 5 (438) -

Configure IR accounts
Notes OT2 058b03_12 Lib7555 200bp 053a01_12 314TIN

Read Summary: Unaligned
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A confirmation dialog appears.

¢ Select Yes to upload as planned.

e Select No to cancel.

¢ Select Review-Plan to look at the run results.

lonReporterUploader plugin file transfer progress

You can monitor the progress of the transfer of analysis results files from Torrent

Suite” Software to Ion Reporter  Software.

To monitor lonReporterUploader plugin
progress through the following

See the following

Email

The two email notifications for sent for each
plugin run:
e When the plugin starts to transfer your
files

e When the upload to lon Reporter”™
Software is finished

The notifications are sent to the email
address of the lon Reporter” Software user
whose authentication token was used to
configure the plugin.

Torrent Suite" Software

See the Torrent Suite” Software Help

Log files

“Open a plugin log” on page 119

186

Torrent Suite™ Software 5.6 Help



Integration with lon Reporter™ Software [
Review lonReporterUploader plugin results

2l

e

View You can view a list of the run reports on which the IonReporterUploader plugin has
lonReporterUploa been run, the plugin completion status, and the sizes of the plugin output.

der F_’l-ug in status 1. Sign in to Torrent Suite™ Software.

details

2. Click Settings () » Plugins. The installed plugins are listed.

3. Click Settings (%F)Usage for IonReporterUploader plugin:

Enabled Disabled Either Clear
Enabled Name
" varianiCaller
"] RunTransfer
" ampliSeqRNA
"] lonReporterUploader Updates Available!
" smallRNA
"] samplelD
rd coverageAnalysis
"] DataExport
] PGxAnalvsis

You can view the following information from the list of run reports:

¢ Time that the plugin runs started and ended.

¢ Status of the plugin run.

* Size of the plugin run result output files.

Selected by

Default

Version

5604

5606

5603

56030

5600

AAENN

Installed
Date v

Aug 10 2017

Aug 10 2017

Aug 10 2017

Aug 10 2017

Aug 12017

Jul 212017

Jul 212017

Jul 212017

ul 212017

lon Supported

Ye

Ye

Rescan
Configure
Uparade to Latest
nstall 5.2.0 68
nstall 5.2.1.0
nstall 52.1.2

nstall 5.4.0.41

Manage

Delete

lonReporterUploa  report for a run and cannot be undone.

IMPORTANT! This action permanently deletes the IonReporterUploader plugin

der plugin report

files For details, see “Delete a plugin result” on page 119.

Review lonReporterUploader plugin results

1. In the Data tab, click Completed Runs & Reports.

2. In the list of runs, find the run of interest, then click the link in the Report Name

column.

3. In the left navigation menu, click IonReporterUploader to view the plugin

results.
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4. From the IonReporterUploader, you can view information related to the data

transfer, including the name of the Ion Reporter™

Server used, the version of Ion

Reporter™ Software that is on the server, the server directory that contains the
uploaded files and the Ion Reporter™ Software organization and user account
that was used. You can also review details about barcoded samples that were

uploaded with IonReporterUploader, or failed to upload.

To do this Click
View errors messages associated with the plugin run. Errors
View warnings that contain details about the barcoded Warnings

samples used in the plugin run.

Show or hide a detailed status of the pre- and post-
processing of the data transfer.

Show detailed
status/Hide detailed
status

Open a report the data transfer in a separate browser tab. Stdout
Open the plugin log files in a separate browser tab. Log
Openastartplugin. json file that contains metadata Input

used by the plugin.

Download a CSV file that contains a list of the uploaded and
defined samples.

Download CSV list of
samples that are
uploaded and defined
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To do this Click
Download lonReporterUploader of the plugin log files and Download IRU logs
other plugin files.
Plugins
lonReporterUploader 56030 (2535256 Viewlog  Delete
Completed 216 kB
Server Name: dxir-30-28.chbd
IR Wersion: IR 5.8
Upload Folder Path: idstal|Ridats’|R_Crg/dataRU_Uploads/2017-8-18_13_42_1A1
User: lonlser
Org: IR Org
Status: Completed
Errors{1]
Warnings(2)
T5 Sample Name IR Sample Name Size Status Validity
PBL_panel kot2_1 PBL_panal kot2_1_RNA_w3 1.44 GB Completed alid
PEL_panel kot2_1 PEL_panel lot2_1_RNA_VCF_v3 Failed Irvalid
PBL_pane k2 2 PEL_pand lot2 2 RMNA_ w3 Failed Irnvalid
PBEL_p=nel ot1_2 PEL_p=nel lot1_2_RMNA&_WCF_v3 Failed Irmvalic
PBL_pane kot1_1 PEL_pand lot1_1_RMA_VCF_vE Failed Imvalid
PBL_panel kot1_2 PEL_panel lot1_2_RMNA_w3 127 GB Completed alid
PEL_panel kot2_Z PEL_panel lot2 2 RNA VCF_v3 Failed Irvalid
PBL_pane kbot1_1 PEL_pansl lot1_1_RNA_vE 1.43 GB Completed Valid
Detailed Status
Stage Status Stdout Log Input Output
pre Complated Stdout [§ Log (% Input &
post Completed Stdout (5 Log (% Input (%
g Download CEV list of samples that are uploaded and defined.
@ Download IRU logs
Hide datailad status &
. ™ . . . ™ o .
Torrent Suite Typically the BAM file output of your Torrent Suite = Software analysis is uploaded to
™ ™ .
Software output Ion. Reporicer' S(;lftware and then Ion Reporter = Software runs through the following
™ major analysis ases:
and lon Reporter J ysisp
Software analysis 1. Mapping
phases 2. Variant calling

3. Annotation
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This table shows how Torrent Suite” Software output files are used in Ion Reporter

Software analyses:

Torrent Suite Software
output file

Output from this Torrent
Suite™ Software analysis
phase

Input to this lon Reporter™
Software workflow

BAM file

TS analysis pipeline

Any except annotation-only

VCF file

TS Variant Caller
(variantCaller) plugin

Annotation-only

The Ion Reporter  Uploader plugin by default uploads both the BAM file and the
VCF file from your Torrent Server to Torrent Suite Software.

The following table describes the input and output file types for the analysis phases:

Analysis phase

Input file type

Output file type

Mapping

BAM file (mapped or
unmapped)

Mapped BAM file

Variant calling

Mapped BAM file

VCF file

Annotation

VCF file (with or without
annotations)

Annotated VCF file

Each output file type is required as input to the next analysis phase. In almost all
cases, the Ion Reporter  Software analysis phases are performed in order.

The exception is the annotation phase. The annotation-only workflow runs this phase
by itself. (All other workflows include the annotation phase as their last analysis
phase.) The annotation-only workflow requires as input a VCF file, which can be
generated from either a Ion Reporter  Software analysis, a Ion Reporter  Software
analysis variantCaller plugin analysis, or a different source.

190
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Rescan a plugin

When you rescan a plugin, the files for the plugin are updated with any changes. For
example, if you uninstalled and reinstalled the plugin, you can rescan the plugin to
ensure that all files from the previous installation were removed.

1. Sign in to Torrent Suite™ Software.

2. Click Settings (%#) » Plugins. The installed plugins are listed.

Enabled  Disabled  Either Clear
Installed
Enabled Name Selected by Default  Version lon Supported Manage
Date v
! variantCaller 5604 Aug 10 2017 Yes [- g
v RunTransfer w 5606 Aug 10 2017 Yes [- 4
"] ampliSegRNA 5603 Aug 10 2017 Yes o~
" lonReporterUploader Updates Available! 5.6.0.30 Aug 10 2017 Yes o~
. ., Usage
rl smallRNA 5600 Aug 12017
¢ samplelD 5601 Jul 21 2017 4  Configure |
Upgrade to Latest
"] coverageAnalysis 5.6.0.1 Jul 21 2017 Ye nstall 5.2.0.66 |
nstall 52.1.0
DataExport 5.6.0.1 Jul 21 2017 Ye
¢ . e nstall 5.2.1.2 |
nstall 5.4.0.41 -
] PGxAnalvsis AANN Jul 21 2017

3. Click Settings (%¥)Rescan.

You cannot complete other operations in Torrent Suite™ Software until the rescan
is complete.

Note: You can also rescan the output files from the list of reports when you view
the usage for a plugin. For details see, “View lonReporterUploader plugin status
details” on page 187.

lon Reporter  Uploader command-line utility

You can use IRU command-line utility to transfer files from a local machine (that is
not an Ion Reporter™ Software server) to the Ion Reporter™ Software server. This
utility can be used if you do not have access to Torrent Suite™ Software, and you have
files on your local machine that you want to transfer. For example, if you have a BAM
or VCF file on your local machine that you want to upload and then analyze the file in
Ion Reporter™ Software.

You can also use IRU command-line utility if you have problems using the plugins in
Torrent Suite™ Software.

The IonReporterUploader command-line utility is a stand-alone utility that is not part
of either Ion Reporter™ Software or the Torrent Browser. This procedure is
recommended only for users who are familiar with the command-line utilities.
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The Command-line Uploader can be run on any of these systems:
¢ Your Torrent Server
e A standard Linux™ machine
* A standard Windows™ (XP or later) machine

e A standard Macintosh™ machine

Note: IonReporterUploader command-line utility supports the upload of combined

™

Ion Reporter™ Software analysis results that are output by the Combine Alignments

option in the Torrent Suite™ Software Projects tab. The IonReporterUploader plugin
does not support uploading these files.

This procedure explains how to download and install the Ion Reporter Uploader
command-line utility from Ton Reporter  Software.

Ideally, download the Ion Reporter Uploader command-line utility onto the machine
where you run it. At a minimum, use a machine with the same operating system.

1. Sign in to Ion Reporter™ Software, then click Settings ({#) » Download Ion
Reporter Uploader.

2. Click the filename IonReporterUploader-cli.zip, then download the file to your
target machine.

3. On your target machine, extract the downloaded IonReporterUploader-cli.zip
file, then copy the IonReporterUploader-cli directory to a convenient location.

The Ion Reporter Uploader command-line utility (irucli) is ready to run after you
extract it. Run the Ion Reporter Uploader command-line utility from the
IonReporterUploader-cli bin directory (with the irucli.bat or irucli.sh script).
Instructions for using the command-line uploader are downloaded with the utility
and with Ion Reporter documentation.
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To call single-nucleotide polymorphisms (SNPs), multi-nucleotide polymorphisms
(MNPs), insertions, deletions (INDELS), and block substitutions in a sample across a
reference or within a targeted subset of that reference in Torrent Suite Software, use
the variantCaller plugin.

This variantCaller plugin provides optimized pre-set parameters for many
experiment types. The settings can also be customized. After you find a parameter
combination that works well on your data and includes the balance of specificity and
sensitivity that you want, you can save that parameter set and reuse it in your
research.

Supported lon AmpliSeq  panels

The variantCaller plugin supports the various panels in the Ton AmpliSeq " family of
sequencing kits. See the AmpliSeq.com website.

Run the variantCaller plugin

There are two ways to run the variantCaller plugin:

¢ Configure the variantCaller plugin as part of the Planned Run or Run template to
run it immediately after primary analysis is complete.

* Run the variantCaller plugin at any time from a completed Run report.

Note: To get variantCaller plugin results as quickly as possible, set up the plugin to
run automatically.
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The configuration options for the variantCaller plugin are described in the following

table.

Note: Changes to parameters can dramatically affect the behavior and sensitivity of
the variantCaller plugin. If you are new to the variantCaller plugin, we recommend
that you do not change parameters.

Note: The variantCaller plugin parameter settings change acglording to the selections
you make. Data from the Ion PGM , Ion Proton , and Ion S5  sequencers require
different default settings. Select settings that are appropriate for both your sequencing
instrument and your experiment.

Setting

Configuration

If you run the the variantCaller plugin manually, you can
apply the same settings to all barcodes, with a saved
configuration. Use the Configuration dropdown list to apply
the settings.

Manage Configurations/Barcodes
Configuratior v Current 6c88827c-1258-44bd-ae91-8a7d2d840e77

human
e-coli
Chip Type: my_config

Click Manage Configurations/Barcodesto review or
change the configurations and barcodes.

Chip Type

Select the chip type that is used in the sequencing run.

Library Type

Select Whole Genome, AmpliSeq or TargetSeq.

When Library Type is set to AmpliSeq, read trimming will
be automatically applied to remove the primers from
reads.

Variant Frequency

Select one of the following choices:

e Somatic: This option detects somatic variants at low
allele frequencies.

e Germline: This option optimize detection of germline
variants that are expected to be present at allele
frequencies of 50 to 100 percent.

AmpliSeq Panel

If the sequencing run used an AmpliSeq panel, you can
select a panel here to automatically add the selections for
Reference Genome, Target Regions, Hotspot Regions, and
Parameter Settings.

Reference Genome

Select a reference genome that the current Run report was
generated against and that is for use with variant calling.
The files that you upload when you configure the
variantCaller plugin must be uploaded to a specific
reference, such as hg19. For details, see “Upload a new
reference file” on page 226.
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Setting

Targeted Regions

Variant calling is restricted to only the regions of interest
that you specify in the targeted regions file.

Note: Before you can use a targeted regions file, it must
be uploaded in the Torrent Browser References and
associated with a specific reference. See “Target Regions
Files and Hotspot Files” on page 231 for details.

If a target regions file is not provided, the variantCaller
plugin analyzes every position of the reference genome,
which typically takes longer. In the case of a whole genome
analysis, variantCaller plugin processes every position that
corresponds to the reference genome.

Hotspot Regions

A hotspots regions file contains a list of alleles on the
genome.

Before you can use a Hotspot Regions file, it must be
uploaded in the Torrent Browser References and
associated with a specific reference. See “Target Regions
Files and Hotspot Files” on page 231 for details.

When a hotspot regions file is used, the alleles listed in the
hotspots regions file at the position will be generated as
variant candidates, then be evaluated. variantCaller plugin
output files include these alleles whether or not a variant
is called, and include evidence for a variant and the
filtering thresholds that disqualified a variant candidate.
The filtering metrics for each allele are reported in the
output VCF file, including for NOCALL.
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Setting

Parameter Settings You can use advanced parameter settings that are pre-
configured in the variantCaller plugin, or you can
customize parameter settings.

e The variantCaller plugin provides these defaults that
are optimized for several experiment types. Select
Generic to use pre-configured parameter settings for
Chip Type, Library Type and Variant Frequency.

e Select Custom to change the advanced parameter
settings. For details see “variantCaller plugin
advanced parameters” on page 212.

e Germ Line - Low Stringency Optimized for high
frequency variants and minimal false negative calls
for lon AmpliSeq™ experiments.

¢ Somatic - Low Stringency Optimized for low
frequency variant detection with minimal false
negative calls lon AmpliSeq" experiments.

e Germ Line - TargetSeq Low Stringency Optimized for
high frequency variants and minimal false negative
calls. (lon Proton™ data only).

For lon AmpliSeq™ experiments, when you import your
template from AmpliSeq.com, your template and run plans
are already pre-configured with parameters that are
optimized for your panel.

Load external parameter You can import a file that contains parameter settings that
file are optimized for fixed panels and community panels in
ampliseq.com. (Optimized parameter sets for on-demand
panels are not supported in this release.) Click Custom
Settings Choose File to upload a custom parameters file.

You can also download the parameters used in a
variantCaller run and then either customize those
parameters or reuse them in future variantCaller runs.
The parameters file is a JSON text file of the variantCaller
parameter values.

Configuration Name You can name and save a configuration if you have made
changes to the pre-configured settings, or have used the
Advanced Settings.

You can save configurations settings for the variantCaller plugin and apply the
configuration later when you run the plugin manually. For barcoded runs, you can
save a variantCaller plugin configuration that applies to all barcodes. You can also
temporarily apply one or more saved configurations to individual barcodes. When
you apply a saved configuration to individual barcodes, you must run the plugin
when you apply the configurations. Configurations applied to individual barcodes
cannot be saved.

Torrent Suite™ Software 5.6 Help



0]
285
=g

Variant calls in Torrent Suite Software
Run the variantCaller plugin

Create or modify a configuration for the variantCaller plugin

When you run the variantCaller plugin manually, you can configure and save a
barcode configuration setting so that you can reuse the configuration for other

sequencing runs.

1. Inthe Data tab, click Completed Runs & Reports, then click the Report Name
for the sequencing run of interest.

2. Click Plugins » Select Plugins to Run.

3. Select the variantCaller plugin. The variantCaller plugin configuration screen
opens.

Select a Plugin to Run

Torrent Variant Caller 5.6

Configuration: | ‘Current ¢ 1b57F-8596-4989- bad-7833b36D6515 v Manage Configurations/Barccdes
Chip Type: Proton P
Library Type: AmpliSeq
Variant Frequency: Germ Line
AmpliSeq Panel: Unspacified - Add pane
Reference Genome: hg18@ - Homo sspiens
Targeted Regions: AmpliSeqExome 20141112 designed - Add targets.
Hotspot Regions: Mone - Add hotspots...

Parameter Settings: v Stringency

Load extamsl parameter file

Show Advanced Settings w

Configuration Name:

sufficient statistical evi support calling a SNP or INDEL at a given position.
gions are defined, TVC includes their positions in the report, even if variants have not

Get more information by visifing Torrent Variant Caller Documentation.

4. Click Manage Configurations/Barcodes. In the Configuration tab, you can add a
new configuration or edit an existing configuration:

¢ (lick Add to add a new plugin configuration. Name the configuration, then
select settings for that configuration.

¢ C(lick the Edit link to modify an existing plugin configuration. Change the
configuration settings. You can modify Chip and Library types, variant
frequency, reference genome, targeted, and hotspots regions and parameter
settings. You can also click Show Advanced Settings and adjust variant
detection and alignment parameters.

5. Click Save.

Torrent Suite™ Software 5.6 Help 197
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If you create a new configuration, it is added to the list on the Configuration tab. An
existing configuration reflects the changes that you made. You can now apply the
configurations when you run the variantCaller plugin manually. See “Run the
variantCaller plugin manually” on page 199 for details.

To run the variantCaller plugin automatically after the Torrent Suite " analysis
completes, configure the vvariantCaller plugin when you create a Planned Run or
Run template.

IMPORTANT! The variantCaller plugin parameter settings are saved in Run
templates but are not saved in Planned Runs. Parameter changes that you make in a
Planned Run affect only that specific run. When you change variantCaller plugin
parameter settings in a Run template, your changes affect all users who create run
plans from that template.

1. During the plugin step in the Workflow bar of the Planned Run or Planned Run
template, select the variantCaller checkbox, then click the Configure link next to
the variantCaller listing:

T

Select plugins to execute, then click Next. SelectAll | Clear Summary
ampliSeqRNA ERCC_Analysis PGxAnalysis
AssemblerSPAdes FieldSupport RNASegAnalysis lon Reporter: None
CloudUpload FileExporter RunTransfer Application: DNA
w coverageAnalysis Configure | FilterDuplicates samplelD Application Category:
DataExport immuneResponseRNA  variantCaller Configure RO G
Target Technique: Other
lon Reporter Workflow:
oous lon Reporter Upload
Options:

2. Make your changes to the parameter values available in the variantCaller
configuration screen. For details, see “variantCaller plugin configuration” on
page 194.

Save Plugin Settings || Cancel

Torrent Variant Caller 5.6

Chip Type: 540 -
Library Type: AmpliSeq -
Variant Frequency:

Parameter Settings:

Load extemal parameter file

Show Advanced Setfings w

Ahout Torrent Variant Caller

ference base to deduce whether there is sufficient statistic rt calling a SNP or INDEL at a
eir positions in the report, even if varian

t of the genome by defining targsted regions. If hotspot regions are defined, TVG includss the

Get more information by visiting Torrent Variant Galler Documentation

3. (Optional) Click Show Advanced Settings, then customize additional parameters.

Torrent Suite™ Software 5.6 Help
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4. Click Save Changes.

Note: The settings for the reference genome file, target regions file, and hotspots
file that are used in the Planned Run are used for all barcoded samples on the
chip when the variantCaller plugin is run automatically. When you configure the
variantCaller plugin in a Planned Run, you cannot change the reference genome
file, target regions file, or hotspots file for any barcoded sample. The parameter
file for the Planned Run will be applied to all barcodes.

To use a different reference genome file, target regions file, or hotspots file, for
one or more barcodes, or if you want to apply different parameter files for each
barcode, you must run the variantCaller plugin manually.

You can start the variantCaller plugin from a completed run report. If the sequencing
run includes barcodes, you can apply one configuration that you saved previously all
barcodes, or you can apply a different configuration individual barcodes.

1.

In the Data tab, click Completed Runs & Reports, then click the Report Name
for the completed sequencing Run of interest.

Click Plugins » Select Plugins to Run.

Select the variantCaller plugin. The variantCaller plugin configuration screen
opens.

Select a Plugin to Run

Torrent Variant Caller 5.6

Configuration: | ‘Current ¢ 1b7F-8596-4989- blad-7833b3606515 v Manage Configurations/Barccdes
Chip Type: Proton P
Library Type: AmpliSeq
Variant Frequency: Germ Line
AmpliSeq Panel: Unspecified - Add panel...
Reference Genome: hg1@ - Homo sspiens
Targeted Regions: AmpliSeqExome. 20141112 designed - Add targets...
Hotspot Regions: None - Add hotspots.

Parameter Settings: 1 - Germ Line - Low Stringsncy

Load extamal parameter file

Show Advanced Settings w

Configuration Name:

Save
About Torrent Variant Caller
TWG analyzes mapped reads covering each individual reference base to deduce whether there is sufficient statistical evidence to support calling a SNP or INDEL at a given position

an be restricted to a subset of the genome by defining targeted regions.
ly identified.

Get more information by visiting Tarrent Variant Caller Documentation
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4. Apply one or more configurations to barcodes:

¢ If you want to apply the same configuration to all barcodes:
a. Select the configuration in the Configuration dropdown list.

Manage Configurations/Barcodes

Configuratior v Current 6c88827¢c-1258-44bd-ae91-8a7d2d840e77 4
human
e-coli
Chip Type: my_config L -
[T PO » . =

b. (Optional) Make any other changes to the configuration settings.
¢ If you want to apply a different configuration to individual barcodes:

a. Click Manage Configurations/Barcodes, then click Setup and apply a
saved configuration to for one or more barcodes.

Configure Plugin

Torrent Variant Caller 5.6

Back to initial page

Configuration  Setup

setal 48K v
[BAM File Name [Sample [Barcode [Configuration
lonXpress_001_rawiib.bam 807 8K v
2_rawiib.bam 5K v
S_rawiib bam 5K v
lonXpress_009_rawiib.bsm 528807 llonxpress_008 43K v

Click on the configuration drop down to change the configuration

About Torrent Variant Caller

TVC anzlyzes mapped reads covering sach individusl reference base to dedu
Th an be restricted to a subset of the genome by defining targeted
been specifically identified

hether there is suffitient statistical evidence 1 support calling & SNP or INDEL at & given position
ons. If hotspot regions are defined, TVC includes their positions in the report, even if variants have not

Get more information by visiting Torrent Variant Caller Documentation

Close

5. When your changes are complete:

* C(lick Submit. The variantCaller plugin reruns, then applies the changes that
you made.

¢ If you want to save the configuration for later use, click Close to close dialog
without running the plugin.

Note: To cancel a plugin run that is in progress, click Stop.

Review variantCaller plugin run results

After your variantCaller plugin run completes, review results on the run summary
page.

Variants that pass all the set filters are reported to a single output VCEF file. All
variants, not at the hotspots regions, that fail any one of the set filters are reported to a
filtered output VCF file. The filtered variants have an associated filter reason tag in the

200 Torrent Suite™ Software 5.6 Help
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VCF file, which the users can query to identify the filters that the candidate variant
failed to pass.

1.

2.

Torrent Suite™ Software 5.6 Help

In the Data tab, click Completed Runs & Reports.

In the list of runs, find the run of interest, then click the link in the Report Name

column.

In the left navigation menu, click variantCaller to view the plugin results.

The variantCaller plugin summary includes information about the analysis type,
targeted regions and hotspot files, and variantCaller parameter settings and the
total number of variants called.

Click variantCaller.html link to open the variantCaller plugin report in the

browser tab.

¢ If the sequencing run contains barcodes, the plugin report includes a list of
the barcodes that were used and file download options.

variantCaller variantCaller.ntmi Completed  ~
Library type: AmpliSeq
Reference genome: hg'\ 9
Targeted regions: AmpliSeqExome.20141113.designed
Hotspot regions: none
Configuration: Generic - Proton P1 or S5/S5XL (540) - Germ Line - Low Stringency
DUIDU! d\recmvy var\amCaHeLaul 2410835
Download all barcodes: VCF.ZIP XLS.ZIP XLS cov
Please note: Variant Cang was carried out for all barcodes with reference genome as spemﬂed above
Barcode Name Sample Variants Downloads
lonXpress_001 1 37,426 VCFE.GZ VCF.GZ.TBI gVCF.GZ gVCF.GZ.TBI XLS
lonXpress_002 2 37,237 VCF.GZ VCF.GZ.TBI gVCF.GZ gVCF.GZ.TBI XLS
o S * items per page 1-20f2 items
Download option Description
VCF.ZIP A compressed directory that contains
the VCF files of each barcode.
XLS.ZIP A compressed directory that contains
the tables of alleles for each barcode
in tab-separated format, which can be
. . ™ ™
opened in Microsoft  Excel .
XLS The table of alleles of all barcodes in
tab-separated file, which can be
. ™ ™
opened by Microsoft  Excel .
cov This a file for the coverage of the
variant call results for all barcodes in
tab-separated file format, which can
. . ™ ™
be opened in Microsoft = Excel .
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¢ If the sequencing run does not contain barcodes, the plugin report contains
information the sample used in the and file download options.

variantCaller

Completed 2.19 GB

~variantCaller.html
Library type
Reference genome
Targeted regions
Hotspot regions
Configuration
Output directory
Please note

Sample

sample_1

BIRY 100

ViewLog | Delete

Ampliseq

hg19

Oncomine_BRCA_Research_Assay. 20170303 designed
Cncomine_BRCA_Research_Assay. 20170316 hotspots blist 318

Custom

variantCaller_out.2083138

Variant calling was carried out for all barcodes with reference genome as specified above

Variants Hotspot Variants Downloads
2 0 VCEGZ VCEGZTBI = QVCRGZ | QVCRGZIBI  XLS
20 ¥ ltems per page 1-10f 1items

5. To open the detailed variantCaller plugin report for each barcode, click one of the
following links in the variantCaller section of the plugin summary:

* Barcode name link in a report from a barcoded sequencing run. For
example, IonXpress_301.

* Sample name link in a report from a sequencing run that does not contain
barcodes. For example Sample_1.

You can download files for all barcodes and files for individual barcodes. See
“Detailed variantCaller plugin summary report” on page 202 for more

information.

Detailed
variantCaller
plugin summary
report

You can view details about individual barcodes and download files in the
variantCaller section of the plugin summary. Click the Barcode Name link in a report
from a barcoded sequencing run; Click the Sample Name link in a report from a
sequencing run that does not contain barcodes.

Barcode lonXpress_00" Mapped Reads BAM BAI
Sample Name 627755 TVC-Processed Reads BAM BAI
Reference Genome ng1e Variant Calls vcrez | vcrezTel | xis || cov
Library Type AmpliSeq Variants + Non-Variant aVEF.GZ gVCFGZTEI
Coverage
Read trimming Enabled -
View Variant Calls in IGV L=
Targeted Regions AmpliSeqExome.20141113.designed  BED
Deprecated Features Classic
Hotspot Regions Hone
Catter 0
Effective Regions Ampl 20141112 designed_effective | BED
Parameter Settings e Panel - erm Line - L HNGENCY | Parameters File
Variant Caller Version 8a)
Variant Calls by Allele
Chrom ~  Position Allele Name Gene ID gion Name
Allele Souree e = | Atiete Can | Heterozygous 23600, Hem = | ver Freq o
iew Allele Annotations iew iew Quality Metrics
Fostion et Avsle Call Fequency | Quaity | |susetor Verant Type Aeesouce | Alei e Gene 0 P——
ohrt:471334 s i Homozygous A% 4 NP Novel p— samoit
onr A o Homozygous w00% B Novel f—r noczL
r—— A Homozygous 0% NS Nl fs— =
shrt:getez c A Homozygous o12% a2 - swe el nenoves =
ohrt-823625 A G Homozygous W% 41 - e Novel " =
chrt:ga3058 B E Heterczygaus 48% w1 - swe Novel fr— =
onrt:sa7s80 A c Homozygous woo%  ema - ED Nl p— =
ohrt:za7801 A G Hamozygous 0% ER Nl f— =
T c Heterczygous s23% swe Nevel ps—"r =
i -

202
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Download option

Description

VCF.GZ and VCF.GZ.TBI

Compressed directory of variant call results
files in VCF file format

gVCF.GZ and gVCF.GZ.TBI

Compressed directory of files for the
variant call results and the coverage in the
genome VCF (gVCF] file format.

XLS

The table of alleles in the tab-separated file
format, which can be opened in Microsoft™
Excel™.

Torrent Suite™ Software 5.6 Help
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The Variant Calls by Allele table in the variantCaller plugin detailed report includes
the following features:

Variant Calls by Allele

Ghrom ~ | Position to Allele Name Gene ID
Region Nams Allsle Source ~ | Type ~ | Allle Call| Heserozygous (23800). Homx ~ | viar Freq to
Total Gov =

View Allele Annotations | View Coverage Mefrics | View Quality Metrics

1 Variant Frequency | Quaity | |Subsetor Veriant Type Allsle Source Allele Name Gene ID
chr1:871324 =] T o7o% 4453 e Mo tvenavel.1 SAMD11
chr1:880238 A =] 00D% 227 e Mo tvenovel 2 MOC2L
chr1:881626 00D% 2881 n: Mo vz novel 3 MOC2L
chr1:881627 =] A 012% 404 e Mo vz novel 4 MOC2L
chr1:883625 =] 00D% 1041 e Mo vz novel 5 MOC2L
chr1:883839 T =] 485 041 e Mo vz novel B MOC2L
chrl 387560 A c 100D% 8201 e Mo vz novel 7 HOCZL
chrl-287801 A = 100D% 2383 e Mo tvznovel & NOCZL
chrl 388639 T c 335 352 e Mo vz novel HOCZL
chr1:388659 T E 100.0% 702 e Mo tvenovel 10 NOCZL
chr1:283158 = cc 100D% 1783 MN Mo vz novel 1 HOCZL
chr1:354573 =] A es1% 10152 e Mo tvenovel. 12 NOCZL

¢ Each position is a link to open the variant in Integrative Genomics Viewer (IGV).
In some browsers, you save the igv.jnlp file to your local system, and then
click on igv. jnlp to open the IGV browser.

¢ C(lick on a column header to order the table by the contents of that column.

¢ For candidates that are filtered out, the filtering reason is highlighted in the table.
For example:

lele coverage | allele coverage + allele coverage - | strand hias

29 21 g 0.5397
23 15 a 0.5522
15 15 1] 0.5000
15 14 1] 0.5000
288 133 154 0.5000
85 gs 7 0.5028
20 20 0 0.5000
] 1] ] 0.5000
259 102 157 0.5000
187 a0 107 0.5000
239 91 148 0.5000

The main columns are described in the following table. Use the tabs on the right of the
table (View Allele Annotation, View Coverage Metrics, and View Quality Metrics) to
change the display of the columns on the right.

Torrent Suite™ Software 5.6 Help
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Column

Description

Position

The chromosome [or contig) name in the
reference genome, and the one-based
position in the reference genome.

Ref

The reference base(s).

Variant

Variant allele basel(s).

Var Freq

Frequency of the variant allele.

Quality

Phred-scored quality field. [V Larger values
mean more certainty in the call.

Typically very large for reads strongly
distinguishing variants with good depth;
that is, under the model assumed, evidence
is overwhelming for the variant or for the
reference. Marginal values in this field can
mean either the reads do not distinguish
the variant well or there is insufficient
depth to resolve, or the observed allele
frequency is near the cutoff. Filters to
compensate for the cases in which the
model assumptions are not true are found
in the INFO tags.

Computed by posterior probability that the
sample variant allele frequency is greater
than the min-allele-frequency specified for
the variant type (if a variant), or posterior
probability that the variant allele frequency
is below this threshold (if a reference call).
Posterior probability computed conditional
on the reads observed, includes sampling
variability.

1 For variants found by the indel assembler, this value is always set to 50.

View allele These columns are displayed in the run report in the View Allele Annotations tab:

annotations
Column

Description

Variant Type

e SNP Single nucleotide polymorphism
¢ IND Insertion
e DEL Deletion

e MNP Multiple nucleotide
polymorphism, the substitution of a
block sequence by the block of another
length

e COMPLEX Block substitution of
sequence by a block of unequal length

Torrent Suite™ Software 5.6 Help
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Column Description

Allele Source e Hotspot if called only because of its
entry in a hotspots file

e Novel all others

Allele Name The Allele name as given in the hotspot
regions file, if it is an hotspot allele. Since
Torrent Suite" Software 5.6, the name of an
novel allele is given by tvc.novel. #.

Gene ID The Gene ID as given in the target regions
file
Region Name The regionname as given in the target
regions file
View coverage These columns are displayed in the run report in the View Coverage Metrics tab:
metrics
Column Description
Coverage Total coverage at this position, after

downsampling [

Coverage + Total coverage on the forward strand, after
downsampling

Coverage - Total coverage on the reverse strand, after
downsampling

Allele Cov The number of reads that contain this
allele, after downsampling

Allele Cov + Allele coverage on the forward strand, after
downsampling

Allele Cov - Allele coverage on thereverse strand, after
downsampling

Strand bias Discrepancy between allele frequencies on
the forward and reverse strands

01 Variants calls are made on a sample of reads when coverage is higher than specified in the parameter
settings file. This is referred to as "downsampling”. See downsample_to_coverage in variantCaller plugin
advanced parameters.
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View quality These columns are displayed in the run report in the View Quality Metrics tab.
metrics Associated filtering codes are given in brackets.
Column Description

Common Signal Shift Distance between predicted and observed
signal at the allele locus. [RBI]

Reference Signal Shift Distance between predicted and observed
signal in the reference allele. [REFB]

Variant Signal Shift Distance between predicted and observed
signal in the variant allele. [VARB]

Relative Read Quality Phred-scaled mean log-Llikelihood
difference between the prediction under
reference and under the variant hypothesis.
[MLLD]

HP Length Homopolymer length.

Context Error + Probability of sequence-specific error on
the forward strand (reported only for
deletion variants).

Context Error - Probability of sequence-specific error on
the reverse strand (reported only for
deletion variants).

Context Strand Bias Basespace strand bias (reported only for
deletion variants).

Export variant This option exports your variant calls to a tab-separated file. The exported file is

calls to afile

named subtable.xls and has the same columns that are included in the Variant

Calls table (including columns for all three display options: View Allele Annotations,
View Coverage Metrics, and View Quality Metrics).

Torrent Suite™ Software 5.6 Help
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Click the left column checkboxes to select your variants, then click the Export Selected
button:

Variant Caller Export Tools

Rows selected: 3
® Download table file of selected rows.

O Submit variants (human only) for PCRE/Sanger sequencing
primer design.

{0 Subrmit variants for Taghan assay design.

T

Troubleshoot the Click Show Troubleshooting in the variantCaller plugin detailed report to
variantCaller troubleshoot the variantCaller plugin results for missing variants (false negatives) or
false positives. You can also export the results to share them with a field

plugin results bioinformatics specialist.

Find false negatives

When a variant expected to be present is not called by the variantCaller plugin, an
alignment viewer, such as Integrative Genomics Viewer (IGV) or Ion Reporter -
Genomic Viewer (IRGV) in Ion Reporter  Software, can help you ensure the presence
of the variant in the sample at the position where it is expected.

® IGV can reveal problems, such as mismapping or low coverage.

* Visually inspect the coverage of the region where the variant is expected, paying
special attention to the depth of coverage and the quality of the bases covering
the position of the variant. Low coverage or low base quality might explain the
no-call.

® The variant could be slightly misplaced (especially for indels).

Optionally, the variantCaller plugin has built-in tools that can be used to display call
details.
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If a hotspots regions file was used:

1. Check that the position of the variant is included in the hotspots file.

2. Check the Variant Calls output table. Values that cause a candidate to be filtered
out are shown in colored cells:

allele coverage  allele coverage + allele coverage - | strand bias
29 21 8 0.5897
5 0 5 0.5000
259 102 157 0.5000
187 80 107 0.5000

3. Adjust parameters.
4. Rerun the variantCaller plugin.

If no hotspots regions file was used:

1. Navigate to the variantCaller plugin results directory on the Torrent Server and
open the file small_variants_filtered.vcf. On Linux, the variantCaller plugin
results directory can be found
at /results/analysis/output/Home/{analysis_report_name}/plugins/variantCaller/
for non-barcoded runs
or /results/analysis/output/Home/{analysis_report_name}/plugins/variantCaller/{
bar code}/ for barcoded runs. In the Torrent Suite” Software, you can access the
variantCaller plugin results directory by opening the variantCaller plugin results
for the sample or barcode of interest, removing the final 'variantCaller.html' from
the URL, and press Enter.

2. If the location of the variant is found, look at the FR field (filtered reason).

3. Relate the reason to parameters using the table Filtering Codes variantCaller
vd.x.

4. Adjust parameters.
5. Rerun the variantCaller plugin.

If the location of the SNP is NOT in the filtered.vcf file, create a hotspots regions file
that includes this location.

Fix false positives

False positives are usually related to artifacts that create unexpected amplification,
such as a primer-dimer or contamination problems. Some false positives are reported
because of the difficulties inherent with the handling of homopolymer regions.

Use one of the following methods to resolve these issues:

¢ Adjust parameters that control the homopolymer calls. This can increase the
report of false negatives.

¢ If you are repeatedly running a panel, manually curate specific sites (positions)
since the false positive tends to occur in the same positions.

Note: Currently, the variantCaller plugin does not support manual curation. It is
available in the command-line version.
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210

Export files for troubleshooting

Variant calls in Torrent Suite Software
Review variantCaller plugin run results

Torrent Suite Software includes a tool that helps you determine why variant calls are
unclear in analyses. You can use the Slicer tool to select one or more variant calls, then
export the related data as miniature BAM, BED, and VCF files. You can then share
these files with a field bioinformatics specialist for further review.

1. In the variantCaller plugin output table, click Show Troubleshooting.

View Allele Annotations | View Coverage Metrics | View Quality Metrics

| Position ~ Ref Variant Alele Call

Frequency | Quality | | SubsetOf VariantType  AleleSource | Alele Name Gene ID Region Name
o chri:87560 A Homozygous 1000% 19266 — swe Novel tenovel.t Noc2L NOC2L_29.1330
chr1:888639 T c Homozygous 1000% 9144 - SNP Novel tvenovel.2 NoC2L NOC2L_31.3056
7 chri:8a6sy ki c Homozygous 1000% 9144 — swe Novel enoveld Noc2L NOC2L_31.3056
) chrisasTs o A Homozygous 1000% 11800 — swe Novel tonoveld Noc2L NoC2L_38.506
O chri9oste c T Heterozygous 513% 4799 — swe Novel Wonovels PLEKHN1 PLEKHN1_66.8304
O chri:981931 A s Heterozygous a74% 3514 — swe Novel tenovels AGRN AGRN_93.3579
Export Selected  Selected 10f 6 Showing1-60f6 < Back = Next =+
Show Troubleshooting v-
View Allele Annotations | View Goverage Metrics | View Quality Metrics
| | Position ~ Ref Variant Allele Call Frequency  Quality | | Subset Of Veriant Type | Allele Source | Allele Name Gene ID Region Name
L chr1:887560 A c Homozygous 1000% 19256 — sNP Novel tvenovel.t NocZL NOCZL 291330
@ chr1:888639 T © Homozygous 1000% 9144 — SNP Novel tvenovel.2 NoczL NOCZL_31.3056 I
[T chrBe6eo8 T T Fomozygous T00.0 THd — NP Tover TCnovers NoCZL NOCZL_57.3056
) chr1:Bs4sT3 G A Homozygous 1000% 11800 — SNP Novel tvenoveld NoCZL NOCZL_36.506
[ Jenrt:sosate c T Heterozygous 513% 4799 — SNP Novel tvenovel.5 PLEKHN1 PLEKHN1_66.8304
) chri9B1831 A G Heterozygous A% 3614 — sNP Novel tvenovels AGRN AGRN_93.3679

Export Selected Se\sclediuiiil Export for Troubleshooting I

@ Variants to inspect (mini bam/bed/vef files will be generated)
Add Manualy

Position Reference Variant

chri:888639 T c

Enter the Expectant Variant.
Click Export.

Click Download the .zip.

Expected Variant

Showing 1-60f6 4 Back  Next +

Hide Troubleshooting A

Remove

[ e

The compressed directory of miniature BAM, BED, and VCF file is downloaded

to the directory, according to your browser settings.

Torrent Suite™ Software 5.6 Help
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You can adjust the variantCaller plugin parameters that are used for the barcode, then
save the adjusted parameters to a configuration.

Note: The reference genome, target regions, and hotspots files in the saved
configuration inherit the files that are used to obtain the variantCaller plugin results

for this barcode.

1. Scroll to the Adjust Parameters section at bottom of the detailed results page,

then click Show Filter Settings:

Adjust Parameters

How to optimize variant caller parameters

2. Inthe parameter list, change the parameter settings:

Show Filter Settings s

Note: Only the parameters that are most commonly changed available.

Adjust Parameters

How to optimize Torrent Variant Caller parameters?

Parameter #No Calls

Minimum allele frequency
min_allele_freq

Minimum quality 0
min_veriant_score

Minimum coverage 0
min_coverage

Minimum coverage on either strand 0
min_coverage_each_strand

Maximum strand bias 0
sirand_bias

Minimum relative read quality 0
data_quality_stringency

Maximum common signal shift 6
iter_unusual_predictions

Maximum referencelvariant signal shift (insertions) 0
fiter_insertion_predictions

Maximum referencelvariant signal shift (deletions) 0
filter_deletion_predictions

Maximum homopolymer length 0

hp_max_length

Save Adjusted Parameters:

Configuration Name:

Column

Allele Frequency <

Quality <

Coverage <

Coverage + or - <

Strand Bias >

Relative Read Quality <

Common Signal Shift >

Reference or Variant Signal Shift >

Reference or Variant Signal Shift >

HP Length >

Hide Filter Settings &

Parameter threshold value

SNP

0.1

10

5

0

0.98

5

03

03

03

INDEL MNP Hotspot
0.1 01 01
10 10 10
10 5 5
4 0 0
0.95 098 098

3. Enter the Configuration Name that stored the adjusted parameters, then click

Save to Configuration.

4. To add barcodes to the configuration, run the plugin manually, then assign the
barcode to the saved configuration with the adjusted parameters.
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Variant calls in Torrent Suite Software
variantCaller plugin advanced parameters

Advanced parameter settings for the variantCaller plugin allow additional
customization of the variant calling algorithm and are for advanced users only.

In general, you can safely customize parameters for SNP calling. For indel calling,
changes to the parameters tend to have a significant effect in the number of indels
called. With indels, the tradeoff between sensitivity and specificity becomes too large.

Both the long indel assembler and the FreeBayes module generate lists of variant
candidates. The list is then passed on to other modules that evaluate the candidates.
The assembly module attempts to call any indel longer than 3 bp, but only reports
indels that fail to be called by the FreeBayes module.

Parameter

Description

downsample_to_coverage

Reduce coverage in over-sampled locations
to this value to save computational time

Allowed values: Integers >= 1

Suggested trial value: 400 (germline], 2000
(somatic)

heavy_tailed

Avariant evaluation parameter:
(2*heavy_tailed-1] is the degree of freedom
of the t-distribution for modeling the heavy
tail in signal residual distribution

Allowed values: Integers >= 1

Suggested trial value: 3

outlier_probability

A variant evaluation parameter: probability
that a read comes from none of the models
under consideration

the variantCaller plugin will make NOCALL
with filter reason REJECTION if FXX is too
high.

Related VCF field: FXX

Allowed values: Decimal numbers between
O0and 1.0

Suggested trial value: between 0.005 and
0.01

prediction_precision

A variant evaluation parameter: The
number of pseudo data points suggesting
our predictions match the measurements
without bias

Allowed values: Decimal numbers >=0.1

Suggested trial value: 1.0
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Parameter

Description

min_detail_level for_fast scan

A variant candidate evaluating parameter:
The minimum detail-level to trigger the fast
scan algorithm that considerably speeds up
the evaluator.

Allowed values: >=0 (0 = always apply the
fast scan algorithm)

Suggested trial value: 0

max_flows_to_test

A variant candidate evaluating parameter:
The maximum number of scoring flows
being used.

Allowed values: Integers > 0

Suggested trial value: 10 (20 if the
Hotspots file contains long variants)

suppress_recalibration

A variant evaluation parameter:
Homopolymer recalibration values should
not be used when set

Allowed values: 0 = allow recalibration, 1 =
do not allow recalibration

Suggested trial value: 0

do_snp_realignment

A variant candidate evaluating parameter:
Realign reads in the vicinity of SNP
candidates when set

Related VCF content: REALIGNEDx

Allowed values: 0 = do not realign, 1 =
realign

Suggested trial value: 0

do_mnp_realignment

A variant candidate evaluating parameter:
Realign reads in the vicinity of MNP
candidates when set

Related VCF content: REALIGNEDx

Allowed values: 0 = do not realign, 1 =
realign

Suggested trial value: 0

realignment_threshold

A variant candidate evaluating parameter:
Maximum allowed fraction of reads where
realignment causes an alignment change

Related VCF content: SKIPREALIGNx
Allowed values: Decimals between 0 and 1

Suggested trial value: 1

Torrent Suite™ Software 5.6 Help
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Parameter

Description

use_fd_param

(experimental in Torrent Suite Software 5.4)

Afiltering parameter: Use Flow
Disruptiveness (FD] instead of allele types
(INDEL, SNP, MNP) as the criterion to
select the parameter set.

If turned on, the (non-FD, moderate FD, FD)
allele applies the (INDEL, SNP, MNP]
parameters, respectively.

If powered on, the (non-FD, moderate FD,
FD] allele applies the (INDEL, SNP, MNP)
parameters, respectively.

Allowed values: 0: do not use FD
parameters, 1: use FD parameters.

min_ratio_for_fd

A filter parameter: Claim flow-disruption if
the portion of reads that are flow-disrupted
>= this value

indel_as_hpindel

A filter parameter: A flag indicating
whether INDEL filters or SNP filters should
be applied to non-HP indels

X_min_allele_freq

X'is one of the allele type in {indel, snp,
mnp, hotspot}

A variant evaluation parameter: The
presence of the allele of the type is defined
by which allele frequency is greater than
this value

Allowed values: Decimal between 0 and 1

Suggested trial value: between 0.01 and
0.2

X_min_variant_score

X'is one of the allele type in {indel, snp,
mnp, hotspot}

A filter parameter: A called allele of the
type needs to have a QUAL score greater
than this Phred-scaled value

Related VCF fields: QUAL
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Parameter

Description

X_min_coverage

Xis one of the allele type in {indel, snp,
mnp, hotspot}

A filter parameter: The location of a called
allele of the type needs to have a coverage
greater than this value

Filter reason: MINCOV
Related VCF fields: FRO, FAO
Allowed values: Integers >=0

Suggested trial value: between 5 and 20

X_min_cov_each_strand

X'is one of the allele type in {indel, snp,
mnp, hotspot}

A filter parameter: Minimum coverage
required on each strand for a the type of
allele to be called Filter reason: PosCov or
NegCov

Related VCF fields: FSRF, FSRR, FSAF,
FSAR

Allowed values: Integers >=0

Suggested trial value: >=3

X_strand_bias

X is one of the allele type in {indel, snp,
mnp, hotspot}

Afilter parameter: A candidate allele of the
type will be filtered out if its strand bias p-
value is less than X_strand_bias_pval and
its strand bias is greater than
X_strand_bias

Filter reason: STDBIAS and STDBIASPVAL
Related VCF field: STB

Allowed values: Decimal numbers between
0.5and 1.0

Suggested trial value: 0.95

Torrent Suite™ Software 5.6 Help

215



216

2 Variant calls in Torrent Suite Software
| variantCaller plugin advanced parameters

Parameter

Description

X_strand_bias_pval

Xis one of the allele type in {indel, snp,
mnp, hotspot}

A filter parameter: A candidate allele of the
type will be filtered out if its strand bias p-
value is less than X_strand_bias_pval and
its strand bias is greater than
X_snp_strand_bias

Filter reason: STDBIAS and STDBIASPVAL
Related VCF field: STBP

Allowed values: Decimal numbers between
Oand 1

Suggested trial value: 0.01 for strand bias
filter, 1 for no strand bias filter

data_quality_stringency

A filter parameter: A called variant needs to
have a mean log-Llikelihood difference per
read greater than this Phred-scaled value

Related VCF field: MLLD
Filter reason: STRINGENCY
Allowed values: Decimal numbers >=0

Suggested trial value: >= 6.5

filter_unusual_predictions

A filter parameter: A called variant needs to
have RBI less than this value

Filter reason: PREDICTIONSHIFTx

Related VCF fields: RBI = sqrt(FWDB " 2 +
REVB " 2]

Allowed values: Decimal numbers >=0

Suggested trial value: 0.3

filter_deletion_predictions

A filter parameter: Filter out a deletion if
the observed clusters deviate from
predictions more than this amount

Filter reason: PREDICTIONVarSHIFTx or
PREDICTIONRefSHIFTx

Related VCF fields: VARB, REFB
Allowed values: Decimal numbers >=0

Suggested trial value: 0.2
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Parameter

Description

filter_insertion_predictions

A filter parameter: Filter out an insertion if
the observed clusters deviate from
predictions more than this amount

Filter reason: PREDICTIONVarSHIFTx or
PREDICTIONRefSHIFTx

Related VCF fields: VARB, REFB
Allowed values: Decimal numbers >=0

Suggested trial value: 0.2

hp_max_length

A filter parameter: HP indels of more than
this length will be filtered out

Filter reason: HPLEN Related VCF field:
HRUN

Allowed values: Integers >=1

Suggested trial value: 8

hp_indel_hrun

A filter parameter: Define the HRUN for
filtering HP-INDEL variants with lengths
specified by "hp_del_len" and "hp_ins_len".

Filter reason: HPINSLEN, HPDELLEN
Related VCF field: HRUN

Allowed values: vector of positive integers
(e.g. [1,2,3]) with size matches 'hp_del_len’
and ‘hp_ins_len’

Suggested trial value: []

hp_ins_len

A filter parameter: Filter out HP-INS
variants whose INS length <= the
corresponding entry of this vector if the
HRUN is defined in "hp_indel_hrun'.

Filter reason: HPINSLEN Related VCF field:
HRUN

Allowed values: vector of non-negative
integers (e.g. [1,2,3]) with size matches
‘hp_del_Llen" and 'hp_indel_hrun’

Suggested trial value: []

Torrent Suite™ Software 5.6 Help
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Parameter

Description

hp_del_len

A filter parameter: Filter out HP-DEL
variants whose DEL length <= the
corresponding entry of this vector if the
HRUN is defined in "hp_indel_hrun’.

Filter reason: HPDELLEN
Related VCF field: HRUN

Allowed values: vector of non-negative
integers (e.g. [1,2,3]) with size matches
‘hp_ins_len" and 'hp_indel_hrun’

Suggested trial value: []

use_position_bias

A filter parameter: Enable the position bias
filter when set

Filter reason: POSBIAS, POSBIASPVAL
Allowed values: 0 = disable, 1= enable

Suggested trial value: (AmpliSeq) 1, (other)
0

position_bias

A filter parameter: Filter out a variant if the
position bias is greater than position_bias
and the position bias p-value is less than
position_bias_pval

Filter reason: POSBIAS, POSBIASPVAL
Related VCF field: POSBIAS

Allowed values: Decimal numbers between
Oand 1

Suggested trial value: 0.75

position_bias_pval

A filter parameter: Filter out a variant if the
position bias is greater than position_bias
and the position bias p-value is less than
position_bias_pval

Filter reason: POSBIAS, POSBIASPVAL
Related VCF field: POSBIASPVAL

Allowed values: Decimal numbers between
Oand 1

Suggested trial value: 0.05

position_bias_ref_fraction

A filter parameter: Skip the position bias
filter if (reference read count) / (reference
and alt read count) <= this value

Filter reason: POSBIAS, POSBIASPVAL

Allowed values: Decimal numbers between
Oand 1

Suggested trial value: 0.05
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Parameter

Description

error_motifs

The file name of the error motif file

sse_prob_threshold

A filter parameter: Filter threshold for
motif-predicted error probability

Filter reason: NOCALLxPredictedSSE,
NOCALLxPositiveSSE,
NOCALLxNegativeSSE

Related VCF fields: SSEP, SSEN
Related VCF field: PPA

Allowed values: Decimal numbers between
Oand 1

Suggested trial value: 0.02

report_ppa (Torrent Suite Software 5.4) Report Possible

Polyploidy Alleles (PPA) in the INFO FIELD
of the vcf lines.
Related VCF field: PPA
Allowed values: 1 = report PPA, 0 = do not
report

Long indel The Long indel assembly advanced settings parameters control the behavior of the

assembly long indel assembler, a module within the variantCaller plugin.

advanced settings

IMPORTANT! These parameters are recommended for advanced users only.

Parameter

Description

kmer_len

Size of the smallest k-mer used in
assembly

Impact: Increasing values make indel calls
less sensitive but more specific

Allowed values: Integers >=5

Suggested trial value: 11 and 30

min_var_freq

Minimum frequency of the variant to be
reported

Impact: Increasing values make indel calls
less sensitive but more specific

Allowed values: Decimal numbers between
Oand 1

Suggested trial value: 0.1 and 0.4

Torrent Suite™ Software 5.6 Help
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Parameter

Description

min_var_count

Minimum support for a variant to be
evaluated

Impact: Increasing values make indel calls
less sensitive but more specific

Allowed values: Integers > 1

Suggested trial value: 3 and 30

short_suffix_match

Minimum assembled sequence match on
both sides of the variant

Impact: Increasing values make indel calls
less sensitive but more specific

Allowed values: Integers > 2

Suggested trial value: 4 and kmer_len

min_indel_size

Minimum size indel reported by assembly

Impact: Increasing values make indel calls
less sensitive but more specific

Allowed values: Integers > 0

Suggested trial value: 2 and 30

max_hp_length

Variants containing HP larger than this are
not reported

Impact: Increasing values make indel calls
more sensitive but less specific

Allowed values: Integers > 1

Suggested trial value: 2 and 11

relative_strand_bias

Variants with strand bias above this are not
reported

Impact: Increasing values make indel calls
more sensitive but less specific

Allowed values: Decimal numbers between
Oand 1

Suggested trial value: 0.6 and 1.0

output_mnv

Enables reporting of complex variants

Allowed values: 1 = report complex
variants, 0 = don't report

Suggested trial value: 0
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FreeBayes These parameters control the behavior of the FreeBayes module, which generates a

advanced settings list of variant candidates.

IMPORTANT! These parameters are recommended for advanced users only.

Parameter

Description

allow_indels

Candidate generation parameter: Allow
indel candidates to be generated when set

Allowed values:1 = generate indel
candidates, 1 = generate indel candidates

Suggested trial value: 1

allow_snps

Candidate generation parameter: Allow
SNP candidates to be generated when set

Allowed values: 1 = generate indel
candidates, 1 = generate indel candidates

Suggested trial value: 1

allow_mnps

Candidate generation parameter: Allow
MNP candidates to be generated when set

Allowed values: 1 = generate MNP
hypotheses, 1 = generate indel candidates

Suggested trial value: 1

allow_complex

Candidate generation parameter: Allow
complex variant candidates to be generated
when set

Allowed values: 1 = generate MNP
hypotheses, 0 = don't generate

Suggested trial value: 1

gen_min_alt_allele_freq

A candidate generation parameter: A non-
HP-indel candidate needs to have an allele
frequency greater than this value in the
pileup

Allowed values:Decimal numbers between
Oand1

Suggested trial value: 0.02 to 0.15

gen_min_indel_alt_allele_freq

A candidate generation parameter: An HP-
indel candidate needs to have an allele
frequency greater than this value in the

pileup

Allowed values: Decimal numbers between
0and 1

Suggested trial value: 0.02 to 0.15
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Parameter

Description

gen_min_coverage

A candidate generation parameter: A
variant candidate location needs to have
coverage depth greater than this value

Allowed values: Integers >=0

Suggested trial value: 6

min_mapping_qv

A candidate generation and variant
evaluation parameter: Minimum mapping
quality value required for a read to be
considered (for both candidate generation
and variant evaluation)

Allowed values: >=0

Suggested trial value: 4

read_snp_Llimit

Do not use reads with number of snps
above this

Allowed values: Integers >=0

Suggested trial value: 10

read_max_mismatch_fraction

A candidate generation parameter: Ignore
reads with fraction of mismatch greater
than this value

Allowed values:Decimal numbers between
Oand 1

Suggested trial value: 1.0

Parameter

Recommended

Comments
value

tvcargs

This field is for internal use "tvc”

tmapargs

The desirable arguments for | “tmap
aligning the BAM file

mapall...-J 25
--end-repair 15
--do -repeat-clip
--context stage1
map4”
(ampliseq),
“tmap” (others]|

unifyargs

This field is for internal use "tvcutils

unify_vcf”
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Reference Management

GRCh38 human reference

Add the lon
GRCh38 Reference
to Torrent Suite™
Software

New in Torrent Suite " Software 5.4, you can start using the Ton GRCh38 human
reference in custom run plans. The new Ion GRCh38 Reference Genome is based on
the latest GRC human reference assembly. Highlights include:

¢ Changes to chromosome coordinates

e Corrected errors in the former sequence

* Addition of Mitochondria

* Multiple loci for some highly variable genes.

AmpliSeq™ Designer currently offers one custom AmpliSeq™ panel and related target
and hotspot regions files for GRCh38 experiments. Optionally, you can also convert
existing coordinates to GRCh38 by using a publicly available lift-over tool, such as
CrossMap.

T™

To use the GRCh38 human reference in Torrent Suite™, you must import it.

1. Log into Torrent Suite™ as administrator.
2. Go to the Reference page and click Import Preloaded Ion References.
3. Select GRCh38 and click Import.

Now the reference is available and can be selected in run plan.

AmpliSeqTM Designer preloaded reference genomes

™

AmpliSeq ™ Designer includes many preloaded reference genomes, including:
¢ Human (GRCh38)
* Human (hgl9)
* Mouse (mm10)
e Cow (boxTau?)
* Chicken (galGal4)
¢ Pig (susScr3)
* Sheep (oviAri3)
* Maize (AGPv3)
¢ Rice (IRGSP-1.0)
* Soybean (Glymal.l)
¢ Tomato (SL2.40)
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References Management Guide

1. In the Plan tab, click Settings (£#), then click References.

The main reference management page opens:

[ B

About

Analysis Parameters

Senvices
Plugins

lon Mesh

Configure

lon Reporter Configure
Accounts

Updates

The main reference management page opens:

EE—
> Obsolete Reference Sequences Reference Sequences

> TargetRegions

> Hotspots shortName  Descripton  Notes Date v Index version  status Enavled

> TestFragments

Supported only
» Barcodes GRCh38 2 upporied o - a017masta

GRCh3gp2m... o onTorentsute oL map-3 complete e
3 Upload History ek 522and higher !

hg19 Homo sapiens R 201710313 tmap-3 complete true
supportedhgte 0840 P

e_coli_dh10b E. coli DH10B 201710313 tmap-3 complete true
08:40PM

2. Enter the following:

* Nucleotide sequence Test Fragments
* Reference Genomes for aligning reads
* DNA Barcodes for barcode set management
In this page you can select reference details, download a reference file from your
Torrent server, add a new reference, or use the navigation tabs on the left:
* Reference Sequences. The main reference management page.

* Obsolete Reference Sequences. Lists references that need to be reindexed
before use. Reindexing is required only on releases that involve a TMAP
index change.

* Target Regions. Analysis is restricted to only the regions of interest that you
specify in this file.

* Hotspots. Variant Caller output files include these positions whether or not a
variant is called, and include evidence for a variant and the filtering
thresholds that disqualified a variant candidate.

¢ Test Fragments. Known sequences used to monitor system characteristics.

¢ Barcodes. Work with Ion barcode sets or your own custom barcodes sets.
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Reference pages

Reference Management X
References Management Guide ="

¢ Upload History. Shows the recent uploads of target regions, hotspots, and
ampliseq.com zip files:

Upload History

Uploaded File Type Date * Status

-
Cancer50_Desigred.bed Targel Regions 20130315 Successiully Completed
BRCA1_BRCAZ resubts.zip AmpliSeq ZIP 201308730 Successfully Completed
dos2uinx_BRCA1_BRCAZ _hotspol_vid.bed Holspots 2013008730 Successfully Completed
Aug29_4471262_CP_holspols _20121002.bed Holspots 20130829 Successfully Completed
CHPW2_DB22201 2. hed Target Repions 20130730 Successiully Completed
IADZIFA4-123-300.bed Target Renlons Successiully Completed
test1234.bed Hotspots Successfully Completed
A0D_hsm_w12_1_sedq.bed Targal Regions Successiully Completed

The Status column shows any error results.
This warning often appears in the References tab:

W arning!

Due to the upgrade of TMAR, the TMAP specific index files for your
references are stale, and need to bhe rebuilt by ThAP for each reference
hefore that reference can be used for alignments. We ask you to manually
initiate this process because the index rebuild may take a few hours for
larger genomes during which time use of the server is unadvisable.

We recammend you rebuild all indices at the end of the work day,
hioweesyer, you will find controls to rebuild each index manually on that
index's page.

Rebuild All How

This warning appears if your server has references listed in the Obsolete References
section. Your action in response to this warning depends on your particular upgrade
scenario and obsolete references situation:

¢ If you upgrade from release 2.2 or higher to 4.x, you do not need to rebuild your
reference indices.

e If you upgrade from a release earlier than 2.2, you must rebuild your reference
indices after the first upgrade to a 3.x or 4.x release (and before using the upgraded
server for analyses).

The following pages describe how to manage your references and related files.
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Upload a new
reference file

Prerequisites

Import preloaded
ion references
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References Management Guide

As part of the standard analysis process, reads are aligned to a genomic reference,
using the TMAP aligner that comes pre-installed on the Torrent Server.

Note: Currently, the variantCaller plugin does not support IUPAC base codes other
than A, C, T, G, and N. When Torrent Suite™ software uploads a genome containing
other IUPAC characters, each such character is replaced with N.

For a new genome sequence, use the Admin » References tab to add the new
reference genome. (These reference sequences are also displayed on the Ion PGM™ or
Ion Proton™ Sequencer when you load a sample.)

™

The following are prerequisites to uploading a new reference file:

Create a FASTA format reference sequence file (on your client machine).

Note: FASTA files can be found at: http://www.ncbi.nlm.nih.gov/sites/genome
download the FASTA file to your local client machine.

IMPORTANT! It is important that the format of your FASTA file conform to Ion
Torrent™ requirements.

IMPORTANT! When working with larger genomes, performance improves if you
first zip the FASTA file. The create index tool supports a zip archive, provided the
file contains only a single FASTA file.

Prepare a descriptive name for the genome.

Prepare the short name for the genome.

Prepare a version for the genome.

Know the number of reads to randomly sample for alignment.

Prepare a regions of interest file or hotspots file (on your client machine).

Note: To provide a better uploading experience, Adobe® Flash® or Microsoft™
Silverlight® plugins are required to be installed for your browser. You may need
to contact your local system administrator for assistance.

— Silverlight® can be downloaded from http://www.silverlight.net/getstarted/.
— Adobe® Flash® can be downloaded from Flash® player/.

Click Settings (¥F)References:

Torrent Suite™ Software 5.6 Help
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2. Click the Import Preloaded Ion References tab.

3.

ENETEEE @ -

References

[ [ ot o e
> Obsolete Reference Sequences Reference Sequences

> TargetRegions

> Hotspots

ShortName  Description Notes Date v Indexversion  Status Enabled
» Test Fragments
Supported only
» Barcodes GRCh38 2 upporied on - p017marta
GRengpzma.. 0 onTorentsute oo map3 complete e
3 Upload History i i

5.2 and higher.

Ampliseq 201703113

ngt Homo sapiens map3 compiete e
supported hgta  08:40 P

e_coli_dh10b E. coli DH10B 201710313 tmap-3 complete true
08:40 M

The following screen opens:

EEETEEE @ -

References

lon References

Chicken (galGal4)
Chinese hamster (crigri1)

Cow (bosTau7) Import

Dog (canfam3) Import

Click Import to download the genome. Complete appears when the download is
finished.

(Optional) Click complete to edit the data. You have the following choices:

¢ Edit the fields, then click Save Changes.
* (lick Delete Genome.

¢ In the Available Target Regions and Hotspot Files. click Upload New Files.
The following section appears:

Available Target Regions and Hotspot Files Upload new Target Regions file (BED) or Hotspot file (BED or VCF) for chicken_galgal4:

Upload new fles
(s braf_v600e_melanoma.vcf (11 kb)

Select a new BED/VCF File | Hotspot g ?
A"HotSpot” type BED or VCF file defines regions and individual bases where variants are expected to occur.

Upload

Click Select a new BED/VCE. The file appears under Upload new Target Regions
file.

Import custom Follow these steps to import a reference genome:

reference 1
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2. Inthe References Sequences section, click Import Custom Reference:

About Analysis Param

> Obsolete Reference Sequences

» Target Regions
» Hotspots
» Test Fragments
» Barcodes

> Upload History

References

Short Name

OCAV3_design.

Zika_Asian_K.

ZikaNearComp.

CanTran_Abrid

10panel_v3_re

Oncomine_Foc.

Reference Sequences

Description

OCAV3_design.

Asian Strain Zika
cal

Setof multiple

strains of Zika

CanTran_Abrid

10panel_v3_ref

Oncomine_Foc.

Plugin

Notes,

Date v

2017001109
05:34 Pl

2016007106
11:16 AM

2016106128
1230 P

2016106106
05:47 P

2016105119
09:42 Pl

2016105109
01:41PM

Configure

onfigure A

= -

s

Import Preloaded lon References | Import Custom Reference.

Index version

tmap-13

tmap-13

tmap-13

tmap-13

tmap-13

tmap-13

Status

complete

complete.

complete

complete.

complete

complete.

Enabled

true

true

true

true

true

true

3. Fill out the Add New Reference Genome form. Required fields are noted on the

form.

Add New Reference Genome

UploadFile  Install via URL

Upload a FASTA file
(required) :

Short name (required) :
Description (required) :

Version (optional)

Notes (optional)

228

Select File

Please select a FASTA file to upload, with the fasta extension. FASTA files can be found at

the NCBIweb page.

FASTA files which are zip compressed are also accepted

Alonger, more descriptive reference name

919", "Homo sapiens Amplicon S

[SYI  import Reference.
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Field

Description

Upload FASTA file

[required] This
entry must have

a .fasta extension.
You can upload a
FASTA file from
your local machine
or click the link to
the website and
upload one from
there.

Short name

[required] A
shortened form of
the genome name,
the short form of
the genome name
may be any
alphanumeric
character and the
underscore (_]
character. The
name should not
match any existing
references installed
inthe /results/
referencelibr
ary/

<index type>/
<genome_short
name>/ directory,
including previous
unsuccessful
attempts at
creating reference
sequences.
Undesired
sequences can be
removed. Deletion
allows the short
name to be used for
a new genome.

Description

[required] This
entry may be any
text string. The
description usually
includes the genus-
species, version,
and other
identifying
information. The
description entered
here is displayed in
various report
output, and is listed
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Field Description

in the Reference
Sequences section
of the Admin >
References tab.

Version [required] Enter
any string for the
genome version
number. The
accession humber,
if there is one, is a
good choice. The
version entered
here is displayed in
various report
outputs.

Notes [optional] Use this
field to record any
notes about the

reference genome

4. Click Select File, then browse to the genome file (on your local machine).
5. Click the Upload file and create reference button.

6. (Optional) Click the Install via URL tab, fill out the form, then click Import
Reference.

After the reference is created, you can optionally add target regions BED files
and hotspots BED or VCF files to the reference.
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If you uploaded an invalid FASTA file, the following error displays when you attempt
to view the reference sequence associated with the file:

ENEEEN -

References

Error

The Genorme info text file for test3could not be opened from
the filesystern. It may have manually been deleted.

Please contact your Torrent Server Administrator.

Verbose index creation error

FASTA file failed validation. Please review the error below and
modify the FASTA, file to correct the problem.

Imvalid fasta file supplied, fix and retry.
FATAL ERROR: Mo fasta header found at line 1 |

For additional information, check the online help .

m Delete Genome

To recover from the error:

1. Delete the existing reference sequence entry.
2. Identify and correct formatting errors in the FASTA file.

3. Retry uploading the reference.

Browser Extensible Data (BED) files and Variant Call Format (VCF) files supply
chromosome positions or regions. When applied to a reference genome in the Torrent
Browser, these files perform these two functions:

¢ Targeted regions of interest Specifies your regions of interest, for instance the
amplified regions that are used with targeted sequencing. Analysis in the
complete Torrent Suite” Software analysis pipeline, including plugins, is
restricted to only the specified regions. (BED file only)

* Hotspot Instructs the Variant Caller to include these positions in its output files,
including evidence for a variant and the filtering thresholds that disqualified a
variant candidate. Only affects the variantCaller plugin, not other parts of the
analysis pipeline. (Either a BED or VCEF file)
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Target regions files and hotspot files are listed in the admin References tab. These files
are uploaded to a specific reference and available for use only when that reference is
used for an analysis.

To view the target regions files and hotspot files on your system, click Settings
(£F) » References:

In the References tab left navigation panel, click the Target Regions or Hotspots tab:

¥ Beference Sequences

» Obsolete Reference Sequences
» Hotspots

¥ Test Fragments

» Barcodes

» Upload History

The left navigation tabs openHotspots or Target Regions pages, which are very

similar:
Hotspots
Show All References - Add Hotspots
Name Description Notes Reference  Enabled g';“f

lon AmpliSeg™ BRCAT
BRCA1_BRCAZ _hotspo, .. PlisEq hg19 frue 20130901 3
and BRCAZ Fanel

ColonLung_hotspot hg18 frue
BRCA1_BRCAZ_holspol hg19 frue
4471262_CP_hotspots._ .. hg19 frue
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Target Regions

Show All Refer ences Ml Add Target Regions

1 d
Haime Description Noles Reference  Enabled pioa
Date «
lon AmpliSeq™ E Fanel K
AmpliSeqExome. 20130 nAmpliSeq™ Exome Fane] kit ho14 true 20134091 3

g 2013 TVG pararmeaters)

lon AmpliSeq™ BRCAT and
BRCA1_BRCAZ Design.. @ rioed i ngia e 20130091 3
BRCAZ Panel

Colonlung_Designed hg19 trug

4477686 IDP_designed hgid trus

Both Hotspots and Target Regions pages offer the following actions:
® C(lick the file name to open its details page.

¢ Use the references selection menu (default Show all References) to display only
files of one reference.

e C(lick the Add Hotspot or Add Target Regions button to upload a new file (to
associate with any reference).

Details page File details and download

In either the Hotspots or Target Regions page, when you click on a hotspot file name
or a target regions file name, a details page opens with details of both the hotspot file
and the related target regions file (provided both are available):

Hotspots Details - ColonLung_hotspot.bed

Procassed File :  jresufisiuploadsBED/13hg 19 unmergedidetail iColonLung_hotspot.bed {128,615 byies)
Reference: hgld

Description :

Motes ©

Enabled: [

Back to Hotspots Save Changes

Torrent Suite™ Software 5.6 Help 233



s ‘:.E Reference Management

. .
" References Management Guide

Target Regions Details - ColonLung Designed.bed

Processed File : fresulisuploadsBED 3hg 1%unmer gedidetail ColonLung_Designed.bed (4 395 bytes)
Reference : |E|E|
Description :
Motes :
Enabled: [¥

In these details sections, you can do the following;:
® C(lick on the Processed File link to download the hotspot or target regions file.
* Add a description or notes.
* Uncheck the Enable check box to prevent the file from being used in an analysis.

Click the Save Change button to save your description, notes, or Enable status.
Zip file details and download

For files imported for ampliseq.com, the details page also shows the zip file that was
imported from ampliseq.com:

Original Upload - ColonLung_results.zip

Original File : fresults/uploadsBEDM3/ColonLung_results.zip (105,691 bytes)
Type: AmpliSeq ZIP
Date: MonMay6 11:54:03 2013

Status : Successfully Completed

Back to Upload History

Note: The Delete button in the Original Upload section removes the hotspot or target
regions file from the system. The file is not available to be used in analyses.

Upload log file

The details page also has a section with the validation log from when the hotspot and
target regions files were originally uploaded.
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Manage Target Regions Files and Hotspot Files

Overview

This page describes how to add, download, and remove target regions files and
hotspot files.

Browser Extensible Data (BED) files and Variant Call Format (VCF) files supply
chromosome positions or regions. When applied to a reference genome in the Torrent
Browser, these files perform these two functions:

* Targeted regions of interest Specifies your regions of interest, for instance the
amplified regions that are used with targeted sequencing. The complete Torrent
Suite™ Software analysis pipeline, including plugins, is restricted to only the
specified regions. (BED file only)

* Hotspot Instructs the Variant Caller to include these positions in its output files,
including evidence for a variant and the filtering thresholds that disqualified a
variant candidate. A hotspots file affects only the variantCaller plugin, not other
parts of the analysis pipeline. (Either a BED or VCEF file)

With the Torrent Browser, you add BED and VCF files to an existing reference. The
reference must be listed in the Torrent Browser Admin > References tab before you
can upload our BED or VCF files.

Your uploaded BED and VCF files are then available as an option when you create a
new template or planned run in the Plan tab. In the template and planned run wizard,
menus on the Reference chevron page offer the BED and VCF files that you uploaded
to a reference.

You can optionally upload multiple BED and VCEF files to a reference. In the template
and planned run wizard, you specify the BED or VCEF files used for each template or
each run.

Notes about hotspot files:

* By default the variantCaller plugin calls variant candidates at hotspot positions
with more sensitivity than candidates at other positions. You can customize
certain variantCaller parameters separately for hotspot candidates.

¢ The Torrent Browser also accepts VCF files as hotspot files.
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Summary of steps
to add a target
regions or
hotspots file

236

IMPORTANT! Target regions BED files provide an option to restrict the analysis of
the entire reference genome. Whole genome analysis is supported by the run type
Whole Genome Analysis. Do not specify a target regions BED file on the Planning tab
run registration page if the variants are to be called over the whole genome.

IMPORTANT! All regions specified in your t arget regions BED files are analyzed.
Follow the instructions in “Modify a BED file” on page 237 (before uploading your
Target regions BED file) to delete lines representing regions that span variants that
you do not wish to call.

IMPORTANT! The BED file coordinates (example: chr2 29443689 29443741) use zero-
based indexing and a half-open interval. The start position is included, and the range
extends up to, but not including, the end position.

IMPORTANT! BED files used with Ion AmpliSeq™ workflows define the internal
segment only, and do not include the primer sequence.

IMPORTANT! A BED or VCF file is tied to specific reference. The coordinates within a
BED or VCF file must match coordinates and the coordinate sorting in the reference
genome. Torrent Suite™ Software reference genomes are sorted alpha-numerically (not
by a chromosome sort). The BED files and VCF files that you use with Torrent Suite™
references must also use an alpha-numeric sort. If you upload your own reference
genome, the BED and VCF files that you use with that reference must be sorted by the
same method as your reference file.

Before your analysis run or run registration (on the Planning page), you can add BED
or VCF files to your genome reference:

1. Use the Torrent Browser to upload the BED or VCF file from your local client

machine to Torrent Suite™ Software.

2. During file upload, the Torrent Browser validates the BED or VCF file, and
ensures that the BED or VCF file's coordinate regions are valid for the genome
reference.

3. The new BED or VCF file is then available as an option when you create a new
run registration in the Planning tab. Your new file also appears in the Target
Regions or HotSpots menus in the template and planned run wizard References
step in the Workflow bar.
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Modify a BED file

You can optionally modify a BED file before adding it to your reference genome. You
can use this technique to avoid regions for which you do not want variants called
(even if the variants appear in your sample).

You can modify a BED file only before uploading the file with the Torrent Browser.

Follow these instructions to modify a BED file:

1. Make a copy of your BED file. Rename the two files in a way that reflects changes
you make to the regions being analyzed.

2. Open the BED file with a text editor.
3. Delete the lines for regions you do not want.

4. Save the file.

If the region (or regions) appear in both your targeted regions BED file and in
your hotspots BED or VCF file, you must delete the line for those regions from
both types of BED file.

Supported file types
* Targeted regions of interest BED file only. Supported file extensions
are .bed, .zip, and bed.gz.

* Hotspot BED file or VCF file. Supported file extensions are .bed, .vcf.gz, .zip,
bed.gz, and .vcf.gz.

Upload a BED or VCF file

These instructions upload a BED or VCF file from your local client machine to Torrent
Suite” Software. These instructions apply to both targeted regions of interest files and
hotspot regions files.

IMPORTANT! You must upload only BED or VCF files that both match the reference
and are for the correct reference version. The uploader attempts to validate the BED or
VCF files, but cannot always detect the errors listed below.
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You have the responsibility to avoid the following mismatch errors. The uploader
does not always detect these errors:

1. Upload a BED or VCF file to a reference genome of a different version (for
example, an hg18 BED or VCF file with an hg19 reference).

2. Upload a BED or VCEF file for a different species.

3. Upload a hotspots BED file as a targeted regions BED file, or upload a targeted
regions BED file as a hotspots BED file.

Follow these steps to upload a target regions BED file or hotspots BED or VCF
file to a reference:

a. In the Reference tab, click either the Hotspots or Target Regions tab in the
left navigation panel:

3 Reference Sequences

3 Obsolete Reference Sequences
» Target Regions

3 Test Fragments

3 Barcodes

» Upload History

The Hotspots (or Target Regions) page opens:

Hotspots
Show Al References - Add Hotspots
Hame Descrigtion Notes Reference  Enabled LPio2
Date «
i el -1
BRCA1_BRCAZ hotspo. .. lon AmpligeqT™ BRCA hig18 frue 20130901 3
and BRCAZ Panel
ColonLung_hotspot hg18 frue
BRCA1_BRCAZ _hotspol hig18 rue
4471262 _CP_hotspots._ .. hg19 frue
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b. Click the Add Hotspots (or Add Target Regions) button in the top right
corner. The New Hotspots (or New Target Regions) page opens:

New Hotspots

Hotspots File : select File
Please select 2 BED or WCF file to upload.

Reference : g coli_dh10b - E. coli DH10B v
Description : optional
e
Notes : optional

Upload Hotspots File Cancel

c. Click the Select File button and browse to the file to be uploaded.

d. In the Reference menu, be careful to select the correct reference. The new file
can only be used with this reference.

e. Add the optional (but recommended) description and notes.
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f. Click the Upload Hotspots File (or Upload Target Regions File) button.
Wait while the file is validated:

Original Upload - lon_AmpliSeq_Cancer.bed

Original File :
Type:
Date :

Status :

Back to Upload History

resubtsuploadsBEDI2 lon_AmpliSeq_Cancer.bed (49152 bytes)
Hotspats
2013-09-28T11:03:25

Walidating

Processing Log

For large files, validation can take a couple minutes. Refresh your browser to
check that validation is complete.

240
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After validation, the Torrent Browser opens to the Hotspots detail page for your new

file:

Hotspots Details - lon_AmpliSeq_Cancer.bed

Procassad Fila @
References :
Mumbar of Loxi

Description :

Metes

Enabvled :

Back te Uipload Histons

Dasche toy it pots:

Qriginal Upload - lon_AmpliSeq_Cancer.bed

original File :
Type :
Drake ©

Status ;

Iresaitsupbaads BEDGHhY tRunmanged detailion_AmpliSeq_Cancerbed |52 108 tryies)

L
e

upload example

nesaitsAupbeads BEDGHln_AmpiSes_Cancerbad (49,192 bytes)

Haotspots
201 3-09-28T11.03:25

Sucresshuly Completed

Processing Log

Ton_dmplise) Cancer.bed: Validetleon successful wmith @ warnings aod & errocs

From this page, you can download the hotspots file or target regions file, remove the
file from the system, and view the validation log.
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Uploading errors
Validation errors appear in the Processing Log section of the details page.

Some types of error do not appear in the Processing Log section. There are major
problems that prevent validation from being attempted:

e Incorrect file format

e Incorrect file extension

e Zip contains 0 or multiple files
® A corrupted .zip .gz file

Download a Follow these steps to download a hotspots BED or VCF file, or a target regions BED
hotspots or target  file:
regions file 1. Go to the admin References tab and click either the Hotspots or Target Regions

tab in the left navigation panel:

¥ Beference Sequences

» Obsolete Reference Sequences
» Target Regions

¥ Test Fragments

» Barcodes

» Upload Histony

2. In the Hotspots (or Target Regions) page, click the name:

Hotspots
Showe Al References - Add Hotspots
Name Description Notes Reference  Enabled g';af
flon_AmpliSeq_Cancer__ | upload example hot9 true 201308528
HotSpots_1.0_lon_A. . upload test hog19 frue 201309728
lan ArnpliSeq™ BRCAT and
BRCA1_BRCA2 hot. . T PI=gd M a9 tue 20130843

BRCAZ Panel
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3. In the details page, click the link in the Processed File field:

Hotspots Details - lon_AmpliSeq_Cancer.bed

Procassad Fila ; I it ks BE DG hg PR uninen ged detailion AmgliSeg Cancan LFlII_‘\: 0 Eryies)

Referemce @ nQio

Humber of Loci = 723
Description : Ipinan gxamps
Motes
Ensbled: [
—
L ol

The Original File link in the Original Upload section also downloads the same
file.

Delete a hotspots Note: This step removes the file from the system. There is no recovery or undo.
or target regions Consider first downloading the file as a backup.

file Follow these steps to delete a hotspots or a target regions file:

1. Go to the admin References tab and click either the Hotspots or Target Regions
tab in the left navigation panel:

» Reference Sequences

» Obsolete Reference Sequences
» Target Regions

» Test Fragments

» Barcodes

¥ Upload History
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2. In the Hotspots (or Target Regions) page, click the name:

Hotspots
Show Al References - Add Hotspots
Hame Description Moles Reference Enahled ;‘;';af
flon_AmpliSeq_Cancer__ | upload example hot9 true 201308528
HotSpots_1.0_lon_A. . upload test hog19 frue 201309728
lan ArnpliSeq™ BRCAT and
BRCA1_BRCA2 hot. . T PI=gd M a9 tue 20130843

BRCAZ Panel

3. In the details page, go to the Original Upload section and click the Delete button.
If you are sure, click Yes in the confirmation popup.

The Browser Extensible Display (BED) format is used for both target regions files and
hotspot files. The Torrent Browser also accepts the Variant Call Format (VCF) for
hotspot files.

BED files are text files with tab-separated fields.
Target regions BED files use 3-column, 4-column, 6-column, and 8-column formats.

3-column Target Regions BED File Format

The 3-column BED file format is used when amplicon IDs and gene names are not
known.

The track line is optional. If present, it includes these tab-separated fields:

Field Type Description
Name string A unique design identifier.
Optional.
Description string Description of the design.
Optional.

The following is an example track line:

track name="ASD270245" description="AmpliSeq Pool ASD270245"

In a 3-column target regions BED file, the coordinates lines require the following tab-
separated fields:
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Field Type Description
chrom string (chars >= 0x20, other | Name of the chromosome.
than \tab) This name must be an exact

match with a chromosome
in the reference.

chromStart unsigned inté4 Starting position of the
feature (zero-based).

chromEnd unsigned inté64 Ending position of the
feature (not inclusive). Must
be greater than chromStart.

Partial example of a 3-column target regions BED file:

chr9 133738312 133738379 chr9 133747484 133747542 chr9
133748242 133748296 chr9 133748388 133748452 chr9 133750331
133750405 chr9 133738312 133738379 chr9 133747484 133747542
chr9 133748242 133748296 chr9 133748388 133748452 chr9
133750331 133750405 chrl4 105246407 105246502 chrl4 105246407
105246502 chrl4 105246407 105246502 chr2 29432658 29432711

4-column Target Regions BED File Format

The 4-column BED file format is used when gene names are not known and some or
all amplicon IDs are known.

The track line is optional. If present, it includes these tab-separated fields:

Field Type Description
Name string A unique design identifier.
Optional.
Description string Description of the design.
Optional.

The following is an example track line:

track name="ASD270245" description="AmpliSeqg Pool ASD270245"

In a 4-column target regions BED file, the coordinates lines require the following tab-
separated fields:

Torrent Suite™ Software 5.6 Help 245



A
]
|
/
<]

=
),
3

246

Reference Management
Manage Target Regions Files and Hotspot Files

Field Type Description
chrom string (chars >= 0x20, other | Name of the chromosome.
than \tab) This name must be an exact

match with a chromosome
in the reference.

chromStart unsigned inté4 Starting position of the
feature (zero-based).

chromEnd unsigned inté64 Ending position of the
feature (not inclusive). Must
be greater than chromStart.

AmpliconID string Amplicon ID. If missing, the
following string is used
“chrom™ +":" +
“chromStart” + "-" +
“chromEnd”

Partial example of a 4-column target regions BED file:

chr9 133738312 133738379 amplID73150 chr9 133747484 133747542
amplID73075 chr9 133748242 133748296 amplID73104 chr9
133748388 133748452 491413 chr9 133750331 133750405 74743 chr9
133738312 133738379 73150 chr9 133747484 133747542 73075 chr9
133748242 133748296 73104 chr9 133748388 133748452 491413 chr9
133750331 133750405 74743 chrl4 105246407 105246502 329410
chr2 29432658 29432711 34014

6-column Target Regions BED File Format

The 6-column BED file format is used when some or all of the gene names are known.
BED files that are generated by AmpliSeq.com use this 6-column format.

The track line is required in a 6-column target regions BED file. The following is an
example track line:

track name="ASD270245" description="AmpliSeq Pool ASD270245" 2
type=bedDetail

The track line includes these tab-separated fields:

Field Type Description

Name string A unique design identifier.
Optional.

Description string Description of the design.
Optional.

Type string Must be “bedDetail” (without
quotes). Required.

ionVersion string Introduced in the Torrent
Suite™ Software 4.0 release.
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In a 6-column target regions BED file, the coordinates lines require the following tab-
separated fields:

Field Type Description

chrom string (chars >= 0x20, other | Name of the chromosome.
than \tab) This name must be an exact
match with a chromosome
in the reference.

chromStart unsigned inté4 Starting position of the
feature (zero-based).

chromEnd unsigned inté64 Ending position of the
feature (not inclusive). Must
be greater than chromStart.

AmpliconID string Amplicon ID. If missing, the
following string is used
“chrom” +":" +
“chromStart” + "-" +
“chromEnd”

ID string Customer-specified ID. If
missing, set to ".". This field
is not used currently.

GeneSymbol string Gene name. If missing, set
to".".

Partial example of a 6-column target regions BED file:

? track name="ASD270249 v1" description="AmpliSeq Pool
ASD270249" type=bedDetail chr9 133738312 133738379 AM73150

NM 005157 ABL1 chr9 133747484 133747542 AM73075 NM 005157 ABL1
chr9 133748242 133748296 AM73104 NM 005157 ABL1 chr9 133748388
133748452 AM491413 NM 005157 ABL1 chr9 133750331 133750405
74743 NM 005157 ABL1 chr9 133738312 133738379 73150 NM 007313
ABL1 chr9 133747484 133747542 73075 NM 007313 ABL1l chr9
133748242 133748296 73104 NM 007313 ABL1 chr9 133748388
133748452 491413 NM 007313 ABL1l chr9 133750331 133750405 74743
NM 007313 ABL1l chrl4 105246407 105246502 329410 NM 001014431
AKT1 chrl4 105246407 105246502 329410 NM 001014432 AKT1 chrl4
105246407 105246502 329410 NM 005163 AKT1 chr2 29432658

29432711 34014 NM 004304 ALK

8-column Target Regions BED File Format
An 8-column BED file format is for Fusion panels.

The additional columns are:

Field Type Description
Score Unsigned inté4 Score. If missing, set to "."
Strand string [+ or -} Strand. If unknown, set to
e
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BED files generated by AmpliSeq.com custom designs

The track line for BED files generated by AmpliSeq.com custom designs follows the 6-
column BED format, but with two additional fields. These additional fields are not
used by Torrent Suite  Software.

Field

Type

Description

Name

string

A unique design identifier.

Description

string

Description of the design.

Type

string

"bedDetail" (without quotes].

ionVersion

string

Introduced in the Torrent
Suite™ Software 4.0 release.
When set to "4.0" or higher,
indicates that the BED file
supports the Extended BED
Detail format.

db

string

The UCSC Assembly ID.

reference

string

The Torrent Server
reference ID. Present for
AmpliSeq.com 5.2 and
higher.

color

string

Code for color track in UCSC
Genome Browser (when
uploaded from
AmpliSeq.com).

priority

string

Sets the order for color
track in UCSC Genome
Browser (when uploaded
from AmpliSeq.com).
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The track line is required in a HotSpots BED file. The following is an example track

Format line:
The track line includes these tab-separated fields:
Field Type Description

Name string A unique design identifier.
Optional.

Description string Description of the design.
Optional.

Type string Must be "bedDetail" (without
quotes). Required.

db string The UCSC Assembly ID.
Optional.

reference string The Torrent Server
reference ID. Optional for
hg19. Required for GRCh38.

The following is an example track line:

track name="ASD270245" description="HotSpots locations for
AmpliSeq ASD270245" type=bedDetail db=hg38 reference=GRCh38.p2

In HotSpots BED files, the coordinates lines require the following tab-separated fields:

Field

Type

Description

chrom

string (chars >= 0x20, other
than \tab)

Name of the chromosome.
This name must be an exact
match with a chromosome
in the reference.

chromStart

unsigned inté64

Starting position of the
feature (zero-based).

chromEnd

unsigned inté4

Ending position of the
feature (not inclusive). Must
be greater than chromStart.

HotSpotName

string

This ID is either the COSMIC
ID, dbSNP ID, or user-
defined. If missing, the
following string is used
"chrom” + ":" +
"chromStart” + "-" +
"chromEnd”
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Field

Type

Description

HotSpotAlleles

string

This field describes the
variant, using this format
(see examples below): REF=
reference_allele ; OBS=
observed allele ; ANCHOR=
base_before_allele

AmpliconID

string

Amplicon ID. If missing, the
following string is used
“chrom” + ":" +
"chromStart” + "-" +
"chromEnd”

The HotSpotAlleles field

This field specifies the alleles involved in variant calls, using this format:

REF= reference_allele; 0BS= observed_allele

Examples:

¢ ATT insertion with 1-base prior at reference C: REF=; OBS=TT
e A TT deletion with 1-base prior at reference G: REF=TT; OBS=

Notes:

e 6-column format

— The elements can be empty: "REF=;" or "OBS=;". Empty means deletion.

— An additional element ANCHOR=base_before_allele can be provided for
backward compatibility, but is completely optional. In fact, it is
recommended that the ANCHOR key it is NOT provided for TS >=4.2.

— Insertion alleles should have the same start and end position, and that
position corresponds to a region between two bases. SNV, MNV, deletion,
and complex variants should correspond to the reference bases that are
spanned by the event.

— The REF and OBS should be on the forward genomic strand. There should be

one alternative allele per line.

8-column format

— The +/- strand notation in the hotspot file refers to the orientation of the Ion
AmpliSeq"™ design input sequence, not to the reference sequence. REF and
OBS alleles must always be reported on the forward strand of the reference

sequence.

— HotSpotAlleles are always reported based on the allele information from the
positive strand of the reference sequence. Even if the allele strand is negative,
the REF and OBS bases still report the alleles on the positive strand.

For example, if there is a hotspot either on the positive strand or on the negative
strand on a genomic coordinate, the strand information makes no difference to
what is reported on the HotSpotAlleles column. HotSpotAlleles column always
reports the alleles on the positive strand. In the following example, the strands
are different, but the reported alleles are always from the positive strand:

chr 143815007 43815009 ID1 0 - REF=TG;OBS=AA AMPL1
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chr 143815007 43815009 ID2 0 + REF=TG;OBS=AA AMPL2

Partial example of a HotSpots BED file

track name="HSMv12.1" description="AmpliSeg Pool HSMv12.1"
type=bedDetail

chrl
chrl
chrl
chrl
chrl
chrl
chrl
chrl
chrl
chrl
chrl
chrl

Note:

43815007 43815009 COSM19193 REF=TG;OBS=AA AMPL495041
43815008 43815009 COSM18918 REF=G;OBS=T AMPL495041

115256527
115256527
115256527
115256527
115256527
115256528
115256528
115256528
115256528
115256528

115256528
115256528
115256529
115256529
115256530
115256529
115256529
115256529
115256530
115256530

COSM585 REF=T;OBS=A AMPL30014
COSM586 REF=T;OBS=G AMPL30014
COSM33693 REF=TT;OBS=CC AMPL30014
COSM30646 REF=TT;OBS=CA AMPL30014
COSM53223 REF=TTG;OBS=CTT AMPL30014
COSM583 REF=T;OBS=A AMPL30014
COSM584 REF=T;OBS=C AMPL30014
COSM582 REF=T;OBS=G AMPL30014
COSM12725 REF=TG;OBS=AA AMPL30014
COSM579 REF=TG;OBS=CT AMPL30014

The REF=;0BS= field is required, as is the track line.

Extended BED Detail format

Beginning with the 3.0 release, AmpliSeq.com uses this format for the following fixed
panels:

e CCP
e CFTIR
e CHPv2

e Jon AmpliSeqTM Exome

New fixed panels introduced after the AmpliSeq.com 3.0 release also follow this
format. Other panels, and all panels from previous releases, do not use this format.

The Extended BED Detail format contains two additional fields (at the end of each

Values Description

Any string, if supplied by the
user, or".'

User-supplied name orid
for the region.

line):
Name
Id
Description

key-value pairs separated by
semicolon, or "." if empty

Contains a "." or one or more
of the following:

e GENE_ID=
e SUBMITTED_REGION=
e Pool=

These key-value pairs are
described in the next table.

This table describes the key-value pairs that are supported in the Description column:
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Key Description

GENE_ID A gene symbol or comma-separated list of
gene symbols. If no gene symbol is
available, this key is absent.

Example: GENE_ID = brcal
Example: GENE_ID = brcal, ret

Pool The Ampliseq.com pool or pools containing
this amplicon.

Example: Pool=2

If an amplicon is present in multiple pools,
the pools are delimited with *," a comma,
with the primary pool listed first. For
example, if an amplicon is present in pools
1and 3, and 1is the primary pool, the entry
is: Pool=1,3.

Single-pool designs do not include the
Pool= key-value pair.

SUBMITTED_REGION The region name provided by the user
during theAmpliSeq.com design process. If
a region name is not provided, this key is
absent.

Example: SUBMITTED_REGION=Q1

CNV_ID A gene symbol used to specify a copy
number region for the cnv pca algorithm.
This will take precedence over the GENE_ID
and once CNV_ID can span multiple
GENE_IDs.

CNV_HS A CNV region hotspot. This can be a value of
either 0 or 1. A 1 will report as a hotspot
(HS) in the output VCF file from the CNV
PCA algorithm. A 0 will not be reported as
HS.

The Extended BED Detail format requires a track line with both type=bedDetail
and ionVersion=4.0. The Torrent Suite” Software BED validator treats these fields
(Id and Descriptor) as optional.

Examples from BED files in the Extended BED Detail format

This example shows the GENE_ID= and Pool= keys:

track name="4477685 CCP"
description="Amplicon Insert 4477685 CCP" type=bedDetail
ionVersion=4.0

chrl 2488068 2488201 242431688 . GENE ID=TNFRSF14;Pool=2
chrl 2489144 2489273 262048751 . GENE ID=TNFRSF14;Pool=4
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chrl 2489772 2489907 241330530 . GENE ID=TNFRSF14;Pool=1l
chrl 2491241 2491331 242158034 . GENE ID=TNFRSF14;Pool=3

This example is from the CFTR designed.bed file:

track type=bedDetail ionVersion=4.0
name="CFTRexon0313 Designed"
description="Amplicon Insert CFTRexon0313"
chr7 117119916 117120070 CFTR 1.91108
GENE ID=CFTR;Pool=1;SUBMITTED REGION=1, 31
chr7 117120062 117120193 CFTR 1.38466
GENE ID=CFTR;Pool=2;SUBMITTED REGION=1
chr7 117120186 117120304 AMPL244371551
GENE_ ID=CFTR;Pool=1;SUBMITTED REGION=1, 32

Merged Extended BED Detail format files

In the case of two overlapping records, those records are merged during upload into
Torrent Suite” Software. An ampersand (&) is the delimiter between multiple values
in merged files.

Example 1

When these two GENE_ID fields appear in overlapping records:
GENE_ID = raf

GENE_ID =brcal

The merged GENE_ID field is:

GENE_ID=raf&brcal

Example 2

When these two GENE_ID fields appear in overlapping records:
GENE_ID = raf

GENE_ID = brcal,ret

The merged GENE_ID field is:

GENE_ID=raf&brcal,ret

The score and strand fields in uploaded BED files

Uploaded BED files are converted to add score and strand columns, with the default
values 0 and +. You see these values in BED files that you download from Torrent
Suite” Software:

track type=bedDetail name="BRCAl.BRCA2 HotSpots"
description="BRCA HOTSPOT ALLELES"
allowBlockSubstitutions=true

chrl3 32890649 32890650 COSM35423 0 + REF=G;O0BS=A
AMPL223487194

chrl3 32893206 32893207 COSM23930 0 + REF=T;0BS= AMPL223519297
chrl3 32893221 32893221 COSM23939 0 + REF=;0BS=CCAATGA
AMPL223519297
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chrl3 32893290 32893291 COSM172578 0 + REF=G;OBS=T
AMPL223521074

This page describes the target regions Browser Extensible Display (BED) format used
with Ion AmpliSeq™ RNA fusion designs. BED files are text files with tab-separated
fields

Track line

The track line is required in the target regions BED file. The following is an example
track line:

track name=

"Fusions 2.6"

description=

"AmpliSeqg RNA"

type=bedDetail ionversion="4.0"

The track line includes these tab-separated fields:

Field Type Description
Name string A unique design identifier.
Optional.
Description string Description of the design.
Optional.
Type string Must be “"bedDetail" (without

quotes). Required.

ionVersion string Introduced in the Torrent
Suite™ Software 4.0 release
(AmpliSeq.com 3.0 and
higher fixed panels). When
set to "4.0", indicates that
the BED file supports the
Extended BED Detail format.
Optional. This field relates to
BED File format version
only, not the version of panel
designs.

Columns

This format includes 8 required columns separated by a tab (\t) character:
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Field

Type

Description

chrom

string (chars >= 0x20, other
than \tab)

Name of the chromosome.
This name must be an exact
match with a chromosome
in the reference.

chromStart

unsigned inté64

Starting position of the
feature ( Insert Start not the
Amplicon Start). Must be
zero-based.

chromEnd

unsigned inté4

Ending position of the
feature [not inclusive) (Insert
End not the Amplicon End).
Must be greater than
chromStart.

AmpliconlID

string

Amplicon ID. If missing, the
following string is used
“chrom” + ":" +
"chromStart” + "-" +
"chromEnd”

Score

Unsigned inté4

Score.If missing, set to ".".
This field is not used
currently.

Strand

string (+ or -)

Strand. If unknown, set to
"

ID

string

Customer-specified ID. If
missing, set to ".". This field
is not used currently.

Key-value pairs

string

Multiple attributes specified
as semi-colon separated
key-value pairs. See below
for specific key-value pairs.
All of these KVPs are
mandatory for Fusions
designs files, but most of
these are optional for other
White Glove designs.

Note that the Genomic (hg19) coordinates provided in the Key-Value pairs must
represrent the entire Amplicon sequence. If we want to generate the fusions mapping
reference fasta file from the BED file, all the information needed to do that should be

available in the Bed file.

These key-value pairs are supported:
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Key Value Example
TYPE Type of the event. Allowed TYPE=Fusion
values:
e Fusion

e CONTROL or
ExpressionControl

e Driver_Gene or
5p3pAssay

e GeneExpression
e RNA_Hotspot

FP_TRANSCRIPT_ID Transcript ID for the Five FP_TRANSCRIPT_ID=ENSGO
Prime Gene partner. This 0000156735
key value pair is only for
Fusion type Targets.

TP_TRANSCRIPT_ID Transcript ID for the Three TP_TRANSCRIPT_ID=ENSGO
Prime Gene Partner.(This 0000077782
field is absent for CONTROL
type amplicons).This key
value pair is only for Fusion
type Targets.

BREAKPOINT Position in the sequence for BREAKPOINT=56
the breakpoint. Applicable to
only FUSION Type
amplicons. This position is
number of bases from the
Insert start, not the
Amplicon Start.

FP_GENE_ID Name of the Five Prime FP_GENE_ID=BAG4
Gene partnerin the
Fusion.This key value pair is
only for Fusion type Targets.

FP_GENE_STRAND Strand for the Five Prime FP_GENE_STRAND=+
Gene partner. Allowed
values are '+ and '-".This key
value pair is only for Fusion
type Targets.

FP_EXON_NUMBER Exon number in the Five FP_EXON_NUMBER=2
Prime Gene. Use comma
separated values if there the
Amplicon spans multiple
Exons.This key value pair is
only for Fusion type Targets.
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Key

Value

Example

TP_GENE_ID

TP_GENE_STRAND

TP_EXON_NUMBER

FP_CHROM

FP_START

FP_END

TP_CHROM

TP_START

Torrent Suite™ Software 5.6 Help

Name of the Three Prime
Gene Partner in the Fusion.
(This field is absent for
CONTROL type
amplicons.).This key value
pair is only for Fusion type
Targets.

Strand for the Three Prime
Gene partner. Allowed
values are '+ and '-". [This
field is absent for CONTROL
type amplicons.). This key
value pair is only for Fusion
type Targets.

Exon number in the Three
Prime Gene.Use comma
separated values if there the
Amplicon spans multiple
Exons. This key value pair is
only for Fusion type Targets.

Chromosome of the Five
Prime Gene.This key value
pair is only for Fusion type
Targets.

Start position for the Five
Prime Segments, Use
comma separated values if
there are multiple segment
Starts.This key value pair is
only for Fusion type Targets.

End position for the Five
Prime Segments. Use
comma separated values if
there are multiple segment
Ends.This key value pair is
only for Fusion type Targets.

Chromosome of the Three
Prime Gene. (This field is

absent for CONTROL type
amplicons.).This key value
pair is only for Fusion type
Targets.

Start position for the Three
Prime Segments, Use
comma separated values if
there are multiple segment
Starts.This key value pair is
only for Fusion type Targets.

TP_GENE_ID=FGFR1

TP_GENE_STRAND=-

TP_EXON_NUMBER=6

FP_CHROM=chr8

FP_START=38050257

FP_END=38050313

TP_CHROM=chr8

TP_START=38283673
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Key

Value

Example

TP_END

HOTSPOT_POSITION

CHROM

GENE_ID

TRANSCRIPT_ID

GENE_STRAND

EXON_NUM

START

End position for the Three
Prime Segments. Use
comma-separated values if
there are multiple segment
Ends.

Genomic coordinate of the
hotspot snp covered by the
amplicon. Use comma
separated values if multiple
hotspots are covered by the
amplicon.

Chromosome name of the
target region. This key is for
all non-fusion type targets.
For Fusion targets, we have
FP_CHROM and
TP_CHROM.

Name of the Gene for non-
fusion type targets. For
Fusion targets, we have
FP_GENE_ID and
TP_GENE_ID.

Transcript Id for non-fusion
type targets. For fusion
targets, we have
FP_TRANSCRIPT_ID and
TP_TRANSCRIPT_ID.

Strand of the Gene. This key
is for all non-fusion type
targets. For fusion targets,
we have FP_GENE_STRAND
and TP_GENE_STRAND.

Exon number(s) in the Gene.
For fusion targets, we have
FP_EXON_NUM and
TP_EXON_NUM.Use comma
separated values if there the
Amplicon spans multiple
Exons.

Start position of the Target
segment. Use comma
separated values if there are
multiple segment starts in
genomic space. This key is
for all non-fusion type
targets. For fusion targets,
we have FP_START and
TP_START.

TP_END=38283763

HOTSPOT_POSITION=38283
769

CHROM=chr8

GENE_ID=LMNA

TRANSCRIPT_ID=ENST0000

0389048

GENE_STRAND=+

EXON_NUM=3,4

START=53586113,53585786
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Key Value Example

END End position of the Target END=53586228,53585803
segment. Use comma
separated values if there are
multiple segments in
genomic space. This key is
for all non-fusion type
targets. For fusion targets,
we have FP_END and
TP_END.

MIN_READ_COUNT Minimum number of reads  MIN_READ_COUNT=100
needed to call the particular
target as present/absent.
This value is optional and if
present, it will override the
universal minimum read
count threshold (eg: 20).
Example Usage: For EGFR
deletion assay, we would use
a higher read count
threshold (greater than 20).

Example BED file entries

BAG4-FGFR1.B2F6 1 156 AMP1 . +

TYPE=Fusion;BREAKPOINT=36; FP GENE ID=BAG4;FP GENE STRAND=

+;FP EXON NUM=2;TP GENE ID=FGFR1;TP ~ GENE STRAND=-; TP ~EXON NUM=6
; FP CHROM=chr8; FP START=3805025

7 FP END=38050313; TP CHROM=chr8;TP START=38283673;TP END=382837
63; FP TRANSCRIPT ID=ENSG00000156735;TP TRANSCRIPT ID= =ENSG000000
77782 2 ITGB7.ENCTRL.E14E15 ? 1 2 132 2 2 AMP99 2 . 2 ?

+ ? . ? TYPE=CONTROL; FP_GENE

ID=ITGB7;FP CHROM=chrl2;FP EXON NUM=14,15; FP START=53586113,535
85786; FP END=53586228,53585803; FP GENE STRA

ND=-; FP TRANSCRIPT ID=ENSG00000139626

This section describes how to manage barcode sets.

™

With the pre-installed Ion Torrent™ barcodes, you can view the barcode sets and the
barcodes, incuding the barcode sequences.

With your own barcodes sets, you can do the following:
¢ View a DNA barcode or barcode set
* Add a custom DNA barcode set
* Delete a DNA barcode set
¢ Add abarcode to an existing DNA barcode

e Edit or delete an individual barcode
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Access the DNA barcode set pages
1. Click Settings (%) » References.

2. Inthe Admin References tab, click the Barcodes option in the left navigation
panel:

» Reference Sequences

» Obsolete Reference Sequences
» Target Regions

¥ Hotspots

» Test Fragments

» Barcodes

¥ Upload History

The DNA Barcodes page opens:

DNA Barcodes

Hame & Action
lonSset1 =]
lonXpress e
lonXpressRHA =]
MuSeek_Sprime_tag e
RHNA_Barcode_Hone =]
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Pre-installed DNA barcode sets

The pre-installed DNA barcode sets are seen under the Admin References tab:

DNA Barcodes

Name & Action
lonSet1 F e
lonXpress s )
lon¥pressRNA F e
MuSeek_Sprime_tag s )
RHA_Barcode_Mone F e

View a DNA barcode or barcode set

Follow these steps to view a DNA barcode or barcode set:

1. Click Settings (4) » References, then scroll down to the DNA Barcodes panel.

2. Do one of the following:

* C(lick the name of the barcode set to view.
* Click Settings (¥) » Edit for that barcode.
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This displays the barcodes in the set:

Barcodes in lonSet1 Delete Barcode Set

Flow Score Score jnnotation

ID & Sequence Adapter Order Mode Cutoff Action
lonSet1_01 TACTCACGATA CTGCTGTACGS. .. n 0.9 e
lonSet1_02 TCGTGTCGCAL CTGCTGTACGS. n 0.9 =3
lonSet1_03 TGATGATTGCC CTGCTGTACGS. .. n 0.9 e
lonSet1_04 TCGATAATCTT CTGCTGTACGG. . n 0.9 =3
lonSet1_05 TCTTACACCAC CTGCTGTACGS. .. n 0.9 e
(1]2 3 4

Note the page number controls to view other pages:

[i]z 3 4

You can click any column header in bold to sort the display by that column.

The Settings (#F) menu provides Edit and Delete options:

Annotation Action
I

£

ity
Edit
Delete

L2

The Settings (3#) menu Edit option is the same as double-clicking the barcode name.
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Dialog buttons are displayed to add a new barcode to this set and to delete the entire
barcode set. The barcode edit and delete feature is only for custom barcode sets that

you install.

IMPORTANT! Do not edit, delete, or modify the pre-installed barcode sets TonSet1,

IonXPress, IonXPressRNA, RNA Barcode None, or MuSeek 5Sprime tag.

lonSet1 barcodes

Here are the barcodes in the IonSetl barcode set:

1

lonSetl
IonSetl
IonSetl

01
02
03
04

IonSetl

neG

IonSet] 3

06

IonSetd

07

IonSetd 7

lonSet] 08

Ca

09

longet] 10

lonSet]
lonSetl
IenSetl
IonSetl
IonSetl

11
1.2
13
14
15
16

IonSetl

Sequence

TACTCACGATA
TCGTGTCGCAC
TGATGATTGCC
TCGATAATCTT
TCTTACACCAC
TAGCCAAGTAC
TGACATTACTT
TGCCTTACCGE
TACCGAGGCAC
TGCARGCCTTC
TACATTACATC
TCAAGCACCGL
TAGCTTACCGC
TCATGATCAAC
TGACCGCATCC
TGGTGTAGCAC

lonXpress barcodes

Here are the barcodes in the IonXPress barcode set:

Torrent Suite™ Software 5.6 Help

Adapler

CTECTGTACGGECCAAGGCGT
CTGCTGTACGGCCAAGGCGT
CTGCTGTACGGCCAAGGCGET
CTGCTGTACGGCCAAGGCGT
CTGCTETACGGCCAAMGGCGT
CTGCTGTACGECCAAGGOGT
CTGCTGTACGGCCAAGGCGT
CTGCTGTACGGCCAAGGCGT
CTGCTGTACGGCCAAGGCGT
CTGCTGTACGGCCAAGGCGT
CTGCTGTACGCCAAGECE]
CTGCTGTACGLCCAAGGCGT
CTGCTGTACGGCCAAGGCGET
CTGCTGTACGECCAAGGCGET
CTGCTETACGGCCAAGGCGET
CTGCTGTACGGCCAANGGCGT

(=N = — O = B — I — 0 — T — = — N Y — Y Y — O =

Flow Score Score Cutofl
Order Mode Annotation

0.9
0.9
0.9
0.9
0.9
0.9
0.9
0.9
0.9
0.9
0.9
0.9
0.9
0.9
0.9
0.9

263



@¥% Reference Management
" Manage Target Regions Files and Hotspot Files

lonXpressRNA barcodes
Here are the barcodes in the IonXPressRNA set:

RNA_Barcodes_None barcode

Here is the barcode in the RNA_Barcodes_None barcode set:

Museek barcode

Here is the barcode in the MuSeek_5prime_tag barcode set:

Barcodes in MuSeek_Sprime_tag

D Sequence Adapter Flow Order Score Mode Score Cutoff

MuSeek_Sprime_tag_001 TTCA 1 2

For custom DNA barcode sets

For your own barcode sets, you can do the following:
¢ View a DNA barcode or barcode set.
* Add a custom DNA barcode set.
* Delete a DNA barcode set.
¢ Add abarcode to an existing DNA barcode.

e Edit or delete an individual barcode.

Add a custom DNA barcode set

To add a barcode set, packaged as a list of barcodes in a Comma-separated Variable
(CSV) text file, create the CSV file then select the file to add it to the barcode set list.

1. If needed, create the CSV file containing a maximum of 96 barcodes, using
Microsoft™ Office Excel™, OpenOffice.org Calc, or an equivalent program. Save
the file with a . csv extension.

2. Click Settings (£¥) » References, then scroll down to the DNA Barcodes panel.
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3. Click Add new DNA Barcodes on the right side of the DNA Barcodes panel:

DNA Barcodes

Hame & Action

lon%set1 o)

4. Inthe Add New DNA Barcodes dialog, enter the required Barcode Set Name in

Torrent Suite™ Software 5.6 Help

the edit window and browse to find the Barcode CSV File:

Add New DNA Barcodes

Barcode
Set Name

Descriptive narme of the Result

Barcode Choose File | Mo file chosen

CSVY File

5% File of barcodes . Download the example file
sequence coilmn is required

Cancel Upload & Save

265



KK A

S@% Reference Management

WA
ane Manage Target Regions Files and Hotspot Files
5. To view an example CSV file, click Download the example file: The example
CSV file contains column headers only. The following table describes the column
headers:
Name Type Description
id_str String The unique name for this
barcode entry.
sequence String The barcode sequence. G,
C, A, and T (always upper-
case) are allowed.
adapter String The portion of the barcode
adapter not used to
identify this barcode. Often
referred to as the "stuffer
sequence”. G, C, A, and T
(always upper-case] are
allowed.
flow order -- Not used.
annotation -- Not used.
6. Click Upload & Save to add the new barcode set.
7. When you return to the DNA Barcodes section, click the Name column header to
sort the column and have your new barcode set appear.
Note: In previous releases, the CSV file used score_mode and score_cutoff fields.
These are now entered as BaseCaller parameters (--barcode-mode and --barcode-
cutoff) during reanalysis of a run.
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Delete a DNA barcode set

This feature is only for your own custom barcode sets.

IMPORTANT! Do not delete the pre-installed barcode sets IonSet1, IonXPress,
IonXPressRNA, RNA_Barcode_None, or MuSeek_5prime_tag.

1. At the top of the page, click Delete Barcode Set. This displays a delete
confirmation prompt:

Confirm Delete Barcode Set

Are you sure you want to delete this barcode set {MyBCSet)?

Cancel ¥es, Delete!

2. Click Yes, Delete! to delete the entire barcode set. Click Cancel to keep the
displayed barcodes.

Add a barcode to an existing DNA barcode set

This feature is only for custom barcode sets that you install.

IMPORTANT! Do not edit, delete, or modify the pre-installed barcodesets IonSet1,
IonXPress, IonXPressRNA, RNA Barcode None, or MuSeek 5Sprime tag.

1. Click Add Barcode.

B_EI'GDC'EE Delete Barcode Set
in CustomBCSet

ID Sequence Adapter Flow Order ﬁﬁ;‘:’? gﬁ&rﬁ Annotation Action

bhoch1 TACATC CTGC 1] 09 o3
hc2 TACATCS CTGC 1] 04 =3
boc3 TACATC CTGC 1] 09 o3
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2. The Add new barcode in set page opens:

Add new barcode in set
-
Barcode ID
IO of this barcode sequence
Sequence
SEQUENCE
Adapter
Adapter
Floworder
Flow Order I
Annotation
Motes
M

3. Add the barcode information and click Save Barcode. The new barcode is added
to the set displayed in the current barcode set list.
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Delete an individual barcode

The barcode delete feature is only for custom barcode sets that you install.

IMPORTANT! Do not edit, delete, or modify the pre-installed barcode sets IonSet1,
IonXPress, IonXPressRNA, RNA Barcode None, or MuSeek 5prime tag.

Follow these steps to remove a single barcode from a custom barcode set:

1. For the barcode to be deleted, click Settings (¥¥) » Delete:

B_arcndes Delete Barcode Set
in CustomBC Set

ID Sequence Adapter Flow Order fﬂ%?g gﬁ&rﬁ Annotation Action

hohl TACATC CTGEC 1] 0.a L g
Edit
hch?2 TACATC CTGC 1] 0.9 Delete ,h
hehD3 TACATC CTGC 1] 0.a o3
1)

2. In the confirmation window, if you are sure, click Yes, Delete!:

Confirm Delete Barcode

Are wou sure wou want to delete this barcode ke01 (24377

Cancel Yes, Delete!

The barcode is removed for the barcode set.
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Edit an individual barcode

The barcode edit feature is only for custom barcode sets that you install.

IMPORTANT! Do not edit, delete, or modify the pre-installed barcodesets IonSet1,
IonXPress, IonXPressRNA, RNA Barcode None, or MuSeek 5prime tag.

Follow these steps to edit a single barcode in a custom barcode set:

1. Click on the ID of a barcode, such as bc03. The Edit barcode in set page opens:

Edit barcode in set

Barcode |D : bcis

ID of this barcode sequUenCce ®
Sequence : TTCTCATTGAAL

SEfUENCE

Adapter:  GAT

Adapter
Floworder :

Flow Crder
Annotation :

Motes

2. To edit the barcode details, make your changes and click Save Barcode.
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Update Reference Library Indices

Note: When you upgrade your Torrent Suite  Software from a version earlier than
3.0, you must rebuild your reference indices. This process can take a few hours for
larger reference genomes. Your users should not submit data analysis jobs while the
reference indices are being rebuilt.

Follow these steps to rebuild your reference genome indices:

1. Log in with an ionadmin account.
2. Ensure that users do not submit analyses while the rebuild is in progress.

3. Click Settings (##) » References option:
Lo

Ahout

e |

Services
Flugins
Configure

Accounts

4. Click the Rebuild All Now button:

Ahout References Senices Flugins

Warning!
Due to the upgrade of TMAP, the THMAP specific index files fo
because the index rebuild may take a few hours for larger ge

Wie recormmend you rebuild all indices at the end of the wark

Rehuild All How

The TMAP index version used in 3.x and 4.x releases is tmap-f3.
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Work with Test Fragments

Use the Admin References tab to enter the test fragment nucleotide sequence to
search for within the sequenced nucleic acids. You can give a Name label and Key to
your test fragment sequence.

Ton Torrent  Software provides four test fragments by default.

1. Click Settings (£¥) » References:
o

About

Serices !
Flugins

Configure

Accounts

2. Inthe Admin References tab, click the Test Fragment option in the left
navigation panel:

» Reference Sequences

» Obsolete Reference Sequences
» Target Regions

» Hotspots

» Barcodes

» Upload History
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The Test Fragment listing page opens:

Test Fragments

Hame * HKey Comments Sequence Enahled
TF_D ATCG TTGCGCGCGCTETGAATGE .. Yes
TF_C ATCG TACGAGCGTGTAGACGTGT, | NEE:
TF_B ATCG TGAAGCCCTTTTCCCGETG .. Yes
TF_A, ATCG TETTTTAGGGTCCCCGEEE . Yes

3. Click on a test fragment name to see its complete sequence.

Be sure to enter the test fragment sequence using only the uppercase letters: A, T,
Cand G. If you enter an invalid character or duplicate test fragment, you are not
be able to save your changes.

Contact your Ion Torrent " representative if you have questions about the test
fragment templates installed in your Torrent Browser.
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Edit a test fragment

If Ton Torrent  provides new test fragments as part of an updated protocol, it will be
necessary to carefully cut and paste this information into the fields.

ﬁ WARNING! Do not modify the test fragment sequences for the test fragments
that are supplied by Ion Torrent  Software: TE_A, TF_B, TF_C, and TF_D

1. Click the Name column label to display test fragment details. This example
showstest fragment TF-C selected for editing:

Edit Test Fragment
Mame (TF_A
Key ATCG

Sequence  TGTTTTAGGGTCOCCE

Enabled

Comments

Delete Cancel m

™

2. On your own test fragment (not test fragments supplied by Ion Torrent™), you
can make the following edits:

¢ Change the test fragment name, key, or comments.
* Change the test fragment nucleotide sequence in the Sequence field.

¢ Change whether or not the test fragment is enabled.

3. Click Save to save your changes or click Cancel to end your edit session without
modifying the test fragment.
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Add a test fragment

1. Click the Add Test Fragment button at the upper right corner to add a new test
fragment.

Add New Test Fragment

Name
Key
Sequence

Enabled []

Comments

2. Choose a unique name for your test fragment.

3. Be sure to enter thetest fragment Key and Sequence using only the uppercase
letters: A, T, C and G. If you enter an invalid character or duplicate test fragment,
you are not be able to save your changes.

4. Click Save to save your changes. Your new test fragment is displayed in the test
fragment list.(Or click Cancel to end your session without adding a new test
fragment.)

Download an lon Reference File

In the admin References tab, you can download a GHRC38, MM10, hg19, or E. coli
reference file.

The hg19 reference available here is the same as what is used for Torrent Suite™
analyses.
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Download a reference file

Follow these steps to download a reference file:

1. Click Settings ($) » References:

About
[ e |

| Senices
| Plugins
Configure
lon Reparter Configure

Accounts

2. Click the Import References button:

“ m QV

About References Senvices Plugins Configure on Reporter Configure

Reference Sequences

3 Obsolete Reference Sequences

Accounts

» Target Regions

> Hotspots Short Name Description Notes Date v Index version Status Enabled

3 Test Fragments

3 Barcodes - Enterchacteria WIS complete e
phage lambda

3 Upload History

) [y 8y 2014/10/30 04:63
hg19_ampliseq_..  Transcriptome o tmap-3 complete true
ERCC v
Rhodopseudomo.
2014/04/07 12:40
thodopalu palustris CGAOD9 o tmap-3 complete true
chromosome
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lon References

Chicken (galGald)

Chinese hamster (crigri1)

Cow (bosTauT)

Dog (canfam3)

hg19 AmpliSeq Transcriptome ERCC vi

Human (hg19)
AmpliSeq supported hg19

Human RNA (hg19 RNA)
AmpliSeq supported hg19

Maize (AGP v3)

Mouse (mm10)

AmpliSeq supported mm10

Pig (susSer3)

Rice (IRGSP 1.0)

Sheep (oviAri3)

Soybean (glyma 1.1)

Tomato (SL 2.40)
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3. Click the Import button for the reference:

Import Custom Reference

Reference URL

Import
(required) :

URL to the reference, a zip or gzip file on a remote server

Import
i Short name (required) :

Short form of reference name, use letters, numbers, and underscore only
Import

Description (required) :

import Alonger, more descriptive reference name.

Version (optional)
complete

mpor Notes (optional)

Import Custom

Import

Import

Import

Import
Import
Import
Import

Import

Note: these downloads are larger than the tranditional zipped fasta file because they are pre-ndexed for your convenience. If you prefer a smaller total download, please visit the lon

Community

References Downloading

Nama

4. Wait while the file downloads. You can click the Refresh button to update the
progress percentage:

o Rusfrersh it
Prograss (%) Status
TouEE_ il 0. Lar i I BB E
jaenio_hgl § fasta 100 npete
= phennedyeelemncasmouss_mmi0iEog 1000 C O plee

5. Alternatively, you can also import a custom reference from this page. Enter

relevant information in the Import Custom Reference pane and click Import

Custom.

This human reference is based on the GRCh37.p5 version of the human genome
assembly. The GRCh37.p5 version is described at this web site: http://
www.ncbi.nlm.nih.gov/projects/genome/assembly/grc/human/data/index.shtml.

The remainder of this section lists differences between GRCh37.p5 and the Ion
Reference hg19 versions of the human genome.
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Three positions with ambiguity codes

Three positions on chromosome 3 are marked with 'N' in the UCSC version of the
genome. These positions have IUPAC ambiguity codes in our version:

Position IUPAC Ambiguity code in lon | Hard masked character in
reference UCSC hg19
60830534 M N
60830763 R N
60830764 R N

Hard masked PAR regions in chromosome Y

The chromosome Y sequence has the Pseudo Autosomal Regions (PAR) hard masked.
This practice is consistent with the 1000 Genome Consortium's decision to hard mask
these regions inchromosomeY in order to prevent mis-mapping of reads and issues in
variant calling on the gender chromosomes.

The masked Y pseudoautosomal regions are chrY:10001-2649520 and chrY:
59034050-59363566. (A related file can be downloaded from ftp://ftp.ensembl.org/
pub/release-56/fasta’homo_sapiens/dna/
Homo_sapiens.GRCh37.56.dna.chromosome.Y.fa.gz)

The following background information is from the UCSC site http://genome.ucsc.edu/
cgi-bin/hgGateway?org=human&db=hg19

"The Y chromosome in this assembly contains two pseudoautosomal regions (PARs) that were
taken from the corresponding regions in the X chromosome and are exact duplicates:

chrY:10001-2649520 and chrY:59034050-59363566 chrX:60001-2699520 and chrX:
154931044-155260560"

Chromosome M

We use the Cambridge Reference Sequence (rCRS) for chromosome M with the
GenBank accession number NC_012920. UCSC has announced that they also are
using this version in the next human assembly release.

The following background information is from the UCSC site http://genome.ucsc.edu/
cgi-bin/hgGateway?org=human&db=hg19

“Note on chrMSince the release of the UCSC hg19 assembly, the Homo sapiens mitochondrion
sequence (represented as ‘chrM’ in the Genome Browser) has been replaced in GenBank with
the record NC_012920. We have not replaced the original sequence, NC_001807 in the hg19
Genome Browser. We plan to use the Revised Cambridge Reference Sequence (rCRS) in the
next human assembly release.”
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Work with Obsolete Reference Sequences

The Obsolete References Sequences section provides a checklist of the libraries that
need to be upgraded after an update to a Torrent Suite™ Software release that uses a
new TMAP index. (Your list will be different.)

Obsolete Reference Sequences

Name Description Noles Date Index version Status

)
e_coli_dh10b E. coliDH10B 201 2004727 04:08 PM tmap-12 errot
hg19 Homo saplens 2012004181016 AM tmap-12 error
chromi0_hg18 Chromosome 10 hg18 2012002721 0341 P trmap-12 arror
CFTR2010genomic CFTR 2010 2012002721 D341 PM tmap-12 error
HI_amplicon Broad HIV Amplicon 201200221 03:41 PM trmap-12 error

The Torrent Browser aids you in identifying the obsolete sequences by automatically
recording the libraries that were installed before the upgrade. You need to upgrade
these obsolete reference sequences using the Rebuild All Now button. (However, the
Rebuild All Now process does not remove the references from the obsolete table. If
you previously upgraded to 2.2, you rebuilt your references indices at that time, and
you do not need to rebuild them again.)

The only reference library available after upgrade is E. coli DH10B, which is displayed
in the Reference Sequences panel of the Admin References tab and on the Ion PGM™
Sequencer genome choice list menu. The previous default Ion Torrent™ reference
library, E. coli K12, is permanently removed.

Why are my references obsolete

™

Only when a Torrent Suite™ Software upgrade requires that reference indices be
rebuilt, the upgrade involves these steps:

1. The upgrade installs only E. coli DH10B and moves other references into the
Obsolete Reference Sequences table.

2. When you do Rebuild All Now and the previously obsolete references are
copied back to the main Reference Sequences section.

3. The previously obsolete references also remain in the Obsolete Reference
Sequences table.

Delete a Reference Sequence
The section provides instructions to delete a reference sequence.

Recovery of a deleted reference sequence is not supported.
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Delete a Reference Sequence
1. Click Settings (%F) » Reference:

About

Sernvices
Plugins

Configure
lon Reporter Configure
Accounts

2. In the Reference Sequences section, click the Name of the reference sequence
you want to delete. Click Delete Genome to delete the reference sequence:

test1

Name test
Nchi hame tost

Read Sample Size .

(setto 0 for noe sampling)
Motes
P
Enabled

Genome Info  « penome_name : test
index_version : trnap-f3
CENOME_VErsion ;1

« fenome_length ;. 4639675

FASTA test1.fasta (File size 4,706,046 bytes)

Save Changes Q&L Delete Genome
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A confirmation box appears:

m Delete Genome

AFE YOl SUME yoU want to delete test3? Once you delete this, it can not be recovered.

Mo, Keep It Yes, Delete It

3. Click Yes, Delete It only if you are sure this genome should be deleted. Click No,
Keep It to exit the dialog without deleting the reference sequence: The deleted
reference sequence is removed from the Reference Sequences list.

In this release you cannot delete a reference from the Obsolete Reference Sequences
section.
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To avoid data loss and ensure that sufficient disk space is available on the server, you

T™

can configure Torrent Suite™ Software to automatically archive and delete sequencing
data that are no longer needed.

You can also manually archive or delete data from individual run reports or groups of
reports, or export selected data to a mounted external drive. To understand how disk
space is allocated and how files are managed, you can view disk usage, active data
management jobs, statistics, and detailed logs on each of these activities.

lon instrument data types

Data that are generated from Ion sequencers consists of the following types of files:
¢ Signal Processing Input (.dat)
¢ Basecalling Input (1.wells)
¢ Output files (.bam, plugin output, etc.)
* Intermediate files

For more details about these file types, see “Analysis pipeline overview” on page 417.

Recommendations on when to archive each file type are listed in the following table.

File type Details
Signal Processing Signal Processing Input files (4 files per cycle] consist of the raw
Input voltage measurement data collected during the sequencing run.

On the lon PGM™ System, you can reanalyze a run with the Signal
Processing Input file, which is available on the instrument. Keep
the Signal Processing Input data if you want to reanalyze the run
starting from raw signal processing data.

However, on the lon Proton™ or lon S5™ Systems, Signal
Processing Input data are used on the instrument, then deleted.
These files are only available on the Torrent Suite™ Software as
thumbnails for the lon Proton™ or lon S5™ Systems.

Basecalling Input Signal Processing Input files are converted to a single condensed
Basecalling Input file representing the processed signal.

Keep or archive Basecalling Input data if you want to reanalyze the
run. This can save time and resources because reanalyses use the
Basecalling Input data, rather than the raw Signal Processing
Input data.

On the lon Proton™ and lon S5™ Systems, Basecalling Input data
are transferred to the Torrent Server and are available for
reanalyses.
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File type Details

Output files Output files consist of all BAM files, run reports, and plugin
results. It is important to keep and archive these files. Delete
output files onlyif you are sure that you no longer need the files.

Intermediate files Intermediate files contain information used for debugging runs.
You can delete these files immediately after instrument runs,
without affecting data.

Archive or delete data automatically

To avoid data loss, it is critical that sufficient disk space is available on the server.
Therefore, it is important to have a strategy to monitor disk space and archive or
delete data as needed.

* You can configure your Torrent Server to archive data to a mounted drive
automatically after a data age threshold is met. Data that you assign to be
automatically archived are copied to the designated location, then deleted from
the Torrent Server. Automatic archiving helps to maintain available disk space,
and simplifies management of data that you want to save to another volume.

* You can also configure your Torrent Server to delete data automatically when
thresholds of filled disk space and data age are met. Automatic deletion of files is
important to maintain available disk space, and simplifies removal of data that
are no longer necessary to keep.

* You can assign automated archive or delete actions to each data file category
independently of the others.

* An admin role is required for configuring data management.
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IMPORTANT! When you configure your Torrent Server to delete data automatically,
the data are permanently deleted. You cannot restore data after deletion.

1. In the Data tab, click Data Management, go the Configuration section, then click

Configure.

2. On the Data Management Configuration screen, select an auto-action, or select
Disabled for each file category, then configure:

If you select
this auto action

Select these options:

Disabled

No selections are necessary—data in the file category must be
archived or deleted manually.

Archive

1. Data Age Threshold (days): Set the number of days that you
want data stored on the server before data are archived.

2. Archive Directory: Select the mounted volume where you want
to store the archive, or click Browse, then navigate to the
mounted volume where you want the archive stored.

Delete

1. Data Age Threshold (days]: Set the number of days that data
are stored on the server before data are deleted.

2. Disk Full Threshold (Percent): Set the percentage of disk
space that is filled on the server before data are deleted.

284
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Note: Data deletion is triggered when the Disk Full Threshold for that file
category is met. Data that exceeds the Data Age Threshold for that file category
is then deleted.

Data n

Data Management

Data Management Configuration

Data Age Threshold Disk Full Threshold

File Category Auto Action (days) (Percent) Archive Directory
Signal Processing Input Required input files for signal processing Delete v 21 80
Basecalling Input Required input files for besecaliing Delete v 60 80
Output Files Report rendering, defiverables, plugins output | AICNIVE v 90 imnt/external v | Browse
Intermediate Files Files ussd for debugging only Delete vo|7 20
Enabled: ¥

Enable the automatic data management actions to run. Uncheck to disable.

Email : yourname@email.com

Enter one or more email addresses where notifications are sent. Email is sent through unauthenticated postfix, a Linux e-mail program.

Auto Acknowledge ¥

Delete?:  Acknowledge Signal Processing Input data deletion automatically.

Torrent Suite™ Software 5.6 Help
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Select the Enabled checkbox to enable the automatic data management you have
configured. Deselect the checkbox to suspend automatic action.

Enter an email address in the Email: field to receive notifications for automatic
data management actions.

Note: If you use a Linux™ mail server, you may have access to Postfix, an open-
source Linux™ mail server. Postfix has many configuration options that IT
administrators can use to adjust mail routing parameters. You can find Postfix
documentation at http://www.postfix.org/documentation.html.

(Optional) To enable auto-acknowledgement of deletion of Signal Processing
Input data, select the Auto Acknowledge Delete? checkbox. Action is not
required for data deletion to occur.

Note: If you deselect Auto Acknowledge Delete, notifications are sent for each
Signal Processing Input deletion. A reviewer must manually acknowledge each
deletion action before the Signal Processing Input data are deleted.

After you have completed the configuration, click Save.
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7. (Optional) On the Data Management screen, click Configuration Log in the
Configuration section to view a record of configuration changes.

8. (Optional) To view a record of data management actions (archiving and deleting),
click History.

Import data for data transfers or restoration

You can import data from a mounted storage drive such as an external server or USB
drive. The import function can be used to transfer data between servers or restore
data that has been archived.

Data can only be imported from storage drives that have been mounted on your
Torrent Server. For information about mounting a storage drive, see “Increase file
storage and available disk space” on page 293.

Note:

+ Exported and archived files on a mounted drive can be viewed and analyzed
directly in Torrent Suite” Software under Completed Runs & Reports, but if you
unmount the storage device, the data will no longer be available. Import files before
unmounting a drive to continue using them.

+ Imported files appear as standard data files under Completed Runs & Reports.

- The Import function can only retrieve data files that were previously exported or
archived. For example, if you try to import files from an archive that does not
include Signal Processing Input or Basecalling Input files, these files are not
retrieved.

To import files:

1. Under the Data tab, click Data Management.
2. In the Data Import section of the screen, click Import.

3. Select a mounted Archive Directory from the dropdown list, or click Browse to
navigate to a particular subdirectory, then click Select.

4. Select the file categories that you want to import with the checkboxes, then click
Import.

View disk usage parameters

286

In the Data tab, click Data Management, then scroll to the Disk Usage section.
Parameters in the Disk Usage section

Parameter Definition

Keep File space devoted to files that are to be
kept.

Used File space being currently used by data
files.

Free Space available for storing data files.
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View category statistics
Parameter Definition
Threshold | Threshold above which intermediate files
are deleted or archived, based on the
automatic configuration settings.
Threshold S Threshold above which Signal Processing

Input files are deleted or archived, based on
the automatic configuration settings.

Threshold B Threshold above which Base Caller Input
files are deleted or archived, based on the
automatic configuration settings.

Threshold O Threshold above which Output files are
deleted or archived, based on the automatic
configuration settings.

Note: For details about automatic deletion and archive creation, see “Archive or
delete data automatically” on page 283.

View category statistics

In the Data tab, click Data Management, then scroll to the Category Statistics section.
Parameters of the Category Statistics section

Parameter Definition

File Category Group File type (see “lon instrument data
types” on page 282 for details.)

Total Number of data sets in each file category.

Keep Number of data sets in each file category
that are exempt from data management
actions.

Archived Number of data sets in each file category

that have been removed from your system
by data management archival.

Deleted Number of data sets in each file category
that have been removed from your system
by data management deletion.

In Process Data sets that are currently
archiving/deleting/importing.

Error Error column displays the count of file
categories that are currently in an error
state.

Note: If a data management action is rerun
on one of these file categories and
completes successfully, then that file
category no longer appears in the error
count.

Disk Usage GB used by each file category.
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View active data management jobs

You can view runs that are in progress on the Torrent Server.

1. Click the Data tab, then click Data Management, and scroll to the Active Data
Management Jobs section.

Active Data Management Jobs

Started On v State

2017/08/23

Deleting
01.43PM

2017105123
0541 PM

OO [0

Deleting

288

Size

Report Name Category wB) Destination User Comment
Auto_user_S5XL viola-

217--R132281-530_23_1_SOP_SOP_ext- Output Files 1054.2 dm_agent Auto Action
CEl_71064_tn

Auto_user_501-336-R127212- .

79252 IC_530Cartridge_T5.308_661... Qutput Files 8495 dm_agent Auto Action

E‘llems per page 1-2of 2 items

Details about active data management jobs

Parameter Definition

Started On Start date and time of job.

State Status of job/file.

Report name Identifier of job.

Category Identifies the file as one of the following
file types.

¢ Signal Processing Input: Required
input files for signal processing.

e Base calling input: Required input
files for base calling.

e Output files: Files for data
processing.

¢ Intermediate Files: Files used for
debugging.

File size File size of report.

Destination Destination is the folder for archive or
export action on a report.

User User that started the data management
action. For auto-actions, "dm-agent” is
the user.

Comment Free space for notes.

2. (Optional) Click on a report to see the status of that report.
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Error messages Monitor the Disk Space Management section for messages that require administrator
action:
Error message Action
Backup drive is full or missing Replace the backup drive.
Error Check the file /var/log/ion/

data management.log for information
regarding the specific error condition. If
appropriate, report the error to lon
technical support.

Disk full message Torrent Suite™ Software performance is affected when a disk partition is more than
95% full. When Torrent Server or a mounted storage device reaches 95% full (and

™

again at 99%), a warning is displayed at the top of the Torrent Suite™ Software screen.

*** CRITICAL! /results/: Partition is getting very full - 95% ***

Search for run reports with disk usage status

You can find run reports with searches that are based on disk usage status, such as
whether the data type is archived, or is stored in a local directory. You can also use
other search criteria, including name and report date.

1. In the Data tab, click Data Management, then scroll to the Disk Space
Management section.

2. Enter a search term or select for the following criteria:

e Search names
* Report date

¢ File type settings that are configured as Keep, are stored in the Local
directory, Archived, Deleted, In-process, or contain an Error for each file
type:

SigProc (Signal Processing)

— Basecalling (Basecalling input)

Output

Intermediate

3. After you select the filters, click Go.

Run reports that match the criteria that you use in the search are listed in the Disk
Space Management table.
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Keep run report data

You can prevent data from being deleted for individual run reports.

1.

In the Data tab, click Data Management, then scroll to the Disk Space
Management section.

Find the report, then select the checkbox under the Keep column next to each file
category in that row.

If Keep is enabled, the data file will not be deleted. Instead, an error occurs if a user
tries to confirm a deletion of run report data.

Manually export run data

You can manually export run data to a storage device that is mounted on the Torrent
Server. When you export the data, it is copied from the Torrent Server to the archive
location. The data remains on the Torrent Server, and the run results listed in the
Completed Runs & Results screen continue to link to the data on the Torrent Server
(see “Increase file storage and available disk space” on page 293 for more

information).

1. Inthe Data tab, click Data Management, then scroll to the Disk Space
Management section.

2. Select the checkboxes to the left of the report names that contain the run data that
you want to export, then click Process Selected.
To export data from only one run report, you can click Settings ({#) » Actions to
the right of the report name.

3. In the dialog, click the checkbox to the left of each File Category for the type of
data that you want to export, then click Export Selected.

4. Click Browse to select an export directory from the list of mounted storage
devices.

5. (Optional) Enter a comment.

6. Click Confirm.

290

The data for the file categories of the selected run reports are copied to the
external hard drive. The data are also available in the local hard drive run results
directory.
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Manually archive run data

You can manually archive run data to storage device that is mounted on the Torrent
Server. When you archive the data, it is moved from the Torrent Server to the archive
location. The run results listed in the Completed Runs & Results screen link to the
data on the archive storage device as long as that device remains mounted on the
Torrent Server. For details, see “Increase file storage and available disk space” on
page 293.

To manually archive run data:

1.

Torrent Suite™ Software 5.6 Help

In the Data tab, click Data Management, then scroll to the Disk Space
Management section.

Select the checkboxes to the left of the report names that contain data that you
want to archive, then click Process Selected.

To archive data from only one run report, you can alternatively click Settings
(£}#) » Actions to the right of the report name.

In the dialog, click the checkbox to the left of each File Category for the type of
data that you want to archive, then click Archive Selected.

Report Name: Auto_user_g41-867--R130434-536av5_045mM-KG_69256_tn

Run Name: R_2017_05_16_14_25_20_user_g41-867--R130434-536av5_045mM-KG

select All File Category size(MB) [Keep| state
signal Processing Input ~ Required input s forsignal processing 36896.1 Local

Basecalling Input R asecalling 560.0 Local

Output Files Reporte ins output 455.7 Local

Intermediate Files Files used for debugaing only 3130 Local

Delete Selected | Archive Selected | Export Selected | Close

Click Browse to select an archive directory from the list of mounted storage
devices.

(Optional) Enter a comment.

Click Confirm.

The data in the file categories of the selected run reports are moved to the archive
location.
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Manually delete run data

You can manually delete run data from the Torrent Server.

Note: For details about automatic deletion of run data, see “Archive or delete data
automatically” on page 283.

IMPORTANT! Use this procedure only if you are sure that you no longer require
access to the run data. After you delete data, it cannot be restored.

. In the Data tab, click Data Management, then scroll to the Disk Space

Management section.

Select the checkboxes to the left of the report names that contain the run data that
you want to delete, then click Process Selected.

If you want to delete data from only one run report, you can click Settings
(£} » Actions to the right of the report name.

Note: If Keep is enabled, the data will be kept on the local hard drive. If you try
to delete data, you will receive an error.

In the pop-up window, click the checkbox to the left of each File Category for the
type of data that you want to delete, then click Delete Selected.

Report Name: Auto_user_g33-1409-R130406-C5051_ICHI-Q_TS5.4_AmpTx-0516_69211_tn
Run Name: R_2017_05_16_13_14_02_user_g33-1409-R130406-C50s1_ICH-Q_TS5 4_AmpTx-0516
select All File Category Size(MB) Keep State

signal Processing Input ~ Required input fles for signal processin 617412 Local

Basecalling Input 10018 Local

Output Files 737.9 Local

Intermediate Files Files used for debugaing only 4441 Local

(Optional) Enter a comment.

Click Confirm.

The data for the file categories of the selected run reports is permanently deleted
from the system.

View the data management actions log

292

You can view a log for each run report that describes each change that is made to data
management settings.

1.

2.

In the Data tab, click Data Management.
Scroll to the Disk Space Management section.

Find the report for which you want to view the data management actions log.

See “Search for run reports with disk usage status” on page 289 for details about
how to search for a run in the Disk Space Management section.
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4. Click Settings (£}) » View Log.
A new screen containing chronological list of actions taken for this run report
opens. The date of the action, name of the user, and any comments are displayed.

5. Click Close to return to the Data Management page.

Increase file storage and available disk space

USB drives

You can increase file storage space for data and results files with a Torrent Storage™
NAS device, your own network access storage (NAS) device, or a USB drive.

After one or more of these storage drives has been installed and configured, you can
use the drive to save data locally in the lab, transfer data between servers, store data
with disk failure tolerance, and expand storage space.

Storage method Description
Torrent Storage™ NAS A field service engineer typically installs this device. It
device attaches directly to a Torrent Server or lon S5 Instrument

server, or can connect over a local network. After
installation, it must be mounted on the local server as
described in “Connect to a Torrent Storage” NAS
device” on page 296.

Your own NAS device Similar to the Torrent Storage™ NAS device, but typically
installed by your own system administrator.

USB Drive Attaches directly to a Torrent Server or lon S5™ Instrument
server. After installation, it must be mounted on the local
server as described in “Mount a USB drive” on page 293.

Mount a USB drive

To mount a USB drive (either an external hard drive or large flash drive), a working
knowledge of Linux command line and a basic understanding of disk drives and
partitions are necessary.

Torrent Server is an Ubuntu ' server, which does not mount external hard drives
automatically. To address this need, the ion-usbmount utility is included with
Torrent Suite " Software. This utility automatically mounts attached USB drives in
the /media directory. If ion-usbmount does not mount a particular USB drive
automatically, follow these steps to mount the drive manually.

Note: These instructions only provide an overview of the required steps, and can be a
helpful reminder if you are new to the Linux  operating system. We recommend that
a system administrator perform the Linux mount and unmount procedures. For
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more detailed instructions and background information, see the Ubuntu’

M

documentation: https://help.ubuntu.com/community/Mount/USB.

1.

ionadmin@itw-test0l:~5 sudeo fdisk
-1

Disk /dev/sda: 500.1 GB,
5001078562016 bytes

255 heads, &3 sectors/track, 60801
cylinders

Units = eylinders of 16065 * 512 =
8225280 bytes

Sector gize (logical/physical): 512
bytes / 512 bytes

I/0 sgize (minimum/optimal): 512
bytes / 512 bytes

Disk identifier: 0x0004366b

Device Boot Start End
Blocks Id System
Jdev/adal * 1 37

291840 82 Linux
Partition 1 does not end on
cylinder boundary.

Jdev/ada2 37 60802
488092673 5 Extended
Jdev/adas 37 60802

488092872 82 Linux LVM

2. Connect the USB drive.

Before connecting a USB drive, enter the following command to see a list of the
drives in the system: sudo fdisk \-1
The local hard drive usually has a name such as /dev/sda, as in the following
example:
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3. Wait approximately 10 seconds, then reenter: sudo fdisk \-1.
The new USB drive appears in the list. The name of the USB drive is
usually /dev/sdb or /dev/sdc, depending on the number of drives installed.
The partition is a number that is added to the name of the physical drive. For
example, the first partition on drive /dev/sdc would be called /dev/sdcl.In
the following example, there is a 2-GB partition (1953512001 blocks) attached to
the system that is named /dev/sdbl. It is configured with a Linux ™ partition. (If
the drive was formatted on Windows™, it is either a FAT or an NTES partition).

ionadmin@itw-test0l:/35 sudo
fdisk -1

Disk /dev/sda: 500.1 GBE,
500107862016 bytes

255 heads, 63 sectors/track,
60801 cylinders

Units = cylinders of 16065 *
512 = 8225280 bytes

Sector size
{logical/physical) : 512 bytes
/ 512 bytes

I/0 size (minimum/optimal}:
512 bytes / 512 bytes

Disk identifier: 0x0004366b

Device Boot Start End
Blocks Id System
J/dev/sdal * 1 37

291840 83 Linux
Partition 1 does not end on
cylinder boundary.

/dev/sda2 37 60802
488092673 5 Extended
/dev/sdas 37 60802

488092672 8e Linux LVM

Disk /dev/sdb: 2000.4 GB,
2000398934016 bytes

255 heads, 63 sectors/track,
243201 cylinders

Units = cylinders of 16065 *
512 = 8225280 bytes

Sector size
{logical/physical) : 512 bytes
/ 512 bytes

I/0 size (minimum/optimal}:
512 bytes / 512 bytes

Disk identifier: 0x5786fcfb

Device Boot Start End
Blocks Id System
/dev/sdbl 1 243201

1953512001 83 Linux
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4. If the drive has a Windows™ FAT or NTFS partition, reformat the drive as an ext3
partition to preserve the Linux™ file information, as follows.

IMPORTANT! Be careful to format the correct hard drive.

a. Enter sudo mkfs.ext3 <your device>.For example:

sudo mkfs.ext3 /dev/sdeb

b. Label the partition on the external USB drive. To label the partition, enter the
following:

sudo e2label <your device place> <partition label>.?

For example, the external drive that is connected in /dev/sdbl is labeled as
‘TS_Backupl"

sudo e2label /dev/sdbl TS Backupl

It is important to provide a different label name to each partition to avoid
error when multiple external USB drives are connected to the Torrent Server
at the same time.

5. Ensure that the external USB drive mounts automatically. Disconnect the external
USB drive, then reconnect it. Wait approximately 10 seconds. The external USB
drive appears under the Services tab in the Torrent Suite™ Software.

Unmount a USB drive

Before disconnecting a USB drive, we recommend that you unmount it first, to ensure
that all data have been written to disk. If you pull out the USB connection without
unmounting the USB drive first, there is a high risk of data loss.

To unmount a USB drive, enter the following command in the command line of your
Torrent Server: sudo umount /dev/sdbl /media/external.

Connect to a Initial setup of your Torrent Storage™ NAS device is provided by your field service
™ engineer. If the device is moved or disconnected for any reason (e.g., a power outage),
Torrent Storage & y g-ap g
. this section provides instructions for an administrator-level user to reconnect the
NAS device P

device to a Torrent Server.

™

¢ If the Torrent Storage™ NAS device connects directly to the Torrent Server, see
“Connect directly to a Torrent Storage™ NAS device” on page 297.

e If the device connects over a network to the Torrent Server, see “Connect over a
network to a Torrent Storage™ NAS device” on page 298.
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Connect directly to a Torrent Storage™ NAS device

If your Torrent Server or Ion S5 Instrument is connected directly to your Torrent
Storage NAS device, use the following steps to mount the device.

Note: You must be signed in as an administrator-level user to perform these steps.

1.

In the Torrent Suite™ Software, click Settings (£F) » About, then confirm that the
Torrent Suite™ Software version is 5.2 or later.

Note: To update your software, see “Update Torrent Suite™ Software” on
page 303.

Click Settings (%) » Configure, then scroll to Torrent Storage.

Locate the IP address of the Torrent Storage™ NAS device in the Select a
TorrentNAS Device list. It may take several seconds for the list to populate.

™

Note: If the Torrent Storage™ NAS device is not automatically detected in
<1 minute, confirm that the correct network ports are connected, then click
Refresh List.

Select the IP address of the device in the Select a TorrentNAS Device list.

Select a volume on the device under Select a Share Volume, then click Add
Volume.

Torrent Storage

1. Select a TorrentNAS Device... Refresh List Currently Mounted Volumes Refresh List

192.68.204.10 192.68.204.10/Pool/share1 on server nfs

...or enter an IP or hostname here

2. Select a Share Volume

sharet

3. Review mountpoint and click Add Velume

192 68.204 10/pool/share1

The storage volume is connected to the server and is listed in the Currently Mounted
Volumes list.

Torrent Suite™ Software 5.6 Help
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Connect over a network to a Torrent Storage”™ NAS device

If your Torrent Server or Ion S5 Instrument is installed on the same network as your
Torrent Storage NAS device, use the following steps to mount the device.

Note: You must be signed in as an administrator-level user to perform these steps.

1. In Torrent Suite™ Software, click Settings (¥#) » About, then confirm that the
Torrent Suite™ Software version is 5.2 or later.

Note: To update your software, see “Update Torrent Suite™ Software” on
page 303.

2. Click Settings (##) » Configure, then scroll to Torrent Storage.

3. Enter the IP address of the Torrent Storage™ NAS device in the ...or enter an IP or
hostname here field, then press the Enter key.

4. Select a volume on the device under Select a Share Volume, then click Add
Volume.

Torrent Storage

1. Select a TorrentNAS Device... Refresh List Currently Mounted Volumes Refresh List

192.68.204.10 192.68.204.10/Pool/sharet on server nfs

...or enter an IP or hostname here

2. Select a Share Volume

share1

3. Review mountpoint and click Add Volume

192 68.204 10/pool/share1

The storage volume is connected to the server and is listed in Currently Mounted
Volumes.
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You can check the status of a Torrent Storage” NAS device in Torrent Suite” Software.

1. Click Settings (%) » Services.

2. Scroll to the Torrent NAS Info section to view information on Torrent Storage"

M

NAS devices that are attached to your server through a network, including
available storage capacity, usage, and health of the device.

Torrent NAS Info o

Name
+ pool
+ syspool
Name
+ pool
+ syspool

Torrent Suite™ Software 5.6 Help

Allocated
33.4T
51.2G

Allocated
33.4T
51.2G

Available
84.0T
404G

Available
84.0T
404G

Capacity
25%
1%

Capacity
25%
1%

Health

(onwne]

Health

(onne
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Administrative privileges allow you to configure Torrent Suite™ Software and

administer Torrent Server databases. An ionadmin account is required for the
procedures in this section.

Note: An ionuser account does not include sufficient privileges for these
procedures.

Stop a sequencing Run

Use the following procedure to stop an analysis job for a run that has started but not
completed.

1. Click Settings (%) » Services.
o

Ahout

References

Flugins
Configure

Accounts

2. Scroll down to the Active Jobs section, find the Name for the sequencing Run
that you want to stop. The Status Message column indicates job is running.

Active Jobs

Hame Job/PID Type Status Message Report

B--35_R151330 127445 gnd Jobisrunning B9-38_R151330 Terminate

B9-30_R1512331 127545 gnd  Jobis running B9-30_R151331 |Terminate

3. Click Terminate for the sequencing Run that you want to stop.
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4. In the confirmation dialog, click Yes to end the run, or click No for the analysis
job continue.

Are you suUre you want to terminate B9-38_R151331 7

Yes Mo

5. Refresh your browser to update the information in the Active Jobs section. The
run is removed from the Active Jobs list, which displays No active jobs if no
other runs are active:

Active Jobs

Mo active jobs.

6. In the Data tab, click Completed Runs & Reports.

The status is TERMINATED next to the name of the sequencing Run that you

stopped.
Reanalyze
Edit
Status
TERMIMNATED a-
Completed Lo

Note: You can always start a new analysis run.
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Torrent Suite” Software updates

Update Torrent
Suite™ Software

The instructions in this section describe how to update your Torrent Suite™ Software
to a new version.

IMPORTANT! Additional steps and procedures might be required, depending on the
type of Torrent Suite™ Software upgrade. For complete instructions, see the latest
Release Notes on the Thermo Fisher Scientific product.

IMPORTANT! To ensure compatibility between the software and instruments, you
must also upgrade your instruments after the Torrent Suite™ Software upgrade is
complete.

Updates to Torrent Suite” Software cause the software web services to restart. Ensure
that no analysis jobs are running on the server or are queued to run.

IMPORTANT! These procedures require an administrative (ionadmin) account. A
user account such as ionuser does not include sufficient privileges for these
procedures.

1. Sign in to Torrent Suite™ Software with your ionadmin account.
2. Click Settings (¥) » Configure.

3. Scroll to the Database Administration section, then click Admin Interface.

Database Administration

The Admin Interface provides direct access to the database entries for system administrators.

If you are prompted to Sign in, use your ionadmin account.

The Site administration page opens.

4. Click Update Server in the Management Actions section:

The Update Torrent Suite page opens with information on available software
versions, including whether updates are available.

5. Click Activate to power on website maintenance.

6. Click Check to check for updates.
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7. If software updates are available, click Update Server to update Torrent Suite
Software on the server.

8. When the software update is complete, click Back to Main Site, then click
Settings ($F) » About.

9. Review the Torrent Suite™ Software version number in the Releases list to ensure
it reflects the update that you completed.

10. To ensure that the Torrent Suite™ Software upgrade is complete, and that the
software is ready to run analysis programs, click Settings (%) » Services.

11. Under Status in the Services, review all services to ensure that each is running.

Services

Hostname IP Status Job Count Uptime
athens 10452198 Running a 8 days, 50 minutes, 23 seconds
Service Name Status

RSM_Launch Running
RabbitMQ Running
i Running
Running
Running
Running
Running
Running
Running
dhep Running
ionCrawler Running
ionJobServer Running
ionPlugin Running
ntp Running
tomcat Running

IMPORTANT! To ensure compatibility between the software and instruments,

you must also upgrade sequencing instruments after the Torrent Suite™ Software
upgrade is complete.
Lock current You can prevent users from installing updates to Torrent Suite  Software. Use this
Torrent Suite™ procedure to lock the current version of Torrent Suite Software.
Software version 1. Sign in with your ionadmin account.

2. Click Settings (£F) » Configure.
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3. Scroll to the Database Administration section, then click the Admin Interface
link.

Database Administration

The Admin Interface provides direct access to the database entries for system administrators.

If you are prompted to Sign in, use your ionadmin account.

4. Click the Update Server link in the Management Actions section.

Software versions that are currently available are listed and the area below the
list indicates whether updates are available. For example, No updates indicates
that updates are not available.

5. In the Software Versions list, click the Lock current TS software version
checkbox to prevent accidental updates to your software:

Update Torrent Suite

Software Versions Checking for updates

5.4.0.RC1 | Available Your system will automatically check for updates periodically. You can click Check below to manually check for new
sa21 updates

@ Automatically download but do not install updates.

Check | [ Update Server

Disable software updates

@) Lock current TS software version

Torrent Suite Release Notes

After the Torrent Suite upgrade is completed, don't forget to also upgrade your instruments to the same software level to

ensure they are compatible

Website Maintenance is OFF
Activate | | Cancel

When Maintenance s activated all webpages other than this one will be disabled and display Maintenance mode

Enable off-cycle Beginning in Beginning in Torrent Suite  Software 5.2, you can add new Kits, chips,
product updates templates, plugins and Ion Chef scripts that are released outside of the regular
software release cycle.

When you learn of a new product that you would like to use, check to see if a software
update is available.

™

1. Sign in to Torrent Suite™ Software as administrator.
2. Click Settings ($#) » Updates.

3. Scroll down to the Update Products section at the bottom of the screen.

4. Select the desired new product and click Update.

Your installed version of Torrent Suite™ Software is updated to include the new
products that you selected.
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Update off-cycle Beginning in Torrent Suite” Software 5.2, you can add new plugins that are released
release plugins outside of the regular software release cycle.
When you learn of a new plugin that you would like to use, check to see if an update
is available.
1. Sign in to Torrent Suite™ Software as administrator.
2. Click Settings (£¥) » Updates.
3. Scroll down to the Update Plugins section at the bottom of the screen.
4. Select the new Torrent Suite™ Software plugin that you want to install and click
Update.
Your installed version of Torrent Suite™ Software is updated to include the new
plugin that you selected.
Manage Torrent The section that follows explains how to manage user accounts from the Torrent
Suite" Software Suite” Software Site Administration screen.
user accounts 1. Click Settings (%¥) » Configure.

2. Scroll to the Database Administration section, then click the Admin Interface
link.

Database Administration

The Admin Interface provides direct access to the database entries for system administrators.

If you are prompted to Sign in, use your ionadmin account.

Site administration

Groups 4Add 2 Change

#add o Change

The Users dialog allows you to create and modify user accounts to access the
Torrent Suite™ Software.
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Approve a new user account

An administrator must approve new accounts that users register for on the sign-in
screen. When a new user approval is pending, you see a message when you log in as
an administrator.

1. In the message for the new pending registration, click Account Management.

2. Scroll to the User Registrations section.

Option Description
Approve the Click Approve to approve the account for the new user,
registration. then click Yes, Approve.

Reject the registration. | Click Reject to approve the account for the new user, then
click Yes, Reject.

The user account is added to the list of user accounts in the Torrent Suite” Software
Site Administration screen. For details, see “Manage Torrent Suite = Software user
accounts” on page 306.

Modify a user

Use the following procedure to modify the information and permissions for an
existing user:

1. On the Users line of the main Site administration menu, click Change.

2. On the Select user to change screen, click the Username of the user you want to
change. Usernames can be filtered, selected to the right, according to: By staff
status, By superuser status or By active status.

lon W Eb Wielcome. ionadmin. Change password [ Log out

Select user to change | Add user | +]
Q, Seareh

Usernama E-mail address First name Last mame Staff status By staff status

innadmin ionadmin@wntonrent.com ]

il_|||I_|'_.I"r g 'II.1"'£II ThG ek, Com (]

L By superuser
my Ll serfan: [=] ==l
By active
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3. Use the Change user dialog to modify user information. To log in to the server, it
is important to select the Staff status checkbox in the Permissions dialog, which
is shown in the following figure:

4. Select one of the Save options at the bottom of the screen to save your changes.
Delete a single user account

1. In the Users line of the main Site administration menu, click Change.

2. On the Select user to change page, click the Username of the user to be deleted.

3. At the bottom-left of the Change user page, click Delete.

4. Ensure that you want to delete the user by clicking Yes, I'm sure:

Are you sure?
&re you sure wou want to delets the user "newlserl™? &l of the following related items will be deleted:
s User: n=vdlserl

o Apd bey: T727b5cTeiSh102830d7c1516a03bbScE 145535 for newillser]

Yex, ['m sure

Delete multiple user accounts

1. In the Users line of the main Site administration menu, click Change.

2. On the Select user to change page, check the checkbox for each users you want
to delete.

3. Click the dropdown menu, then select Delete selected users:

Actior | -------- | | Eﬂ| 2 of 4 selected

= Delete selected users ress First name Last name Staff status
[]  ionadmin ]
] | ionuser ]
[ myUserMame (-]
newllser (=]
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»
:

4, Click Go:
Actior | Delate zalacted uzers [« |G | 20of4 selected
[  Username =  E-mail addrr‘%u” fhejseiectediaching Llﬂl'l“'_‘ Staff status
[  ionadmin &
[0 | ionuser L]
[¥]  myUserMame -]
[#]  mnewlUser =]

5. Ensure that the list of users you want to delete is correct by clicking Yes, I'm sure.
If you do not want to delete the user, click the back arrow on your browser.

6. On the Select user to change page, the list of users confirms your deletions.

E— [=] |Go| 0 of 2 selected

Username ¥ E-mail address First name Last name Staff status

&Y

ionadmin (]
ionuser ]
2 users

Approve requests for new accounts

New users can request accounts on the Torrent Suite™ Software login page. An admin
must approve each request in the Site administration page before the new account is
active.

An administrative account (1onadmin) is required to approve a user account request.

Approved accounts are created with ionuser permissions.

Torrent Suite” Software user password changes

An administrative user (ionadmin) can change the password that they use to log in to
the Torrent Suite™ Software and can be locked out of the administration menu, or
locked out of Torrent Suite™ Software.

This password is stored in a database field. Use one of these two methods to access
the database and change the administrative user password:

* “Create a new superuser account to change a password” on page 310

e “Change a password in the Torrent Suite™ Software database” on page 312
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Create a new superuser account to change a password

The first way to change a username with minimal terminal interaction is to create a
new super user account.

1. Run the following commands: cd /opt/ion/iondb ./manage.py
createsuperuser

2. After the new superuser account has been created, Sign in to the admin page
with the newly created username and password.

3. Select the Users section under Auth:

Site administration

Groups

e Add *Change

e ddd #Change

Note: If you Sign in with an ionuser account, the Auth section does not
appear .

4. Select the account that you want to change the password for:

lon Web

Wakcoma, duds Documsnastion | Changs password | Log out

Select user to change

Q,

Usarnamae

disdi
I rdn

s

3 ukery

310

=]| Go

E-muail addreas

Dl FR O DITENL LT
ot P D DR T OO

B e O O FEn Looem

Swarch

Firsl mame  Last name  Seal seatus
o
o
o

el e | )

By staff statas

Al

By superuser status
All

By acthe
Al
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5. Click Change password form:

lon Web ‘Welooes, duds. Docwmemanies | Thange password | Log oin
Home « Auth « Users « onad
Change user . History T Wiew on sie =]
Username: iradmin
d| W dl
Fassword: shal 5450025 21995047 LEFIS 8411 56800

6. Enter the new desired password, then click Change Password:

lon Web ‘Welcome, duds. Decumeststion | Change pawwwsrd | Log oot

Hodmie » Siath » LISErs o isAadsin « Change L

Change password: ionadmin
Eriter & fiw passwond far The user sanadmin,

Fassward:

Passward
(agair:

Torrent Suite™ Software 5.6 Help 311



S99E  Software administration
Torrent Suite™ Software updates

Change a password in the Torrent Suite™ Software database

IMPORTANT! This process updates the database directly, and cannot be undone or
recovered in case of error. Do not proceed unless you can confidently execute SQL
commands with a command-line utility.

1. Login to the database

Sign into your Torrent Server host and get an interactive postgres database
command prompt:

ionadmin@my-torrent-server:~$ psgl -U ion -d iondb psgl
(8.4.5) Type
"help" for help. iondb=>

2. Display the user list

In our example, the user ionadmin forgot the password, but we know the
ionuser password. This command provides a list of users and passwords:

iondb=> SELECT username, password from auth user; username

password ——--——-——--
+ _____________________________________________________
ionuser |
shal$7e254$476582a5fa365cdd6081a80acl61cl1904cc9c374
ionadmin |

shal$93099Sb7da0df453d8dblc7715cabef9651c73003de849 ion |
shal$7798b
$Sc025c463682£84b66cf3b5168356a04e3¢ce3b899 (3 rows)

3. Copy the password from another user

The passwords are hashed in the database, so we do not know what the actual
password is. But we know the ionuser password is ionuser, so we can copy
that hashed password to ionadmin, and that will change the ionadmin
password to ionuser.

IMPORTANT! The UPDATE command modifies the database. Do not proceed
with this step if you are not comfortable with SQL commands.

iondb=> UPDATE auth user set
password="'shal$7e254$476582a5fa365cdd6081a80acl61c1904cc9c3

where
74" h
username="'ionadmin';
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Check that the password has been changed

Query the database one again to verify that the password has been changed. See
that ionadmin and ionuser now have the same password

iondb=> SELECT username, password from auth user; username

ionuser |
shal$7e254$476582a5fa365cdd6081a80acl61cl1904cc9c374
ionadmin |

shal$7e2545476582a5fa365cdd6081a80acl61c1904cc9c374 ion |
shal$7798b
$c025¢c463682f84b66cf3b5168356a04e3ce3b899 (3 rows)

Reset the password

Now you can Sign in via the Ul as 1onadmin, and reset the password.
Remember to change the password via the Change password form.

Check user account notification

Click Settings (f¥) » Accounts.

When user account requests are pending, the Accounts tab contains notifications such
as the following:

New pending user registration for 'ExampleNewUser'. See “Manage Torrent Suite™
Software user accounts” on page 306 to review.

Approve and reject new accounts

1.

Torrent Suite™ Software 5.6 Help
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The User Registration section shows the pending requests for new user
accounts:

User Registrations

Usarname Email Full Name Date Joined

Exampleblewlser  Exampleiewlser@domain.com  Dec. 18,2012
ExampleNewlser2 ExampleNewUser2 @domain.com Dec 18, 2012 -”"“:|

2. To approve or reject a new account, do one of the following:

Option Action

Approve | Click Approve in the User Registrations section, then confirm.

Reject Click Reject in the User Registration section, then confirm.

When you approve an account request, the account status is changed to Active in
the user database and the user can Sign in to the Torrent Browser.

Disk usage

It is critical that sufficient disk space is available on the server to avoid data loss. If
needed, it is important to have a strategy that periodically monitors disk space and
archives or deletes data. For details on how to check disk space on the server, see
“View disk usage parameters” on page 286.
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Add customer support contacts

1. Click Settings ($#) » Configure.

Customer Support Contact
This is the person in your arganization who should be notified during =] Suppm‘t
request of problems related to the nature of an experiment/run.

Name
Email ionuseriiontorrent. com

Telephone Number

IT Contact

This is the person in your organization who should be notified during a support
request of prokblems related to the Torrent Server's hardware or the network eryvironment,

Name

Email ionuserngiontarrent. com

Telephone Number

Save Contacts Reset

2. Add the information for a customer support contact and an IT contact in your
organization, then click Save Contacts.
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Change the displayed server name

You can change the server name that appears in the Torrent Suite” Software. By
default, this name is Torrent Server. This change affects only the server name that
is shown in the Torrent Suite” Software, and the default bookmark name that appears
in the browser when a bookmark is created.

1. Click Settings (%) » Configure, then scroll to the Customize Site Name section.

Customize Site Name

Exarmple Mame Save Name

2. Enter the name of your choice, then click Save Name.
The server name that is displayed for the Torrent Browser is changed.

- ™
Change the time zone for the lon Torrent Server
1. Click Settings (%) » Configure.

2. Scroll to Change Timezone, select a region and a time zone, then click Save Time
Zone.

Change Timezone

3. () Click Auto Detect Timezone, then click Save Time Zone.

The new time zone takes effect immediately on the Ton Torrent " Server.
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Monitor your lon Torrent” Server

Click Settings (£¥) » Services.

The following information appears:
* Services
e Active Jobs

¢ jonCrawler Service Details

e RAID Info
Jobs Server The Services panel lists services used by Torrent Suite™ Software.
service
Services
Hostname P Status Job Count Uptime
athens 10.45.2.198 Running 0 & days, 59 minutes, 23 seconds
Service Name Status.
RSM_Launch Running
RabbithMQ Running
C _diskutil Running

_periodic Running
_plugins Running
_slowlane Running
_transfer Running

W Running
celerybeat Running
dhcp Running
ionCrawler Running
ionJobServer Running
ionPlugin Running
ntp Running
tomeat Running

During normal operation each service's status is "Running". A status of "Down"
indicates the service should be restarted.

Start a job request There are 2 ways to start a job request.

1. (Optional) Click Analyze to start a job request for a given run.
An analysis job starts automatically for that run after data is transferred when an
auto-analysis completes on alon PGM™ or Ion Proton™ Sequencer.

™

2. (Optional) Click auto-analysis on alon PGM™ or Ion Proton™ Sequencer. After
data is transferred when an auto-analysis completes, an analysis job starts
automatically for that run.
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You can end a sequencing run that has started but is not yet completed.

1. Scroll to the Active Jobs section and click Terminate to the right of the run name.

2. Click Terminate to stop a job in Active Jobs.

Active Jobs

Name Job/PID Type 5tatus Message Report

BI_R151330 127445  grid  jobisrunning  B9_R151330 Terminate

BA_R151331 127545 grid  jobisrunning  B9_R151331 | Terminate

The ionCrawler panel displays information about processes that transfer data from
Ion PGM™ and Ion Proton™ Sequencers to the Torrent Server.

ionCrawler Service Details

Status: Funning.
Crawler Uptime 8 days, 3 hours, 24 minutes, 3 seconds
HMumber of Huns Added 0
Fecently Added Runs
Currently Inspecting Folder (none)
otate Sleeping for the [ast 23.78 seconds.

Running on Host nightride
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Storage device (Dell PowerVault MD1200):

RAID Info

Show Details

Slot 0:0nline, Spun Up

Slot 1: Online, Spun Up

Slot 2:0nline, Spun Up

The Show Details link opens a popup with details of the RAID drives (only one

shown here):

Slot0

Wedia Error Count
Cither Error Count
Fredictive Failure Count

Firmware state
Inouiry Data

Meeds EkM Attention
Foreign State

Fort-0

Port status

Fort-1

Port status

Drive has flagged a S.MAR.T

alert

Drive Termperature

1l
1l
1l

Online, Spun Up

SEAGATE 5T3200044455

KSET7IWMOLATT

Mo

Mone

Active

Artive
Mo

30C (56.00 F)

Refresh your browser to see changes in status. This information is not updated

automatically.
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Set up lon Mesh

Follow these steps to connect (link) or disconnect (unlink) your Torrent Server (TS) to
another Torrent Server(TS).

1. In the any tab, click Settings (), then click Ion Mesh.

I BT T B -

Configure Mesh

lon Mesh

R12.chd v | Link Selected TS Link TS Manually

Nickname a Address Enabled Status TS Version

10.45.0.171 10.45.0.171 e Emror: Unauthorized 560 o
hawik itw hawk itw @ =1 560 o
s Edit
peregrine.tw peregrine.iw @ Emror: Unauthorized § |
Unlink
“ o > (M T-3of 3items

2. Select one of the following options.

Option

Action

Unlink a TS from another TS | Click Settings (&}#) in the TS Version column of the

row of the TS being unlinked, then click Unlink.

alinked TS

Edit the connection settings of | Click Settings [ﬁ] in the TS Version column of the

row of the TS being edited, then click Edit.

Link a selected TS

Click Link Selected TS.

Manually link a TS

Click Link TS Manually.

3. Enter the following information in the Setup Mesh Computer dialog.

Parameter

Definition

Hostname/Address

Host name or address of the server.

Note: If linking a selected TS, this field is automatically
populated and cannot be edited.

Nickname

A common name that is assigned to the TS.

Username

Your username.

Password

Your password.

4. Click Setup.

320
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View network settings

The Network Settings page also describes the following ports and remote sites in its
Remote System Summary section:

Click the View Network Settings link to see information about the Ion Torrent™
Server:

|View Network Settings

Shutdown Server
Update Server
Update OneTouch Device

TS Virtual Machine

Network Settings

Mac Address:  b8:2a:72:e0:fd:8e Ethernet 0 Detected v
X IP Address Detected +
Public IP: 12.27.71.34
Default route Detected
® DHCP static rt.iont t. 443 Detected v
support.icntorrent.com: etecte
IP Address: 10.45.2.198 e
b rssh.iontorrent.com:22 Detected «
Subnet:
255.255.252.0 ionupdates.com:80 Detected +
Gateway: 10.45.3.1 us.archive.ubuntu.com:80 Detected +
Nameservers: 10.45,16.11,10.45.3.2 drm.appliedbiosystems.com:443 Detected +
Search Domain: ity ite,chd,ads.invitrogen.net security.ubuntu.com:80 Detected v
Set no_proxy: jsealhost,127.0.0.1,127.0.1.1,5:1 Set Default
Proxy server | address Port
Proxy login Username Password
Update Reset

The Network Settings page also describes the following ports and remote sites in its
Remote system Summary section:

Remote System Summary

support.iontorrent.com:443

Access to "support.ientorrent.com” is required to initiate Customer Support Archive uploads for a run report in the event of a customer support request.
ionupdates.com:80

Access to "ionupdates.com” is required to download updates for Torrent Suite software when they are made available.

us.archive.ubuntu.com:80

Access to "us.archive.ubuntu.com” is required te download updates for the Torrent Server's operating system (Ubuntu). This repository also provides updates to some
packages which are required for the Torrent Server to cperate.

drm.appliedbiosystems.com:443

The Remote System Monitoring (RSM) agent on the Torrent Server sends system metrics & health information to this URL over port 443 to facilitate Life Technologies ability to
help cur customers maintain their systems in running order. If a problem with the PGM or Tarrent Server is detected, the RSM agent provides real time warnings to help
proactively diagnose issues before they cause any failures and downtime. Without access to the RSM agent, issues may not be detected until a failure occurs on the Torrent
Server. Also please keep in mind that remote troubleshooting cannot be provided if this functionality is disabled

security.ubuntu.com:80

Access to "security.ubuntu.com” is required to download updates for the Torrent Server's operating system (Ubuntu). This repository also provides updates to some packages
which are required for the Torrent Server to operate,

rssh.iontorrent.com:22

Outgoing access to rssh.iontorrent.com over port 22 is required for the Remote System Menitoring (RSM) agent on the Torrent Server to initiate a remote access. When
remote support or troubleshooting is required, remote access through the agent can reduce resolution time te hours instead of days and require minimal on-site rescurces.
Without the remote access capabilities, diagnosing and implementing a solutien can take much longer and will require significant back and forth over telephone and email
with your on-site personnel.
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The Torrent Server maintains the following types of data in separate locations:

Data type Storage location
lon PGM™ and lon S5™ Sequencer data /results/< PGM Name/S5 Name>
directory, by default.
lon Proton™ Sequencer data /rawdata/<Proton Name> directory,
by default.
Report data /results/analysis/output/Home

directory, by default.

Database records PostgreSQL database

The nightly backup of the database is created automatically, then stored for 30 days.

The following instructions delete the current database.

¢ To restore the database, you need a complete working Torrent Server installation.
The two scenarios for restoring a database are:

a. Installing a new Torrent Server from the Torrent Server installation disk due
to migrating the database to a new server or needing to reinstall the server.

b. Replacing the database on an existing Torrent Server, possibly because the
database is corrupted and you want to restore a previous version.

* To restore the database from the backup file, execute these commands on the
Torrent Server:

{{# copy the backup file to the server and decompress it
gzip -d iondb.20100711 142442 .backup.gz

# stop the Torrent Server background processes
sudo /etc/init.d/ionCrawler stop

sudo /etc/init.d/ionJobServer stop

sudo /etc/init.d/ionPlugin stop

sudo /etc/init.d/celeryd stop

# login as user postgres
sudo su postgres

# restart the service to clear database connections
/etc/init.d/postgresgl restart

# drop the existing iondb database
dropdb iondb

# create a new empty database

psgl <<-EOFdb CREATE DATABASE iondb;

GRANT ALL PRIVILEGES ON DATABASE iondb to ion;
\g EOFdb

# import data
psgl -e iondb < iondb.20100711 142442.backup
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# logout of user postgres
exit

# start the Torrent Server background processes
sudo /etc/init.d/ionCrawler start

sudo /etc/init.d/ionJobServer start

sudo /etc/init.d/ionPlugin start

sudo /etc/init.d/celeryd start}}

Occasionally, there is a django error after completing the import data step.
If an error is displayed on the browser U, repeat the following steps:
a. Drop database.

b. Create database.

c. Import data.

Axeda Remote System Monitoring (RSM)

Overview

The Axeda® RSM (Remote System Monitoring) agent is a software component that is
installed automatically on the Torrent Server and Ion S5, Ion PGM™, and Ion Proton™
Sequencers via the software update process.

1

Approximately every 60 seconds, this agent sends a heartbeat message to Thermo
Fisher. This information is used to track the deployment and software configuration of
machines in the field.

Data is collected in the Axeda® monitoring database, where Thermo Fisher technical
support personnel can review the information that agents collect. Because the
heartbeat message is sent many times an hour, Tech Support can quickly see the
following:

e If a machine is online
¢ The software versions

* Some technical details about the instrument such as temperature and hard drive
status.

™

The agent also allows Ion Torrent™ to log in remotely to the Ion S5, Ion PGM™,
andlon Proton™ systems and the Torrent Suite™ Software, which is required for
system support. Without remote access, Thermo Fisher Field Application Scientists
cannot access, view, and troubleshoot problems regarding machine performance.
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Port assignments To support fully the Ion Torrent  Server and Ion Torrent sequencers, remote
monitoring must be provided using Axeda® Remote System Monitoring software
enabled, and able to reverse ssh into the boxes. This requirement means that the Ion
sequencers and Torrent Servers be connected to the Internet with outbound
connections that are permitted on the following ports:

Port Required Use

22 Yes Start reverse SSH tunnel for
remote troubleshooting

80 Yes Download updates from
http://
updates.iontorrent.com and
http://
us.archive.ubuntu.com

123 Yes (UDP) NTP access to the
Internet, incoming and
outgoing.

443 Yes Enable sending of basic
status information to the
remote monitoring server.

The lonReporterUploader
plugin also requires port 443
to transfer data to lon
Reporter” Software.

5432 No Remote access to
PostgreSQL database.

Data automatically Field names, data types, and examples of the data being collected are described in the

collected by the following tables. This information is sent automatically from the Tgrrent Server and
RSM agents Ion S5", Ion PGM™, andlon Proton™ Sequencers back to Thermo Fisher.
Torrent Server EventNaTe Type Sample Value
TS.Config.biosversion String 6.00
TS.Config.configuration String standalone
TS.Config.hostname String lon-torrent-server
TS.Config.ipaddress String 10.45.3.246
TS.Config.mode String Master
TS.Config.serialnumber String 1SMJFP1 ( Dell™ service tag)
TS.Contact.IT Contact String email, phone
TS.Contact.Lab Contact String email, phone
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Event Name Type Sample Value

TS.Experiment String chip type, flow count, run
type, bedfile, barcode count,
seq s/n

TS.GPU String No problems

TS.host String lon-torrent-server

TS.HW.HD./results Analog 58.99

TS.Location.City String Rockville

TS.Location.Org-Name String Unknown

TS.Location.Postal-Code String Unknown

TS.Location.State String Unknown

TS.Location.Street-Address | String Unknown

TS.Nexenta<n> String 180

_lic_days_left

TS.Nexenta<n>_lic_status String license status

TS.Nexenta<n> String S5EDIBLINA

_machine_sig

TS.Nexenta<n>_UUID String 44454c4c-5900-1046-8048-
b2c04f533532

TS.Nexenta<n>_vol<v> String pooll size=32.5T

allocated=860G free=31.7T
capacity=2% health=ONLINE

TS.Nexenta<n>_vol<v>_d<d> | String c0tbd1 health=ONLINE
vendor=SEAGATE
product=ST6000NMO0034
serial=Z4D1XT26 size=6TB

TS.Server.celerybeat String ok/offline/error
TS.Server.celery_diskutil String ok/offline/error
TS.Server.celery_periodic String ok/offline/error
TS.Server.celery_plugins String ok/offline/error
TS.Server.celery_slowlane | String ok/offline/error
TS.Server.celery_transfer String ok/offline/error
TS.Server.celery_w1 String ok/offline/error
TS.Server.dhcp String ok/offline/error
TS.Server.ionCrawler String ok/offline/error
TS.Server.ionJobServer String ok/offline/error
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Event Name Type Sample Value
TS.Server.ionPlugin String ok/offline/error
TS.Server.ntp String ok/offline/error
TS.Server.RabbitMQ String ok/offline/error
TS.Server.RSM_Launch String ok/offline/error
TS.Server.tomcat String ok/offline/error
TS.TYPE String TS1
TS.Version.alignment String 1.42-0
TS.Version.analysis String 1.40-0
TS.Version.dbreports String 1.95-3
TS.Version.docs String 1.15-1
TS.Version.referencelLibrary |String 1.6-1
TS.Version.tmap String 0.0.19-1
TS.Version.tsconfig String 1.3-9
Event Name Type Sample Value
Instrument.Event.LastExperi | String R_2011_04 22 15 34 58 u
ment sr_S-1
Instrument.Event.Pressure | Analog 0 (chart)
Instrument.Event.ValveBoar | String Valve Board not accessible
d Valve Board Down Stream
Errors
Valve Board Up Stream
Errors
Instrument.Event.RunAborte | String Run aborted
d
Instrument.Event.LostChipC | String Lost chip connection, run
on aborted
Instrument.Event.UBoot String U-boots don’'t match
Instrument.Event.Kernel String Kernels don’t match
Instrument.Event.ResultsDri | String Results drive not accessible
ve
Instrument.Event.BootDrive | String Bad boot drive detected
Instrument.Event.DataDrive | String Bad data drive detected
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Event Name Type Sample Value
Instrument.HW.HD1 Analog 34.001 (chart]
Instrument.InstrumentNam | String Stork
e
Instrument.Pressure Analog 10.2 (chart)
Instrument.Temperature Analog 27.06 (chart)
Instrument.TYPE String PGM1
Instrument.Version.Board String 4 AN
Instrument.Version.Datacoll | String 180
ect
Instrument.Version.driver String 31
Instrument.Version.fpga String 70
Instrument.Version.Graphics | String 15
Instrument.Version.LiveView | String 268
Instrument.Version.0S String 12
Instrument.Version.Scripts | String 16.3.58

Ion S5 and Ton Proton” sequencer data is divided into these categories:

¢ DataCollect - These items come from the instrument configuration file.

* RunData - These items reflect parameters from the last Auto pH or sequencing

run.

* Status - These items reflect the current instrument parameters.

¢ System - These items provide parameters related to the operating system
supporting the instrument.

* Version - These items provide the version numbers for the various software
packages installed on the instrument.

In addition, two items (InstrumentState, Type) are not placed in any category.

The number and names of these entries are subject to change across software releases.

Data Item Name

Type

Sample value

Alarm.* String Various hardware alarm
messages

BIOS.BIOS Analog 5350

DataCollect.FlowsSinceClea |Analog 400

n

DataCollect.RunsSinceClean | Analog 1

Event.CleanCompleted String Clean completed
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Data Item Name Type Sample value
Event.DatacollectStarted String Datacollect Started
Event.InstrumentMustBelnit | String Instrument must be
ialized initialized
Event.PostRunCleanHasNot | String Post Run Clean has not been
BeenRun run
InstrumentState String Idle
RunData.ala? String R_2016_02_17_13 .01 .08 u
ser_F4--145 W1.dat dffffe
cntArry 9009

RunData.AutoPhFinal Analog 7.660635

RunData.AutoPhlnitial Analog 6.321023

RunData.AutoPhlterations Analog 4

RunData.AutoPhResult String Pass

RunData.AutoPhTotalW1Vol | Analog 1.0

ume

RunData.ChipGain Analog 1.066389

RunData.ChipPixelAverage | Analog 8241

RunData.ChipPixelsInRange |Analog 164698460

RunData.ChipPixelsPinnedH | Analog 0

igh

RunData.ChipPixelsPinnedL | Analog 676

ow

RunData.ChipTemp Analog 81.826172

RunData.CpuTemp0 Analog 53

RunData.CpuTemp Analog 74

RunData.efuse String FRARRRRRxx:Q6C841,W:
4,J:WC2012C00086-
C00272,P:16,C:PT4,F:F6,Y:
4,X:0,B:3,5B:31,B:1P,N:
3k 3k 3k 5k 5k 3k 3 3 % X Xk Xk % %

RunData.FpgaMasterTemp | Analog 113

RunData.FpgaSlaveTemp Analog 118.4

RunData.GpuTempC Analog 82

RunData.LastAutoPhRealPh | Analog 766

Torrent Suite™ Software 5.6 Help



Axeda Remote System Monitoring [RSM]

H . reew
Software administration ;"‘_:3'1

249

o

Data Item Name Type Sample value
RunData.LastAutoPhRef Analog 745
RunData.LastAutoPhTarget |Analog 770
RunData.R1pH Analog 7.00
RunData.R2pH Analog 7.00
RunData.R3pH Analog 7.00
RunData.R4pH Analog 7.00
RunData.W1pH Analog 8762
RunData.W2pH Analog 7619
RunData.W3RefpH Analog 7.45
Status.HDPctFull Analog 0.823612
Status.SsdPctFull Analog 6.220454
System.CpuUsagePct Analog 7
System.Date String 2013-01-0
System.FreeMemoryKB Analog 129951948
System.Hostname String d1l.ite
System.|pAddress String 10.25.3.150
System.PhysMemTotalGB Analog 128
System.Time String 03:42:58 PM GMT
TYPE String Proton1
Version.Datacollect String 3371
Version.Disklmage String 2015_06_04
Version.Graphics String 80
Version.KernelRelease String 3.13.9-ionrt1
Version.LiveView String 2166
Version.OIA String 5203
Version.0S String 17
Version.Reader FPGA String 3d400109
Version.Reader FPGA1 Analog 33400109
Version.Reader Woddr FPGA | String 3400043
Version.Reader Woddr String 340004b

FPGA1
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Data Item Name Type Sample value
Version.RSM String 24
Version.Scripts String 2.0.63
Version.S5 Release Analog 5.2
Version.S5 Script String 0.1.13
Version.TSLink String 1.0.2r5
Version.Valve FPGA String c010

When there is a problem with the Ion sequencer or Torrent Server, this agent allows
Thermo Fisher support personnel to remotely:

¢ Collect log files from the systems for review.
* Restart the device.
* Upgrade software.

¢ Provide a remote login connection to the device for further diagnostic work.

™ ™

When a problem with an Ion S5™ system, an Ion PGM™ system, an Ion Proton™
system, or Torrent Suite™ Software is reported, the Thermo Fisher service and support
tries to solve the problem by telephone or email. If remote access is required for
additional troubleshooting, a member of Thermo Fisher service and support requires
authorization from the technical contact to initial remote connection. Only after
getting authorization does Thermo Fisher personnel proceed with remote
troubleshooting. After the problem is resolved, you are notified. Additional
authorization is required before starting any further remote help.

Troubleshoot Torrent Server

Check crawler and
job server status

330

These troubleshooting suggestions apply to system level issues such as networking,
disk space, and system load.

For investigations of an individual failed analysis run, see instead “Handle a failed
analysis run” on page 43.

Access the Crawler and Jobs Server page:
Click Settings () » Services.
Note: Startup scripts for each process can be found in the /etc/init.d directory.

Note: Log file for each process can be found in the /var/log/ion directory. They
are:

* crawl.log

* iarchive.log

* celery wl.log

* ionPlugin.log

Torrent Suite™ Software 5.6 Help
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If these processes are not running, run information is not updated and analysis
reports are not generated. If this occurs, there is no risk of data loss but the Crawler
and Jobs Server processes should always be running. The Archive process only runs
if archiving has been configured.
Process status is displayed in the Admin Services tab, as shown in the following
figure:
Jobs Server
Hostname IP Status | Job Count Uptime
knoserer 127.0.1.1| Running | 0 A days, B hrs, 23 mins
Service Name Status
REM_Launch Running
RabhithC Running
celery_diskutil Running
celery_periodic Running
celery_plugins Running
celery_slowlane Running
celery_transfer Running
celery_w1 Running
celerybeat Running
dhep3-server Running
ionCrawler Running
ionJobServer Running
ionPlugin Running
ntp Running
tomcats Running
Active Jobs
Name Joh/PID Type Status Message Report
B30-117--R15 172407  grid |jokisrunning | B30-117-R15 Terminate
B31-277--R15 172408  grid |jokisrunning | B31-277-R15 Terminate
ionCrawler Service Details
Status: Running.
Crawler Uptime 5 days, 8 hours, 23 minutes, 33 secs
Murmber of Funs Added &
R 2011 _06_01_12 18 58 _PG2-34
R 2012 03 14 _17_03_06_FOX-30
Recently Added Runs R_2012_01_27_15 03_26_B26-10
R 2012 01 05 20 58 05 B10-6
test_C02-426
Currently Inspecting Folder (none)
State Sleeping for the last 3.26 secs
Funning on Host knoserver
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If a process is not running, a Down or Offline reason is displayed in the Admin
Services tab. An example is "The crawler is offline".

Click Settings (¥F) » Services.

The following table lists the background processes that run on Torrent Suite
Software:

T™

Process Program Startup Script Description

Crawler crawler.py ionCrawler Searches for new
runs from the lon
PGM™ orlon Proton”™
Sequencers and puts
run information into
the database so that
they appear in the
Torrent Browser
Data > Completed
Runs & Reports

page.
Job Server serve.py ionJobServer Sends analysis jobs

to the Sun Grid
Engine (SGE).

Plugin Server ionPlugin.py ionPlugin Sends plugin jobs to
the Sun Grid Engine
(SGE).

Celeryd manage.py celeryd A background job
processor for
Django.

Queue status

Click the Queue Status link in the Active Jobs section to open a table of SGE queue
activity:

Cluster Queue Status

Mame Pending Used Available Error Total
all.g 1] 1] 20 0 22
plugin.g 0 21 11 1] 32
thumbnailg 0 28 1] 26
1o 1 0 G0 0 fid

Close
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Restart services Currently, there is no method to restart a process using the Torrent Browser. The
easiest approach is to is to shutdown and restart the server. Before restarting the
server, make sure that no Ilon PGM™ or Ion Proton™ Sequencers are uploading data to
the server, otherwise the file transfer is interrupted.

After restarting a process, it continues from the point where it was interrupted, and
no more user interaction is needed.
™

1. Before restarting the server, ensure that no Ion PGM™ or Ion Proton™ Sequencers
are uploading data to the server, otherwise the file transfer is interrupted.

2. Shutdown and restart the server

3. (Optional) Restart the processes using the scripts located in the /etc/init.d
directory. For example, use the following command to restart the Crawler:

user@svr:/etc/init.d$ sudo /etc/init.d/ionCrawler restart
Stopping crawler Starting crawler pid = 26025

4. Verify that the processes are running using the ps ax | grep py command or
the Torrent Browser UL

Note: If the processes do not continue to run after being restarted, contact your
Ion Torrent™ representative for assistance.

Verify network There can be many reasons for network connectivity or name resolution to fail. Use
connectivity and the following procedure to try to resolve connectivity and name resolution problems:
name resolution If you cannot reach the Torrent Server an IP address, you are likely to need help from

the site IT administrator who understands how the local network is configured.

1. Click Settings (4#) » Configure » Admin interface » Management
Actions » Network Settings. The Torrent Browser performs several network
checks:

Ethernet 0 Detected «

IP Address Detected «

Default route Detected ¢
updates.iontorrent.com: G0 Detected o
us.archive.ubuntu.com: 80 Detected &

drr.appliedbiosystermns.comid43 Detected

security .ubuntu.com: 80 Detected

rssh.iontorrent.net: 22 Detected &

2. Verify that the Torrent Server is configured correctly by reviewing the Torrent
Server deployment instructions.

3. Find the IP address of the Torrent Server as described in “Verify Torrent Server IP
address” on page 334.
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The Torrent Server is configured out-of- the-box to automatically get an IP address
from the DHCP server on the network. Unless the local IT administrator has
specifically assigned an IP address in advance, you will not know what the current IP
address is.

The Torrent Server has several Ethernet ports on the back. Make sure your site
network is connected to the port labeled LAN, called eth0 in Linux  terminology. The
Ethernet port are identified as eth0, ethl, ..., for as many ports as are available. On
Torrent Server, eth0 is the only port connected to your network and is configured by
DHCP.

To determine the IP address assigned to eth0, login and type: ifconfig eth0. This
displays the following output:

ionadmin@ion-torrent-server:~$ ifconfig ethO

ethO Link encap:Ethernet HWaddr 00:1b:21:5b:bb:44

inet addr:192.168.1.123 Bcast:192.169.4.255 Mask:255.255.255.0
inet6 addr: fe80::21b:21ff:fe5b:bb44/64 Scope:Link

UP BROADCAST RUNNING MULTICAST MTU:1500 Metric:1

RX packets:209970726 errors:0 dropped:0 overruns:0 frame:0

TX packets:419252947 errors:0 dropped:0 overruns:0 carrier:0
collisions:0 txgqueuelen:1000

RX bytes:14131928595 (14.1 GB) TX bytes:607398487997 (607.3 GB)

Memory: fbea0000-fbec0000

Your IP address is the inet addr:

inet addr:192.168.1.1 Bcast:192.169.4.255 Mask:255.255.255.0

Another useful check is the line beginning with UP, which indicated the interface is
active and working;:

UP BROADCAST RUNNING MULTICAST MTU:1500 Metric:1

If the eth0 port is not available, it is possible the Ethernet cable is connected to a
network, so you will not see the word UP:

BROADCAST MULTICAST MTU:1500 Metric:1

If an IP address is assigned, the interface is likely to work. If no IP address is assigned
and the interface is not UF, you may need to get help from your site IT administrator.
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If you are still concerned about network connectivity, you can test that different
desktops are able to successfully ping the server IP address. If you are not able to
ping the server from the desktops that need to access the Torrent Browser running on
the server, contact your site IT administrator.

The Torrent Server uses the Linux™ Network Time Protocol (NTP) program to
synchronize its time with another time server. By default, the Torrent Server is
configured to synchronize its time service to a trusted time service on the Internet.
This requires that the network configuration permits the NTP network protocol to
connect to that time service on the Internet.

™

The Torrent Server can also act as a time server for Ilon PGM™ and Ion Proton™
Sequencers. However, if the server is not able to synchronize with the trusted time
service, it does not act as a time server for the sequencers (Torrent Server does not
forward potentially incorrect information to other machines).

If the network configuration is blocking the NTP protocol from reaching the Internet,
the Torrent Server and thelon PGM™ and Ion Proton™ Sequencers are not be able to
synchronize time.

Your site network administrator is probably aware of this connectivity restriction, and
it is likely that IT has a time server in the network.

Do not delete the data from the Ion PGM " orlon Proton" Sequencer until you are
confident that the data is present on the Torrent Server, the analysis is successful, and
the Analysis Report has been generated successfully.

1. Verify that all files successfully transferred from the Ion PGM™ and Ion Proton™
Sequencers to the Torrent Server.

2. (Optional) Manually transfer files by going to the Data Management » Re-
transfer, then select the an option for any of the runs in question. You can then
safely re-transfer data.

After the root cause of a major problem is identified, the following more intrusive
action may be needed:

* Replace failed hard disk drive

* Downgrade software packages

* Reinstall software

* Modify config files

e Add, modify, or delete database information

Please contact your Ion Torrent™ representative for assistance before you attempt any
of these steps.
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You can download an archive that Customer Support can use to diagnose Torrent

Suite™ Software issues. The Customer Support Archive contains log files and other
technical data about your Torrent Suite™ Software and analysis runs.

Note: Under some circumstances, you can use the FieldSupport plugin to generate an
archive for use by Customer Support. For details, see “FieldSupport plugin” on
page 144.

Generate a Customer Support Archive
1. Under the Data tab, in the Completed Runs & Reports screen, click the link for

your completed analysis run.

2. In the Run Summary, click the Plugin Summary link, or scroll down to the
Plugin Summary. Click the Support tab.

3. Click Download.

A compressed archive is downloaded to the directory that you use to download files
from the browser. This location will depend on your browser settings. You can
attached this archive to an email for Customer Support.

Note: Torrent Server is not able to access the customer support server automatically.
If you would like to upload files directly, contact your support representative and ask
how to enable Customer Support Archive upload for your Torrent Server.

Customer Support Archive contents

The tables in this section describe the files included in a Customer Support Archive.
Files for optional modules (such as recalibration) only appear if the optional module
is run.

In the top level directory:

File Description
alignment.log Log of the final TMAP alignment process
< RunName>_< AnalysisReportName> Text format summary of sample alignment
.alignment.summary final results
alignment.summary Text format summary of sample alignment

final results (same as the file < RunName>_
< AnalysisReportName>
.alignment.summary, but with a predictable
file name)

backupPDF.pdf PDF file of the analysis report and plugin
results (similar to the output of the
Download as PDF button on a run report)

Controller Live View log of user activity on the
sequencing instrument

debug Log from data collect, the background data

acquisition module
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File

Description

DefaultTFs.conf

List of known Test Fragment sequences and
their bases

drmaa_stderr_block.txt

Analysis pipelin eerror log for the block
being executed by Sun Grid Engine

drmaa_stdout.txt

Log of events after primary analysis

drmaa_stdout_block.txt

Analysis pipeline output log for the block
being executed by Sun Grid Engine

explog.txt

Initial run s settings needed for Torrent
Browser analysis when being exported from
instrument

explog_final.txt

Final run s settings needed for Torrent
Browser analysis when being exported from
instrument

InitLog.txt

Instrument auto pH log

InitValsW2.txt

pH log of the W2 solution

InitValsW3.txt

pH log of the W3 solution

Rawlnit.txt

Contains initialization data output

sysinfo.txt

Torrent Browser system software settings

TF.alignment.summary

Summary of test fragment alignment
results in text file

uploadStatus Log of metrics being uploaded to the
Torrent Browser
version.txt Torrent Suite™ software versions used for

the analysis report

In the basecaller_results directory:

File

Description

basecaller.log

Log file for the basecaller analysis module

datasets_basecaller.json

A JSON-format file of the settings needed
for basecaller to analyze the sample data

datasets_pipeline.json

A JSON-format file of the settings needed
by the pipeline to run the basecallermodule

datasets_tf.json

A JSON-format file of the settings needed
for basecaller to analyze the Test
Fragments

< RunName>_< AnalysisReportName>
.quality.summary

A quality summary of basecaller unaligned
reads/bases after filtering and trimming
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File

Description

quality.summary

Same as above, but with a predictable file
name

TFStats.json

A JSON-format file ofTest Fragments
results statistics

In the basecaller_ results/recalibration directory:

File

Description

alignment.log

Log of the TMAP alignment process during
base recalibration

alignmentQr_out.txt

Log file from the TMAP analysis module

In the basecaller results/unfiltered.trimmed directory:

File

Description

alignment.log

Log of the TMAP alignment process based
on unfiltered and trimmed reads

< RunName>_< AnalysisReportName>.
alignment.summary

Text format summary of sample alignment
results for unfiltered and trimmed reads

alignment.summary

Text format summary of sample alignment
results for unfiltered and trimmed
reads(same as above, but with a predictable
file name)

datasets_basecaller.json

A JSON-format file of the settings needed
for basecaller to analyze the sample data,
when generating the raw BAM file

< RunName>_< AnalysisReportName>
.quality.summary

The basecaller unfiltered and trimmed
reads/bases quality summary

quality.summary

The basecaller unfiltered and trimmed
reads/bases quality summary (same as
above, but with a predictable file name])

In the basecaller results/unfiltered.untrimmed directory:

File

Description

alignment.log

Log of the TMAP alignment process based
on unfiltered and trimmed reads

< RunName>_< AnalysisReportName>.
alignment.summary

Text format summary of sample alignment
results for unfiltered and untrimmed reads

alignment.summary

Text format summary of sample alignment
results for unfiltered and untrimmed
reads(same as above, but with a predictable
file name)
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File

Description

datasets_basecaller.json

A JSON-format file of the settings needed
for basecaller to analyze the sample data,
when generating the raw BAM file

.quality.summary

< RunName>_< AnalysisReportName>

The basecaller unfiltered and untrimmed
reads/bases quality summary

quality.summary

The basecaller unfiltered and untrimmed
reads/bases quality summary (same as
above, but with a predictable file name])

In the sigpror_results directory:

File

Description

analysis.bfmask.stats

Analysis statistics of wells in the bead find
stage (the bfmask is a set of bit flags for
each well, indicating the contents of each
well)

avgNukeTrace_ATCG.txt

ATCG key signal measurements

avgNukeTrace_TCAG.txt

TCAG key signal measurements

bfmask.stats

Summary statistics of wells in the bead find
stage

processParameters.txt

Parameter settings for analysis signal
processing

separator.bftraces.txt

Matrix data to separate between live wells
and empty wells during bead find phase

separator.trace.txt

Matrix data to separate between live wells
and empty wells

sigproc.log

Log file for the analysis module

In the sigpror_results/dcOffset directory:

File

Description

dcOffset.txt

background model parameter values of
dcOffset

In the sigpror_results/NucStep directory:

The files in this folder contain background model parameter values based on the

location of the well in the chip.
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File

NucStep_frametime.txt

NucStep_inlet_head.txt

NucStep_inlet_empty.txt

NucStep_inlet_empty_sd.txt

NucStep_inlet_step.txt

NucStep_middle_head.txt

NucStep_ middle_empty.txt

NucStep_ middle_empty_sd.txt

NucStep_ middle_step.txt

NucStep_outlet_head.txt

NucStep_ outlet_empty.txt

NucStep_outlet_empty_sd.txt

NucStep_outlet_step.txt
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View system System diagnostics information can help in troubleshooting network, disk space, and
support system status problems.
diagnostics To access system diagnostics information, click Settings (%) » About:

Scroll down to the More Information and Assistance section and click System
Support Diagnostics:

More Information and Assistance

The diagnostics page has Network, System, and Data sections. A small section of each
is shown here:

Network

MAC Address = @@:1@:18:a2:3d: 88

————— Checking that that serwver has acquired an IP Address-----
G000 - this server has an IP address: 167.116.6.195

Gdon - the 'eth@' ethernet port is UP
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Date Collected:
Hed Sep 5 2@:45:26 PDT 2012

server Uptime:
20:45: 26 up 14 davs, 8:@5, T users,

load average: @.15, .17, @.17

Ion Software FPackage Status:

Desired=lUnknownsInstall/Remove s PurgesHold

| status=NotsInst/CFg-files /UnpackedsFailed-cfg/Half-inst trig-akait s
| # Erre=inonel/Reinst-required (Status,Err: uppercase=had)

| |/ Mame

i1 ion-alignment

Data

Raw Data Storage Report
Runs Total

Runs Deleted

Runs Archived

Runs Live

Runs to keep

Runs to &rchive Raw
Runs to Delete Raw

Runs in Grace Period

15

15

14

YWersion

Disk Space &llocation Report: fresultsy /devsmappersion--torrent--ser

Total Disk Space : 18286 GBEwtes
lsed Disk Space H 2882 GBytes 20.2%
Free Disk Space 3 28 GBEvytes 79.8%

File serwvers and PaEMs writing to them:

192, 168.2@1.1: (not mounted)
default

PaMd_test

ts: (not mounted)

impaort
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View instrument Use Instrument Diagnostics to investigate chip and sequencing instrument problems,
diagnostics such as pH levels.
1. To access the Instrument Diagnostics information, click Settings (£#) » About:
2. Scroll down to the More Information and Assistance section, then click the
Instrument Diagnostics link:
More Information and Assistance
The Instrument Diagnostics page lists the sequencing instruments that are
associated with each of your results partitions. Passed and failed analysis runs
are shown for each instrument.
The InitLog.txt file includes diagnostic measurements and if possible presents a
probable cause and suggests next steps.
3. Toinvestigate a failed run, click the View log link for that run:

Torrent Suite™ Software 5.6 Help

What the links do:

[Download] will download the diagnostic archive file (zip format)
[View Log] will extract and display the Init log file

[PDF] will download an Installation Acceptance Report

Location: nas10

[[1B350:
Passed:
B350_24304 _AutoPHPass_14_04_04_10[Download] [View log] [PDF] |
B350_24304 _AutoPHPass_14_04_03_10[Download] [View log] [PDF] ‘
B350 24304 _AutoPHPass_14 04 02 10[Download] [View log] [PDF] |
B350 24304 _AutoPHPass_14_04_01_10[Download] [View log] [PDF]
B350 24304 _AutoPHPass_14 03 31_10[Download] [View log] [PDF]
Failed: |
B350 24304 _AutoPHFail_14_03_14_09 [Download] ‘
B350 24304 _AutoPHFail_13_12_11_13 [Download] [View log]
B350 24304 _AutoPHFail_13_11_21_13 [Download] [View log]
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The InitLog.txt file opens for that run on the instrument:

InitLog.txt

Fri Mar 14 09:23:17 2014

serial=24304

MName: B350

Sequencing Kit Used: lonPGM400Kit

ChipChecking...

Prepping for Chip Calibrate

Calibrating Chip

Started

Optimizing Reference Electrode

Optimizing Channel Dacs

Optimizing Reference Dacs

Measuring MNoise

Chip Noise 2.34/2.83, Avg Vout 1.22

Generating LS Row Image

VREF=38108 Chan dacs=<24304 24111 24112 24037=
RefV=<16828 16832=

Chip Noise 2.34/2.83, Avg Vout 1.22

Passed gain:0.711542

Chip Type 314R

Starting AutoPH (PH:7.70 = 7.75 = 7.85)

-145 < target=63 < 167

ADC counts/pH = 2090

surface=TiN mv/pH=42_310000 TiNGainCutoff=0.660000
PHShift{pH)=0.330000, PHShift{counts)=6589 PHRef=7 450000
phTotalAdded=0.000000

stddev = 67

W1 Step 8865 counts.

W2 Avg=9078& StdDev =1

stddev = 973

Chip Reading Inconsistent.

Run Flow Check to confirm no waste line blockages and/or
replace chip. Press start to try again.

Fri Mar 14 09:28:10 2014

Close
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Monitor disk Use the following procedure to monitor disk space if the Torrent Browser is not
space available, or you want to use a command-line utility:
1. Log into the server using an ssh client:

S ssh ionadmin@Rion-torrent-server
$ password: ionadmin

Enter the df command to display partitions and disk utilization:

$ df -h

ionadmin@itw-test0l:~35 df -h
Used Avail

Filesystem Size
Use% Mounted on
J/dev/sda3 5.3T
8y [/

none 24G
1% /dev

none 24G
0% /dev/shm

none 24G

1% /var/run

none 24G
0% /var/lock

none 24G
0% /lib/init/rw
/dev/sdas 61G
1% /tmp

Jdev/sdal 276M
12% /boot

Jdev/sdad 3.8C6
65% /var

nas3:/c/results2 19T
91% /results2
nas2:/cfarchive/tahiti

18T
71% /media/archive
nasl:/c/results 19T
89% /results4
nasl:/c/resultsl 19T
89% /results3

3726

200K

88K

524M

29M

2.4G

17T

13T

17T

16T

4.6T

24G

24G

24G

24G

24G

57G

233M

Most growth is seen in the /results directories, which is where Ion Torrent™
data are stored.

The Use% column indicates how much space is being used.

IMPORTANT! If there is insufficient space on the Torrent Server, data files are
retained on the Ton PGM™" and Ion Proton” Sequencers until space becomes available.

You can also monitor disk space through the Torrent Browser. For details, see “View
disk usage parameters” on page 286.
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Administration with command-line utilities

Use the following command to change the hostname:

sudo TSconfig --change-hostname

You must restart the server after the hostname is changed. This command
automatically restarts the server.

Use the following command to change the time zone:

sudo TSconfig —--configure-timezone

Use the following command to add an HTTP proxy:

sudo TSsetproxy

Set the proxy address and authentication according to the following prompts:

1. Enter http proxy address: Enter the proxy address. (If no address is
entered, you are prompted to exit the program.)

2. Enter http proxy port number [3128]: Enter a port number or carriage
return to accept the default, 3128, port number.

3. Enter the username for proxy authentication: Enter a username. If
you do not enter a username, no authentication is set.

4. Enter the password for proxy authentication: Enter a password. If
you do not enter a password, no authentication is set.

A proxy address confirmation message is displayed:

http proxy is set to http://username:password@proxyAddress

The recommended usage is to enter the command sudo TSsetproxy, as shown above,
and be prompted for each value. You can however use the TSsetproxy arguments
instead:

Usage: TSsetproxy [option]... —--address Proxy address (example:
'http://proxy.net') --port Proxy port number
(default: 3128) —--username
Username for authentication --password
Password for authentication --remove Removes
proxy setting --debug,-d Prints script
commands when executing (set -x) --demo

Prints what changes would be executed only. No
changes are made --help,-h Prints
command line args --version,-v Prints version

Torrent Suite™ Software 5.6 Help
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Connect to your Torrent Server host, using ssh, and verify that the Crawler and
Job Server services are running:

ps —aux | grep py
This should show active crawler.py and serve.py processes.

Run a test analysis of the provided cropped data set and review the resulting
report.
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Work with analysis files

Analysis results For a standard Torrent Server configuration, analysis results files are located in the
file location following directories:
Type of Data Directory Name
Raw /results/<Sequencer name>/

<Run_name>/

Processed /results/analysis/output/Home/
<Report name>/

Log files in the Many log files, which are shown in the following table, are generated for different

results folder parts of the Analysis pipeline. Some files only appear when a problem occurs. You do
not need to log in to see these files. Opening a report and removing the report name
gives you a directory listing of all the files, which you can open directly as text files.
Be careful that you do not open a large file using the web browser.

Filename Description

version.txt Lists the versions of the lon software
packages that were installed at the time the
report was generated and the host name of
the server. This information is also
displayed on the default report.

DefaultTFs.conf Lists all of the Test Fragment Templates
that were used for generating this report. If
the file size is zero and there are no data in
the file, either no templates are installed or
none are flagged isofficial. Analysis
only checks against the templates that are
marked isofficial, whichis set using
the Templates tab in the browser.
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Work with analysis files

Filename

Description

uploadStatus

Lists problems uploading data to the
database. If analysis results are not being
displayed in the browser, check this file.

Normal results:

Updating AnalysisAdding TF MetricsAdding
Analysis MetricsAdding Library
MetricsAdding Quality Metrics

Error examples:

Failed addAnalysisMetricsFailed
addLibMetrics

status.txt

Analysis run status. If the analysis
completed successfully, the contents of this
file are a 1. Avalue of 0 indicates a failure
occurred, requiring that you check other log
files to determine the cause. No specific
error information is provided in this file.

processParameters. txt

Run events and length. The command-line
passed to the Analysis program is also
included, which is useful to re-run the
same analysis. These files are in
subdirectories named

sigproc results/block *.

sigproc results/sigproc.log
basecaller results/
basecaller.log alignment.log

Analysis pipeline log files. Always check for
errors in these files, especially the first and
the last windows.

The contents of these log files (without
HTML formatting) are available in the
Torrent Browser with the run report
Support tab View the report log link:

Plugin Summary Test Fragments | Analysis Details Support

« Download the Customer Support Archive

View the report |:"\(_|

drmaa_ stdout.txt

Post-analysis events.

drmaa_ stderr.txt

Error messages related to processes called
after the primary analysis. This has a value
of zero if the analysis completed
successfully.

analyzeReads err.txt

Useful troubleshooting information
generated during the alignment process.
This file is only created when there is a
problem.
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Filename Description

core A memory dump listing, usually caused by a
critical fault. You should see a related
exception or core dump message in
an analysis pipeline log file.

alignmentQC out.txt Errors related to TMAP. If the file is not
present, it is likely that TMAP was not
called.These files are in subdirectories

named basecaller results/block
*

Standard reference files are stored in the following location:

/results/referencelibrary/<index type>/<genome shortname>/

Design custom barcodes

Cautions

Barcode overview

350

Custom barcode design involves certain technical challenges:
* Calculation of the your barcodes' hamming distances in flow space

¢ Adjustment of basecaller parameters to match your barcodes' distances

Custom barcode design is for advanced users only and only if you have a compelling
need for a custom barcode set.

If are considering creating your own custom barcode set, we recommend that you first
contact your FBS.

IMPORTANT: The default Basecaller parameter settings are optimized for the
IonXpress barcode set. The use of a different barcode set, especially a custom barcode
set, requires custom Basecaller parameter settings.

The Torrent Suite™ Software supports barcoded runs, in which multiple barcoded
samples are processed on the ION Chip during an Ion sequencing run. A barcode run
typically involves sample-prep with an Ion barcode adapter kit (or compatible kit)
such that two or more barcode adapters are present in a run. The user selects the
barcode set in the run Planning tab of the Torrent Browser. This barcode set
information is used during analysis to separate out reads by barcode, remove the
barcode and adapters from the read, and output reads by barcode into separate BAM
files. Reads are aligned against the reference genome, and results stored in BAM and
BAM index (BAI) files for each barcode. Reads that can not be classified as being one
of the barcodes in the designated set are grouped into a "no-match™ group, and
alignment against the reference also performed on the no-match group.

Alignment metrics for each barcode are available in the Output Files section of the
analysis run report. The run report shows Q20 performance metrics for all barcodes in
the run, providing a quick glance at the high-level quality of each barcode. The
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barcode section in the run report also shows the following metrics for each barcode in
the run:

* The number of bases

¢ The number of bases at Q20 (or better) accuracy
* The number of mapped reads

* The mean read length

* A read length histogram

The Torrent Suite™ Software includes barcode sets for the latest available barcode kits.
These barcode sets are selected in the run Planning tab. Advanced users optionally
can add additional barcode sets in the References section of the Torrent Browser
admin tab, either by uploading a CSV file of all barcodes or by manually adding each
barcode.

Barcode sets are designed to efficiently separate reads from each other in the presence
of errors. Ion Torrent™ sequencing technology produces raw data in flow space. These
reads are best described as having a homopolymer run of length 0, 1, 2, etc,, ... in flow
1,2, 3, etc. Because of this characteristic, the most typical error patterns involve either
over- or under-estimation of a homopolymer signal in a flow. The most effective
barcodes designs for Ion Torrent™ technology are those with distinctive flow-space
representations.

One way of describing the separation of two sequences in flow space is by the
hamming distance between them for relevant flows. Hamming distance is the number
of flows in which the expected homopolymer length is different between the two
sequences. For example, if two barcodes differ in 5 flows in flows 9-22, those two
barcodes have hamming distance 5.

Hamming distance corresponds naturally to the ability to detect and correct errors.
When two sequences have hamming distance 5, 2 errors can occur on one of the
sequences and that sequence is still 3 errors away from the other sequence. Sequences
separated by hamming distance 5 can tolerate 2 errors and still be classified correctly.

One side effect of operating in flow space is that barcodes are not limited to binary
sequences. For example, each flow can correspond to 0, 1, or 2 bases in a ternary
encoding scheme. This scheme allows for a greater number of codewords occupying
the same number of flows. However, a flowspace representation must correspond to a
legitimate sequence that yields these flow-space values. For example, we cannot have
aflow of T, C, T with values 1, 0, 1. For a flow of T, C, T, both T bases are consumed in
the first flow, and the sequencing reaction yields the incorrect values 2, 0, ?.
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Design custom barcodes

We designed Ion Torrent™ barcode sets to provide at least 1-error correction
(hamming distance 3) in flow space for a large set of barcodes, and 2-error correction
(hamming distance 5) for a usefully sized subset of such codes. This goal is
accomplished by taking the ternary hamming code on 13 characters and assigning
codewords to flows 9-22 to generate flow sequences (flows 1-8 are used for the library
key and are not considered here). These flow sequences then have hamming distance
3 and are 1-error correcting. The codewords are further reduced by the constraint of
requiring that they correspond to legitimate flow sequences. We also apply the
constraint that the flow sequences must correspond to base sequences that are 9 to 11
bases in length. Finally, within the set that satisfies all these constraints, a subset is
chosen (by greedy aggregation) such that any pair of flow sequences has hamming
distance 5.

To insulate these sequences from the target sequences, a ligation adaptor CGAT is
added. The ligation adaptor performs two functions. First, the C in flow 22 provides a
synchronized flow that both marks the end of the barcodes and ensures that barcodes
ending with "0" do not have sequence overwrite those flows. Secondly, this adapter
mitigates any sequence-specific biases caused by the differing barcode sequences.

We provide a tool that classifies barcode reads by finding the flow-space
representation of the read and comparing it to the flow-space representation of the
barcodes. Classification standardly occurs after the last flow of the key (G), and
continues to the end of the barcode sequence provided in flowspace. IonTorrent
barcode sets are designed to be synchronous so that they all are classified using the
same set of flows.

For flow space classification of custom barcodes, the barcodes should be designed to
be compatible with the flow order, be synchronized at a final flow, and be well

separated. However, the Torrent Suite™ Software attempts to classify any reasonable
set of sequences that are separated in flow space. Many standard software packages
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also classify usefully in sequence space, and have been found to work well with Ion
Torrent™ data.

714 9-mer ternary hamming codewords compatible with flow

codeword

Scan your sequencing Kit

The sequencing kit that you use affects the nucleotide flows on the Ion sequencer.

You can scan the sequencing kits for the Ion S5™, ITon PGM™, and Ion Proton™
instruments. You can also enter sequencing kit information in the Torrent Browser
when you create a template or a planned run.

IMPORTANT! Use of the sequencing kit scanner is preferable for this procedure,
because the scanner provides more detailed kit information that can be used for
troubleshooting or other purposes.

The template Enter the sequence kit in the Torrent Browser template wizard, under the Kits step in
wizard the Workflow bar.
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Overview

354

™

The Torrent Suite™ Software supports barcoded runs, which allow you to process
multiple barcoded samples in a single run on the Ion S5™, Ion PGM™, or Ion Proton™
Sequencer.

1

Your Torrent Suite™ Software comes pre-installed with several DNA barcode sets,
including: Ion Code, ionSet1, ionXpress, ionXpressRNA, MuSeek_5prime_tag, and
RNA_Barcode_None. These barcode sets are available for use on the Ion S5™, Ion
PGM™, and Ion Proton™ Sequencers.

A barcode run on the Ion sequencer requires a sample-prep kit such as the IonSet1 or
Ion Xpress barcode adapter kits. You select a DNA barcode adapter kit when you set
up your lon sequencer run. The barcode sequences for the IonCode, IonSetl1, Ion
Xpress, and Ion Xpress RNA barcode adapter kits are included with the Torrent
Suite™ Software.

This barcode set information is used during analysis to separate out reads by barcode,
to remove the barcode and adapters from the read, and to output reads by barcode
into BAM files. Reads are aligned against the reference genome, and the results stored
in BAM and BAM index (BAI) files for each barcode. Reads that can not be classified
as being one of the barcodes in the designated set are grouped into a "no-match"
group, and alignment against the reference also performed on this group. The new
barcode results files are available in the run report File Links section.

Alignment metrics for each barcode are available in the run report page for the given
run.

You can add additional DNA barcode sets by clicking Settings ({#) » References:
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$ Obsolete Reference Sequences DNA Barcodes
$ Target Regions
3 Hotspots Name » Action
> Test Fragments
3 Upload History
MuSeek Barcode set1 g,v
MuSeek_5prime_tag B
lonXpressRNA s
lon Xpress MuSeek Barcode set 1 (-2 4
lonXpress P
lon Single Seq Barcode set1 (-2 4
lonSet1 P
lon Select BC Set-1 £- 24
lonCode - TagSequencing e
lonCode Barcodes 1-32 ﬂ' -
lonCode ety
. . . ™
Workflow The standard workflow for a barcoded sample is similar to a normal Ion S5, Ion

PGM", or Ion Proton™ run and analysis. This section provides an overview of the
workflow, with the new steps involved on a barcoded run.

Summary of the Here is an overview of the recommended workflow for a barcode run. Screenshots
recommended and more details are provided below.
workflow 1. Create a template for your runs in the Plan tab Template page. In the template

Torrent Suite™ Software 5.6 Help

wizard Kits page, select one of the available barcode sets from the drop-down
Barcode Sets menu, and fill out the other run information. Save your template.

When you have the actual sample name, click the Plan Run button for your
template. Enter you run name and sample name, then click Plan.

The Torrent Suite™ Software assigns a name to your planned run, and generates a
5-character code for your planned run name. Your run information is stored in
the Torrent Suite™ Software as a planned run until you are ready to start the run
on the sequencer.

When you are ready to start the run, on the Ion S5™ Run Selection screen you
select your run from a list of planned runs. Torrent Suite™ Software populates the
Ion S5™ Detail screen with the information you entered in the Planning tab. (You
may optionally change information on the Run Info screen.)

You start the Ion S5™ sequencer run as usual.

When the run and report are complete, you can review the performance of the
barcoded reads in the default report page. The following additional barcode-
specific files are available for download from the File Links download section:

e A zip of BAM and BAM index (BAI) files for each barcode

* A csv-style spreadsheet summarizing the barcode performance for each
barcode
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The same steps apply to a planned run (which is created from a template).

Follow these steps to set up a barcoded run in a template:

1. Click Plan » Template, then click Add New Template for the application group
appropriate to your experiment.
The Template wizard opens.

2. Select the correct application group and click Next.

3. On the Kits page, click the Barcode Set menu. Select the barcode set that
corresponds to your barcode kit.

Create Template lon Reporter Application Kits Plugins

Select instrument, chip and kits and then hit next.

Instrument : Chip Type :

lon S5™ System v lon 520™ Chip A
Sample Preparation Kit (optional) : Control Sequence (optional) :

lon AmpliSeq CCP v A
Library Kit Type Details+ : Barcode Set (optional) :

lon AmpliSeq 2.0 Library Kit v lonCode v

Template Kit ) CneTouch ) lonChef:
lon 520 & lon 530 Kit-Chef v

Read Length: 5 200, 400

Sequencing Kit : Flows :
lon S5 Sequencing Kit v 500 -

© Base Calibration Mode : © Mark as Duplicates Reads
Default Calibration v © Enable Realignment

- Pre\’ious

4. Click Next and complete the rest of the wizard. On the last page, click Save.
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5. Your new template appears in the Plan » Templates page, in the application
group you selected.

6.

7.

Torrent Suite™ Software 5.6 Help

Plﬂn m Dam

Plan Runs Samples Templates List
Yy Favorites Generic Sequencing
@ All
n AmpliSeq DNA Template Name Instr. OTI/IC Barcode Reference lon Reporter
Kit Account
n AmpliSeq RNA hg1% IR_Ruo (Version:
lonCade Bsre ~
Copy of template-test2 ﬁ @ N = Target CHP2.2013100 4.4 | User. lon User |
i:3 DNA and Fusions pees 12 1 designed bed Org: IR Org)
Generic lon Xpress Mu
Sequencing lon Xpress MuSeek Library ﬁ (3] Seek Barcode

To run on the Ion sequencing instrument, create a planned run from your new
template. Click Settings (#) » Plan Run for the template you just created.

Template Name Instr. OTIC Barcode  Reference lon Reporter lon Reporter Date Source

Kit Account Workflow

hg1g ;
Copy of template-test2 & o T : ¢ crr2 2013100 :Eﬁuo\weflonu 2016/05/20 "L'
opy ol template-tes ‘\/ . * Target: C 2.21 ser. lon User . * User iona
des 132 org: IR Org) 03:15PM o

1.designed bed
Set as Favorite
| Review

Plan Multiple

Copy

Edit

Delete

The planned run wizard opens, in the wizard Plan page. Enter a descriptive run
name and enter the sample name for each barcode you want to use click Plan

Run to save and finish.
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8. The Planned Runs page opens with your planned run at (or near) the top of the

table:

Templates Planned Runs

Planned Runs

[] Select Run Code Run Plan Name a Barcodes Application

] EFHYE ExamplePlannedRun lonXpress ﬂ

The Torrent Browser assigns a short code name to your planned run. The
example short code here is 6 7HYE

Start your planned This section describes how to go from a planned run to an actual run on the Ion
run on the lon PGM  or Ion Proton  Sequencer. You must first create a planned run, as described in

sequencer Set up a barcode run in a template before using the instructions in this section.

1. Open the Run Info screen on the Ion PGM™ Sequencer.

2. Click on the Browse button (near the middle of the screen, to the right of the
Planned Run field).
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3. The Planned Run pop-up opens with a list of available planned runs. Your
planned run is identified by short code and plan name (as listed under the Plan
tab). Select your run and click OK.

lon PGM™ System

Confirm or enter the run information,
then press Next.

Planned Run

500 F

LLIRE FIonE

L35 - Run2

Your selection appears in the Planned Run field:

Planned Burn: ITHwWI - Bung I I |
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The Ion PGM™ Sequencer Run Info fields, including your barcode set, are
populated with information from your planned run.

lon PGM™ System mn torrent ., 4.
FED D DT IINID  6:Runivo IIIIB

Confirm or enter the run information,

then press Next.
Barcods kit none m m

| Chip Barcode: g [F-:-'I.-Jar-:' Run |

L It-p]l-:ﬂF'E:H[lrn]"'I'I'Iﬂequer'u'-lruq Libvany Kit: |

Punject “
i .-

e Run Name: LILT-337RunS ‘m
. User Notes ‘ " Change

If required, you can manually update any Run Info fields now.

4. Click Next --> to start your Ion PGM™ Sequencer run, as usual. Approve your
run on the confirmation screen.

IMPORTANT! When you accept the confirmation screen, your planned run
information is deleted from the Data tab Planned Runs page. If you terminate your
Ton PGM " Sequencer run and at a later time want to start the run, you must either
enter the run information on the Ton PGM"" Sequencer Run Info screen or re-create the
planned run again under the Torrent Browser Planning tab. The new planned run has

a different short code.
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To initiate a plan on the Ton S5 or Ion S5 XLsequencer:

Select the appropriate plan when you are setting up the run on the sequencer.

Run Selection
r10

Choose a run plan

Planned Run: WOSTA - test_barcode

Chip Barcode: |DABF01278

| Enable post-run clean

P ——
Review

This section describes the ways to import your planned run information into the Ion
PGM"™ Sequencer Run Info screen. These are all done on the Ion PGM™ Sequencer

Run Info screen, and are all different ways to populate thelon PGM™ Sequencer Run
Info screen with the run information previously entered in the Planning tab. Choose

the method which best fits your work environment.

Planned run run code

You can type the run code for your planned run into the Planned Run: text field. An
example run code is ITHWQ.

A run code is assigned to your planned run when you enter the run information in the
Plan > Template page planned run wizard and is listed in the Plan > Planned Runs

page.

Torrent Suite™ Software 5.6 Help 361



,-,
=
=0
ol

:’
(o
2

Barcode reports
and output files

362

Manage sequencer settings from Torrent Suite™ Software
Use DNA barcodes with the lon Torrent Sequencers

This section describes output and reports for barcode runs. The barcode reports
section appears at the top of a run report for a barcode run and shows key
performance metrics for each barcode in the run. The category named "No barcode"
contains barcodes that could not be matched to known members of the barcode set
being used.

g Mean Read Read Length
Barcode Name Sample Output %>-Q20 Reads /CC Histogram  BAM

Mobarcode  E2575-p7 326M 201M 408254 80 bp " . ' BAM BAJ
lon¥press_001 E2575-p7 18.7M 111M 235382 T9bp ", " BAM B
lon¥press_D02 E2575-p7 247M 15.2M 312251 79bp "SR ' BAM BA
lon¥press_003 E2575-p7 29.2M 181M 366937 79bp " BAM BAJ

Q70 [TJQ

The BAM and BAI links in the barcode report download files for only that barcode.

The Output Files section of the Torrent Browser run report includes barcode-related
results files available for download. The links in the Barcodes row download
compresses files of all barcodes for the run. The data in the Reads column are before
alignment.

Output Files

File Type Reads Aligned Reads

Lilirary BARM SFF  FASTO BAM  BAl

Barzodes BAM SFFE | | FASTQ BAM  BAl
File Type Description

Barcode-specific Library Alignments (BAM  Binary Sequence Alignment/Map (BAM), is

and BAM Index] a compressed, binary form of the SAM file.
The BAM index (BAI] file speeds up the
access time for a coordinate-sorted BAM
file. The BAM and BAl files for each barcode
are added to a single compressed file.

IMPORTANT! The FASTQ file format is not produced by the default analysis
pipeline.
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Plugin Support for The following plugins supports barcode libraries:
Barcodes » Coverage Analysis

e Torrent Variant Caller

Reference library and barcode

On the ITon PGM™ or Ion Proton™ instrument, during a run, you can enter information
about the experiment, or run, on Run Info screen. The Ion PGM™ or Ion Proton™
instrument gets the lists of reference library and barcode set from the Torrent Browser.
The information is queried in real time.

™ 1

For example, while at this Run Info screen on thelon PGM™ or Ion Proton™
instrument, you realize the reference library has not been added on Torrent Browser.
Click Settings (#F) » Reference and add a new reference library. Back at the
sequencing instrument, you see the new reference library when pressing the drop-

™

down menu (in red below, shown on an Ion PGM™ instrument):

lon PGM™ System ion torrent ., ...

PRI T T s Rnie S T

then press Next.

E00 Flows
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Connect the sequencer instrument to the Torrent Server

This section uses the Ion PGM™ Sequencer as an example of how to connect an Ion
sequencer to the Torrent Server.

On the Ion PGM™ Sequencer Advanced screen, you can set Torrent Server login
information, for example, server address ( Torrent Server), username ( TS
UserName), and password ( TS Passwd), to connect to the Torrent Server. The Torrent
Server field turns green to indicate that the login information is correct.

IMPORTANT! The Ion PGM™ Sequencer uses the Torrent Browser API to
communicate with Torrent Suite™ Software. The username and password are the ones

used to log on to Torrent Browser. The Torrent Server ssh login can be different from
Torrent Browser login.

lon PGM™ System lun.turre_gt Ny Y—

Enable: Development Conbiok: Serial #: sn10c122004
Femember Laszt Sample PGM N ame:. Ultrﬂ m

W Feznert Stablizabion FTF Server: 192.168.201.1

FTP User: ionguest

FTP Password: ™™™

FTF Root Oir: /results

FBEE (Update Home: 192.168.201.1 | oheege

“orenge Local Home: Cherge
m Library Key Sequence: TCAG m
RunNumber: 336

Torrent Server: 192.168.201.1

Default settings for experiments

364

Default settings for experiments can be accessed and modified through Torrent
Browser, provided you Torrent Suite™ Software administrator privileges. However,
any changes made to these settings will affect all subsequent sequencing runs, or
might lead you inadvertently corrupt a database or permanently delete experiment
data. Therefore, such changes should only be made under special circumstances by
administrators who are knowledgeable about the potential such consequences.
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Default settings for experiments 501
Open the Site Administrator-level users can modify default settings for sequencing runs, using tools
Administration in the Site Administration screen.
screen

IMPORTANT! Use extreme caution when modifying any of the settings in this screen.
Fields that are set to incorrect values may corrupt the database or produce
unpredictable results. Check with your Field Application Scientist or Field
Bioinformatics Specialist if you need to change any of the settings or complete any of
the procedures that are available through this administrative tool.

1. Click Settings (%) » Configure.

2. In the Configure screen, scroll down to the Database Administration section.
Click the Admin Interface link to access the database administration functions.

3. If you are prompted to sign in, enter your administrator user name and
password, then click Sign in.

The Site administration screen in the Ion Web portal opens. After you have made
changes, click Back to Main Site at the top of the screen to return to the software.
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Change the report name

If you manually started an analysis and realize that you typed the report name
incorrectly, you can change the report name using the following procedure. These
steps require admin login.

IMPORTANT! It is not safe to change the report name while the report is being
processed.

1.

Select the Results dialog.

Home » Rundh

3' adapters gk Add

Analysis metrics gk Add

Rundb administration

S Change
S Change

Backup configs geiadd o Chapge
Refererice genomes Add ¢ Change

Variant Frequencies kAdd

View MNetwork Settings
Shutdown Server

Update Server

Update OneTouch Device

Report storages gradd #Change
|RESU|t5 gradd ##Change
Rigs gradd ##Change
Run scripts gradd ##Change
Run types gradd ##Change
TF metrics gradd #Change
Templates gradd ##Change
User event logs gradd #Change
User profiles gradd ##Change

& Change
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2. On the Select results to change page, click the name of the run you want to

change, in the ResultsName column:

Haore » Rundb » Results

Select results to change
Q |

¢ 2012 August9 August 10 Augustl

[] Resultshame
test123

Auto_P2-109_824
Auto_B17-103-cropped?_823
Auto_B11-182-croppedl50_822
Auto_B13-212 821
Auto_CB1-42-r97232-314wfa-tl_B20
Auto_ B17-103-cropped2_819
Auto_RB11-182-100_8138

OO0O0O0O00O0000

Auto_CAR-194-Cropped_816

Torrent Suite™ Software 5.6 Help

Search

1 August 22

" | Gao| 0of 23 selected

Experiment
test CAR-194-Cropped

cropped_Pz-109
B17-103-croppedz
Bl1l-1582-croppedlSi
cropped_B13-212
R_Z011_04_07_12_44 33
B17-103-croppedz
B11-152-100

test_CAR-194-Cropped
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3. Enter the new report name in the ResultsName field:

Haorme » Rundb » Results » Auto_B11-182-100_815

Change results
Experiment: B11i-182-100 v o
[] Representative

ResultsMame: Auto_B11-152-100_518

SffLink: JoutputfHorme/Auto_B11-182-100_518
FastqLink: JoutputfHorme/Auto_B11-182-100_518
ReportLink: JoutputfHorme/Auto_B11-182-100_518
Status: Pending

TfSffLink: foutput/Home/duto_B11-152-100_5815
TfFastq: _

Log: foutput/Horme/Auto_B11-1582-100_818_

1048/ og.htrl

AnalysisVersion:

4. Click Save (on the bottom right) to save your change.
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Change the run date

Occasionally, the Ion PGM or Ion Proton " Sequencer cannot get a date/time from the
internet time server. When this occurs, the sequencer date is set to January 1, 1969.

The date of the run is encoded in the folder name, which is parsed and used as the
Run Date in the database. This causes the new run to be displayed with the incorrect
date. With a date of January 1, 1969, the run is the last item on the last page of run
reports listings in the Data tab.

Use the following procedure to change the date for this run:

1. In the Torrent Browser Config tab, click Admin Interface and login, if prompted.
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2. Click to open the Experiments database item for modification:

Site administration

Groups gkidd # Change
Users dkiadd #Change

Crontabs g Add #* Change
Intervals g Add #* Change
Periodic tasks $kadd o Change

Tasks & Change

Waorkers g Add #* Change

3' Adapters geidd #Change
Analysis metrics grAdd #Change
Appl products grAdd #Change
Backup configs grAdd #Change
Backups grAdd #Change
Chips grAdd #Change
Content uploads grAdd #Change
Contents grAdd #Change
Crunchers grAdd #Change
DM - PruneGroup grAdd #Change
DM - Reports grAdd #Change
DMA Barcodes grAdd #Change
Email addresses grAdd #Change
Experiments grAdd #Change
File servers geiadd o Change
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3. Find your run in the experiment name list. The list is sorted by date, starting with
the newest runs in the database. Because the run from 1969 is at or near the end
of the list, it is convenient to re-sort by date, in ascending order (oldest at top).
Re-sort by clicking the Date column heading:

Torrent Suite™ Software 5.6 Help

Select experiment to change

0

JOo0ODoOaan

Ooooo

O O

OoO0D0O0Ooao

ExpMrme
R_z010 67 24 @0 F3 18 SCR-135 MG (ibl-4 A7 preBor

R_2010_07_26_90_33 00 KER-41 M5 076 956 _ION
R_2010_67_24 &0_20_10_WOL-54_ MS_ib3-4_SSE_KN
R_Z010_07_76_00 19 31 FOZ304 WS 87 S58 KON
R_2010 07 2% T3 16 24 jafid.n2d43.47T.chda

R_2010 07 2% 23 02 OO jalilied i .c208
R_2010_07_25 ¥ 19 56_[ariJedam.c20g
R_2010_07_25_71_73_&0_madT-x25-ci0-c 711
R_I010_67 3% 30 14 40 jarnlpdai.e21iy

R_2010 07 2% 10 14 22 [@l29.1psin cil?

R 2010 67 25 16 12 96 ENG-I3T 1mM_dAMP W3
R_2010_07_25_14_07_50_CYC-74.83.EF
_2010_067_25 14 O6_&0_BEA-LLA%.EF

R_Z010 07 2% 14 05 43 HON-2I150EF

R 2010 67 25 @0 X2 00 ENG-T8&-ma-ild-10N-550
R_2010_07_24_23 47 40 WOL-51-Eb3-5-ms-nanchull-BE(T
R_2010_07_24 X3 AT 34 BEA-4L-IR]-E-ms-BsiTs
R_Z010_07_24_73_70_56_ma45a25-Hi-18mc2il
R_z010 67 34 33 31 14_médSax2o-cT-d8s.e211
R_2010 07 24 23 46 34 SHA-30ansppge Z30-243
2010 07 34 1 16 44 HOMN-232-sdiorm-T010-E03d-BR

Dt

Juby 36, 2000, 1223am
July 30, 2010, 1223am
Juby ), 2000, 1FMiam.
Juby 6, 2000, 121Bam
July 15, 2000, 1EL5pm
Jubp 39, AES 1L05 am
Jubty 15, 2000, 119 pm.
ity 35, 000 P em
July 20, 2009, B3 e
ey 25, 2000, B3 o
July I5, 2000, £l mm
July 30, 2000, 207 B
Suty 28, 2000, 200 pm
July 35, 2010, F106 e
July 36, J0LY, 1337 am
Judy 24, 2000, 1X4TAam
Julg B4, 2000, 14T pm.
Juby 34, 2000, 1120 pm
July 34, 3000, 111 pm
Jedy 34, 3000, ARAE M
JUF T, I, I mm
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4. Click the ExpName for your run to select it and display the following run

information:

SS9E  Manage sequencer settings from Torrent Suite™ Software

Horme » Rundb » Experiments

Change experiment

ExpDir:
ExpMame:
PogmMame:

Log:

Unigue:

Storage options:

User ack:

Sample:

5. Use one of the following two options to change the date: a) Click the Today and
Now buttons to set the Date and Time values to the current date and time in one

click.

fresults/Cropped/B4_231_cropped
cropped_Bd--231
Cropped

{"autoanalyze":false,"nurn_frames":103,"
r1","oversample":8,"segbarcode":"","lbr:z
requency” 53333333, "board_version":4,"
[16,0,1],"board_serial™:"000069","libraryl
4" "liveview_version"1210,"calibratepasse
1z202","user_name":"user","vrefs""2662:
[51,0,0,0,0,0,0,0,1,11,25,153,698,1964 5
457 62127 ,86264,107105,1195801, 1232453
307,13756,7174,3610,1675,626,272,75,1
[32913,32555,52654,32636,33294,33230
005474, ref_electrode":"1.,99500000000

dresults/Cropped/Bd_231_cropped

Date: zp011-02-20 =

Time: {1:55:53 | Mow
Delete Raw %
Unset b

wrmas_dry_20_3

IMPORTANT! The automatic method is recommended because it places this run
at the top of the run report lists, in both the Data > Completed Runs & Reports

tab and the Data > Projects > projectname tabs.

b) Manually edit the date/time strings.

372
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6. Click Save, on the bottom right to save the new date:

FrpEtatus T
Library¥ey: TOAL
& Gelcic Serce and rdd nctheer | Srvw and coetee rétag %

7. Return to the Data tab when done.

Update the lon lon OneTouch™ Device

IMPORTANT! These procedures require your ionadmin account. (Do not use your
ionuser account.)

This procedure requires actions on both the Ton OneTouch™" sequencing instrument
and in the Torrent Browser.

Follow these steps to update the Ion OneTouch™" instrument software:

1. Connect the Ion OneTouch™ device and the Torrent Server with an Ethernet
connection.

2. Sign in to Torrent Browser with an administrator (ionadmin) account.

3. Click Settings (%¥) » Plugins, in the Torrent Browser (near the top right).

Ahout
References
Services

Flugins

Accounts
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4. Get the updated IP address of the Ion OneTouch™ device. Follow either one of the

following steps: As ionadmin, in the Torrent Browser Config tab Management
Actions section, click the link Update OneTouch Device.

* Power cycle the Ion OneTouch™ device, or

e Wait for the IP address to update (takes one or two minutes).To check for the
IP address, press the About button on the Ion OneTouch™ device.

IMPORTANT! This page does not refresh. To refresh, go to a different screen
and then go back.

More than one update may appear for the optional download.

Click Update.

On the Ion OneTouch™ device, a splash screen appears with update progress.

6. After update is complete, the Ion OneTouch™ device reboots itself.

Update lon Chef  scripts

Ton Chef'" scripts can be updated between software releases and you can elect to
update them. When an Ion Chef  script is updated, you will see an announcement at
the top of your Torrent Suite screen.

1.

Click on the new Ion Chef™ script announcement and click Upgrade.
The system installs the new script.

If you find you need to revert back to the old script, click Revert.

Next, upgrade the Ion Chef™ instrument.

Handle a failed analysis run

If an analysis run fails, determine the cause of the failure and, possibly, restart the run.

374
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Determine the If an analysis run fails, make the following checks:

fault cause 1

Torrent Suite™ Software 5.6 Help

Has the Ion PGM™ or Ion Proton™ Sequencer completely transferred the data for
the run? Go to the sequencer Data Management screen to ensure complete data
transfer. If you are not sure the data was transmitted. you can retransfer it.

In the Data tab, click Completed Runs & Reports tab to ensure that the file
transfer was complete. Also, check if there are any error messages, such as User
Aborted. Look for a status of Error or Pending.

If the report was generated, check if there are any messages on the report itself.
Click the Support link towards the bottom of the run report (above the Plugin
Summary row of buttons). Click View the Report Log or Download the
Customer Support Archive. You can send the customer support archive to your

Ion Torrent™ contact for review.

If you cannot determine the cause of the fault, try restarting the run.
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2

Planned Runs screen

How to... Learn more about...

“Create a planned run with AmpliSeq™ DNA “Plan Tab" on page 394
template” on page 26

“Plan by sample set” on page 33 “Templates “ on page 391
“Create multiple planned non-barcoded “Wizard Plan or Save step in the Workflow
planned runs” on page 37 bar” on page 387

“Create a Planned Run with DNA and
Fusions templates” on page 27

“Plan a run using Generic Sequencing
template” on page 29

“Plan a run using lon 165™ Target
Sequencing template” on page 113

“Copy a template” on page 29

“Create a template with lon AmpliSeq.com
Import” on page 31

Samples screen

How to... Learn more about...
“Enter new sample” on page 16 “Sample information” on page 20
“Create sample sets manually” on page 17  “Sample attributes” on page 19

“Import samples to create a sample set” on “CSV Metrics File Format” on page 402
page 17

“Create multiple planned non-barcoded
planned runs” on page 37

“Search samples” on page 21
“Edit samples” on page 22
“Delete samples” on page 23

“Sort samples” on page 24
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Learn more about...

“Create a planned run with AmpliSeq” DNA “Plan Tab" on page 394

template” on page 26

“Create a Planned Run with DNA and
Fusions templates” on page 27

“Plan a run using Generic Sequencing
template” on page 29

“Plan a run using lon 165™ Target
Sequencing template” on page 113

“Copy a template” on page 29

“Create a template with lon AmpliSeq.com

Import” on page 31

“Plan by sample set” on page 33

Planned Run List screen

How to...

“Execute a Planned Run on your
sequencer” on page 58

“Start your planned run on the lon S5™ or
lon S5 XL sequencer” on page 361

Runs in Progress screen

How to...

“Review the Planned Run settings” on
page 64

Torrent Suite™ Software 5.6 Help

“Templates “ on page 391

“Wizard Plan or Save step in the Workflow
bar” on page 387

Learn more about...

“Plan Tab” on page 394

“Customizing and editing templates” on
page 26

“Wizard Plan or Save step in the Workflow
bar” on page 387

“Example Planned Runs page” on page 401

Learn more about...

“Monitor the sequencing run” on page 60

“Monitor the sequencing run” on page 60

“Data views for runs in progress” on
page 63

“Auto Refresh the Monitor tab” on page 63
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lon Chef screen

How to...

“Analyze lon AmpliSeq™ on lon Chef™
samples” on page 41

Completed Runs & Results screen

How to...

“Manage Completed Runs and Reports” on
page 65

“Search for a Run report” on page 65

“Add a Run report to a project” on page 71
“Stop a sequencing Run” on page 301

“Change the Default Alignment
Reference” on page 67

“Reanalyze a run report” on page 65

“Add or change barcoding for a completed
Run report” on page 68

“View the data management actions log” on
page 292

“Manually delete run data” on page 292
“Reanalyze a run report” on page 65
“Edit a Run report” on page 67
“Manually archive run data” on page 291

“Manually export run data” on page 290

378

Learn more about...

Learn more about...
“Test fragment report” on page 102
“Analyze lon AmpliSeq™ on lon Chef™
samples” on page 41

“View plugin run status” on page 118
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Run Report [
Run Report
How to... Learn more about...
“Review pre-alignment metrics” on page 78 “Introduction” on page 77
“Review alignment metrics” on page 79 “ISP density” on page 87
“Download results set” on page 79 “ISP summary” on page 90
“Manually run a plugin on the run “Read length” on page 94
results” on page 79
“Review the planned run settings” on “Key signal” on page 88
page 80

“Review the test fragments and their quality “Output files” on page 101

metrics  on page 81 “Run metrics overview” on page 84

“Review Chef Summary” on page 81 “Predicted quality (Q20)" on page 85
“Review calibration report” on page 82 “Quality following alignment (AQ20)" on
page 85

“Review analysis information” on page 82
“Compare run reports” on page 84

“Tune lon Reporter™ Software speed
parameters” on page 178

Projects screen

How to... Learn more about...

“Add a Run report to a project” on page 71 “Organize run results with projects” on
page 70

“Download a CSV file of metrics” on page 76 “Search for projects by name” on page 70

“Add selected results to another project” on “Combine aligned reads from multiple run
page 73 reports” on page 75

“Remove result sets from project” on
page 76

“Search for projects by name” on page 70

“Filter projects or result sets by date” on
page 71
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Data Management screen

How to...

“Open the Site Administration screen” on

page 365

“Connect to a Torrent Storage” NAS
device” on page 296

“Monitor the Torrent Storage” NAS
device” on page 299

“Increase file storage and available disk
space” on page 293

Analysis Parameters screen

How to...

“Configure and select a custom analysis
parameter set” on page 412

References screen

How to...

“Upload a new reference file” on page 226

“Add the lon GRCh38 Reference to Torrent

Suite™ Software” on page 223

“Import custom reference” on page 227

“Manage Target Regions Files and Hotspot

Files” on page 235
“Modify a BED file” on page 237

“Download a hotspots or target regions
file” on page 242

“Delete a hotspots or target regions file” on

page 243

380

Learn more about...

“Data management” on page 282

“lon instrument data types” on page 282

“Import data for data transfers or
restoration” on page 286

“View active data management jobs” on
page 288

“View category statistics” on page 287
“View disk usage parameters” on page 286

“Dataflow file sizes” on page 410

Learn more about...

Learn more about...
“Prerequisites” on page 226

“GRCh38 human reference” on page 223

“Error handling” on page 231

“Target Regions Files and Hotspot Files” on
page 231

“BED File Formats and Examples” on
page 244

“Target Regions File Formats™ on page 244

“RNA Fusions BED File Formats and
Examples” on page 254
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Services screen

How to...

“Check crawler and job server status” on
page 330

“Restart services” on page 333

“Monitor your lon Torrent™ Server” on
page 317

Plugins screen

How to...

“Enable an installed plugin” on page 115

“Configure a plugin to run by default after
every run” on page 117

“Run a plugin manually from the
sequencing run report” on page 118

“Uninstall a plugin” on page 115

“Rescan a plugin” on page 120

lon Reporter configure screen

How to...
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Learn more about...

“Alternate checks” on page 347

Learn more about...

“Pre-installed plugins” on page 121

“Plugin configuration” on page 116

Learn more about...

“Set up an account for lonReporterUploader “lonReporterUploader plugin

plugin” on page 173

“Tune lon Reporter™ Software speed
parameters” on page 178

Torrent Suite™ Software 5.6 Help

configuration” on page 177

“lonReporterUploader plugin file transfer
progress” on page 186
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Configure screen

How to... Learn more about...

“Add customer support contacts” on
page 315

“Change the displayed server name” on
page 316

“Update Torrent Suite™ Software” on
page 303

“Delete multiple user accounts” on
page 308

“Archive or delete data automatically” on
page 283

Account Settings

How to... Learn more about...

“Approve requests for new accounts” on “Approve and reject new accounts” on
page 309 page 313

Product and Plugin updates

How to... Learn more about...

“Enable off-cycle product updates” on
page 305

“Update off-cycle release plugins” on
page 306
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This appendix describes how to create and select barcode sets in the software for
sequencing barcoded libraries.

Pre-installed barcode sets

Torrent Suite™ Software includes pre-installed barcode sets such as “IonXpress”,
“lonXpressRNA” and "IonCode".

When setting up a Planned Run or performing a run, select the appropriate barcode
set for your library type as follows:

* DNA libraries: Select the IonXpress barcode set, which includes all barcodes in
the Ion Xpress™ Barcode Adapters 1-96 Kits, or the IonCode barcode set, which
includes the 384 barcodes in the IonCode™ Barcode Adapters 1-384 Kit (Cat. No.
A29751).

* RNA libraries prepared using the Ion Total RNA-Seq Kit v2: Select the
IonXpressRNA barcode set, which contains all 16 barcodes in the Ion Xpress™
RNA BC01-16 Kit (Cat. No. 4475485).

If you are not using barcodes:

e DNA libraries: Leave the Barcode field blank.

* RNA libraries prepared using the Ion Total RNA-Seq Kit v2: Select
RNA_Barcode_None from the dropdown list. This will ensure that the proper
trimming is performed on the resulting sequence when the RNA library does not
have a barcode.

IMPORTANT! Do not edit, delete, or modify the pre-installed barcode sets.
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Select a barcode set for a sequencing run

Select the barcode set in the Torrent Browser when planning the run.

Select instrument, chip and kits and then hit next.
Instrument :

lon PGM™ System E|

Sample Preparation Kit (optional) :

Library Kit Type Details + :

lon Xpress Plus Fragment Library Kit E‘ lonXpress
Template Kit g, OneTouch = lonChef:

lon PGM Hi-Q View OT2 Kit - 400 E‘
Sequencing Kit : Flows :

lon PGM Hi-Q View Sequencing Kit E‘ 850 :
@ Base Calibration Mode :

Default Calibration E|

Custom barcode sets

Chip Type (required) :

lon 318™ Chip v2

M

Control Sequence (optional) :

Barcode Set (optional) :

B

© Mark as Duplicates Reads []:
© Enable Realignment []:

You can create custom sets of barcodes as comma-separated value (.csv) files, then
load these sets onto the Torrent Server for use during sequencing runs.

To access the Torrent Server, you must have a username and password. For more
information on working with custom barcode sets, see the Torrent Suite™ Software Help.

To add the file to the Torrent Server, open the software and click Settings

Create and add a 1. Create a comma-separated variable (CSV) text file for your custom barcode set.
custom barcode The CSV file can contain up to 384 barcodes.

set on the Torrent 2

Server '

(£¥) » References.

e m o

Completed Runs & Results

Completed Runs & Results

List View | Table View

* Go | [ Anyproject ~| [ ny sampie

AllFlows | [anychip ~| [ Anymstrument ~| | AnResutt status

3. In the left navigation bar, select Barcodes.

4. Click the Add new DNA Barcodes button.

3 Reference Sequences
> Obsolete Reference Sequences DNA Barcodes
> Target Regions

3 Hotspots P
Test Fragments

fonXpressPlusCtri

384

Apout

Sen

Plugins
Configure
lon Reporter Configure
Accounts

Any Reference

Reports new to old ~| | Clear

Add new DNA Barcodes

Action

Frd
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5. In the popup dialog, click on the Download the example file link for an example
file showing the correct CSV format. Edit your own CSV barcode list to match
this format, and save the CSV file on your computer.

Add New DNA Barcodes

Barcode Set Name :

My barcodes |

Descriptive name of the Result

Barcode CSV File : || Choose File |
CSV File of barcodes| Download the example file $equence column is required

Cancel Upload & Save

6. Enter the Barcode Set Name and click on Choose File to select your formatted
barcode CSV file. Then click Upload & Save.

7. The barcode set file name is displayed in the list.

Other barcode set
operations View a barcode set

1. To view a barcode set, go to the Torrent Browser and click the References tab.

2. Scroll down to the Barcodes section and click on the barcode set name to display
the list of barcodes in the set.

Delete a custom barcode set from the Torrent Server
1. To view the barcode set names, click the References tab in the Torrent Browser.

2. Scroll down to the Barcodes section and click the name of the barcode set that
you want to delete.

3. In the barcode set page, click + Delete Barcode Set then click Yes to confirm the
deletion.

Add a barcode to a custom barcode set

1. Open the Torrent Browser and click the References tab.

2. Scroll down to the Barcodes section and click the name of the barcode set to be
edited.
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3. Click + Add Barcode. You see the new barcode window:

iqntﬂrr&gt
; s Famm |[ R ][ e |[ e |[ R || S [

Add nesy Darcode in set Darcode_Test

Barcod id
SeUaNce
ALapLE
LT
'_\:::11 Fiede
Scove Cutall

Annot aton

Saen Oarcode

4. Complete the fields, then click Save Barcode.

Edit or delete a barcode from a set
1. Open the Torrent Browser and click the Settings button on the right side of the
window, then select References.

2. In the Barcodes panel, click the file name of the barcode set to be edited.

3. Click the button under Action to edit or delete the panel.

¢ To edit a barcode, change the barcode in the edit window, then click Save
Barcode.

e To delete a barcode from a set, click Delete Barcode, then click Yes to confirm
the deletion.
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Wizard Plan or Save step in the Workflow bar

The title for last step in the Workflow bar of the wizard is different for templates, run
plans, and run plans that are planned by sample set:

¢ Templates The step in the Workflow bar is Save. Here you enter the new
template name and optionally mark it as a favorite.

* Run plans The step in the Workflow bar is Plan. Here you enter the new run plan
name and sample information.

¢ Plan by sample set The step in the Workflow bar is Save & Finish. Here you enter
the new run plan name. (Sample information is automatically entered into the
Barcoding step in the Workflow bar.)

Note: Templates that are marked as favorites are listed in their own section at the top
of the Templates tab.

Wizard lon Reporter Page

Ion Reporter is the first page in the Torrent Browser run template wizard. When you
select an Ion Reporter account in this page, features related to Ion Reporter™ Software
appear in the other wizard pages.

Flan m pata ﬂ “

Create Plan from lon Proton Human CEPH Control 170

Create Plan L LE LTy Applical Kits Plugins Projects

Select an lonReporter account and workflow to use:g & Summary *
® None Sample
ionwest - go wild (Version: 4.0 [ User: lon Grouping lon Reporter: None

User | Org: IR Org)

Sample_Control Application: DNA
ir-carlsbad (Version: 4.0 | User: lon User | Gelf Somle G o
Org: IR Org) ple Grouping:
Tumor_Normal Target Technique:  Other
Trio len Reporter
Other Workflow:
DNA_RNA

SINGLE_RNA_FUSION

These selections on this page are only for Ion Reporter™ Software users.
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Wizard Application Page

In the Application page you select your experiment type:

e

Select the application and target technigue, then hit next.

Application Target Technigue
DNA AmpliSeq RNA
RMNA = AmpliSeq

Metagenomics DNA+RNA

Typing
= DNA and Fusions

Based on the information that you specify here, the Kits page is set with the
appropriate selections.

Notes about the Application choices:

* Metagenomics is reserved for future use with Ion Reporter™ Software.

* Typing is used for molecular fingerprinting to detect single strains of viral or
bacteria for research purposes.

Wizard Kits Page

On the Kits wizard page, enter the following information about laboratory kits and
other sequencing parameters:

* (Optional) Sample preparation kit

¢ Library kit type, including the forward library key and the forward 3' adapter
¢ Templating kit type

* Sequence kit

* Number of flows

* Barcode set Required for barcoded runs

* Base calibration mode

* Control sequence Required for RNA runs

e Chip type Required

e Mark PCR Duplicates Not recommended for Ion AmpliSeq™ data

Chip type is required. As with all fields, if you enter chip type in your templates, then
it is automatically entered in your run plans.
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New in version 5.2, smart filtering is enabled on the Kits screen. When you select an
instrument, the Chip Type options are filtered so that you cannot select an
incompatible chip in error.

Example Kits page:

SR “

Select instrument, chip and kits and then hit next.

Instrument : Chip Type (required) :
lon PGM™ System ’ lon 318™ Chip v2
Sample Preparation Kit (optional) : Control Sequence (optional) :
Library Kit Type Details+ : Barcode Set (optional) :
lan AmpliSeq 2.0 Library Kit v lonipress
Template Kit . oneTouch @ lonChef

lon PG Hi-G Chef Kit g
Templating Size: @ 200 © 400

Library Read Length: 227

Sequencing Kit : Flows :
lon PGM Hi-Q Seguencing Kit v 500

© Base Calibration Mode : © Mark as Duplicates Reads [ :
Default Calibration ’ © Enable Realignment [ :

Note: The value entered for number of flows represents the maximum possible for a
run using a planned run based on this template. Instrument conditions such as the
availability of consumables might cause fewer flows to be completed.

Beginning in Torrent Suite 4.4, there is a base calibration mode drop-down menu. For
Torrent Suite” Software v5.2, this menu contains four options: Default Calibration,
Enable Calibration Standard, Blind Calibration, and No Calibration. (Previously, in
Torrent Suite " Software v4.2, you could choose to Enable Base Recalibration or not.)
You can select the base calibration method during run planning and in the reanalysis
menu.

Default Calibration — allows a random subset of wells to be used for base calibration.
(This is equivalent to the default setting for Torrent Suite  Software v4.2 and earlier,
i.e., a checked Enable Base Recalibration check box). This option uses TMAP to align
the training subset of wells and is recommended if a good reference for the template is
available.

Blind Calibration — uses the same random subset of wells as Default Calibration but
does not require an alignment step to generate the calibration model. This option is
recommended if the template does not align well to a reference genome or if no
reference is specified.

Enable Calibration Standard — allows wells belonging to the Calibration Standard to
be selected as training subset.

The Calibration Standard is a small panel consisting of known sequence content with
comprehensive and uniform representation of long homopolymers (up to 10-mers).
The calibration standard can be spiked into Ion S5, Ion PGM™, and Ion Proton™

Torrent Suite™ Software 5.6 Help 389



# Reference
Wizard Plugins Page

runs as a quality control for higher homopolymer performance and as a known
reference for base recalibration.

The Calibration Standard is designed for use in combination with IonXpress or
IonCode barcoded libraries. The calibration standard sequences are around 200 base
pairs in length. Dor best results, the DNA templates should have similar read lengths.

Please note that this method of base calibration only works if calibration standard
beads were spiked into the run. A summary of the number of calibration standard
beads found can be viewed under the Calibration Report tab on the run page.

Wizard Plugins Page

In the Plugins page, you select plugins to run with this run plan or to run every time a
run plan is created from this run template:

Select plugins to execute, then click Next.

Select All Clear Selections

ampliSegRNA AssemblerSPAdes coverageAnalysis
ERCC_Analysis FileExporter FilterDuplicates
RunTransfer samplelD variantCaller

o PrEVious

Note:

- The plugins available to you depend on what is installed and configured in your
Torrent Browser.

- All active plugins (those installed, configured, and enabled on your Torrent
Browser) are available in this menu.

- The IonReporterUploader plugin does not appear on this page.

- When you enable the variantCaller plugin, a Configure link appears for that
plugin. For information on configuring the variantCaller (variantCaller) plugin.
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In the Projects page, you select projects the will receive the completed analysis from
this run plan or from every time a run plan is created from this run template:
Select the project(s) that will receive data from runs planned in this template,
then hit next.
0000000000111111111122222222233
00000000001111111111222222222333
073113 _TargetSeq Rescue
076A02_13B
076A02_13c_Reworked -
Search Add Project...
You can also create a new project in this page.
Torrent Suite " Software includes many planned run templates to simplify your
sequencing. Most templates have a corresponding Ion AmpliSeq panel. The
following describe a template:
* A canned set of instructions for both your sequencing run and your post-
sequencing data analysis.
A digital protocol with specifications for almost your entire experiment, from
sample preparation through sequencing, data analysis, and data export to other
systems for additional analysis. (A plan template is missing only the sample
name, from your experiment information.)
A sample planned run that you can copy to quickly create actual planned runs
with known defaults and settings.
A reusable set of laboratory, sequencing, data analysis, and data management
instructions.
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These steps describe how a plan template fits into your Ion S5, Ton S5 XL, Ton
PGM " or Ion Proton sequencing workflow:

* Decide what sequencing application and sequencing product (such as an Ion
AmpliSeq " panel) you will use.

* Select a pre-installed template with defaults for your application and sequencing
product, or create your own template from scratch. Then, customize your
template.

¢ Copy the template to a new planned run, adding the name of the tissue sample to
be sequenced. The Torrent Browser assigns your new plan a run code.

* Enter the run code directly on the Ion sequencing instrument to initiate the
sequencing. The planned run automates the process from sequencing through
data analysis and data handling.

With the planned run wizard, you can create a new planned run with only a few
clicks and the entry of the sample name. With the Plan Multiple feature, you
download a CSV and customize it to create multiple planned runs without using the
planned run wizard.

Plan templates play an important role in enabling rapid throughput across your
sequencing instrument. Templates also help reduce the chance of error, by listing the
reagent kits used on the instrument.

The Plan » Templates screen contains your experiment templates. These include pre-
installed product templates (for instance for products such as the Ion AmpliSeq"
panels) and as well as templates that you create, and areas for recently-used templates
and ones you mark as favorites. Product templates contain the appropriate defaults
for a product, including the default kits, BED files, and reference.

Templates are organized by sequencing application (and by product for some
applications):
e AmpliSeq DNA Ton AmpliSeq  applications, including the Ton AmpliSeq
Comprehensive Cancer Panel, Ion AmpliSeq  Inherited Disease panels.

e AmpliSeq RNA Ton AmpliSeq RNA applications, including the Ion AmpliSeq
Transcriptome Human Gene Expression Panel and Ton AmpliSeq RNA Panel.

e DNA and Fusionslon AmpliSquI fusion applications, including the Ion
AmpliSeqT\1 Colon Lung v2 with RNA Lung Fusion Panel and Ion AmpliSeqTM
Lung Fusion Panel.

* Generic Sequencing Your own applications that do not fit in the other categories.
With a generic sequencing template, you provide the settings for the experiment.
Your choices are not restricted based on the logic of an application workflow, and
it is theoretically possible to create a flawed template.

e Pharmacogenomics Ion AmpliSeq  Pharmacogenomics Research Analysis Panel.
* RNA Seq RNA sequencing applications.

e TargetSeq TargetSeq products and other targeted resequencing applications,
with parameters optimized for hybridization-based target enrichment.

* Whole-Genome Seq Whole genome sequencing applications, which do not
assume enrichment and do not require a target regions file.

e 16S Target Sequencing Ion AmpliSeq  16S metagenomics applications.

The template page also has groups for recently-used templates and for templates that
you mark as your Favorites.
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You can also create a template from your ITon AmpliSeq " Designer.

You can create your own template in order to have specific customization that is not
available in the pre-installed templates. Examples of customization include the
following:

e Custom plugin usage.
¢ Use of custom BED file for regions of interest or hotspot locations.

* Automatic inclusion of result sets into one or more projects, for convenient data
management step later on.

* Automatic export of results sets to other analysis systems, such as to the Ion
Reporter = Software system.

In general, you start with the product template or application template that most
closely matches your research requirements, copy that template, make your custom
changes in the template wizard, and save your new template under a new name.

Your new template appears in the same application group as the original template.
You optionally can also mark the new template to appear in your Favorites template

group.

IMPORTANT! Valid characters in a template or plan name are the following: alpha-
numeric, dashes, underscores, spaces, and periods.

Commas are not allowed in a plan or template name.

Templates are organized by sequencing application (and by product for some
applications):
e AmpliSeq DNA Ion AmpliSeq " applications, including the Ion AmpliSeq"
Comprehensive Cancer Panel, Ion AmpliSeq  Inherited Disease panels.

e AmpliSeq RNA Ion AmpliSeqTM RNA applications, including the Ion AmpliSeqTM
Transcriptome Human Gene Expression Panel and Ion AmpliSeqwI RNA Panel.

e DNA and Fusionslon AmpliSeq " fusion applications, including the Ion
AmpliSeq" Colon Lung v2 with RNA Lung Fusion Panel and Ton AmpliSeq
Lung Fusion Panel.

* Generic Sequencing Your own applications that do not fit in the other categories.
With a generic sequencing template, you provide the settings for the experiment.
Your choices are not restricted based on the logic of an application workflow, and
it is theoretically possible to create a flawed template.

¢ Pharmacogenomics Ion AmpliSeq Pharmacogenomics Research Analysis Panel.
* RNA Seq RNA sequencing applications.

e TargetSeq TargetSeq products and other targeted resequencing applications,
with parameters optimized for hybridization-based target enrichment.

* Whole-Genome Seq Whole genome sequencing applications, which do not
assume enrichment and do not require a target regions file.

e 16S Target Sequencing Ion AmpliSeq " 16S metagenomics applications.

The template page also has groups for recently-used templates and for templates that
you mark as your Favorites.

You can also create a template from your Ton AmpliSeq " Designer.
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Plan Runs Samples Templates Planned Run List

The Plan tab offers several routes for starting your sequencing experiments. The
preferred way is to use a plan template in the Plan » Template tab to create a digital
protocol with specifications for almost your entire experiment, from sample
preparation through sequencing, data analysis, and data export to other systems for
additional analysis. From the template, you create one or more planned runs, which
execute directly on your Ion S5™, Ion S5™ XL, Ion PGM"™ or Ion Proton™ sequencing
instrument.

Other ways to begin a sequencing run include:

¢ In Plan » Plan Runs, you can plan a sequencing run by sample type or template
run.

e InPlan » Samples, you can start a run by clicking Settings ({¥) » Plan Run.

* In Plan » Plan Run List, click Settings ($#) in the appropriate row in the Run
Plan Name list, then select Copy to make a copy of an existing run.

The workflow below describes how templates and planned runs fit into your
sequencing workflow:

1. Determine your sequencing application and sequencing product (such as an Ion
AmpliSeq™ panel).

2. Select a pre-installed template with defaults for your application and sequencing
product, or create your own template from scratch. Customize your template.

3. Copy the template to a new planned run, adding the name of the tissue sample
to be sequenced. The Torrent Browser assigns your new planned a run code.

4. Enter the run code directly on the Ion sequencing instrument to initiate the
sequencing. The planned run automates the process from sequencing through
data analysis and data handling.

Typically, you create and organize templates, and create planned runs in the
Plan » Templates tab. You review planned run settings, edit, delete, or copy planned
runs in the Plan » Planned Runs tab.

The Plan » Planned Runs page contains planned runs which are ready to execute on
your sequencing instrument. A planned run is an electronic protocol of everything
required for a sequencing run, from reagent kits to sample name to genome reference,
data analysis, and data management. You create each planned run from an
application template (either from a product template or from your own template).

Templates and planned runs provide alternate methods (and timing) of entering the
same data that is otherwise entered on the Ion sequencing instrument, for example on
the Ion PGM™ Run Info screen. With templates and planned runs, you can enter the
information in advance, and have an opportunity to print and review your entries.
Use of templates and planned runs reduces your hands-on time on the instrument. If
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you do not create planned runs here in the Plan tab, you must enter the run
information directly on the Ion sequencing instrument.

You can your run plans based on your sample sets or on run plan templates.

When you create a planned run, the run plan wizard walks you through each aspect
of your new planned run, using pre-populated defaults based on the application
template or product template you choose. The example below shows the defaults in
the reference selections page. The chevrons across the top show the different pages of
the wizard.

To execute a planned run, you select it directly on the sequencing instrument, for
instance on the Ion PGM™ Run Info screen.
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Wizard

When you create a new template or a planned run (from a template), the template
wizard walks you through each aspect of your new template or planned run, using
pre-populated defaults based on the application template or product template you
choose. The example below shows the defaults in the Create Plan page. The chevrons
across the top show the different pages of the wizard.

Creste Plan onReporter Application Kits Plugins Projects n

Template Name : Show Summary

lon AmpliSeq Comprehensive Cancer Fanel

Run Plan Hame [required] :

lon AmpliSeq Comprehensive Cancer Fanel

Default Reference & BED Files

Reference Library : hg18{Homo sapiens) El
g18{Home sapiens)

Target Regions: Nane El

Hotspot Regions: Nene El

Use same reference & BED files for all chips

Number of chips : | 1 -]

| Enter a sample name for each plan (required at least one sample} &

* Sampls Name (requirsd) Sampils ID Sampis Description Sampis Tubs Labsl
1 Sample 1
Add a note :

T Menitoring Thresholds :

Bead Loading (%)
SETE
Key Signal {1-100):

S(30 -

Add LIMS Meta Data :

Usable Sequence (%)

Sl30 2

e —
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Start the wizard

For both templates and planned runs, you start the wizard from the Plan » Templates
page. The steps to start the wizard depend on whether you want to create a planned
run from generic application template or an existing template, or create a template
from generic application template or an existing template.

How you start the wizard is important, especially if your sequencing workflow uses
common sequencing products. Pre-installed templates are available for these common
sequencing products:

e Jon AmpliSeq™ Cancer Hotspot Panel v2.0
e Jon AmpliSeq™ Comprehensive Cancer Panel

™

¢ Jon AmpliSeq™ Inherited Disease Panel

e Jon AmpliSeq™ Cancer Panel

e Jon AmpliSeq™ Any Genome Panel
If you start with a pre-install product template, your new template or planned run has
the correct settings for the product.
Wizard lon Reporter Page

Ion Reporter is the first page in the Torrent Browser run template wizard. When you
select an Ion Reporter account in this page, features related to Ion Reporter™ Software
appear in the other wizard pages.

Flan “ m “

Create Plan from lon Proton Human CEPH Control 170

Create Plan lonReporter

Select an lonReporter account and workflow to use:o £

Summary
® None Sample
ionwest - go wild (Version: 4.0 | User: lon Grouping len Reporter: None
User | Org. IR Org) Sample_Control Application: DNA
ir-carlsbad (Version: 4.0 | User: lon User | ;
org: IR Org) Self Sample Grouping:
Tumor_Normal Target Technique:  Other
Trio len Reporter
Other Workflow:
DNA_RNA

SINGLE_RNA_FUSION

™

These selections on this page are only for Ion Reporter™ Software users.
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Wizard Application Page
In the Application page you select your experiment type:

o o

Select the application and target technigue, then hit next.

Application Target Technique
DNA AmpliSeq RNA
RMNA = AmpliSeq

Metagenomics DNA+RNA
Typing

= DMA and Fusions

«— Previous

Based on the information that you specify here, the Kits page is set with the
appropriate selections.
Notes about the Application choices:

e Metagenomics is reserved for future use with Ion Reporter™ Software.

¢ Typing is used for molecular fingerprinting to detect single strains of viral or
bacteria for research purposes.

Wizard Kits Page
On the Kits wizard page, enter the following information about laboratory kits and
other sequencing parameters:
* (Optional) Sample preparation kit
e Library kit type, including the forward library key and the forward 3' adapter
¢ Templating kit type
* Sequence kit
* Number of flows
* Barcode set Required for barcoded runs
* Base calibration mode
¢ Control sequence Required for RNA runs
* Chip type Required
e Mark PCR Duplicates Not recommended for Ion AmpliSeq™ data

Chip type is required. As with all fields, if you enter chip type in your templates, then
it is automatically entered in your run plans.

New in version 5.2, smart filtering is enabled on the Kits screen. When you select an
instrument, the Chip Type options are filtered so that you cannot select an
incompatible chip in error.
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Example Kits page:

Create Plan

Select instrument, chip and kits and then hit next.

Instrument :

lon PGM™ System ’

Sample Preparation Kit (optional) :

Library Kit Type Details + :
lan AmpliSeq 2.0 Library Kit

Template Kit . oneTouch @ lonChef
lon PG Hi-G Chef Kit
Templating Size: @ 200 © 400
Library Read Length: 227
Sequencing Kit :
lon PGM Hi-Q Seguencing Kit
© Base Calibration Mode :

Default Calibration r

«— Previous

Reference I@ﬁ
PlanTab [0

feptestion “ fluane

Chip Type (required) :
lon 318™ Chip v2 ’

Control Sequence (optional) :
Barcode Set (optional) :

lonXpress v

Flows :

500

© Mark as Duplicates Reads
© Enable Realignment

Note: The value entered for number of flows represents the maximum possible for a
run using a planned run based on this template. Instrument conditions such as the
availability of consumables might cause fewer flows to be completed.

Wizard Plugins Page

In the Plugins page, you select plugins to run with this run plan or to run every time a

run plan is created from this run template:

Create Plan lonReporter

Select plugins to execute, then click Next.

Select All Clear Selections

[ ampliSegRNA
ERCC_Analysis

RunTransfer

«— Previous
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FilterDuplicates

variantCaller

399



sae  Reference
o PlanTab

Note:

. The plugins available to you depend on what is installed and configured in your
Torrent Browser.

. All active plugins (those installed, configured, and enabled on your Torrent
Browser) are available in this menu.

- The IonReporterUploader plugin does not appear on this page.

- When you enable the variantCaller plugin, a Configure link appears for that
plugin. For information on configuring the variantCaller (variantCaller) plugin.

Wizard Projects Page

In the Projects page, you select projects the will receive the completed analysis from
this run plan or from every time a run plan is created from this run template:

(o

Select the project(s) that will receive data from runs planned in this template,
then hit next.

0000000000111111111122222222233
00000000001111111111222222222333
073113 _TargetSeq_Rescue
076A02_13B

076A02_13c_Reworked

Search Add Project....

You can also create a new project in this page.

Wizard Plan or Save step in the Workflow bar
The title for last step in the Workflow bar of the wizard is different for templates, run
plans, and run plans that are planned by sample set:

¢ Templates The step in the Workflow bar is Save. Here you enter the new
template name and optionally mark it as a favorite.

* Run plans The step in the Workflow bar is Plan. Here you enter the new run plan
name and sample information.

¢ Plan by sample set The step in the Workflow bar is Save & Finish. Here you enter
the new run plan name. (Sample information is automatically entered into the
Barcoding step in the Workflow bar.)

Note: Templates that are marked as favorites are listed in their own section at the top
of the Templates tab.
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The following is an example of a Planned Runs page with several planned runs.
Flan Runs Samples Templates Planned Run List
Planned Runs
All | by Template | by Sample
Select
|:| Run Code  Run Plan Name «  Barcodes Application Project  Sample Last Modilied «
el
R154302  EZ3gef-pooldse 20120822 @
TESBG lonkpr 1 i
O 7wsee nighl_fest10g OV RIESS 198 ez 02:24 AM
-R154234- EB5878-poold7- 201208721 @
PJIFHD none 1.2
U nidhi_test-1GC P oaa OED7 AM
-R154215 EZ33E0-pooldd- 20120821 &
[ =T fione . TG
nigh_test16C A+ ? L4922 05:18 AM
R154215 E238B0-pooldd- 201208721 &
4 ST
O Fse nidhi_test16C o WIG | 4922 0515 AM
_ -R154215 _ E38B0-pooidd- 201208721 @
THWESQ nome SKTE
- ! midhi_teet1 G0 , Ldgz? 05114
-R154213 EZ33B0-pooldd- 20120821 &
LTS one . EXT
= nidhi_est1GC A+ L4922 05:23 AM
7
Dedete Selacted Clear Selection
The following table describes the Planned Runs page contents.
Column heading Description

Run Code

A short code identifying the planned run.

Run Plan Name

Name of the planned run.

Barcodes

Name of the DNA barcode set, if any.

Application

An icon identifying the sequencing

application (such as whole genome, RNA

Seq, etc.)
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Column heading

Description

Project

Name of the project to contain the output
result sets.

Note: You can automate result sets going
to more than one project. Only one project
is shown here.

Sample

Name of the sample to be sequenced.

Sample Tube Label

Name of sample’s tube.

Chip Barcode

Chip’s barcode.

Library

Name of the reference library used.

Last modified

Time stamp of the last time the planned run
was created or changed.

Status

Only runs with status of "planned” can be
selected on the sequencing instrument.

A new planned run for the lon Chef™
System is first set to "pending”. The
instrument updates the plan to “planned”
when the plan is ready to be selected on
instrument.

Settings (£¥) menu

The Settings (£F) menu on the right side of
a planned run allows you to review, edit,
copy, delete, or transfer the planned run:

P

Edit
Copy
Delete

Transter

CSV Metrics File Format

A Comma-Separated Value (CSV) file is a universal text file format for storing data.
You can download an analysis metrics CSV file that contains analysis-level
information for one or more Torrent Suite Software analysis runs, in the Torrent
Browser Projects > ProjectsName > Results Sets in ProjectName page.

In the CSV file, each line represents a Torrent Suite Software analysis run, and within
each line information fields are separated by a comma. These files are easily opened
using spreadsheet software, such as Microsoft  Office Excel  or OpenOffice.org Calc,

402
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where each comma-separated field is listed in a separate column. The Torrent Browser
CSYV file has many CSV fields per entry, as described in the following table:

Field Description

Report Name of the analysis run report

Status Status of the analysis (e.g., Started,
Complete)

Flows Number of flow cycles from the actual
sequencing run

TF Name* Test Fragment Name

Q10 Mean* Average Q10 read length.

Q17 Mean* Average Q17 read length

System SNR*

System Signal-to-Noise Ratio

50Q10 Reads*

Number of TF lon Sphere™ Particles (ISP) at
50+ bp at Q10

50Q17 Reads*

Number of TF lon Sphere™ Particles (ISP) at
50+ bp at Q17

Keypass Reads*

Number of reads that have test fragment
keys

TF Key Peak Counts*

Signal strength of the first three bases of
the TF key

Total_Num_Reads

Total number of reads

Library_50Q10_Reads

Reads of length at least 50bp with 90% or
greater accuracy

Library_100Q10_Reads

Reads of length at least 100bp with 90% or
greater accuracy

Library_200Q10_Reads

Reads of length at least 200bp with 90% or
greater accuracy

Library_Mean_Q10_Length

Average length of reads with 90% or greater
accuracy

Library_Q10_Coverage

Average per base coverage considering
reads with 90% or greater accuracy

Library_Q10_Longest_Alignment

Longest read length amongst reads with
90% or greater accuracy

Library_Q10_Mapped Bases

Total bases from reads with 90% or greater
accuracy

Library_Q10_Alignments

Number of alignments from reads with 90%
or greater accuracy
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Field

Description

Library_50Q17_Reads

Reads of length at least 50bp with 98% or
greater accuracy

Library_100Q17_Reads

Reads of length at least 100bp with 98% or
greater accuracy

Library_200Q17_Reads

Reads of length at least 200bp with 98% or
greater accuracy

Library_Mean_Q17_Length

Average length of reads with 98% or greater
accuracy

Library_Q17_Coverage

Average per base coverage considering
reads with 98% or greater accuracy

Library_Q17_Longest_Alignment

Longest read length amongst reads with
98% or greater accuracy

Library_Q17_Mapped Bases

Total bases from reads with 98% or greater
accuracy

Library_Q17_Alignments

Number of alignments from reads with 98%
or greater accuracy

Library_50Q20_Reads

Reads of length at least 50bp with 99% or
greater accuracy

Library_100Q20_Reads

Reads of length at least 100bp with 99% or
greater accuracy

Library_200Q20_Reads

Reads of length at least 200bp with 99% or
greater accuracy

Library_Mean_Q20_Length

Average length of reads with 99% or greater
accuracy

Library_Q20_Coverage

Average per base coverage considering
reads with 99% or greater accuracy

Library_Q20_Longest_Alignment

Longest read length amongst reads with
99% or greater accuracy

Library_Q20_Mapped_Bases

Total bases from reads with 99% or greater
accuracy

Library_Q20_Alignments

Number of alignments from reads with 99%
or greater accuracy

Library_Key_Peak_Counts

Signal strength of the first three bases of
the library key

Library_50Q47_Reads

Number of perfect reads of length at least
50bp

Library_100Q47_Reads

Number of perfect reads of length at least
100bp
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Field

Description

Library_200Q47_Reads

Number of perfect reads of length at least
200bp

Library_Mean_Q47_Length

Average length of perfect reads

Library_Q47_Coverage

Average per base coverage considering only
perfect reads

Library_Q47_Longest_Alignment

Longest reads length amongst perfect
reads

Library_Q47_Mapped_Bases

Total bases from perfect reads

Library_Q47_Alignments

Number of alignments from perfect reads

Library_CF CAFIE metric: Carry forward

Library_IE CAFIE metric: Incomplete extension

Library_DR CAFIE metric: Signal/polymerase loss
(droop)

Library_SNR System Signal-to-Noise Ratio

Sample Name of the sample

Library Name of the reference genome

Notes Any additional user-provided notes

Run Name Long name of the analysis run

PGM Name Name of the lon PGM™ or lon Proton”™
instrument where the sample was
sequenced

Run Date Date the sample was sequenced

Run Directory

Location of the raw DAT files on the Torrent
Server

Num_Washouts NA
Num_Dud_Washouts NA
Num_Washout_Ambigous NA
Num_Washout_Live NA
Num_Washout_Test_Fragment NA
Num_Washout_Library NA
Library_Pass_Basecalling NA
Library_pass_Cafie NA
Number_Ambiguous NA
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Per-Base Quality Score System

Field Description
Number_Live Number of wells producing a signal
Number_Dud Number of wells with ISPs but no signal
Number_TF Number of wells containing test fragment
Number_Lib Number of wells containing library
Number_Bead Number of wells containing beads
Library_Live Number of wells containing library ISP with

signal

Library_Keypass Number of wells containing library ISP with

signal and match key

TF_Live Number of wells containing test fragment
ISP with signal

TF_Keypass Number of wells containing test fragment
ISP with signal and match key

Keypass_All_Beads Number of wells containing ISP with signal
and match key

P JSON string of plugin data

s JSON string of plugin data

* Columns 4-11 contain test fragment metric. There is one row of metrics for each test
fragment: A through D. The other columns contain library read metrics.

Per-Base Quality Score System

Quality Score
Predictors

406

The Ton Torrent ' per-base quality score system uses a Phred-like method to predict
the probability of correct base call. The prediction is based on the quality of the base
incorporation signal that was used for generating the base calls. The sequencers'
quality score system uses a set of 6 predictors whose values are correlated with the
probability of a base miscall.

A Phred lookup table is used for converting the values of predictors to error

probabilities. The lookup table is generated by training on a representative data set in
customer configuration. The lookup table is re-trained for each software release and is
shipped as part of the software package. Quality scores are published in the BAM file.

Torrent software uses the following six predictors that are correlated with empirical
base call quality:

P1 Penalty Residual: A penalty based on the difference between predicted
and actual flow values. Computed by the base caller.

P2 Local Noise: Noise (defined as the maximum absolute difference
between the flow value and the nearest integer] in the immediate
neighborhood (plus/minus 1 base) of the given base.
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P3 High-Residual Events: Number of high-residual flows in the 20-flow
window around the flow containing the base. A flow has high residual
when the normalized difference between the observed and model-
predicted signal exceeds 0.4 or falls below -0.4. The more high-
residual flows in the window, the lower quality the base call.

P4 Multiple Incorporations: Number of incorporated bases in this flow.
Length of the homopolymer. For multiple incorporations of the same
nucleotide in one flow, the last base in the incorporation order is
assigned a value equivalent to the total number of incorporations. All
other bases in the sequence of the multiple incorporations are
assigned the value 1.

P5 Environment Noise: The average signal noise (defined as the absolute
difference between the flow value and the nearest integer] in the
neighborhood (plus/minus 5 bases) of the given base.

Pé State Inphase: Live polymerase in phase.

The six quality predictors are calculated for each base. Other predictors (not described
here) are computed from the corrected flow values generated by the base caller.

The corresponding per-base quality value is located by finding the first line in the
lookup table for which all six calculated predictors are less than or equal to the
predictor values in the table. This process occurs automatically as part of the standard
analysis.

The Phred lookup tables are stored in the /opt/ion/config directory on Torrent Server.
The Torrent Server supports separate phred tables for each type of chip (Ion 314™
Chip, Ion 316™ Chip, Ion 318" Chip, and Ion PI"" Chip), named phredTable.314,
phredTable.316, phredTable.318 , and phredTable.p1.1.17 respectively.

The per-base quality along with all other read information is written to the unmapped
BAM file.

The per-base quality scores are reported in the QUAL field.

The quality scores are on a phred-10*log_10(error rate) scale.
References

1. Brockman et al. (2008): "Quality scores and SNP detection in sequencing-by-
synthesis systems." Genome Res. 18: 763-770.References

2. Ewing B, Hillier L, Wendl MC, Green P. (1998): "Base-calling of automated
sequencer traces using phred. I. Accuracy assessment.” Genome Res. 8(3):
175-185.

3. Ewing B, Green P. (1998): "Base-calling of automated sequencer traces using
phred. II. Error probabilities.” Genome Res. 8(3):186-194.
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lon Torrent BAM format

lon Torrent BAM format

Custom SAM
Recorder Tags

408

Ion Torrent BAM files follow the conventions of the SAM/BAM Format Specification
Working Group. SAM stands for Sequence Alignment/Map. .

The purpose of this section is to highlight specific Ion Torrent conventions and the
meaning of custom tags.

Ion Torrent Conventions:

Run ID: Every TS analysis gets a run ID, a 5-character string consisting of upper
case letters and numbers, assigned. A reanalysis of a specific run will get a
different run ID assigned. Example: OJU8V.

Read Group ID: For non-barcoded runs the read group ID is equal to the run ID.
For barcoded runs it is a combination of the run ID and the barcode name,
separated by a dot. Example: 0JU8V.IonXpress_001.

Key Sequences (KS): For non-barcoded runs, the key sequence tag is the Ion
Torrent library key (TCAG). For barcoded runs the KS tag entry includes the
barcode sequence and the barcode adapter sequence if barcode trimming is
enabled.

SAM record (read) names: Read names are a combination of the run ID and the
chip coordinates of the well that produced the read. The coordinate values are 5-
digit numbers and are given in the order row and the column, separated by a
colon. Example: 0JU8V:01308:00107.

BAM header comment lines (CO): Comment lines in the BAM header are used to
store base calibration information, or information about the 3' adapter sequences.

Ion Torrent uses a collection of custom tags to store sequencing and alignment
information useful for downstream processing. In general, custom BAM tags starting
with Z or Y are written by the BaseCaller and BAM tags starting with X stem from
TMAP. As a consequence, tags starting with Z or Y are present both in aligned and
unaligned BAM files whereas tags staring with X appear only in aligned BAM files.

Tag Type Description

XA

VA The algorithm that produced this mapping and from what
stage. The format is the algorithm name and the zero-
based stage (separated by a dash).

XM

Target Length, i.e., number of reference bases spanned by
the alignment.

XS

The alignment score of next-best sub-optimal mapping.

ZA

Number of library insert bases, where the library insert is

defined as the sequence after the key and barcode adapter,

and before the 3" adapter. (Only present if a 3' adapter was
found.)

/B

Number of overlapping adapter bases. (Only present if a 3'
adapter was found.)
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Tag

Type

Description

ZC

B:i

A vector of the following four values (only present if a 3'
adapter was found):

Field 1: The zero-based flow during which the first base of
the adapter was incorporated (same as ZG)

Field 2: The zero-based flow corresponding to the last
insert base

Field 3: Length of the last insert homopolymer
Field 4: Zero-based index of adapter type found.

ZF

The zero-indexed flow position corresponding to the first
template base after 5' trimmed region.

ZG

The zero-based flow during which the first base of the
adapter was incorporated. (Only present if a 3' adapter was
found.)

AV

Normalized signals, which include phasing effects. Stored
as floor(256*value)

P

B:f

Estimated phase parameters for the read. The values are
stored in the order: CF (carry forward), IE (incomplete
extension), and DR (droop).

T

The trimmed 5’ unique molecular tag sequence. Only
written if a tag was trimmed.

YT

The trimmed 3" unique molecular tag sequence. Only
written if a tag was trimmed.

ZE

The 5" trimmed sequence removed by the extra-trim-
left command. Only written if a sequence was trimmed.

YE

The 3" trimmed sequence removed by the extra-trim-
right command. Only written if a sequence was trimmed.
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Dataflow file sizes

Dataflow file sizes

Torrent Suite™
Software 5.2/5.0
and 400 bp kit on
the lon S5™ XL
System

410

The Ton Torrent  dataflow involves the transfer of raw sequencing data from the Ton

85", IonS5 XL, Ion PGM ', or Ion Proton sequencer to the Torrent Server for
analysis and reporting.

Auto-analysis
Through Run
Planning

Call variants on
re-analysis

Torrent Server

lon §5™ System

H* To Bases —>

vorrent Suite™ Software

Torrent Server

Alignments
Run Data Delivery :
Assessment — (BAM) e Gual]ty Scores
Variant Calls

Torrent Browser
and Flugins

Run Analysis

.

The following tables show a high-level view of the dataflow. File sizes for Torrent data
depend on the Torrent Suite " Software version, chip type, and kit type.

The following table shows a high-level view of the dataflow. File sizes for Torrent data
depend on the Torrent Suite” Software version, chip type, and kit type.

Step Res"tl;:;g file | |on520" Chip | Ion530" Chip | lon 540" Chip
Read Capacity | -- 5M 15-20 M 60-80 M
Signal DAT 210 GB 530 GB 2TB
Processing
Input
Signal WELLS 30GB 75 GB 180 GB
Processing
Output
Base Calling Unaligned BAM |55 GB 75 GB 85 GB
Output
Aligned Output | Aligned BAM 10 GB 25GB 55 GB
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dataflow with 4.x
software and 400

bp kit

lon Proton™

dataflow with 4.x
software and 200

bp kit

Dataflow file sizes

Reference E&9=

The following table shows a high-level view of the dataflow. File sizes for Torrent data
depend on the Torrent Suite” Software version, chip type, and kit type.

Step Res“tl;:)lg file | \on318™Chip | lon316™ Chip | lon 314™ Chip
Flows -- 900 900 900
Raw image DAT 396 GB 246 GB 52 GB
acquisition
Image WELLS 31.4GB 18.4 GB 3.5GB
processing
Signal BAM 6.8GB 4.5GB 0.65GB
processing and
base calling

A CAUTION! File sizes vary depending on the number of flows, the number of
wells generating signal, and the number of library reads available. Your file
sizes may be different. An unmapped BAM file format is used in pipeline steps
before alignment.

The following table shows a high-level view of the dataflow. File sizes for Torrent data
depend on the Torrent Suite " Software version, chip type, and kit type. The following
table shows a high-level view of the dataflow. File sizes for Torrent data depend on
the Torrent Suite™ Software version, chip type, and kit type.

Resulting S lon 318™ lon 316" lon 314"

Step file type lon Proton " Chip Chip Chip Chip
Flows -- 500 500 520 520
Raw image | DAT 2.7TB 225 GB 135GB 30GB
acquisition
Image WELLS 219 GB 16.4 GB 9.0CB 2.0CB
processing
Signal BAM 44 GB 4.2 GB 3.1GB 0.5CB
processing
and base
calling

CAUTION! File sizes vary depending on the number of flows, the number of
wells generating signal, and the number of library reads available. Your file
sizes may be different. An unmapped BAM file format is used in pipeline steps
before alignment.
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Configure and select a custom analysis parameter set

To create and select a custom analysis parameter set:

1. Click Settings (£F) » Analysis Parameters:

Updates

In the Analysis Parameters screen, factory parameters are denoted by "lon
Torrent" in the Source column.

2. To filter the parameter sets by chip type, select your chip type from the All Chips
menu.

3. Identify the parameter set you want to copy, then click Settings (¥#) » Copy in
the table row for that set.

Analysis Parameters

318 v | Go | ClearFilers
Last Modified v Name Description Chip Type Souice
2015/07/14 6:46:52 PM 318 smallRNA fon 318 chip vZ small RNA analysis arguments a8 fon B
2015007114 6:46:52 PM 318 Aneuploidy fn 318 chip v2 pre-implantation analysis arguments a8 ion e
View
2015/07/14 6:46:52 PM 318 HI-Q fan 318 chip v2 Hi-Q analysis arguments. 318
2015/07/14 6:46:52 PM default 318 fan 318 chip v2 analysis arguments s

4. In the Copy Analysis Parameters dialog, enter a parameter name and
description, and make any changes. Click Save.

Copy Analysis Parameters: lon 318 chip v2 analysis arguments (default_318)

Name: Chip Type:
318 b
L
Description:
@
Beadfind args: Thumbnail Beadfind args:

iustBeadFind -CUSTOM|

Analysis args: Thumbnail Analysis args:

Analysis --from-beadfind --use-alternative-etbR-equation

Clase Sava
]
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Your new analysis parameter set is available on the Analysis Parameters table.
The Source column lists the name of the user that created it.

Analysis Parameters

[sear me All Chips A Go Clear Filters
Last Modified Name Description Chip Type Sotitce
201507115 110 1
D715 1:10:26 PM my_args my args for 318 a8 i o
201507114 6:46:52 PM detault_541 fon 541 chip analysis arguments 541 don -

Click Settings (£#) to View or Copy this parameter set.

You select the custom analysis parameter set when you create a Planned Run.
Create a new Planned Run. In the Plan tab of the workflow bar, under the
Analysis Parameters section of the screen, select the Custom button, then select
your custom analysis parameters from the dropdown menu.

m lonReporter Application Kits Plugins Projects

Run Plan Name (required) :

Show Summary

testplan

Analysis Parameters: Default (Recommended) @ Custom Details -
my args (my_args) v

= <Current selection>

BeadFind <Previous custom selection> d:

lon 318 chip v2 analysis arguments (default_318)
justBeadFind lon 318 chip v2 Hi-Q analysis arguments (System default for this plan)

lon 318 chip v2 pharmacogenomics analysis arguments (default_318_PGx)
lon 318 chip v2 pre-implantation analysis arguments (318_Aneuploidy)
lon 318 chip v2 small RNA analysis arguments (318_smallRNA) 2
my args (my_args)

Analysis: Thumbnail Analysis:

Analysis —-from-beadfind --use-alternative-etbR-equation --gopt
foptfion/config/gopt_318v2_Hi-Q.param.json

v v
Pre-BaseCaller for calibration: Thumbnail pre-BaseCaller for calibration:
BaseCaller —-barcode-filter 0.01 --barcode-filter-minreads 20
i v
Calibration: Thumbnail Calibration:

Calibration

Note: You must first specify a chip type for the Planned Run (under Kits in the
workflow bar) before you can select the custom parameters.
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I Configure and select a custom analysis parameter set

7. Click Details+ to review the parameters.

Run Plan Name (required) :

test plan
BeadFind: Thumbnail beadFind:

justBeadFind ~CUSTOM|

Analysis: Thumbnail analysis:
Analysis ~from-beadfind —use-altemnative-ethR-2qua

Pre-basecaller: Thumbnail pre-Basecaller
BaseCaller —-barcode-filer 0.01 —barcode-filter-minreads 20

Calibration Thumbnail calibration:

calibrate —skipDroop

Basecaller: Thumbnail basecaller

BaseCaller --barcode-filter 0.01 —barcode-filter-minreads 20

Note: You can also access the custom analysis parameters from the Reanalyze
Run screen.

Reanalyze Run

Report Name :
Analysis Options
Start reanalysis from : ® Signal Processing Base Calling
Reference & Barcoding
Plugins
Analysis Parameters : @ Default (Recommended) Custom

Start Analysis

Find the TMAP See “TMAP examples” on page 429 for steps to open the run report log and search for
command for a the TMAP command. (The analysis must be completed before you can find the

specific analysis command.)
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The Command Line Args [Advanced) tab

The Command Line Args (Advanced) tab

An example Advanced Options page is shown here:

Beadfind args :

Analysis args :

Pre Basecaller Args
for calibration :

Recalibration Args :

Basecaller Args :

Alignment Args :

justBeadFind

Analysis —from-beadfind —use-alternative-etbR-equation

Reference

BaseCaller —-barcode-filter 0.01 —barcode-filter-minreads 20 —calibration-

trainina=100000 --flow-sianals-tvpe scaled-residual

calibrate —skipDroop

BaseCaller --barcode-filter 0.01 —-barcode-filter-minreads 20

staget map4

Start Analysis

Setting

Description

Beadfind args

Beadfind module command line arguments.
Should not be modified unless instructed by
lon Torrent™ Technical Support.

Analysis args

Analysis command line arguments. Should
not be modified unless instructed by lon
Torrent™ Technical Support.

Pre Basecaller args for calibration

Technical Support.

BaseCaller command line arguments. See
Basecaller arguments for information on

—--barcode-mode, --barcode-
cutoff,and --barcode-filter. Other
Basecaller arguments should not be
modified unless instructed by lon Torrent™

This field is used only if a Base Calibration
Mode other than ‘No Calibration’ is used.

Recalibration Args

Recalibration command line arguments.
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Overview of BaseCaller and Barcode Classification

Setting Description

Basecaller args BaseCaller command line arguments. See
Basecaller arguments for information on
--barcode-mode, ——barcode-
cutoff,and --barcode-filter. Other
Basecaller arguments should not be
modified unless instructed by lon Torrent™
Technical Support.

Alignment Args Arguments for the TMAP aligner.
(Replaces the TMAP Args field that appears

in previous releases.)

Overview of BaseCaller and Barcode Classification

About barcodes

416

This page discusses BaseCaller operations in general and issues around BaseCaller
parameters, barcode classification, and filtering and trimming.

The settings of BaseCaller parameters control barcode classification as well as filtering
and trimming.

Barcodes are short base sequences that during library preparation are placed between
the library key and the read. The barcode sequences provide a mechanism to
distinguish and identify reads from different samplesduring data analysis.

The use of barcodes allows multiple samples to be sequenced together on one chip
during a sequencing run, and still have the run's read data be analyzed separately
afterward as distinct samples.

This diagram shows the placement of the barcode sequence, as well as the library key
and adapters, with the read sequence (which is labeled "Template Bases"). The key is
on the 5' end.

Barcode Template Quality

B Barcode | qapter Bases Trimming

P1 Adapter

This example shows the location of the barcode sequence in both base space and flow
space, using barcode IonPress_001 as an example:

TCAG CTAAGGTAAC GAT TTAGCAGTCGGC...

T T T T

Library Key Barcode Barcode Adapler Read Sequence
(Flows 1 - B) (Flows 9 - 22) (Flows 23 - 25) (Flows 25 - end)
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Analysis pipeline The beginning steps of the Torrent Suite™ Software analysis pipeline are shown below:
overview

Raw traces (.dat files)

! '|.

bl b R et T e WYY

Signal Processing

1.wells

N

W

h 4

BaseCaller s
BAM file

33YAZ:0DD1300012 4 * O O * * 0 O
GATTTGCC TRIC; ZP-B1,0.0028008,0. 00473442 4 82005
W e-05 ZAi12 2G4:20 ZBiE ZCB:i.2022.1.0 ZMB:s,

234.0,242,0,0,226,0,512.0,0.0.4,250,0,0,0,608,0,254,0,2.504,0,268,520,
243 B.-2, 204,14 4 6,248

TMAP A|Igﬂmenl 8236410  ZFiT RGZHVAZ  PGZbe

v

Steps:

1. The sequencing instrument generates DAT files of electrical signals' raw traces.

2. The signal processing step converts the raw traces into a single number per flow
per well, in the 1.wells file.

3. The BaseCaller converts the 1.wells file information into a sequence of bases and
writes the sequence into an unaligned BAM file.

4. The BAM file is passed to TMAP for alignment.

The signal processing step also marks several types of low-quality reads:
¢ Polyclonal reads (reads with two template beads instead of one)

* Reads with high signal processing residual (indicating an ambiguous signal
value)

* Reads that do not contain a valid library key

Thesignal processing step marks these problematic reads but does not remove them.

Overview of In addition to creating a sequence of bases from the 1.wells file information, the
BaseCaller BaseCaller module also performs read filtering and read trimming.
functionality Notes on read filtering:

* Filters out low-quality reads that were marked during signal processing.

* Filters out reads that fail basecalling filters.

* Filtered out reads do notappear in the BAM file. The BaseCaller keeps counts of
these reads but there is no record of specific reads that are filtered out.
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Overview of BaseCaller and Barcode Classification

Notes on read trimming;:

Removes certain bases from the read for quality reasons.
The read appears in the BAM file.
The removed bases do not appear in theBAM file.

These are the steps performed in the BaseCaller:

1.
2.

Remove low-quality reads that were marked during the signal processing step.
Do base calling:

1. From the signal values, create the sequence of bases.
2. Estimate the base quality value for each base.

Do barcode classification:

1. Assign each read to a barcode.

2. Trim the barcode sequence away if ~-trim-barcodes=on is specified.
(The default is 'on').

Trim 5' unique molecular tag (only done if --trim-barcodes=on).

Trim extra bases at the 5' end. Controlled by —-extra-trim-left (defaultis 0,
meaning no extra trimming).

Filter out reads that are too short. Controlled by ~-min-read-length and --
trim-min-read-len.
Filter out reads that do not have the correct library key. Can be turned off by -~
keypass-filter.

1. Trim 3’ unique molecular tag (only done if P1 adapter was found).

2. Trim extra bases on the 3’ end. Controlled by --extra-trim-right (default is 0,

meaning no extra trimming. Only done if P1 adapter was found).

Trim the P1 adapter (at the 3' end).

Perform quality trimming. Affect ed by --trim-qual-window-size and --
trim-qual-cutoff.

Notes about quality trimming:

The purpose of quality trimming is to identify where quality issues begin at the
end of a read. We try to identify when bases fall below a quality threshold and
trim both those bases and a bit before those bases.

The parameter --trim-qual-window-size sets the window size for quality
trimming. The algorithm slides through the sequence of bases and, each time the
window shifts, computes the mean Base QV value for all bases in the window.

If the mean Base QV value for all bases in the window falls below a threshold (set
the by parameter --trim-qual-cutoff, default 16), then we trim all bases
from the center of the window at that time to the 5" end.

Notes about barcode classification and barcode filtering

Barcode classification determines which barcode group a read is assigned to. Barcode
classification is done for each read immediately after base calling.

Barcode filtering determines if a specific barcode is included in the run report or is
filtered out. Barcode filtering works on the barcode groups as a whole

418
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Barcode
Classification
Issues

Explanation of
fields in the
BaseCaller JSON
file

Reference
Overview of BaseCaller and Barcode Classification

Barcode classification metrics are available in the file basecaller results/
datasets basecaller.json in the Torrent Suite™ Software analysis directory.

This file contains information about all barcodes, no matter whether they appear in
the run report or are filtered out. This information describes the numbers of barcodes
that would be included or discarded if you reanalyze with certain changed BaseCaller
settings.

A sample of this file is shown here. Later examples in this page use this file:

"IEXL3.IonXpress 033": { "Q20 bases": 98859279,

"barcode adapter": "GAT", "barcode bias": [ 0.026, -0.028,
-0.034, 0.011, -0.019, -0.001, 0.072, -0.061, 0.103, -0.008,
-0.062, 0.110, -0.021, 0.001], "barcode distance hist":

[ 907546, 50122, 10793, 4498, 5342 ], "barcode errors hist":
[ 949782, 24584, 3935 ], "barcode match filtered": 162,
"barcode name": "IonXpress 033", "barcode sequence":
"TTCTCATTGAAC", "description": "1T 058a0112 Lib6457 Obp 1lr2
1r226b04", "filtered": false, "index": 33, "library": "hgl9/
IonXpress 033", "platform unit": "PGM/318/IonXpress 033",
"read count": 978301, "recalibrate": true, "sample": "None",
"total bases": 109292583 1},

Read count

The read_count field shows how many reads were assigned to this barcode.

"read count": 978301,

Filtered

The filtered field is true if this barcode is filtered out and false if the barcode
appears on the run report.

? "filtered": false,

Barcode errors histogram

The barcode errors histogram shows the number of reads with difference levels of
basecalling errors in this barcode:

¢ First field: The number of reads that have 0 basecalling errors (949782 in this
example). This is the number of reads that perfectly match this barcode (in base
space).

¢ Second field: The number ofreads that have one basecalling error(24584 in this
example).

* Third field: The number of reads that have two basecalling errors(3935in this
example).

From the 3935 value with 2 basecalling errors, we know that if we reanalyze with the
number of allowed errors set to 1 instead of 2, then 3935 fewer reads will be assigned
to this barcode.

? "barcode errors hist": [ 949782, 24584, 3935 ],

This histogram is typical of a real barcode. A large majority of reads are perfect
matches, a few have one error, and a smaller number have two errors.
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b BaseCaller arguments
If the pattern is reversed (with very few perfect matches, some reads with one error,
and many reads with 2 errors), we suspect that this is probably a fake barcode.
Barcode distance histogram
The barcode distance histogram shows, in signal space, the number of reads at various
squared residual distances between the predictedsignal and the observed signal.
The distance fields are given in 0.2 increments:
¢ The first field gives the number of reads with a squared residual distance of
between 0 and 0.2.
e The second field gives the number of reads with asquared residual distance of
between 0.2 and 0.4.
¢ The third field gives the number of reads with a squared residual distance of
between 0.4 and 0.6, etc.
Smaller distances reflect better matches of the read to barcode. Larger distances reflect
poorer matches.
This example reflects the pattern that is typical of a real barcode:
¢ The most reads have shorted distance residuals.
* Fewer reads have larger distance residuals.
¢ The entry 5342 in the fifth field tells us that reducing --barcode-cutoff to 0.8
would cause those 5342 reads not to be assigned to a barcode.
? "barcode distance hist": [ 907546, 50122, 10793, 4498,
5342 1,
Barcode match filtered
The barcode match filtered field gives the number of reads that perfectly
match the barcode in base space and also are filtered out because they do not meet the
separation criteria in signal space. The signal for these reads are in-between two
barcodes and are not close enough to either barcode to be assigned.
? "barcode match filtered": 162,
Barcode bias
The barcode bias values show the mean signal deviation by flow: how much the
observed signal is off from the expected signal. Low bias values, for example with the
value shown here, are indications of good signal.
Bias values around 0.33 indicate a signal that is about a third of a base off. Values near
0.5 indicate a signal that is half a base off. Values in this range indicate a problem with
the sequencing run or with the barcode classification.
? "barcode bias": [ 0.026, -0.028, -0.034, 0.011, -0.019,
-0.001, 0.072,? -0.061, 0.103, -0.008, -0.062, 0.110, -0.021,
0.0017,
BaseCaller arguments

This section describes select arguments used with the BaseCaller module.
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This page describes BaseCaller parameters that are available when you reanalyze a
completed run.

Note: The default BaseCaller parameters are tuned for Ion Torrent  data. In most
cases, you do not need to modify these settings. Modifying these parameters is
recommended for advanced users only.

However, if you use a custom barcode set, please see the cautions and requirements in
Design Custom Barcodes. Correct parameter settings require knowledge of your
barcode's distances in signal space. The BaseCaller defaults are optimized for the
IonXpress barcode set, and likely are not correct for a custom barcode set.

When you reanalyze a run, other parameters are also listed in the BaseCaller
arguments field. These parameters are for internal use please do not change or
remove these fields.

Note: Barcode classification is the process by which reads are assigned to one of the
barcodes present in one analysis run. Correct barcode classification is important
because a classification error results in a read being assigned to the wrong barcode,
which in turn leads to the read beinganalyzed as belonging to a wrong sample.

Barcode classification determines which barcode group a read is assigned to. Barcode
classification is done for each read immediately after base calling.

Barcode filtering determines if a specific barcode is included in the run report or is
filtered out. Barcode filtering works on the barcode groups as a whole.
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This table lists the more common BaseCaller parameters relating to barcode
classification. (All parameters listed in this table are barcode classification

parameters.)

Parameter

Default

Description

--barcode-cutoff

1.0
(Float)

Maximum distance allowed
in barcode matches. A
threshold that sets the
stringency for barcode
matches. Lower values
require more exact matches
when assigning reads to
barcodes. Higher values
allow less exact matches.

Reads that have a distance
greater than this value are
counted as barcode no-
matches.

--barcode-mode

2
(Integer)

Allowed values: 1, 2

e 1: Abarcode is scored
by comparing each read
sequence to each
barcode sequence in a
flow space alignment.
Errors in each flow are
summed over the
length of the barcode
flows.Then any barcode
with a number of errors
equal to or less than
the --barcode-
cutoff value can be
considered, and the
barcode with the fewest
errors with respect to
the input sequence is
the matching barcode.
(The default in 4.0,
known as hard decision
classification.) 2:
Barcode classification
is based on signal
information,specifically
on the squared distance
between the measured
signal and the predicted
barcode signal. (The
default in 4.4, known as
soft decision
classification.)

Note: --barcode-mode
0 is no longer supported.
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Parameter

Default

Description

--barcode-separation

2.5
( Float)

This setting controls how
much ambiguity in barcode
assignment you want to
tolerate, by investigating the
distances to the both the
closest barcode and to the
next closest barcode. A read
is rejected if the difference
in these two distances is
less than the —-barcode-
separation setting.

Note: --barcode-
separation has no effect
when —-barcode-mode is
setto 1.
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Parameter

Default

Description

--barcode-filter-postpone

—_

Allowed values: 0, 1, 2

e 0: Keeps the 4.0
behavior: b arcode
filtering is done
independently on each
block. This is the
default for all lon PGM™
analyses and also for
lon Proton™ thumbnail
(which only consist of a
single block) processing
and base calibration
training stage
processing.

e 1:BaseCaller does
barcode pre-filtering at
a 10x lower frequency
threshold (10 times
more lenient). B arcode
filtering is done on the
chip's full information
as a whole, after the 96
blocks are merged into
one. This is the default
for lon Proton ™ full-
chip [not thumbnail)
analyses.

e 2:The BaseCaller does
not do any barcode pre-
filtering. All barcode
classification happens
after the 96 blocks are
merged into one. (The
setting "2" is slower
than the setting "1". "2"
creates more files and
involves more
processing than 1)

Note: We do not
recommend that you change
this parameter. Instead
accept the pipeline defaults
(which are different for lon
PGM™ and lon Proton™
analyses).
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Parameter Default Description

--barcode-filter 0.01 Barcode frequency

(Float] threshold to be r.eported in
the Ul. The relative
frequency of a barcode is the
number of assigned reads
divided by number of reads
assigned to the most
frequent barcode.

Set to 0.0 to turn this filter
off. The setting 0.0 causes
all barcodes in the barcode
set to be reported in the Ul,
including barcodes with no
or very few reads, provided
that the barcode group has
at least --barcode-
filter-minreads
number of reads. (Typically
barcodes with no or very few
reads are not relevant to
your analysis and should be
filtered out.)

--barcode-filter-minreads 20 Threshold for the minimum
(INT) number of reads in a
barcode group, for that
group to be reported in the
Ul.

--trim-barcodes on Trim barcode and barcode
adapter. If off, disables all
other 5" trimming.

--barcode-adpter-check 0.15 Validate barcode adapter
sequence. The parameter
given is the maximum
allowed squared residual
per flow. This feature
reduces barcode set cross
contamination, e.g., between
the lonXpress and lonCode
barcode sets. (0=off)

The cutoff setting Notes about the ~--barcode-cutoff parameter with ~-barcode-mode 1:

* (1is the most restrictive setting. ~—~barcode-cutoff 0 allows only reads that
perfectly match a barcode in base space.

e The setting 0 works with any barcode set (both Ion Torrent  sets and custom
barcode sets).

* Do not set --barcode-cutoff greater than 2 with the lonXpress barcode set.
Values greater than 2 relax the classification rules and allow incorrect barcode
assignments.
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A rule of thumb for the maximum --barcode-cutoff setting is based on the
minimum distance of the barcode set in flow space:

barcode-cutoff < (d_..-1)/2

min

T he minimum distance for the IonXpress barcode set is 5. Then the maximum
recommended value for --barcode-cutoff is 2 for analyses that use the IonXpress
barcode set.

Notes about the --barcode-separation parameter:

¢ Larger values (close to the minimum distance of the code) require more strict
matching of the predicted signal for a read to be assigned to a barcode.

¢ Smaller values (for example, 0.2 and below) allow barcode assignment with an
expanded tolerance for errors. For example in the extreme case of separation=0,
the measured signal may be right in between two predicted barcode signals.

e If --barcode-separation is set at or above the minimum distance of the
barcodes in flow space, no reads at all are assigned to a barcode.

e If -—barcode-separation is set close to the minimum distance of the barcodes
in flow space, very few reads are assigned to a barcode.

e If --barcode-separation is too small, the risk of cross contamination
increases. More ambiguous reads are forced into a barcodeassignment (with a
higher rate of error in these assignments).

A rule of thumb for a good --barcode-separation setting is one half of the
minimum distance of the barcode set in flow space:

barcode-separation =d_;,/ 2

This table lists the public BaseCaller parameters that are available for you to modify.
However, please note that the defaults for these parameters are optimized for most
scenarios and in most cases the default settings are recommended.

Parameter Default Description

-d, or off When on, disables all
filtering and trimming
and overrides other
filtering and trimming
settings.

--disable-all-filters

-k, or on When on, filters out
reads that do not both
produce a signal and
match the library key
(or the test fragment
key).

--keypass-filter
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Parameter

Default

Description

--min-read-length

25
(Int)

F ilters out reads less
than this minimum read
length.

This filter screens out
poor reads early on to
avoid wasting
processing time on
them. See also —-
trim-min-read-
len, which sets the
minimum length
threshold that is applied
after trimming.

--prefix-mol-tag

Empty

Base structure of 5°
unique molecular tag
(ACGTN bases] to be
trimmed after the
barcode adapter.

--suffix-mol-tag

Empty

Base structure of 5°
unique molecular tag
(ACGTN bases) to be
trimmed before P1
adapter.

--extra-trim-left

(Int)

Trims this number of
bases beyond the
barcode adapter and the
5" unique molecular tag
(if applicable).

--extra-trim-right

Trims this number of
bases at the 3" end of
the template before the
3" unique molecular tag
(if applicable) and the
P1 adapter. Only done if
P1 adapter was found.

--trim-adapter-cutoff

16
( Float)

A score cutoff value.

Smaller values
correspond to more
stringent adapter
search and larger
values to less stringent
adapter search.

Set to 0 to turn off.

--trim-adapter-min-
match

(Int)

The minimum number
of P1 adapter bases
required in order to trim
the P1 adapter.
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--trim-qual-window- 30 Window size for quality
size (Int) trimming.
--trim-qual-cutoff 16 Cutoff for quality
( Float) trimming.
Set to 100 to turn off.
When set to 100, no
reads are filtered out
due to this parameter.
--trim-min-read-len 25 Filters out any
readsthat fall below this
(Int) o
minimum read length
after anytrimming step.
By default it is initialized
with the value of ‘'min-
read-length’.
BaseCaller filters
The BaseCaller module and its parameter settings control these types of filtering:
¢ Keypass
* Quality trimming
* Adapter trimming
Examples of With these examples:
BaseCaller * Do not remove the string "BaseCaller" from the Basecaller Args field.

parameters usage * Do not change BaseCaller parameters other than those listed in the basic table or
the public table (unless specifically directed to do so by Ion).

TMAP Modules

The Torrent Mapping Alignment Program (TMAP) is a sequence alignment software
program optimized specifically for Ion Torrent™ data. TMAP contains several
mapping algorithms, each with its own best application. TMAP's current default is

map4.

When you reanalyze a run, you can optionally change both the TMAP module ( map1,
map2, map3,map4, or mapvsw) and also change the module's parameters.

Note: The default TMAP parameters are tuned for Ion data. In most cases, you do not
need to modify these settings. Modifying these parameters is recommended for

advanced users.

428
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This table lists the mapping alternatives supported by TMAP. The map4 module is the
default. (Other modules are not run unless specifically called, for instance on the
Reanalyze page.)

Click the module name link to see the options supported for that module.

Module Description

map1 BWA-short reads mapping
e Very fast at finding perfect matches

e Very slow at finding a set of matches
with up to two mismatches

map?2 BWA-long / BWASW reads mapping

map3 Simplified SSAHA, based on a k-mer lookup
table

map4 Based on the BWA fastmap routine

Searches for the maximum exact matches
between the reads and reference

mapvsw A vectorized implementation of Smith-
Waterman

e Asingle mapping strategy that is twice
as fast as the other modules

¢ Modified to improve specificity

mapall A command to quickly map short
sequences to a reference genome.

See “TMAP examples” on page 429 for steps to open the run report log and search for
the TMAP command. (The analysis must be completed before you can find the
command.)

This example is the current default setting. Only the map4 module is used.

tmap mapall ? -f /results/referencelibrary/tmap-£3/hgl9/
hgl9.fasta -r /<server path>/results/analysis/output/Home/
Auto user G35-685--R65832-110mM K2S04-

OT salts-0630 24057 58335/IonXpress 057 rawlib.bam -v -Y -u --
prefix-exclude 5 -o 2 stagel map4

This example is the previous TMAP default. This example uses the modules map1,
map2, and map3, in that order. Progressively more reads are mapped by each module.

tmap mapall f <FASTA file> -v -Y -u --prefix-exclude 5 stagel
mapl map2 map3
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Option

alternate option

Type

Default

Description

--fn-fasta

FILE

[ no default ]

FASTAreference
file

--fn-reads

FILE

Standardinput
(stdin)

The reads file
name

--reads-format

STRING

Unknown

The reads file
format(fastq | fq
| fasta | fa Isam
| bam)

---fn-sam

FILE

Standardoutput
(stdout)

The SAM file
name

--bam-start-vfo

NT

0

Sets the starting
virtual file
offsets that limit
the range of
BAM reads to
process

--score-match

INT

Score for a
match

--pen-mismatch

INT

Mismatch
penalty

--pen-gap-open

INT

Indel start
penalty

--pen-gap-
extension

INT

Indel extension
penalty

--pen-gap-long

NT

Long
indelpenalty

Option

alternate option

Type

Default

Description

--pairing

INT

The insert
pairing:

e 0 Do not
perform
pairing

¢ 1 Mate
pairs (-5 0 -
P1)

e 2 Paired
end (-S1-P
0)

INT

INT
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Option alternate option Type Default Description
FLOAT -1.0
FLOAT -1.0

This page describes the parameters for the TMAP mapl module. The mapl module
implements BWA-short reads mapping and has these characteristics:

* mapl is very fast at finding perfect matches

* mapl is very slow at finding a set of matches with up to two mismatches

Note: The mapl module is not the current default for TMAP.

Options supported with the TMAP mapl module (all are optional):

--seed-length

INT

32

The k-mer length to
seed CALs (-1 to
disable)

--seed-max-diff

INT

The maximum
number of edits in
the seed

--seed2-length

INT

48

The secondary seed
length (-1 to disable)

--max-diff

NUM

0.04

The maximum
number of edits or
false-negative
probability assuming
the maximum error
rate

--max-error-rate

FLOAT

0.02

The assumed per-
base maximum error
rate

--max-mismatches

NUM

The maximum
number of or (read
length) fraction of
mismatches

--max-gap-opens

NUM

The maximum
number of or (read
length) fraction of
indel starts

--max-gap-
extensions

NUM

The maximum
number of or (read
length] fraction of
indel extensions

--max-cals-deletion

INT

10

The maximum
number of CALs to
extend a deletion
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--seed-length

INT

32

The k-mer length to
seed CALs (-1 to
disable)

--indel-ends-bound

INT

The number of bps
from the end of the
read

--max-best-cals

INT

32

Optimal CALs have
been found

--max-nodes

INT

2000000

The maximum
number of alignment
nodes

--min-seq-length

INT

The minimum
sequence length to
examine (-1 to
disable)

--max-seq-length

INT

The maximum
sequence length to
examine (-1 to
disable)

Option

Type

Default

Description

This page describes the parameters for the TMAP map2 module. The map2 module

implements BWA-long / BWASW reads mapping.
Note: The map2 module is not the current default for TMAP.

Options supported with the TMAP map2 module (all are optional):

Option

Type

Default

Description

--max-seed-hits

INT

1024

The maximum
number of hits
returned by a seed

--length-coef

FLOAT

5.5

The coefficient of
length-threshold
adjustment

--max-seed-intv

INT

The maximum
seeding interval size

--z-best

INT

The maximum
number of top-
scoring nodes to
keep on each
iteration

--seeds-rev

INT

The number of seeds
to trigger reverse
alignment
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--narrow-rmdup INT false Remove duplicates
for narrow SA hits
--max-chain-gap INT 10000 The maximum gap
size during chaining
--min-seq-length INT -1 The minimum
sequence length to
examine (-1 to
disable)
--max-seg-length INT -1 The maximum
sequence length to
examine (-1 to
disable)
TMAP map3 This page describes the parameters for the TMAP map3 module. The map3 module
Options implements a simplified SSAHA, based on a k-mer lookup table.

Note: The map3 module is not the current default for TMAP.

Options supported with the TMAP map3 module (all are optional):

Option

Type

Default

Description

--seed-length

INT

The k-mer length to
seed CALs (-1 to
disable)

--max-seed-hits

INT

20

The maximum
number of hits
returned by a seed

--hit-frac

FLOAT

0.2

The fraction of seed
positions that are
under the maximum

--seed-step

INT

The number of bases
to increase the seed
for each seed
increase iteration (-1
to disable)

--hp-diff

INT

The single
homopolymer error
difference for
enumeration

--fwd-search

Boolean

false

Use forward search
instead of a reverse
search

--skip-seed-frac

FLOAT

0.2

The fraction of a
seed to skip when a
lookup succeeds
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Option Type Default Description
--min-seq-length INT -1 The minimum
sequence length to
examine (-1 to
disable)
--max-seq-length INT -1 The maximum

sequence length to
examine (-1 to
disable)

Note: The map4 module is the current default for TMAP.

This page describes the parameters for the TMAP map4 module. The map4 module is
based on the BWA fastmap routine and searches for the maximum exact matches
between the reads and reference.

Options supported with the TMAP map4 module (all are optional):

Option

Type

Default

Description

--context

off

Modifies the gap
penalty in
homopolymers to
achieve more
accurate alignments

--do-repeat-clip

off

Clips repetitive
sequence ends of
aligned reads

--hit-frac

FLOAT

0.2

The fraction of seed
positions that are
under the maximum

--end-repair

INT

Rescues false
negatives by
selectively forcing
alignment at the 3
end of the read. The
recommended value
is 15.

INT

off 2147483647

Rescues false
negatives by
selectively forcing
alignment at the 3
end of the read. The
recommended value
is 25.

--seed-step

INT

The number of bases
to increase the seed
for each seed
increase iteration (-1
to disable)
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Option

Type

Default

Description

--min-seed-length

NT

The minimum seed
length to accept hits
(-1 to disable)

--max-seed-length

NT

48

The maximum seed
length to accept hits

--max-seed-length-
adj-coef (-1 to
disable)

FLOAT

2.0

maximum seed
length adjustment
coefficient (-1 to
disable)

--max-iwidth

INT

20

The maximum
interval size to
accept a hit

--max-repr

INT

The maximum
representative hits
for repetitive hits

--rand-repr

INT

false

Choose the
representative hits
randomly. Otherwise
uniformly

--use-min

Boolean

false

When seed stepping,
try seeding when at
least the minimum
seed length is
present. Otherwise,
use the maximum
seed length.

--min-seq-length

INT

The minimum
sequence length to
examine (-1 to
disable)

--max-seq-length

INT

The maximum
sequence length to
examine (-1 to
disable)

Torrent Suite™ Software 5.6 Help

435



@8E  Reference
TMAP Modules

C

&

%

TMAP mapvsw
Options

436

This page describes the parameters for the TMAP mapvsw module. The mapvsw
module implements a vectorized implementation of Smith-Waterman.

Note: The mapvsw module is not the current default for TMAP.
Options supported with the TMAP mapvsw module (all are optional):

Option Type Default Description

--min-seq-length NT -1 The minimum
sequence length to
examine (-1 to

disable)

--max-seq-length NT -1 The maximum
sequence length to

examine (-1 to

disable)
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